Selecting and Querying Data

This chapter presents the ins and outs of selecting records from tables. As you use MapInfo Professional® you will find yourself selecting records quite often. This chapter covers an overview of selecting and querying methods using tools from the Main toolbar.

In this Chapter:

- Selecting Your Data in MapInfo Professional .................. 302
- Querying Your Data in MapInfo Professional ................. 310
While MapInfo Professional allows you to attach data to objects on a map, its true analytical power is its ability to group and organize data. Once your data is broken down into logical groups, you can analyze it based on one or more variables.

For example, you have a basket of fruit. You want to organize the fruit into different categories, based on one or more variables:

- Put all the apples into one group
- Put all the citrus fruit into one group (oranges, lemons, grapefruit)
- Put all the fruit that begins with a vowel into one group (oranges, apples, apricots)

There are many different ways that you could group the fruit. Some fruit would fall into more than one category (oranges are citrus fruit and also begin with a vowel). You could also use more than one variable to group your fruit — put all the citrus fruit that begins with a vowel into one group.

MapInfo Professional can retrieve information or even individual records from within your data. We refer to the record or records that are retrieved this way as selections. A selection is a subset of data that has been collected based on one or more variables.

For example, you have a table of customer records. You could create a subset of all customers who live within a 50 mile radius of Prague. Or, you could create a subset of all customers who purchased over $1000 of merchandise. Or, you could create a subset of all customers whose last name begins with the letter “B”.

The statements above used to create these subsets are known as queries. A query is just another word for a question — which of my customers spent more than $1,000? Which of my customers lives within 50 miles of Prague?
As with the fruit example, there are many different ways to group your data. Some data records will obviously fall into more than one category. You could also use more than one variable to group your data. Which of my customers lives within 50 miles of Prague and purchased over $1000 of merchandise? This section gives you some examples and some practical applications of “selecting” in MapInfo Professional.

Characteristics of Selections

Selections are temporary tables. When you make a selection, MapInfo Professional creates this temporary table (called a selection) to store the records you’ve selected.

You can perform many of the tasks with a selection table that you can perform with a permanent (base) table such as:

- View it in a Browser, a Map window (if it has graphic objects), a Graph or a Layout window.
- Cut and copy it into the clipboard and paste it into another table, or even into another application.
- Use it to edit a table. If you want to edit only certain records in a table, you can get those records into a selection and then edit that selection.
- Make a further selection from it.

To convert selections into permanent tables, on the File menu, click Save Copy As. Once you’ve saved the temporary selection table as a permanent table, you can treat the new table like any other table. Selection tables are totally dependent on the table from which they were created. If you close a base table, all associated selection tables are deleted.

Selection Commands and Tool Descriptions

MapInfo Professional gives you a number of commands and tools for making selections. They fall into two categories:

- Selecting from the screen: Select tool, Radius Select tool, Boundary Select tool, Polygon Select tool, Marquee Select tool, Invert Selection tool, Select All command. To select records with the tools, click or encircle the associated graphic objects. To select records from a layer at the same time, on the Query menu, click Select All.
- Selecting with queries: Select, SQL Select. When you select records with either of these methods, you create a logical expression that MapInfo Professional uses to select the
Selecting Your Data in MapInfo Professional

records. For example, the expression SALES > 20000 means that MapInfo Professional will select only those records with sales higher than $20,000. We discuss Select and SQL Select in more detail in Using Select to Create Queries on page 318 and Using SQL Select to Query Data on page 321).

1. Choose Table > Import to display the Import File dialog box. Choose OS MasterMap (*.gml) from the Files of type: drop-down list and navigate to its location.

2. Select a GML file to import. Click Open. The GML Import dialog box displays.

Selecting from the Screen

To select objects from the screen, the layer that contains the objects must be Selectable. To make a layer Selectable, on the Map menu, click Layer Control and select the Selectable check box for that layer.

When you select map objects in a Selectable layer, MapInfo Professional highlights the objects using the settings defined in the Highlight Control section of the Preferences dialog box (Options menu). When you select map objects in an Editable layer, MapInfo Professional places edit handles (small squares) around the extents of the object you selected.

If you have more than one Selectable layer in a Map window, MapInfo Professional selects objects from the topmost Selectable layer.

For example, you have a Selectable layer of county boundaries and a Selectable layer of state boundaries. If the county boundaries are in the topmost layer in the Map window, MapInfo Professional selects objects from the county layer. If the state boundaries are in the topmost layer in the Map window, MapInfo Professional selects objects from the states layer. When you use the Select tool, MapInfo Professional also displays InfoTips for the topmost Selectable layer. As you move your cursor over the objects, InfoTips display the object’s label expression. You can turn off the InfoTips in the Map window Preferences (on the Options menu, point to Preferences and click Map window).

Likewise, if you perform a boundary search, the boundary object that you want to search should be in the topmost layer.

For example, you have a layer of postal code boundaries and a layer of state boundaries. If you want to select all objects that fall within a postal code boundary, the postal code layer should be the topmost boundary layer. If you want to select all objects that fall within a given state, the state layer should be the topmost boundary layer. You can reorder the layers by selecting the Map menu, and clicking Layer Control.

You can select objects from tables other than the topmost table, by holding down the Ctrl key when you are selecting an object. For example, say you have three selectable layers, such as STATES, COUNTIES, and CITIES. If you want to select objects in the STATES table, but it is the bottom layer in the Map window, do the following:

1. Hold down the Ctrl key and click the map with the Select tool. You are now in the second layer.

2. Hold down the Ctrl key and click the map again with the Select tool. You are now selecting objects from the third layer, the STATES layer.
Selecting a Single Object from a Map or Layout

Making selections is a basic MapInfo Professional operation, using the Select tool is only one way of making selections.

The tool must be active before you can use it; activate the tool by clicking on it. The tool's icon is highlighted in the Main toolbar and the cursor becomes a pointer. If you are editing records in a browser, the cursor becomes an I-beam.

To select a single object from a map or layout:

1. Click the Select button in the Main toolbar.
2. Click the object.

The layer where the object is located has to be selectable in the Map window. When an object is selected it is highlighted according to the settings you specified in Options > Preferences.

- When the layer is editable, the selected object is surrounded by edit handles and is colored and patterned as it was originally defined.
- When you select another object, the first object is unselected.
- To select a number of objects from a map or layout, hold the Shift key down and click the desired objects with the Select tool.

Selecting Tools

MapInfo Professional includes several tools on the Main toolbar to allow you to choose records for further viewing and analysis, including the Select tool, Radius Select tool, Marquee Select tool, Polygon Select tool, Boundary Select tool, and Invert Selection tool. Each tool is discussed in the next section.

Using the Select Tool

Use the Select tool to select objects one at a time or to select all objects that are generally in the same area of the Map window. You select an object by clicking it using the mouse.

To select an object using the Select tool:

1. Make the layer that you want to select objects from Selectable (on the Map menu, click Layer Control).
2. Choose the Select button from the Main toolbar.
3. Click an object in the Map window. If that object's layer is selectable, MapInfo Professional highlights the object. If the layer is editable, MapInfo Professional puts edit handles around the extents of the object. If the layer is neither editable nor selectable, MapInfo Professional does not allow you to select the object.
4. On the Window menu, click New Browser Window to display selected records in a Browser. Choose Selection from the list of tables. MapInfo Professional creates a Browser of the new temporary table. To select records from the Browser, simply click each record with the Select tool.
To select multiple objects individually:

1. Click the first object to select it.

2. Hold down the **Shift** key and click another object. MapInfo Professional selects that object, too. If you select a second object without holding down the **Shift** key, MapInfo Professional unselects the first object and selects the second object.

   • For additional instructions, see *Selecting the Next Selectable Object Beneath the Current Object* in the Help System.

**Using the Unselect All Tool**

Use the Unselect All to deselect all of the selected objects. You use this most often when you have selected too many objects and want to start over.

To select an object using the Select tool:

   • Choose the **Unselect All** button from the **Main** toolbar.

**Deselecting Objects and Removing Objects from the Selection**

To deselect an object or remove it from the selection:

   • Hold the **Shift** key down and then click the object. When you click, the object is removed from the selection set.

To deselect all objects:

   • Choose *Query > Unselect All* or click someplace on the map where there are no objects.

   • For additional information, see *Moving Selected Objects and Rotating Selected Objects* in the Help System.

**Using the Radius Select Tool**

The Radius Select tool is used to select all objects that fall within a given radius. For example, you have a table of blood donors and a table of blood donation sites. Using the Radius Select tool, you could create a temporary list of blood donors that live within a one-half-mile radius of each blood donation site.

The Radius Select tool selects all objects whose centroid falls within the circle. The object doesn’t have to be completely bounded by the circle.
To select objects within a radius:

1. Make the layer you want to select objects from selectable (on the Map menu, click Layer Control).

2. Choose the Radius Select tool from the Main toolbar. The cursor becomes a hand when moved over the Map window.

3. Click a place on the map that you would like to use as the center point of your radius search. For example, if you want to select all the fire hydrants that fall within two miles of a fire station, click the fire station and use that as the center point.

4. Hold down the mouse button and drag the mouse away from the center point. MapInfo Professional draws a circle around the point and reports the radius of the circle in the Status Bar (lower left corner of the screen).

5. When you have the desired radius release the mouse button. MapInfo Professional highlights all map objects that fall within that circle.

6. To see a list of all the records that fall within that circle, choose New Browser Window from the Window menu. Choose Selection from the list of tables. MapInfo Professional creates a Browser of the new selection table.

Using the Marquee Select Tool

The Marquee Select tool is used to select objects within a rectangle. By clicking and dragging using the Marquee tool, you create a dotted rectangle, or marquee box around objects you want to select. All Selectable objects in the topmost Selectable layer will be included in the marquee box.

Note: To select objects from another layer, you must turn off selectable in Layer Control for the upper layers. Only objects from one layer at a time are selected.
To select objects within a rectangle:

1. Make the layer that you want to select objects from Selectable (click **Layer Control**).
2. Choose the **Marquee Select** tool from the Main toolbar. The cursor becomes a hand when moved over the Map window.
3. Click a place on the map outside of the area you want to include in the marquee box.
4. Hold down the mouse button and drag the mouse to form a dotted rectangle around the points you want to select.
5. When you have reached the desired rectangle size release the mouse button. MapInfo Professional highlights all map objects that fall within that rectangle.
6. To see a list of all the selected records, on the **Window** menu, click **New Browser Window**. Choose **Selection** from the list of tables. MapInfo Professional creates a Browser of the new selection table.

**Adding Objects to the Selection Set**

Use the **Shift** key with the **Marquee Select** tool when you wish to add newly selected objects to the previous selection.

**Using the Polygon Select Tool**

The Polygon Select tool selects map objects within a polygon that you draw on a map.

To select objects with the Polygon Select tool:

1. Make the layer that you want to select from Selectable (on the **Map** menu, click **Layer Control**).
2. Choose the **Polygon Select** tool from the Main toolbar. The cursor becomes a pointing hand when moved over the Map window.
3. Click the map location at which you want to place the first end point of the polygon. Move the cursor over your map in any direction. MapInfo Professional draws a line from the point where you clicked to the cursor.
4. Click to create another endpoint. Continue to move the cursor and click until you have the desired number of sides to your polygon.
5. To close the polygon, make your last click as close as possible to the first click. MapInfo Professional closes the polygon and selects the objects that are within it.

**Note:** Press **Shift** while using the **Polygon Select** tool to add newly selected objects to the previous selection.

**Using the Boundary Select Tool**

If you want to select objects that fall within a given region or boundary, use the Boundary Select tool. When you use this tool, MapInfo Professional selects all objects within any boundary on the map, such as state or county boundaries, police precincts, or sales territories.
For example, you have a layer of states and a layer of retailers. Using the Boundary Select tool, you could click a state and create a temporary list of all the retailers in that state.

To select objects within a region:

1. Make the layer that you want to select objects from Selectable (click **Layer Control**).
2. Choose the **Boundary Select** tool from the **Main** toolbar. The cursor becomes a cross hair when moved over the Map window.
3. Click within a boundary object. MapInfo Professional selects all objects that fall within that boundary.
4. To see a list of all the records that fall within that boundary, on the **Window** menu, click **New Browser Window**. Choose **Selection** from the list of tables. MapInfo Professional creates a Browser of the new selection table.

**Using the Invert Selection Tool**

The Invert Selection tool is a convenient way to select many objects at once. You simply select the few objects that you don’t want, and then invert the selection to select all the objects you do want.

1. Make the map layer that you want to select from Selectable (on the **Map** menu, click **Layer Control**).
2. Make the **Select** tool active, and click one or two map objects.
3. Click the **Invert Selection** tool. MapInfo Professional selects all the objects that are not part of the current selection, and cancels the current selection. You can also find **Invert Selection** in the **Query** menu.

**Unselecting Objects or Records**

You may choose to:

- Unselect one object or record from a group of selected objects or records.
- Unselect a group of selected objects or records.
- Unselect all selected objects.

To cancel the selection of one object or record from a group of selected objects or records, hold down the **Shift** key and click the object or record with the Select tool. When you click it, the selection is cancelled.

To cancel the selection of all selected objects, you can either click the Map window where there are no objects or choose the **Unselect All** command from the **Query** menu.
Querying Your Data in MapInfo Professional

A **query** is a mathematical question that you pose to your database to collect information. In MapInfo Professional, there are two query builders available under the **Query** menu, **Select** and **SQL Select**.

**Figure: SQL Query to Determine Homes Affected by Airport Noise Pollution**

In the case of **Select**, you can pose a question of a single table. For example,

- Which of my customers spent more than $20,000?
- Which of my customers live in Vermont?

In the case of **SQL Select**, you can ask your question from one or several table(s) of information and perform these tasks:

- Derive new columns – columns that calculate new values based on the contents of your existing columns.
- Aggregate your data so that you see only a listing of subtotals instead of seeing your entire table.
- Combine two or more tables into one results table.
- Show only the columns and rows that interest you.

**Selecting and Using Queries**

**Select** allows you to query a table. It allows you to select records and objects from a table according to their attributes. You can use it to highlight objects in a Map or Browser window that meet certain criteria. You can also create a results table that you can browse, map, or graph like any other table.
For instance, by formulating queries with Select, you can ask MapInfo Professional to:

- Show only postal code regions where the average household income is above $65,000.
- Show only postal code regions where the median age is 42.
- Show only the postal code regions where the household income is above $65,000 and the median age is 42.
- Show only records for all orders received in July or September.
- Show cities of over 100,000 people in Texas, California and Florida.

When you are working in a Browser, MapInfo Professional highlights the records meeting the criteria of the query. When you are working in a Map window, the graphic objects of the chosen records are highlighted. When you are working in both windows, the objects in both are highlighted. In all cases, MapInfo Professional automatically creates a working table called Selection that contains the results of the query. You can browse, map, or graph this table like any other table. The table can also be saved as a separate table with Save Copy As.

**Finding an Object or Street Address**

To find an object or street address:

Your tables must be mappable and indexed. If you need to set up these components, see File > New Table (Import) or Table > Maintenance > Table Structure.

1. Choose Query > Find, a Find dialog box displays.
2. Click the Search table drop-down list and choose a table from which to search.
3. Click the for objects in column drop-down list and choose the column containing the location information of the objects you are looking for.

You now have the option of refining the search. Use this option when you are trying to find an object or address whose name is not unique and is used for other objects or locations.

For example, when you are searching for the town of Ipswich in Great Britain, do you want Ipswich in Suffolk county or Ipswich in Essex county. Refining the search by county allows you to specify the county for each town, rather than just the town name.

- **Optional** - Click the Refine search with table drop-down list and choose a refining table (the table must contain regions, such as states, counties, census tracts etc.).
- **Optional** - Click the using boundary name column drop-down list and choose your refining column, the column containing the name of the boundary.

4. Check the Find in Front Window Only check box when you want the Find operation executed only in the Front Window. When this check box is unchecked, the Find operation is executed in all windows. When checked, if features are found, they will be marked with a symbol in a Map Window. If the Browser window is the active window, it will be scrolled so the record appears in the Browser view.

When you have finished defining where to look for your search data and selecting between the front most map and all maps then specify what data to look for.
5. Click OK. The Find dialog box displays. This dialog box allows you to specify what data to look for.

The name of the column that you specified in the first Find dialog box is listed to the left of the list box (for example, Street). When locating a street address, type in "# Name", such as "30 Elm St" or "1045 Templar Blvd." What you type in depends on geocoding preferences specified in Options > Preferences > Address Matching.

Note: MapInfo Professional comes with a text file called MAPINFOW.ABB [MapInfo Professional Abbreviations], that contains a list of common street abbreviations, such as "St" for "Street" and "Blvd." for "Boulevard," and so forth. These help MapInfo Professional to obtain exact matches. To familiarize yourself with the MAPINFOW.ABB file, you can take a look at its contents in the Notepad Text Editor.

6. Type the name of the object or address you are searching for in this box. If you have used the Refine option in the first dialog box, a second column name is listed (for example, ZIP).

7. Type the name of the refining boundary in this box. If MapInfo Professional cannot find an exact match for the object you specified, it lists possible matches.

8. Click Up or Down to move to other pages and choose a specific entry from the list.

9. Click OK and the find is initiated.

You can also use the Find command to locate street intersections. When you type in the name of the object to be found in the second Find dialog box (enter object name to find), separate the two items by a double ampersand (&&). For example, to find the intersection of Congress Street and Christie Street, type "Congress Street && Christie Street."

Finding and Displaying a Selected Object

When you create a query or a SQL query, you may want to see the results of that query visually on the map.

To find and display a selected object:

1. Do one of the following:
   - From the Query menu, select Select to display the Select dialog box
   - From the Query menu, select SQL Select to display the SQL Select dialog box

The Find Results in Current Map Window check box displays in both dialog boxes.

2. Create your query and verify that it is correct, selecting the open table that you want to query.
3. Select the **Find Results in Current Map Window** check box to display the results upon completion.

4. Click **OK** to display the results.
   • For more information, see *Selecting All Objects from a Table* in the *Help System*.

**Figure: Query Results of Urban Population > Rural Population**

---

**Making Queries using the Select Command**

MapInfo Professional has two commands for selecting objects through querying: Select and SQL Select. Select is simpler and SQL Select is more powerful.

To make a query:

1. Choose **Query > Select**. The Select dialog box displays.

2. Click on the **Select** records from table drop-down list and choose the table from which to select the records.

3. Type your query expression in the **that satisfy** box, or click the **Assist** button to display the Expression dialog box which helps you write an expression.

4. Type a name in the **Store Results** in table box for the temporary table that stores the results of your query or choose selection (the default). If Selection is chosen, MapInfo Professional automatically names the table Query 1, Query 2 etc.

5. To sort the query by the value in some column (optional) click the **Sort results by column** drop-down list and choose the column containing the value you want to sort with.
6. Click **OK**. A Browser window of your query results displays if the **Browse Results** box is checked.

You can use Select to highlight objects in a map or a table that meet certain criteria and create a results table that you can browse, map, or graph like any other table.

- When you are working in a Browser window, the records meeting the criteria of the query are highlighted.
- When you are working in a map, the graphic objects of the chosen records are highlighted.
- When you are working with both a Map window and a Browser window, the objects and the records are highlighted.

In all cases, a working table is automatically created called Query 3. This table contains the results of the query. You can map, or graph this table like any other table. The table can also be saved as a separate table with **Save Copy As**.

- For more information, see *Saving Queries and Loading Templates* in the Help System.

### Making Queries using the SQL Select Command

To create a query using SQL Select:

1. Open the table you wish to query, if you haven't already done so. The table that you query is known as the **base table**. If you use SQL Select to perform a query on the World table, the World table is your base table.

2. Choose **Query > SQL Select**. Fill in the portions of the SQL Select dialog box that meet your needs. When you click **OK**, MapInfo Professional performs the query.

   MapInfo Professional extracts data from your base table, stores the query results in a special, temporary table, known as the **results table**. The results table contains only the rows and columns that meet your criteria. The default name of the results table is **Selection** (although you can specify a different results table name in the Into Table Named field in the SQL Select dialog box).

3. Open a Map window and/or a Browser window if you want to see the query results. By default, MapInfo Professional displays the results table in a Browser window automatically (unless you clear the **Browse Results** check box in the SQL Select dialog box).

   If your results table is called **Selection** (the default name), the Browser window shows a different table name, such as Query1 or Query2. This is because the moment you Browse the Selection table, MapInfo Professional takes a "snapshot" of the table, and names the snapshot Query\(n\) (where \(n\) is a number, one or greater). MapInfo Professional takes the snapshot because "Selection" is a special table name; Selection dynamically changes every time you select or deselect rows.

   In the SQL Select dialog box, you can enter a different name for your results table (e.g. you can name your results table My_Query). This prevents MapInfo Professional from renaming your results table Query\(n\).

4. MapInfo Professional automatically selects all rows in the results table. Thus, after you perform SQL Select, you can perform operations on the entire set of selected rows. For example, you could apply a different fill color to all selected rows (by choosing **Options > Region Style**), or you could cut or copy all selected rows.
5. Usually, any alterations you make to the results table are automatically applied to your original (base) table. For example, if you use SQL Select to select some of the rows from the Orders table, and then you delete some of the rows from your results table, MapInfo Professional deletes the corresponding rows from your base table (Orders). However, if your query produces subtotals, you can alter the results table without affecting the base table.

6. Choose File > Save As if you want to make a permanent copy of the results table. If you do not perform Save As, the results table will be deleted when you exit MapInfo Professional.
   • For more information, see Using the SQL Select Dialog Box’s Where Condition Field, Updating a SQL Select Query Table and Using the SQL Select Dialog Box’s Select Columns Field Templates in the Help System.

Displaying Query Results Quickly

When you create a query or a SQL query, you can display the results visually on the map.

To find and display the results of a query automatically:

1. Do one of the following:
   • From the Query menu, select Select to display the Select dialog box
   • From the Query menu, select SQL Select to display the SQL Select dialog box

   ![Select Dialog Box]

   The Find Results in Current Map Window check box displays in both dialog boxes. If there are no open Map windows, this check box is disabled. You cannot save this check box setting to a template. This option is cleared by default.

2. Create your query and verify that it is correct, selecting the open table that you want to query.

3. Select the Find Results in Current Map Window check box to display the results. Click OK.
   • For more information, see Choosing Which Columns Appear in the Results Table and Creating Statistical Calculations in the Help System.

Creating Query Expressions

To perform a Select query, you must create an expression. An expression is a logical statement that is used to ask your question. For example, you have a table of apartments for rent. If you want to create a temporary table of all apartments that cost less than $800 a month, you could use the expression:

   • RENT < 800

   where RENT is the name of a numeric column that contains the per month rent rate.
MapInfo Professional searches the apartment table for all records that satisfy this condition and puts those records in a temporary table that you can map, browse, graph or carry out additional queries.

You can also perform mathematical operations on your data. For example, you want to create a temporary table of all apartments that have a total cost of less than $800. Total cost is equal to the sum of the rent and the monthly utilities.

You could use the expression:

- RENT + UTILITIES < 800

You are telling MapInfo Professional to add the number in the RENT column and the number in the UTILITIES column and then compare that number to 800.

For more information, see Creating Expressions on page 485 for details in creating a variety of expressions.

Specifying an Expression

There are two ways of creating an expression. The first method is to type in the expression directly. When you are creating very simple expressions, this method is usually faster. The second method is to press the Assist button in the Select dialog box and build your expression using the pop ups in the Expression dialog box. This method is particularly useful when you are just learning how to build expressions or when you are building very complex expressions.

To specify an expression:

1. Choose Query > Select. The Select dialog box displays.
2. Click the Assist button. The Expression dialog box displays.
3. Type your expression directly into this box, or choose from the drop down list selections to create an expression.
4. Click Verify to verify that your expression is valid.
5. Click OK to return to the Select dialog box.
6. Click OK to run the expression.

The Expression dialog box gives you three drop-down lists that you can use to build your expression: columns, operators, and functions.

Columns

This pop up lists every column in the table from which you are selecting. If the table contains derived columns from previous queries, those columns will also be listed.
Operators

This pop up contains mathematical and logical operation symbols. The mathematical operators in this pop up include addition, subtraction, multiplication, division, greater than, less than, and equal signs. You can use these symbols to create mathematical formulas. For example, from your table of sales representatives you want to select those sales representatives who, on the average, gross more than $2000 per month. Gross sales is computed by adding together sales and commission.

You have two columns in your table: TOTAL_SALES, which is total sales for the year for each representative and COMMISSION, which is total commission for the year for each representative. You could build the following expression:

\[(\text{TOTAL\_SALES} + \text{COMMISSION}) / 12 < 2000\]

This expression tells MapInfo Professional to add the number in the TOTAL_SALES column with the number in the COMMISSION column. However, this gives you gross sales for the year. We want average gross sales for the month. Therefore, we divide the sum by 12, which will give us a monthly average. We then compare that figure with 2000.

The Operators pop up also includes logical operators conjunctions AND, NOT, OR and LIKE. The LIKE operator can be used with two wildcard characters: ‘%’ and ‘_’. The ‘%’ character matches zero or more characters. The ‘_’ character matches only one character.

Functions

This pop up contains mathematical functions that take one or more parameters and return a value. You use functions to perform basic mathematical functions on the data in that column. For example:

• \(\text{abs(<number>)}\)

takes the absolute value of the numbers in the specified column.

For example, a meteorologist wants to select all days where the temperature in her city was more than 10 degrees warmer or cooler than the national average. She has a column in her table, AVG_DIFF, that contains the difference between the national average and city average.

She could create the following expression:

• \(\text{AVG\_DIFF} < -10 \text{ Or } \text{AVG\_DIFF} > 10\)

This expression tells MapInfo Professional to select all records that have an average difference less than -10 or greater than +10. However, she could also create the following expression:

• \(\text{abs(AVG\_DIFF)} > 10\)

This expression tells MapInfo Professional to select all records where the absolute value of the average difference is greater than ten.

The Functions pop up contains many other functions, including area, perimeter, sin, cos, and date-related functions. For a complete list of functions, see Creating Expressions in Chapter 16 on page 485.

Verify

This button reviews the expression you have created and verifies that it is valid. This is particularly helpful if you are new to writing expressions.
Using Select to Create Queries

In general the process for selecting objects using Select is:

1. On the **Query** menu, click **Select** to display the Select dialog box.

1. **Select the table from which to select records.**
2. **Create the expression to select records.**
3. **Choose a storage place for results.**
4. **Choose column for sorting.**

2. To see a list of the records you have selected, select the **Browse Results** check box. MapInfo Professional creates a Browser of the new selection table.

3. To display the query results in the currently active Map window, select **Find Results in Current Map Window**. If there are no open Map windows, this check box is disabled. You cannot save this check box setting to a template. This option is cleared by default.

4. Click **OK** to begin the query.

MapInfo Professional names the table Query1. It will name the next temporary selection table Query2. You can override MapInfo Professional’s default name and give the selection a descriptive name. Type the new name into the Store Results in Table box. The table can also be saved as a separate table with **Save Copy As**.

**Example: Selecting**

MapInfo Professional makes finding information and locations easy. You can use the **Select** feature to create subset databases. As an example, we use the WORLD table to select countries with a literacy rate greater than 90%.

1. Open the WORLD.tab table.
2. On the **Query** menu, click **Select** to display the Select dialog box.
3. Complete the Select dialog box:
   - **Select Records from Table** — From the Select records from table drop-down list, choose World.
   - **Assist** — Click the Assist button to display the Expression dialog box.

4. Complete the Expression dialog box as shown in the figure:
   - From the **Columns** drop-down list, choose Literacy.
   - From the **Operators** drop-down list, choose > (the greater than sign).
   - Type 90.
   - Click **Verify** to confirm the syntax of your expression. Click **OK** to close the Verify dialog box.

5. Click **OK** to close the Expression dialog box. The Select dialog box redisplay.

6. Select the Browse Results check box.

7. Click **OK**. MapInfo Professional creates a Browser that contains the selections. Notice that the selections display in both the World map and Browser.
Making a New Table Using a Subset of a File

Many of the data sets that are used with MapInfo Professional include more objects and information than necessary for some projects. In many cases it is easier to work with a subset of the complete data product. For example, if you were tracking crime statistics for a county by census tract, you would not need the census tracts for the entire state.

There are two ways to create a new table that will contain a subset of the records from an existing file. You can interactively select the objects representing the records you would like to put in the new table using one of the select tools. Or, you can use the SQL Select command to choose a subset of objects based on an SQL function. For an example using the SQL Select command, see Example 1 — Computing Population Density Using Area on page 322. Saving the resulting table is the same procedure, whether you choose the objects interactively or use an SQL select statement.

Note: Many of the queries on the following pages can be done either by using the SQL Select command or through the simpler Select command. Because SQL Select is more versatile and more commonly used, the SQL Select dialog box is used in the following examples.

Interactively Selecting Objects

1. On the File menu, click Open and open the table in a Map window.
2. Select the objects that will make up the subset with the Select tool, Radius Search Selector tool, or Polygon Search Selector tool. Shift-click to select multiple objects.
3. On the File menu, click **Save Copy As** and save the Selection table. The table can be saved with any filename.

**Using SQL Select to Query Data**

A *selection* is a subset of data rows in a table, chosen based on the contents of one or more columns from the table. You create selections by formulating questions, or queries, about your data. How many customers live in the state of Idaho? Which police precinct has the highest rate of violent crime? MapInfo Professional stores the results of these questions in temporary tables called *query tables*.

In the first part of this chapter, we discussed selections and query tables as a result of using Query Select command. We now turn our attention to an extremely powerful and useful feature in MapInfo Professional, querying by SQL Select.

While MapInfo Professional's Select command lets you formulate sophisticated queries, SQL Select goes even further. The records in the query table generated by the Select command don't have any information in them that isn't contained in the records of the base table. They are, in fact, the same records. They have been arranged so that they can be viewed together.

With SQL Select you can create query tables containing information that was only implicit in the base table(s).

The SQL Select dialog box is one of the most elaborate ones in MapInfo Professional. But don't be intimidated. Once you learn what each box is used for, it is fairly simple to create powerful selection statements. You can type directly into the boxes or you can use the pop up menus on the right to enter items into the boxes.
The easiest way to describe the dialog box is to walk you through an example, step-by-step. This example uses data from the WORLD table included in MapInfo Professional, so you can try out this SQL Select exercise yourself. We have included a brief description of the parts of the dialog box with each step. A complete description of each box is given after the example.

**Note:** Expanding the text controls is no guarantee that the resulting query can be handled by MapInfo Professional. You can still receive the *Query too complex* error when adding larger queries.

**Example 1 — Computing Population Density Using Area**

In this example, we’ll use the world map to create a table of all the countries that have a population density of over 500 people per square mile.

The following formula computes population density:

- \( \text{POPULATION} / \text{AREA} \)

While the WORLD table has a population column (pop_1994), it does not include a column for country area. However, since the WORLD table has graphic objects associated with the records, MapInfo Professional can compute the total area for each country.

Open the WORLD.tab table, and maximize its display by clicking the window's maximize button. On the **Query** menu, click **SQL Select** to display the SQL Select dialog box.

To complete the SQL Select dialog box:

1. In the **From Tables** box, choose **WORLD** from the **Tables** drop-down list.

   You can specify more than one table in an SQL statement. This example uses only one table, WORLD.

2. You should fill in the **From Tables** box before you fill in the **Select Columns** box. MapInfo Professional uses the tables in the **From Tables** box to generate the list of columns in the **Columns** drop-down list.

3. Place your cursor in the **Select Columns** box and delete the asterisk (*). In this example, we will specify a list of columns to be included in the resulting query table, instead of including all columns.

   **Note:** An asterisk (*) in the **Select Columns** box means by default that all columns would be queried.

   Remember, the query table is the temporary table that MapInfo Professional creates to store the results of the query.

4. Select **Country** from the **Columns** drop-down list.

5. Select **pop_1994** from the **Columns** drop-down list.

   Now, we need to compute population density. Remember, population density is computed by dividing population by area. There is no Area column in the table. However, there is a function, Area, which will compute the area of any mappable object. Since the WORLD table is mappable, MapInfo Professional can compute the area of each country and, therefore, the population density of each country.

6. Select the division sign (/) from the Operators list.
7. Select **Area** from the Functions popup.

This creates a *derived* column. A derived column is a column that contains the results of calculations performed on another column or columns. When MapInfo Professional creates the query table, it will include two columns: the **Country** column and the `pop_1994/Area(obj, "sq mi")` column, which is our population density column. MapInfo Professional includes a units statement with all geographic functions. If you wanted MapInfo Professional to return the area in square kilometers, you would change “sq mi” to “sq km.”

Now, we need to build an expression that selects only those countries whose population density is over 500 people per square mile.

8. Tab to the Where Condition box and select **pop_1994** from the **Columns** drop-down list.

9. Select the division sign (\/) from the **Operators** drop-down list.

10. Select **Area** from the **Functions** pop up.

11. Select the greater than sign (\>) from the **Operators** drop-down list.

12. Type the number **500**.

   We have now built the expression “Select all countries whose population density (`pop_1994/Area(obj, "sq mi")`) is more than (\>) 500 people per square mile.”

13. Leave the **Group by Columns** box blank.

14. Tab to the **Order by Columns** box and select **Country** from the Columns list.

   The **Order by Columns** box allows you to specify the order the records in the query table will display. By selecting Country, MapInfo Professional will list the records in alphabetical order, according to country name.

15. Tab to the **Into Table Named** box and type **DENSITY**.

   By default, MapInfo Professional names the query table Query1. Subsequent query tables will be named Query2, Query3, and so on. You can change the name of the query table by typing in a new table name in the **Into Table Named** box. MapInfo Professional will name the query table **DENSITY**.

16. Click **Verify**. MapInfo Professional checks the syntax of your SQL statement. If there are any errors in your statement, MapInfo Professional gives you an error message telling you what the error is and which box contains the error.

17. Select the **Browse Results** check box to create a Browser of the query table. If you do not select Browse Results, MapInfo Professional still creates the temporary query table but doesn’t display it. If you wanted to display the table after the face, choose the **Browse** option in the **Window** menu and select **DENSITY** from the drop-down list.

18. To display the query results in the currently active Map window, select **Find Results in Current Map Window**. If there are no open Map windows, this check box is disabled. You cannot save this check box setting to a template. This option is cleared by default.
19. Click **OK** to create the following table.

The first column contains the country name. The second column contains the population density. Note that the countries are listed in alphabetical order (Order By: Country) and the population density for each country listed is over 500 people per square mile (pop_1994/ Area(obj, “sq mi”) > 500).
Example 2 — Computing Population Density with SQL

To set up an SQL Select statement that selects only those states with a high population density, do the following:

1. On the **File** menu, click **Open Table** and open the STATES table in a Map window.
2. On the **Query** menu, click **SQL Select** and fill in the SQL Select dialog box.

![SQL Select dialog box](image)

This creates a new table, HIDENSTY, that contains only those states with a relatively high population density (population divided by total area). The asterisk (*) in the Select Columns box transfers all of the columns in the STATES table to the HIDENSTY table.

3. On the **File** menu, click **Save Copy As** and save the Selection table. The table can be saved with any filename.

For additional examples, see the following Help System topics:

- *Examples of Group by Columns*
- *Example - Using the Group by Columns Field to Subtotal the Results Table*
- *Example - Using the Order by Columns Field to Sort the Results Table*

**Saving Queries**

Any query created using the Select or SQL Select commands can be saved as an MapInfo Professional query table. Query tables consist of a .tab file and a .QRY file. After you have executed a Select or SQL Select statement, on the **File** menu, click **Save Query** to save the query as a table. When you open this table, the tables on which the query is based are re-opened and the query is re-executed.

**Note:** Queries made against other queries cannot be saved as a table or in a workspace.
Saving Queries to Workspaces

You can also save queries in workspaces. When you open a workspace that contains a query, the query will execute and any windows created by the query will redisplay. Unlike saving a query as a table, a separate .tab file is not created when you save a query to a workspace.

**Note:** To save queries to a workspace, the **Save Queries in Workspaces** check box must be selected in the Startup preferences. MapInfo Professional selects this check box by default.

Activating Save Query when Using a Workspace

To activate the **Save Query** option when using a workspace, you must activate the **Save Queries in Workspaces** option in the Startup Preferences dialog box.

1. Choose **Options > Preferences > Startup**. The Startup Preferences dialog box displays.
2. Check the **Save Queries in Workspaces** option (default setting).
3. Click **OK**.

If you selected this option and open a workspace, the associated queries are regenerated. A separate MapInfo Professional table (.tab) file for the queries is not created.

**Note:** Only queries created using the **SQL Select** or **Select** commands are saved in a workspace.

Using Templates for Queries

Query templates enable you to save Select or SQL Select statements as templates and reload them. This saves you the trouble of having to rebuild a query each time you want to use it. Both the **Select** and SQL Select dialog boxes have Load Template and Save Template options to enable you to do this easily. Query templates are useful for re-creating a query with an updated version of the table used in the original query, or for executing a query on a table that has the same fields as the table on which the query statement was created.

Loading a Template

You can load any saved query template.

To load a query template:

1. In the Select or SQL Select dialog boxes, click the **Load Template** button. The Load Dialog From Query File dialog box displays. It lists the .QRY files.
2. Select the .QRY file you want to use, and click **Open**. The Select or SQL Select dialog box displays with the values from the template already filled in. Simply execute your query to create the query browser.

Renaming a Template

Rename a template by selecting and clicking the template name; enter a new name up to 64 characters.
Saving a Template

After you have finished writing your Select or SQL Select query, you can save the query as a template.

To save a query as a template:

1. In the Select or SQL Select dialog boxes, click the **Save Template** button to save the query to a template, or query file. The Save Dialog to Query File displays.
2. Give the query file a name, select a folder, and click **Save**. Query files are saved with a .QRY extension and are saved in the directory specified in the Directories preferences.

**Note:** The query does not need to be complete or syntactically correct to save it to a template.

Deleting a Template

To delete a template:

- Select the template name and press the **Delete** key. A dialog box displays prompting you to confirm or cancel the operation. If no templates of the given type exist, a button to restore a default template displays.

Deriving Columns

A derived column is a column in a query table whose contents are created by applying an expression to the values of columns already existing in some base table. In the example above, population density was a derived column. By default, the **Select Columns** box contains an asterisk (*), indicating that all of the columns in the base table are to be included in the query table. If you don’t want all of those columns, you should delete the asterisk and list only those columns that you want to use. You aren’t limited to creating one derived column. You can create as many derived columns as you want. Note that the more derived columns you create, the longer it will take MapInfo Professional to execute the query.

You can also created derived columns based on the aggregate functions **count**, **sum**, **avg**, **wtavg**, **max**, and **min**. For example:

- `sum(Population)`

  would give you the population for the entire world.

- `sum(Area(obj), "sq mi")`

  would give you the area for the entire world.

Creating Column Aliases

When MapInfo Professional creates a derived column, it uses the expression itself as the name for that derived column, which can be awkward. You can, however, specify an alias for the column. For example, the population density column in our DENSITY Browser was titled:

- `Population / Area(obj, "sq mi")`

To rename the column, add the new name to the Select Columns box when listing the columns.
The alias must follow the expression. It must also be separated from the expression by a blank space and enclosed in quotes. For example:

- Country, Population / Area(obj, “sq mi”) “POP_DENSITY”

When MapInfo Professional creates the temporary query table, the population density column will now be named POP_DENSITY.

You can use aliases to rename any column in a table, not just derived columns. For example, if each country in your table is a separate sales territory for your corporation, you might want to rename the Country column “TERRITORY”. The procedure is identical:

- Country “TERRITORY”, Population / Area(obj, “sq mi”) “POP_DENSITY”

For another example, see Example — Computing Total World Population Density in the Help System.

**Aggregating Data**

When you aggregate data, you perform a mathematical operation on all of a column’s values in all of the records in your table. Unlike the Select command, which only allows you to perform mathematical functions on individual records, SQL allows you to aggregate (or summarize) data across records.

MapInfo Professional looks for each unique set of data values in the specified column or columns and creates one row for each such unique set. When you aggregate data, you need to specify:

- How the records will be grouped.
- How the data will be aggregated (summarized).

For example, you have a table of sales representatives and their sales figures for the past three months:

<table>
<thead>
<tr>
<th>SALES_REP</th>
<th>MONTH</th>
<th>SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>May</td>
<td>1200</td>
</tr>
<tr>
<td>Cathy</td>
<td>May</td>
<td>900</td>
</tr>
<tr>
<td>Julie</td>
<td>May</td>
<td>1100</td>
</tr>
<tr>
<td>John</td>
<td>June</td>
<td>900</td>
</tr>
<tr>
<td>Cathy</td>
<td>June</td>
<td>1400</td>
</tr>
<tr>
<td>Julie</td>
<td>June</td>
<td>600</td>
</tr>
<tr>
<td>John</td>
<td>July</td>
<td>1200</td>
</tr>
<tr>
<td>Cathy</td>
<td>July</td>
<td>700</td>
</tr>
<tr>
<td>Julie</td>
<td>July</td>
<td>1000</td>
</tr>
</tbody>
</table>
MapInfo Professional could also compute the total sales for each representative by specifying in the SQL Select dialog box:

- Select Columns: SALES_REP, sum(SALES)
- Group by Columns: SALES_REP

<table>
<thead>
<tr>
<th>SALES_REP</th>
<th>sum(SALES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>3300</td>
</tr>
<tr>
<td>Cathy</td>
<td>3000</td>
</tr>
<tr>
<td>Julie</td>
<td>2700</td>
</tr>
</tbody>
</table>

or MapInfo Professional could compute the average sales for each representative:

- Select Columns: SALES_REP, avg(SALES)
- Group by Columns: SALES_REP

<table>
<thead>
<tr>
<th>SALES_REP</th>
<th>avg(SALES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>1100</td>
</tr>
<tr>
<td>Cathy</td>
<td>1000</td>
</tr>
<tr>
<td>Julie</td>
<td>900</td>
</tr>
</tbody>
</table>

or MapInfo Professional could compute the total sales for each month:

- Select Columns: MONTH, sum(SALES)
- Group by Columns: MONTH

<table>
<thead>
<tr>
<th>MONTH</th>
<th>sum(SALES)</th>
</tr>
</thead>
<tbody>
<tr>
<td>May</td>
<td>3200</td>
</tr>
<tr>
<td>June</td>
<td>2900</td>
</tr>
<tr>
<td>July</td>
<td>2900</td>
</tr>
</tbody>
</table>
MapInfo Professional has six aggregate functions:

- **Count(*)**: counts the number of records in a group. It takes * as its argument because it applies to the record as a whole, and not to any particular field in the record.
- **Sum (expression)**: calculates the sum of the values in <expression> for all group records.
- **Average (expression)**: calculates the average of the values in <expression> for all the records in a group.
- **WtAvg (expression)**: calculates the weighted average of the values in <expression> for all the records in a group.
- **Max (expression)**: finds the highest value in <expression> for all records in a group.
- **Min (expression)**: finds the lowest value in <expression> for all records in a group.

For more about grouping and ordering your data, see the Help System.

**Joining Tables Using SQL Select**

When performing an SQL Select operation with multiple tables, MapInfo Professional needs to join information from the records in the various tables. You may have a map table containing only graphic objects and their names and a table of statistical data for some geographic region. You want to display the statistical data on the map table. You could use SQL Select to create a query table in which your statistical data and map data are joined in one table.

Whenever you are working with multiple tables, you must put a statement in the Where Condition telling MapInfo Professional how to match up the rows in the different tables. For example, you have the WORLD table that contains countries and a table of economic statistics (Eco_Stats), also broken down by country.

You want to create a query table that contains both sets of data:

- **Select Columns**: * (an asterisk indicates include all columns in the query table)
- **From Tables**: World, Eco_Stats

The two columns that you want to match do not have to have the same name. For example, you have a table of international customers (Int_Cust) that contains a sales territory column (TERRITORY). This column contains continent names, since your company breaks up its sales territories according to continent. If you wanted to temporarily join the two tables:

- **Select Columns**: *
- **From Tables**: World, Int_Cust
- **Where Condition**: World.Continent = Int_Cust.TERRITORY
For an example, see *Example — Total Population and Area by Continent* in the Help System.

### Using the Where Condition

The order of fields used in the Join does not matter. Either of the following syntaxes is acceptable:

Select * from A,B where A.field1 = B.field1

Select * from A,B where B.field1 = A.field1

However, keep in mind that when you switch the order of geographic operands, the geographic operator must also change. The following statements will produce identical results:

Select * from states, cities where states.obj contains cities.obj

Select * from states, cities where cities.obj within states.obj

### Order of Clauses

The order in which Join clauses are performed does not matter. For example, each of the following are valid clauses:

Select * from Us_custg,States,City_125
where States.state = City_125.state and States.state = Us_custg.state and Us_custg.order_amt > 10000

Select * from Us_custg,States,City_125
where States.state = City_125.state and States.state = City_125.state and Us_custg.order_amt > 10000

Select * from Us_custg,States,City_125
where Us_custg.state = States.state and Us_custg.order_amt > 10000 and States.state = City_125.state

**Note:** Some of the data used in this example is from the MapInfo Professional Tutorial, which is only available from the MapInfo web site, www.mapinfo.com/miprotutorial.
**Error Handling**

If an invalid Where condition that uses an OR as a logical operator is detected, MapInfo Professional will indicate an error has occurred. Usually this error will display whenever MapInfo Professional cannot find a join between two tables. For example, if you have specified the following incorrect condition:

```
Select * from A,B where A.field1 = B.field1  or A.field1 = B.field2
```

This error message displays:

```
No join specified between A and B. Invalid join condition in Where clause
```

**Joining Tables Geographically (Using Geographic Operators)**

When two tables have graphic objects, MapInfo Professional can join the tables based on the spatial relationship between those objects. Thus, even if your tables do not share a common column, you may be able to join the tables.

Geographic operators allow you to select objects on the basis of their spatial relationship to some other object. MapInfo Professional has a special column name you use with geographical operators: "obj" or "object". This column name refers to the graphic objects that are attached to your table.

The geographic operators go between the objects being specified. Select the geographic operators from the **Operators** drop-down list.

The following table lists the geographic operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains</td>
<td>Object A Contains Object B if B's centroid is anywhere within A's boundary.</td>
</tr>
<tr>
<td>Contains Entire</td>
<td>Object A Contains Entire Object B if B's boundary is entirely within A's boundary.</td>
</tr>
<tr>
<td>Within</td>
<td>Object A is Within Object B if its centroid is inside B's boundary.</td>
</tr>
<tr>
<td>Entirely Within</td>
<td>Object A is Entirely Within Object B if A's boundary is entirely within B's boundary.</td>
</tr>
<tr>
<td>Intersects</td>
<td>Object A Intersects Object B if they have at least one point in common or if one of them is entirely within the other.</td>
</tr>
</tbody>
</table>

The difference between **Contains** and **Within** on the one hand, and **Contains Entire** and ** Entirely Within** on the other, hinges on how the geographic comparison is made. For Contains and Within, the comparison is based on object centroids. For **Contains Entirely** and **Entirely Within**, the comparisons are based on the whole object.
Chapter 9: Selecting and Querying Data

The following graphic illustrates this point:

In each case, object A contains object B because the centroid of object B is inside the boundary of object A. However, in the cases at the left and in the middle, part of object B is outside the boundary of object A. Only in the case to the right is all of object B inside object A. Only in this case could we assert "object A Contains Entire Object B" or "Object B Entirely Within Object A." Further, if A contains entire B, then A contains B, and If A is entirely within B then A is within B.

MapInfo Professional can perform a simple Contains or Within comparison more rapidly than a Contains Entire or Entirely Within. Therefore, unless you are absolutely sure that objects are completely inside other objects, you should use Contains and Within rather than Contains Entire or Entirely Within.

Geographic operators provide a way of joining tables. When there are no columns in the tables on which you can base your join, you can use a geographical operator to specify the join (in the Where Condition field). If you want to perform a query that involves both a Cities table and a States table, you can join the tables using either of the following expressions:

1. Cities.obj within States.obj
2. States.obj contains Cities.obj

In either case, MapInfo Professional finds the cities within each state and then associates a row for a city with the row for the state that contains it. In the same SQL Select query, you could also use aggregate functions to count the number of cities per state or to summarize city-based data on a statewide basis.

When you have a table of counties and one of customers, where counties are polygons and customers are points, you could specify a geographic join using either of the following geographic expressions:

1. Customer.obj within County.obj
2. County.obj contains Customer.obj
Geographic operators are particularly useful in conjunction with subselects.

Additional related help topics:
- Joining Tables by the Order of the Rows
- Performing Subselects

### Joining Two or More Tables

Typically, you store your information in several different tables. You have your own data files, and you may also have various databases of statistical information that you purchased from MapInfo Professional. SQL Select allows you to create relational joins so that you can bring information from these various tables together into a single results table.

When you want to join two tables, you must determine whether one of the columns in the first table contains values that match one of the columns in the second table. Imagine that you have a table of counties that has demographic information—the population of people in various age ranges, ethnic groups, and occupational categories in each county. You may also have a database containing information about customer orders. You want to examine these two tables and see if certain kinds of orders come from counties having certain demographic characteristics. Perhaps you want to select counties according to combinations of orders and demographic characteristics. To do this you have to be able to join the two tables.

Suppose the counties table contains the name of the county. Similarly, one of the columns in the order table contains the name of the county in which the order originated. Thus, these two tables have one field in common, the county name. MapInfo Professional can use that common field to join the two tables.

<table>
<thead>
<tr>
<th>CountyName</th>
<th>Pop_1980</th>
<th>Pop_1990</th>
<th>Order #</th>
<th>Customer</th>
<th>County</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foster</td>
<td>23,789</td>
<td>27,135</td>
<td>478001</td>
<td>Francis</td>
<td>Foster</td>
</tr>
<tr>
<td>Williamette</td>
<td>35,456</td>
<td>34,846</td>
<td>478002</td>
<td>James</td>
<td>Foster</td>
</tr>
<tr>
<td>Mason</td>
<td>147,101</td>
<td>151,201</td>
<td>478003</td>
<td>Wickwire</td>
<td>Mason</td>
</tr>
</tbody>
</table>

**Counties Table Orders Table**

Within the SQL Select dialog box, you use the Where Condition field to tell MapInfo Professional how to join the two tables. The SQL Select dialog box might look like this:

```
Select Columns: *
From Tables: Counties, Orders
Where Condition: Counties.CountyName = Orders.County
```

The order of the table names (in the From Tables field) is important. If both tables contain map objects, the results table will only retain the map objects from the first table listed in the From Tables field. Furthermore, when the query is complete, MapInfo Professional automatically selects some or all of the rows from whichever table is listed first in the From Tables field. Thus, in the preceding
example, MapInfo Professional will select some or all of the rows from the Counties table. The results table will also include data copied from the Orders table, but the Orders table will not be selected per se.

When you join two tables, the number of rows in the results table depends on how well the two tables match up. Suppose you have an Orders table with 10,000 rows, and you join the Orders table to the States table, which has fifty rows. The results table may contain as many as 10,000 rows. However, if some of the rows in the Orders table fail to match any of the rows in the States table, the results table will contain fewer than 10,000 rows. Thus, if 400 of the rows in the Orders table do not have a state name (perhaps due to data-entry errors), and if the relational join relies on the state name, the results table may only contain 9,600 rows.

You can use Update Column to modify the results of an SQL Select multi-table join. When you want to update a column in one table with information from another table, you can:

1. Join the tables with SQL Select.
2. Use Update Column on Selection. The update automatically takes effect in the appropriate base table.
   - For more information, see Performing Outer Joins and Using the Instr Function to Find Data in the Help System.

**Finding Duplicate Values in a Column**

Often data is entered into tables by many different users. Sometimes data is repeated, or there is common information in several different records. This section explains how to find all rows in a table that, for a given column, share a value with another row. This is accomplished by performing two SQL Select statements.

The first SQL Select statement produces a query table with two columns. The first column is a list of all unique values in the data column and the second column lists the number of times that each unique value occurs. The second SQL statement compares each data column value with all rows in the Query table where the count is greater than one.

In the next example, there is a table EMPLOYEE that has two columns Id_Num and Name.
To find the duplicate values, perform the two SQL Selects, modifying them where indicated.

1. On the Query menu, click SQL Select and fill in the SQL Select dialog box.

   Substitute the name of your data column for ID_Num and the name of your table for EMPLOYEE. The number 1 in the Group By Columns box will group the row by ID_Num (the first column). The 2 Desc in the Order by Columns box will arrange the records in descending order based on the values in the count(*) field (the second column).

   This SQL Select statement returns a query table with two columns. The first column contains every identification number possessed by at least one employee. The second column contains the number of employees that have that identification number. The rows are sorted by the number of employees that have each id number (i.e., the count).

2. On the Query menu, click SQL Select and fill in the dialog box.

   Also, change EMPLOYEE to the name of your table and ID_Num to the name of your data column.
In the example, the SQL statement returns a query table containing all of the rows from EMPLOYEE with duplicated data column values. The where condition selects all rows from EMPLOYEE that have an identification number that is the same as one of the ID numbers in the Count_By_ID query table. This sub-select finds all identification numbers that occur more than once.

**Calculating the Distance to a Fixed Point**

In MapInfo Professional it is possible to calculate the distance from one point to another. This example shows how to calculate the distance from a fixed point to every point in a geocoded table and store the result in another table.

1. Determine the location of the fixed point. To find the position of a symbol on the map, double-click the symbol with the Select tool. In this example, the X value is -101.697209 and the Y value is 35.550036.

2. On the Query menu, click SQL Select and fill in the SQL Select dialog box, substituting your X and Y values for the values mentioned above.

As in the previous SQL query, replace EMPLOYEE with the name of your table, and ID_Num with the name of the relevant column from your table.

3. Click OK. The resulting query table contains last names and first names plus a new column called DISTANCE which records the distance between the fixed location (-101.697209, 36.550036) and the point associated with each row of the table.

4. To save the results in a permanent table, on the File menu, click Save Copy As, and save the CUSTDIST table.

For instructions on entering SQL queries using the Expert button, see the Help System.
Creating Thematic Maps, Legends, and Other Maps

Thematic mapping is a powerful way to analyze and visualize your data. You give graphic form to your data so that you can see it on a map. Patterns and trends that are almost impossible to detect in lists of data reveal themselves clearly when you use thematic shading to display the data on a map.

You can create thematic maps with MapInfo Professional® using the following methods: ranges of values, graduated symbols, dot density, individual values, bar and pie charts and continuous grid. There are also several variations on and options within these methods, such as bivariate thematic mapping and inflection point, that give you even more ways to analyze your data.

In this Chapter:

- MapInfo Professional in Action.........................340
- Using Thematic Mapping to Analyze Information........340
- Types of Thematic Maps.................................344
- Working with Thematic Maps and Legends.................362
- Updating Columns using Thematic Mapping..............365
- Working with Legends.................................369
- Working with Grid Surface Maps......................374

For clarification of the uses of thematic maps in MapInfo Professional, see MapInfo in Action in the Help System.

The Help System also contains these related topics:

- Bivariate Thematic Mapping
- Working with 3D and Prism Maps
Since you have all the tools you need to make effective and useful maps, it is time to talk about what makes a map effective and useful. Whatever you need your map to say, whether it is to convey information, calculate distances between health care providers and their patients, or get a count of the number of customers that live within a given radius of an outlet location, MapInfo Professional can help you do that. By making selections from your table, you can extract information from sets and subsets of your data or see patterns and distributions, getting answers to such questions as: Which of my customers bought more than $5000 of equipment? Which of my customers is located within a 200 mile radius of my warehouse? Which of my customers bought more than $5000 of equipment and is located within a 200 mile radius of my warehouse? For more on selecting, see Selecting Your Data in MapInfo Professional in Chapter 9 on page 302, and Querying Your Data in MapInfo Professional in Chapter 9 on page 310.

MapInfo Professional refers to this grouping of like information as thematic mapping.

• For an example, see Can You Give Me an Example in the Help System.

Using Thematic Mapping to Analyze Information

Thematic mapping is the process of enhancing your map according to a particular theme. At the cornerstone of the theme is the data in your table. Themes represent your data with shades of color, fill patterns, symbols, bar and pie charts, and grids.

With MapInfo Professional, you create different thematic maps by assigning these colors, patterns, or symbols to map objects according to specific values in your table. MapInfo Professional's bar and pie charts allow you to make data comparisons for each record. Grids allow you to see continuous change of your data across an area.

The Thematic Map feature uses a wizard made up of a series of three dialog boxes to help you choose the type of thematic map you want, the table(s) and fields that will be used to construct the map, and a variety of options to customize your map.
MapInfo Professional's thematic templates make it easy to start constructing a theme. Just choose a template that represents the type of thematic map you want. The templates are fully customizable and can be saved as new templates for future thematic mapping needs. More than 40 templates ship with MapInfo Professional.

**Figure: Comparison of Senior Population to Total U.S. Population**

![Thematic Map Example](image)

**Planning Your Thematic Map**

Before you create a thematic map, it is important to know about the elements that make up a thematic map and how to put them together. This section will discuss thematic variables, where you can obtain your data, using data from the same table or another table, and the arrangement and display of thematic layers.

**What is a Thematic Variable**

The data that you display on your thematic map is called the thematic variable. Depending on the type of thematic analysis you are performing, your map can show one or more thematic variables. Ranges of values, grid shading, graduated symbols, dot density, and individual values maps all examine one variable. With bar or pie charts, you can display more than one thematic variable at a time.

A thematic variable can also be an expression. Choose Expression from the field list in place of a data field to construct a statement that derives information from the data in your table(s). Although an expression can be made up of more than one variable (for example, POP_1990 – POP_1980), for purposes of thematic mapping, a complete expression is equivalent to one thematic variable. See [Querying Your Data in MapInfo Professional](#) in Chapter 9 on page 310, and [Creating Expressions](#) in the MapInfo Professional User Guide, which is located in the Documentation subfolder of your installation directory, for more detailed information.

You can also create bivariate thematic maps, where one map object, such as a symbol, represents two different pieces of data. The symbol color, for example, can represent one thematic variable, and the symbol size can represent another.
Using Thematic Mapping to Analyze Information

Where to Obtain the Data

Before you begin your thematic map, you need to decide what information you want to display and locate where that information resides. It can either be in the table on which you are basing the map, or it can be in another table.

If the data is in the same table on which you are basing the map, choose the desired field directly in the Field list box in the Thematic – Step 2 of 3 dialog box.

If the data is in another table, you must first bring the data into the table on which you're basing the thematic map. This requires creating a temporary column using Update Column.

Each situation is described in the next few sections.

Using Data from the Same Table

If you are using data from the same table, choose the table and field on which you want to base your thematic map in the Thematic – Step 2 of 3 dialog box.

For example, you have a table of parking meters that contains the location of the parking meter and the last time the parking meter was emptied. Using Individual Values you want to shade the parking meter symbols according to the last time each meter was emptied. MapInfo Professional will assign a color to each time. In Step 2 of 3, choose the parking meter table as your table, and choose the field that contains the time each meter was emptied.

Using Data from a Different Table

The Join feature within the Thematic – Step 2 of 3 dialog box enables you to use data from other open tables to create a thematic map. Choose Join in the Field list box to display the Update Column dialog box where you can create a temporary column in the base table.

The temporary column can contain data taken directly from the other table, or you can aggregate the data to create derived information for the temporary column.

For example, you have two tables: a table of county boundaries and a table of police stations. You want to shade the table of county boundaries according to the number of police stations in each county.

To do this, all the information you want to use must be in the county table. Therefore, you must add police station data to this table.

Using Update Column, you create a temporary column in the county boundaries table that will store the police station information. To create this column, the two tables must have a link so that MapInfo Professional can access the data that goes into the temporary column. The link can either be a matching field (like county name), or you can make the link geographically (police stations contained within counties).

An example later in this chapter explains more about Update Column.

- For details on how thematic mapping works, see Methods of Thematic Mapping in the Help System.
Methods of Thematic Mapping

When you create a thematic map in MapInfo Professional, the thematic shading is added to your map as a separate layer. It is drawn on top of the base map layer.

Separating Thematic Layers

Separating thematic layers from the base map layer provides you with several important options:

- Graduated symbol thematic maps do not require that your base map contain point objects. Instead, graduated symbol objects are built regardless of the map object type. Therefore, even if your base map contains region or line objects, you will still be able to create a graduated symbols map.
- You can have multiple thematic layers per base map layer. In some cases, you do not have to add another base layer to the map to create another thematic layer. You can display more than one thematic layer at a time, as well as perform bivariate thematic mapping.
- You can use Layer Control to turn the display on or off for a given thematic layer. The layer it is based on can continue to display. You can also set individual zoom layers on thematic maps.

Ordering of Thematic Layers

To display thematic layers properly, they must be in a specific order. This is especially important when you want to display more than one thematic layer at a time. For example, you would want pie or bar charts for an area map to display on top of regions that are shaded in order to see them.

The following lists the order of map layers from top to bottom (note that map layers are drawn from the bottom up):

1. Pies, Bars, or Graduated Symbol thematic layer.
2. Dot Density thematic layer.
3. Ranged thematic layer – where Color or Size Attributes are applied.
4. Ranged (or Individual Value) thematic layer – where All Attributes are applied.
5. Major layer or base layer.
6. Grid thematic layer.

When you create a new thematic layer, MapInfo Professional automatically inserts it into its proper place.

Displaying Thematic Layers

You can turn the display on and off for thematic layers the same way you can for other map layers. All the display settings in Layer Control are also applicable to thematic layers, enabling you to set a zoom level for each thematic layer. You can also access the Modify Thematic Layer dialog box through Layer Control by clicking the Thematic button.
Using Thematic Mapping to Analyze Information

**Figure: Layer Control (Showing Thematic Layer above Base Map)**

Thematic layers are displayed in the list with this naming convention:

<Thematic type> with/by <variable-list>

The type of thematic map is noted first, followed by the list of variables used to create the map. For example, a pie thematic layer that uses commuting data is listed this way:

Pies with ComAlone, ComCarpool...

The variable list is truncated if there is not enough room to display each variable in your analysis.

**Types of Thematic Maps**

With MapInfo Professional you can create seven types of thematic maps:

- Ranges
- Bar Charts
- Pie Charts
- Granulated
- Dot Density
- Individual
- Grid

Each has its own purpose and unique attributes. For example, using Ranges of Values, you could thematically shade a map of the world according to population density. You could shade the countries with graduated shades of red, the darkest red representing the most densely populated countries, and the palest red representing the least densely populated countries. At a glance you can see the distribution of the world’s population.

You are not limited to representing numeric values with thematic mapping. Nominal values also may be shaded thematically. For example, you have a table of underground cables. Those cables that haven’t been serviced in the past six months are labeled priority status. Using Individual Values, you can shade the cables according to their repair status. All records with the same value will be shaded the same. See the individual sections later in this chapter for more information on each type of thematic map. They offer general information on the methods available for creating thematic maps. For more information on any of these methods and options, see *Thematic Mapping* in the Online Help.
Ranged Maps

When you create a ranged thematic map, MapInfo Professional groups all records into ranges and assigns each record’s object the color, symbol, or line for its corresponding range. For example, if you wanted to visualize the population of the world by growth rate, you would shade countries according to their reported growth rate amounts.

With the Ranged map feature, MapInfo Professional groups the growth rate amounts into ranges. For example, in the next table, all countries that had growth rates between zero and one percent are grouped into one range. Countries that had growth rates between one and 2.2 are grouped in a separate range. Countries that have rates between 2.2 and 3.1 are in a third range, and those countries reporting greater than 3.1 are in a fourth range.

**Figure: Ranged Map**

All records are assigned to a range and then assigned a color based on that range. For example, the countries with the higher growth rates are shaded in red. The other ranges are shaded in lighter shades of red to light green and finally darker green. When you display the map, the colors make it readily apparent which locations have the highest growth rate in relation to their neighbors.

Ranges are also useful when the size of the region is not directly related to the magnitude of the data values. In our population density example in this section, we see that countries that are small in size can be very densely populated, and countries that are large in size may not be densely populated. Differences like these are more readily apparent when the regions are shaded in this manner.

**Types of Ranged Values**

MapInfo Professional can create ranges automatically using five methods: Equal Count, Equal Ranges, Natural Break (Standard Deviation), Quantile, and Custom. To set ranges manually, use Custom.

**Equal Count** has the same number of records in each range. If you want MapInfo Professional to group 100 records into 4 ranges using Equal Count, MapInfo Professional computes the ranges so that approximately 25 records fall into each range, depending on the rounding factor you set.
When using Equal Count (or any other range method), it's important to watch out for any extreme data values that might affect your thematic map (in statistics, these values are referred to as *outliers*). For example, if you tell MapInfo Professional to shade according to Equal Count with this database:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>5000</td>
<td>Andrea</td>
<td>7000</td>
</tr>
<tr>
<td>Penny</td>
<td>6000</td>
<td>Kyle</td>
<td>5500</td>
</tr>
<tr>
<td>Miguel</td>
<td>4500</td>
<td>Angela</td>
<td>7500</td>
</tr>
<tr>
<td>Linda</td>
<td>5000</td>
<td>Elroy</td>
<td>6000</td>
</tr>
<tr>
<td>Ben</td>
<td>100</td>
<td>Mark</td>
<td>7000</td>
</tr>
</tbody>
</table>

Ben and Miguel are grouped in the same range (since they have the two lowest values). This may not produce the results you want since the value for Ben is so much lower than any of the other values.

**Equal Ranges** divides records across ranges of equal size. For example, you have a field in your table with data values ranging from 1 to 100. You want to create a thematic map with four equal size ranges. MapInfo Professional produces ranges 1–25, 25–50, 50–75, and 75–100. (Since ranges use “=>” and “<=”, they need to overlap.)

Keep in mind that MapInfo Professional may create ranges with no data records, depending on the distribution of your data. For example, if you tell MapInfo Professional to shade the following database according to Equal Ranges:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>100</td>
<td>Andrea</td>
<td>90</td>
</tr>
<tr>
<td>Penny</td>
<td>6</td>
<td>Kyle</td>
<td>1</td>
</tr>
<tr>
<td>Miguel</td>
<td>4</td>
<td>Angela</td>
<td>92</td>
</tr>
<tr>
<td>Linda</td>
<td>95</td>
<td>Elroy</td>
<td>89</td>
</tr>
<tr>
<td>Ben</td>
<td>10</td>
<td>Mark</td>
<td>10</td>
</tr>
</tbody>
</table>

MapInfo Professional creates four ranges (1–25, 25–50, 50–75, and 75–100). Notice, however, that only two of those ranges (1–25 and 75–100) actually contain records.

Natural Break and Quantile are two ways to show data that is not evenly distributed.

**Natural Break** creates ranges according to an algorithm that uses the average of each range to distribute the data more evenly across the ranges. It distributes the values so that the average of each range is as close as possible to each of the range values in that range. This ensures that the ranges are well-represented by their averages, and that data values within each of the ranges are fairly close together. MapInfo Professional bases its Natural Break algorithm on the procedure described by Jenks and Caspall in their article "Error on Choroplethic Maps: Definition, Measurement, Reduction" from the Annals of American Geographers, June, 1971.
Quantiling enables you to build ranges that determine the distribution of a thematic variable across a segment of your data. For example, you can quantile state population by urban population to illustrate how urban population is distributed across the United States. Your legend will not indicate that you have used Quantile to build your ranges. You can customize the legend so that it shows which field you used to quantile the table.

When you create ranges using Standard Deviation, the middle range breaks at the mean of your values, and the ranges above and below the middle range are one standard deviation above or below the mean. You can also define your own ranges using Custom.

The Help System contains the following related topics:

- Creating a Map by a Range of Values
- Customizing a Range Map
- Customizing the Ranges of a Range Map
- Customizing the Styles of a Range Map
- Customizing Range Styles and Inflection Points
- Customizing the Legend of a Range Map
- Modifying a Thematic Map

Bar Chart Maps

Unlike thematic maps for single variables such as ranges of values or graduated symbols, a thematic bar chart map allows you to examine more than one variable per record at a time. A bar chart is built for every map object at the centroid of the object, enabling you to analyze the thematic variables in a particular chart by comparing the height of the bars. You can also examine the same variable across all the charts in your map.

You can customize the color of each bar, create a frame around each chart, and fill the empty space inside the frame with a pattern or color. In addition, you can change the bar chart’s orientation, such as displaying horizontal bars instead of vertical (the default). You can also control where to display the chart: over the object’s centroid (the default) or any of eight other locations.

You can also change the type of bar chart. In our example, you can create a multi-bar chart, where each thematic variable has its own bar, or a stacked bar chart with each thematic variable on top of one another, or a graduated bar chart, where the bars are graduated in size based on some value. You can also scale the bars in a multi-bar chart independently from one another. To show negative values in a bar chart map, the bars extend in the opposite direction to the chart’s orientation. Note that negative values do not display in stacked bar charts.
The **Help System** contains the following related topics:

- Creating a Bar Chart Map
- Customizing Bar Chart Styles on your Map
- Customizing the Legend of a Bar Chart
- Modifying a Thematic Map

**Pie Chart Maps**

Thematic maps using pie charts enables you to examine more than one variable per record at a time. Like comparing the height of the bars in bar charts, in pie charts you compare the wedges in a single pie, or examine a particular wedge across all pies. Pie charts enable you to compare parts of a whole.

Both pie and bar charts are particularly useful for analyzing demographic data. For example, you have a table of demographic information for the United States. Your table shows the populations of several major demographic groups. Using pie charts, you can show the population of each demographic group, and see what fraction of the pie it makes up in each pie. This enables you to see the distribution of demographic groups on a per state basis, or across the entire United States. You can also look at one demographic group and see how the population of the group varies in different states. For best results, use no more than four to six pie wedges per pie chart in your analysis.
You can customize the color of each pie wedge as well as the borders of the wedges and the whole pie. You can also specify the angle at which you want to place the first pie wedge, and whether the variables go in a clockwise or counterclockwise direction. Like bar charts, you can also change the pie’s orientation. The default is to place the pie over the centroid of the object.

You can choose from graduated pies or half pies. Graduated pies graduate the size of the pies according to the sum of their components. Half pies distribute your data across half a pie instead.

The Help System contains the following related topics:

- Creating a Pie Chart
- Customizing a Pie Chart
- Customizing the Legend of a Pie Chart
- Modifying a Thematic Map

**Graduated Symbol Maps**

Graduated symbol maps use symbols to represent different values. You can use graduated symbols regardless of the type of map object with which you are working.

For instance, use graduated symbols to show the number of housing units by city. When you select the graduated symbols option, MapInfo Professional varies the size of each symbol according to the value in the sales order field.

You can also represent how much interest each customer has expressed in a given product by assigning a symbol whose size is proportional to the customer’s interest.

Graduated symbols maps work best when you use numeric data. If you are working with a layer of restaurants, it makes no sense to create graduated symbols based on the type of cuisine each restaurant serves. However, graduated symbols are appropriate when you want to show the number of hamburgers sold at 20 different fast food restaurants.
There are three attributes you can customize on a graduated symbols map: the color, type, and size of the symbol. To change the symbol's attributes in Thematic Step 3 of 3, choose **Customize Settings** and click the symbol icon in the Customize Graduated Symbols dialog box to access the Symbol Style dialog box. The default symbol is a red circle.

In the Customize Graduated Symbols dialog box, the size of the symbol in the **Symbol** box is the size for the value listed in the at **Value** box. All values between the high value and zero have interpolated point sizes. If you want the symbols at the low end to be larger, increase the point size.
You can also display symbols for negative data values. To change it, click **Options** in the Customize Graduated Symbols dialog box. There is a separate symbol picker so that you can make this symbol as distinct from the symbol for positive values as you want. When you click the icon a different Symbol Style dialog box displays, enabling you to choose a different symbol type, change the color or the size, or change any combination of the three attributes. The default symbol for negative values is a blue circle, and all values between zero and the low value (a negative number) also have interpolated point sizes.

The **Help System** contains the following related topics:

- Creating a Graduated Symbols Map
- Customizing a Graduated Symbols Map
- Customizing the Styles of a Graduated Symbols Map
- Customizing the Legend of a Graduated Symbols Map
- Modifying a Thematic Map

**Dot Density Maps**

Dot density maps use dots to represent the data value associated with a boundary or region. The total number of dots in a region represents that region’s data value. If you have 10,000 senior citizens in a county, and each dot represents 100 senior citizens, there would be 100 dots in the county boundary.

Dot density is particularly useful for showing raw data where one dot represents a large number of something: population, number of fast food restaurants, number of distributors who carry a brand of soda, etc.

For example, if you have a table of age demographics broken down into postal codes, you could use the dot density option to show the concentration of small children in each postal code boundary.
There are three customizing options for dot density maps. You can specify the value of one dot. For example, you have a table of population statistics, broken down by county. There are 10,000 pre-school students in Rensselaer County, New York. If you display Rensselaer County according to the number of pre-school students using the dot density method, each dot could represent 200 students. In that case, there would be 50 dots in Rensselaer County. You can specify the number of units each dot represents using the Customize Dot Density Settings dialog box.

When you increase the value each dot represents, you decrease the number of dots that display on the map. You could modify your dot density map so that one dot represents 400 students. In that case, there would only be 25 dots in Rensselaer County.

A second option is to change the size of the dots according to your needs, either large or small. If you are working with large populations, or large counts of something, make the dot size smaller so that the distribution of dots is easier to see.

Conversely, if you are working with a small data set, making the dot size larger might illustrate your analysis more clearly.

**Note:** Distribution of dots is random within the region. If you shade states according to population, the dots for New York are spread out throughout the state; they are not concentrated in New York City, where the majority of the state's population lives.

Thirdly, in the Customize Dot Density Settings dialog box, change the color of the dot to either red or black to add more variety to the final map. In this dialog box, you can select Circle or Square dot thematics and specify the dot density width (in pixels) of the square or circle. In general, squares look clearer at small sizes. At larger sizes, it may be more appropriate to use circles. You can create multiple dot density maps on the same layer by varying these options.

In the Creating a Thematic Map - Step 3 of 3 dialog box, select the **Customize Settings** button to display the Customize Dot Density Setting dialog box. Here you can change the number of units that each dot represents, and also select the dot shape (square or circle) size, and color. You can specify a circle size from 2 to 25 pixels in width. For a square, the size can range from 1 to 25 pixels.

**Figure: Customize Dot Density Settings**

![Customize Dot Density Settings Dialog Box]

**More Dot Density Choices for Thematic Maps**

For thematic maps, you can select Circle or Square dot thematics and specify the dot density width (in pixels) of the square or circle. In general, squares look clearer at small sizes. At larger sizes, it may be more appropriate to use circles.
In the Creating a Thematic Map - Step 3 of 3 dialog box, select the **Customize Settings** button to display the Customize Dot Density Setting dialog box. Here you can change the number of units that each dot represents, and also select the dot shape (square or circle) size, and color. You can specify a circle size from 2 to 25 pixels in width. For a square, the size can range from 1 to 25 pixels.

The *Help System* contains the following related topics:

- Creating a Dot Density Map
- Customizing a Dot Density Map
- Customizing the Styles of a Dot Density Map
- Customizing the Legend of a Dot Density Map
- Modifying a Thematic Map

**Individual Value Maps**

Individual Value maps show points, lines, or boundaries that are shaded by individual values contained in a particular field. You can use both numerical and nominal values in individual values maps. MapInfo Professional gives each unique value its own color or symbol. When an individual values map uses symbol types, the symbols are taken from the base table.

For example, a soft drink distributor maintains a table of the supermarkets that buy soft drinks from him. Each supermarket sells the distributor’s brand of soft drink for a different price. If the distributor shades the supermarket points by price, using individual values, all stores that sell the soft drink for 49 cents are shaded one color, all stores that sell the soft drink for 51 cents are shaded another color, and so on. Each unique value is assigned its own color. The distributor is able to see the price distribution among the supermarkets and can determine where he should increase his sales volume, based on the price.
If you are shading your points, lines or boundaries using nominal data, you can shade only by individual values. Nominal data is either non-numerical data (name, type of cuisine served, or brand of automobile sold) or numeric data where the numbers represent non-numeric data like an ID number. Dates are considered numeric data and can be used in both ranged and individual values maps.

For example, you have the results from a consumer survey. One question on the survey reads “What is your favorite Sunday afternoon activity?” The possible responses are:

1. Sleeping
2. Watching TV
3. Taking a drive
4. Reading
5. Playing or watching sports
6. Visiting museums or art galleries
7. Going to the movies

You want to shade each consumer point with the response for the favorite Sunday activity. The SUNDAY column of your table contains the number that corresponds to the consumer’s favorite activity. However, the numbers in this column do not represent quantitative values. Going to the movies is not greater than Playing or watching sports even though 7 > 5. When numbers are used as names instead of values, you must shade your objects by individual values. The numbers are only used to reference the pastimes so color can be assigned to them.

The Help System contains the following related topics:

• Creating an Individual Values Map
• Customizing an Individual Values Map
• Customizing the Styles of an Individual Values Map
• Customizing the Legend of an Individual Values Map
• Custom Sort Order for Individual Value Thematic Legends
• Modifying a Thematic Map

Important Notes:

When you are creating and merging theme templates:

• MapInfo Professional saves the custom label order only when the option to Save Individual Value categories is selected in the Save Theme to a Template dialog box. This implies that when you create a theme based on a template, MapInfo Professional applies the custom label order only when the thematic expression creates the same categories as those in the template.

• When you are merging theme templates, the custom label order from the source template is applied to the current theme only when the option to Merge Individual categories is selected in the Merge a Template to a Theme dialog box and the template and current theme have the same number of categories.

• Saving a Template - The entry for theme templates in the Options > Preferences > Directories dialog box allows you to designate the directory where theme templates reside.
Chapter 10: Creating Thematic Maps, Legends, and Other Maps

- For more information, see *Saving Individual Categories in a Theme Template for an Existing Thematic Map and Saving Individual Categories in a Theme Template when Creating a Thematic Map* in the Help System.

Grid Surface Maps

A grid surface theme is a continuous raster grid produced by an interpolation of point data. MapInfo Professional takes a data column or expression from a table and passes those centroids and their data values to an interpolator. The interpolator produces a raster grid file, which appears as a raster table in a Map window.

Grid mapping displays data as continuous color gradations across the map. This type of thematic map is produced by an interpolation of point data from the source table. A grid file is generated from the data interpolation and displayed as a raster image in a Map window.

The Help System contains these related topics:

- Working with Grid Thematic Layers
- Spreading Inflections by Equal Cell Count
- Modifying a Thematic Map

Creating a Thematic Map

There are many kinds of thematic maps, but the process for creating each type of map is the same. In this section, we cover the creation of thematic maps in general terms. You can find more specific instructions for creating specific types of thematic maps in the Help System.

Step 1: Choosing a Type of Thematic Template

Templates allow you to make a thematic map based on values and settings. In our default types, you can alter these settings and/or save them as a new template you can use again. When you first create a thematic map, you select a template that you can modify to suit your requirements. You cannot create a theme without using an existing theme template.

Template Sort by Name
Displays available templates in alphabetical order according to their name.

Template Sort by Time
Displays available templates according to the time they were created or last modified.

Preview Legend Sample (Template Type)
Displays a sample legend for the template type.

Use Customized Legend Text
Displays customized text for the legend. If enabled, the template has custom titles or range labels. Check to use the custom text.

Cancel Button
Cancels the options dialog box and returns to the map.
Creating a Thematic Map

**Next Button**
continue to next step.

**Range Template**
Displays your data according to the ranges you set. Ranges are shaded with colors and/or patterns. Choose from templates displayed as shaded lines, points or regions. Ranged thematic maps allow you to illustrate data values across points, lines and regions. They are used to show a relationship between the data values and geographical area (e.g. sales figures, household income) or to present ratio information such as population density (population divided by area). Ratio information can be shown in other types of thematic maps when you choose Expression in Step 2.

**Bar Chart Template**
Displays a bar chart of your thematic variables for each record in your table. Use bar charts to analyze multiple variables per record on the map. Make comparisons between the size of the bars in each chart to obtain information about a record in the table set, or compare one bar in all the bar charts to draw conclusions about a variable across all of the records, or compare the height of the bar charts to obtain information about the entire table. To indicate a negative value in a bar chart, bars extend in the direction opposite to the charts orientation. Negative values do not display in stacked bar charts.

**Pie Chart Template**
Displays a pie chart of your thematic variables for each record in your table. Pie charts are multi-variable. Use pie charts on the map to analyze more than one variable at a time. You can compare the size of the pie wedges in each chart to obtain information about a record in the table, or compare one pie wedge in all of the pie charts to draw conclusions about a variable across all the records, or compare the diameter of the pie charts to obtain information about the entire data set.

**Graduated Template**
Displays a symbol for each record in your table, the size of which is directly proportional to your data values. A graduated symbol map shows data points with specific numerical values. It is useful for illustrating quantitative information, such as high-to-low rankings. The size of the symbols is proportional to the data values of the points. Points that have larger data values appear larger, and points that have smaller data values appear smaller.

- For instructions on creating a Graduated Symbols thematic map, see *Creating a Graduated Symbols Thematic Map* in the Help System.

**Dot Density Template**
Displays the data values as dots on your map, where each dot is equal to a number, and the total number of dots in a region is proportional to the data value for that region. A dot density map allows you to examine raw counts of data (e.g. population). Each dot represents a number of units. That number, multiplied by the total number of dots in the region, equals the data value for that region.

- For instructions on creating a Dot Density thematic map, see *Creating a Dot Density Thematic Map* in the Help System.

**Individual Values Template**
Shades records according to individual data values. Individual value templates are multi-variable. Choose from shaded lines, points or regions. A thematic map that draws map objects according to individual values is useful when you want to emphasize categorical differences in the data rather than show quantitative information (e.g. types of stores in a given area, zoning classifications in a given area etc.).
Grid Template
Grid mapping displays data as continuous color gradations across the map. This type of thematic is produced by an interpolation of point data from the source table. A grid file is generated from the data interpolation and displayed as a raster image in a Map window.

Step 2: Choosing Thematic Values
Choose the map layer on which you want to base the map, and the field or expression from which you want to obtain the data values (thematic variable).

A thematic variable can be the data value that is associated with the graphic objects (regions, lines, and points) displayed in your map, such as the values in a column like Pop_1990, Buy_Power, or Median Age.

You can also obtain your thematic variable from another table using Table > Update Column. Update Column creates a temporary column in your base table where you can aggregate or calculate information about your data.

You can also use an expression for your thematic variable. For example, you could use the following expression to display population density:

\[ \text{Pop}_1990 / \text{Area(obj, "sq mi")} \]

You can access the Expression dialog box in Step 2 of creating a thematic map. See the Help topics, Using Expressions in a Thematic Map and Creating Expressions for more information.

Your map may have more than one variable, depending on the thematic method you choose. Pie and Bar chart maps contain more than one variable; the other five types of thematic maps contain one variable. Depending on your choice of a one-variable or multi-variable thematic map, one of two Create Thematic Map- Step 2 of 3 dialog boxes displays.

One-Variable Thematic Maps
Ranged, graduated symbol, dot density, individual value, and grid thematic maps examine one variable. The Create Thematic Map - Step 2 of 3 dialog box that displays for these kinds of maps asks you to choose only a table and one field or expression.

1. Choose a table from the Table drop-down list. The drop-down list displays the tables that are mapped in the active Map window.

2. Choose the table on which you want to base the map.

   If you have objects selected in the Map window, the Selection from TABLE item also displays in the list. This enables you to create a thematic map based on the selected items without having to map the selection. You can also base your thematic map on a mapped query table.

3. Choose a field from the Field drop-down list. The drop-down list displays all the numeric fields in the table you selected from the Table list. Choose the field or expression that contains the data values.
4. Select the **Ignore Zeroes or Blanks** check box to ignore zero values and blank values in the table. Because you are creating a thematic map based on one field in a table, any zero or blank values in that field will cause the whole record to be ignored. If you are creating a grid map, you can choose a table of regions to clip the grid against.

5. Choose Next to go on to **Step 3 - Customizing Your Thematic Map**.

**Multi-Variable Thematic Maps**

Pie and Bar Chart thematic maps allow you to analyze more than one variable at a time. In the Create Thematic Map - Step 2 of 3 dialog box, you choose the fields or expressions you want to use as the variables, and list them in an order that best suits your analysis. You can use up to 8 variables in a bar or pie chart thematic map.

To create a multi-variable thematic map in the Create Thematic Map - Step 2 of 3 dialog box:

1. Choose the table on which you want to base the map from the **Table** drop-down list. The drop-down list displays the tables that are mapped in the active Map window.

   If you have objects selected in the Map window, the Selection from TABLE item also displays in the list. This enables you to create a thematic map based on the selected items without having to map the selection.

   Fields from TABLE displays all the numeric fields in the table you selected from the Table list.

2. Choose the field, or create an expression that contains the data values.

   **Fields for Pie/Bar Chart** indicates the fields or expressions you have chosen for your pie or bar chart thematic map. The order of the variables in the **Field for the Pie/Bar Chart** list is the order in which the variables appear in the legend.

   • For bar chart thematic maps, the order in which the variables display in the legend is the order in which the bars display from left to right on the map.
   • For pie chart maps, the first variable in the legend corresponds to the pie wedge that begins at the angle specified in the Customize Pie Style dialog box.

3. To display the Customize Pie Style dialog box, click Styles in the Create Thematic Map - Step 3 of 3 dialog box.

   • Click **Up** to move the selected field or expression up one place in the **Fields for Pie/Bar Chart** list. **Up** is unavailable when the selected item is the first item in the list.
   • Click **Down** to move the selected field or expression down one place in the **Fields for Pie/Bar Chart** list. **Down** is unavailable when the selected item is the last item in the list.
   • Click the **Right Arrow** button to move the selected field in the **Fields from TABLE** list to the **Fields for Pie/Bar Chart** list.
   • Click the **Left Arrow** button to move the selected field in the **Fields for Pie/Bar Chart** list to the **Fields from TABLE** list.

4. Choose Next to go on to Step 3.
Step 3: Customizing Your Thematic Map

The last step allows you to customize your thematic map, or create the map based on the default settings. You can also preview the map’s legend before you display the map, and change the legend’s label order. Use these features:

**Preview Legend Sample (Thematic Map)**
Displays a sample legend of the thematic map you are creating.

**Customize**
The buttons in the Customize group enable you to change the default settings of particular aspects of your thematic map. For more information see the Help topic, Modifying A Thematic Map.

**Settings**
Allows you to customize settings on a ranged map. This option is available for ranged and grid maps.

**Styles**
Enables you to customize style attributes such as color and size. This option is available for ranged, pie, bar, and individual value maps.

**Legend**
Enables you to customize your legend. This option is available for all types of thematic maps. For instructions on this process, see the *Customizing the Legend of a Thematic Map* topic in the Help System.

**Number of Columns**
Use this field to indicate the number of columns in which you want the legend entries to display.

**Legend Label Order**
Determines the order in which range and value labels (for ranged and individual values maps) and field labels (for all other thematic maps) appear in the legend. If you are creating a ranged map, the order you specify is also shown in the Customize Range Styles dialog box. Use these entries to indicate whether the legend entries should display in Ascending or Descending or alphabetical order. Click Custom to select a custom label order and to enable the Order button.

**Order**
Use this button to display the Customize Legend Label Order dialog box. Here you can click an entry in the list and use the Move Up and Move Down buttons to properly position the label entries until they are in the order you want. Click OK to save the custom order.

**Associate Theme with Table**
The options you select in this group determine the default theme display for the current map.

**Save As Default Theme View**
Use this check box to save this theme to the map’s metadata so that the theme you have chosen displays each time you open the map.

**Note:** To ensure that this feature works, you must set the Automatically Open Default Theme option in the Map Window Preferences dialog box.

**Remove Default Theme View**
Use this check box to remove the saved default theme from the map’s metadata.
Creating a Thematic Map

Template
The buttons in the Templates group enable you to specify a name for a template, save the thematic map as a template, and when modifying an existing theme merge the thematic map with another template.

Save As
Displays the Save Theme to a Template dialog box. Type a unique name or select an existing name and overwrite it. If you overwrite an existing template, you are prompted to confirm this action.

Merge
The Merge button is enabled only when you are modifying an existing theme, not when you are creating a thematic map.

When you click OK a thematic map is created based on either the default or customized settings.

Customizing the Legend of a Thematic Map
To customize the legend for a thematic map, choose the Legend button in the Create Thematic Map - Step 3 of 3 dialog box. It displays the Customize Legend dialog box where you can customize the legend's title, subtitle, fonts, or range labels. You can also specify if you want to display a legend for this thematic layer.

- For more information, see Customizing the Legend of a Thematic Map, Showing or Hiding a Legend, and Deleting a Frame from a Legend in the Help System.

Saving a Theme to a Map Window
To save a thematic map to a Map window's table, you must select the Automatically Open Default Theme check box in the Map Window Preferences dialog box.

- For more information, see Saving a Theme to a Map Window in the Help System.

Thematic Maps as Layers
If you have created a thematic map, it will be listed in Map > Layer Control as a separate layer. Thematic layer names are indented and display above their corresponding data layers in the layer list. You can modify the attributes of the thematic map through Layer Control.

Note: A Grid thematic layer will not be indented in the Layer Control dialog box; a grid thematic layer is a read-only layer.

To modify the attributes of a thematic Map:

1. Choose Map > Layer Control. The Layer Control dialog box displays.
2. Choose the thematic layer.
3. Click the Thematic button at the side of the Layer Control dialog box. The Modify Thematic Layer dialog box displays.
4. Change the thematic settings, style, or legends from this dialog box.

   **Note:** The availability of certain dialog boxes depends on the type of thematic map you are altering.

   For a full discussion of altering thematic maps, see *Modifying a Thematic Map*.

### Changing the Display Parameters of a Map

#### Changing a Map's Proportions

When you want to change the proportions of a map, resize the original Map window. MapInfo Professional automatically transmits that change to the layout frame. You cannot change a map's proportions by moving the edges of the frame over the map. MapInfo Professional simply resizes the map, preserving its view.

#### Changing Your View of a Map

You change a map's zoom level by specifying certain parameters in the Change View dialog box. To change a map's zoom level do one of the following:

- Choose **Map > Change View**. The Change View dialog box displays.
- Click the **Change View** button on the **Main** toolbar. The Change View dialog box displays.

The Change View dialog box allows you to set various parameters of the map including:

- Display the current zoom, scale or cursor position in the status bar (the default unit of distance is *miles* which is specified in **Map > Options**).
- Change the zoom, scale, and the center point of the current map view.
- Behavior of the map when you resize the window.
- Resize the map to fit the new window, keeping the view the same.
- Set the map to preserve the current scale, so that resizing the window has the effect of letting you see more or less of the map.

#### Resetting the Map Scale

You can use a frame's Frame Object dialog box to size the map so that it has a specific scale. For example, when you want one inch to equal 50 miles, type 50 into the Scale box, the map is rescaled so that one inch on the Layout page equals 50 miles.

This example assumes the map distance units are in miles and the Layout paper units are in inches.

To reset the map scale:

1. Click the layout, making it the active window.
2. Double-click the map frame to bring up the Object Frame dialog box.
3. Set the map scale to the desired value.
Working with Thematic Maps and Legends

This section covers changing and saving thematic map information and thematic legends.

Modifying a Thematic Map

Once you create your theme, it is likely that you will want to change something about it. MapInfo Professional provides two ways to reach the Modify Thematic Map dialog box where you can customize a variety of settings, styles, and legend components.

To modify a thematic map, do one of the following:

- On the Map menu, click Modify Thematic Map
- Double-click the theme’s legend frame within the legend window to display the dialog box.

When you are modifying a map, a quick way to change a number of settings at once is to change the template of the current theme.

To merge a template into your current map:

1. On the Map menu, click Modify Thematic Map to display the Modify Thematic Map dialog box.
2. In the Modify Thematic Map dialog box, click the Merge button in the Templates group. The Merge a Template into the Current Theme dialog box displays with a list of the same type templates as your theme (all range of values templates, for example.)
3. Choose the new template and click OK to return to the Modify Thematic Map dialog box.
4. Click OK again to display the map with the new thematic template. The settings in this template will be applied to your theme.

The Merge feature is only available once you have created the thematic map.

Using the Theme Templates

You can use the theme templates for region ranges, region individual values, point ranges, and grid elevations. Some of the new region range templates are sequential (variations on a particular color to show intensity), and some are color diverging (starting with one color and moving to other complementary colors) and each has its purpose. Sequential templates are helpful when you are showing a progression of data, that is, when the data is straight forward. An example might be population.
Saving Your Thematic Settings

MapInfo Professional provides a way to save your themes and the templates from which you created them.

Saving Thematic Map Layers

To save your thematic maps, on the File menu, click Save Workspace. A workspace is a listing of all the tables and settings used in a map. When you open the workspace, MapInfo Professional opens the tables and re-creates the thematic map. If you close a table or Map window without saving...
your session to a workspace, MapInfo Professional displays the Save Map Objects dialog box and prompts you to do so. The dialog box indicates what types of objects will be lost (for example, thematic layers, label layers) if you do not save your session to a workspace. You can turn off the warning prompt in Map Window preferences.

**Saving Thematic Templates**

Every thematic map begins with a template from which you can then customize for your particular needs. These settings can be saved for future use. In the Create Thematic Map – Step 3 of 3, choose the **Save As** button in the **Template** group box. The Save Theme to a Template dialog box displays. To save your new settings to the existing template, click **OK**. To retain both the new and the original template, type a different name into the **Name** field. To recover any template that ships with MapInfo Professional, copy it from the `\THMTMPLT` directory on the product CD. Templates have the extension `.THM`. In MapInfo Professional files are stored on a per-user basis.

For individual value themes you can also save the actual categories in a theme template. For example, if you choose to build an individual value theme on a table to show land usage, you can assign a different region style to each type of land usage (commercial, forest, residential, farm land etc.). You may then want to take those same assignments and apply them to another table. You can do this by storing the category in a template, it will be associated appropriately when the template is applied to the second table.

To save individual categories in a theme template when creating a new thematic map or for an existing thematic map, from the Modify Thematic Map dialog box press the **Save As** button and specify a template Name. Check the **Save Individual Value Categories** box and click **OK**. A template is saved that can be used to apply the stored individual categories to a second table. When you choose **Map** menu and click **Create Thematic Map** the template’s name will appear in the Template Name field of the Create Thematic Map - Step 1 of 3 dialog box.

**Creating a Theme Legend**

To create a theme legend:

1. Display a thematic layer.

2. Choose **Map > Create Legend**. The Create Legend Step 1 of 3 dialog box displays.

3. Proceed to the Create Legend Step 3 of 3 dialog box.

   Only title/subtitles can be set for theme frames. If a theme layer is selected, the title/subtitle currently set for the thematic legend displays; you may edit these.

   The other options are not available. Changing a theme legend's title/subtitle affects all occurrences of the thematic legend. Additionally, fonts designated in Step 2 of 3 are not be applied to thematic legends.

**Using Theme Legends in the Cartographic Legend Window**

To use a theme legend in the Cartographic Legend window:

1. Make a thematic map the active Map window and choose **Map > Create Legend**. The Create Legend Step 1 of 3 dialog box displays.
2. Select the thematic layer as one of the legend frames you want to include in the legend. Select any other layers you want to include. Click Next. The Create Legend Step 2 of 3 dialog box displays.


4. Select the theme frame to edit the title and subtitle(s). Click Finish when you are ready to display the legend.

Only title/subtitles can be set for theme frames. If a theme layer is selected, the title/subtitle currently set for the thematic legend displays; you may edit these. The other options are not available. Changing a theme legend's title/subtitle affects all occurrences of the thematic legend. Additionally, fonts designated in Step 2 of 3 will not be applied to thematic legends.

### Updating Columns using Thematic Mapping

As explained earlier in this chapter, you can use data from another table to construct your thematic map using Update Column. Update Column creates a temporary column in your base table and automatically inserts data into it for your map. This data can be a field taken directly from another table, or aggregated from other data.

For example, you have a table of U.S. state boundaries and a table of U.S. city point locations. Using ranges of values you want to shade the STATES table according to the percentage of each state’s population living in urban areas. For MapInfo Professional to calculate this percentage, the population for the cities must be in the STATES table.

**Note:** Some of the files used in this example may be from the MapInfo Professional Tutorial data and is only available from the MapInfo web site, www.mapinfo.com/miprotutorial.

To create a temporary column using Update Column:

1. Open the base table (STATES.tab) and the city table (CITY_125.tab).

2. On the Map menu, click Create Thematic Map. The Create Thematic Map Step 1 of 3 displays.
3. Choose Ranges and select a template name from the list. This is the style of the thematic map you are creating. Click Next to display the Create Thematic Map Step 2 of 3 dialog box.

4. Choose STATES, since this is the table you want to shade and in the Field drop-down list, choose Join. The Update Column for Thematic dialog box displays.

Table to Update is already set to STATES and Column to Update is automatically set to Add new temporary column.

5. Select the CITY_125 in the Get Value From Table box. If that is the only other table open, MapInfo Professional automatically displays its title in the list box.

Note: When you create a temporary column for a thematic map, the field must be a numeric field. This is true for all thematic maps except individual values.

Since in our example, we are looking for the percentage of the population living in urban areas in the United States, we need to calculate the total of the CITY_125 population; that is, we must calculate the total of the population of each city in each state. We need to put that sum into the temporary column.
6. In the Calculate box choose **Sum**. In the of box, choose **Tot_pop**.

To put the data from the CITY_125 table into the temporary column of the STATES table, there must be a link between the two tables that MapInfo Professional can use to access the data. MapInfo Professional can often make this link automatically. In this example, both our tables have a **State** field.

7. Click **Join** to display the Specify Join dialog box.

When you choose **Join** in the Update Column for Thematic dialog box, you can see that MapInfo Professional has already set up the Specify Join dialog box with the STATE fields from both tables. If the join were not calculated automatically it would be necessary to specify the matching fields or geographic join.

8. Choose **OK**. MapInfo Professional calculates the sum and returns you to the Thematic – Step 2 of 3 dialog box. The **Field** list box displays the temporary column you created: **SumOfTot_pop**.

However, before we create the map, we still need to calculate the percentage of the total population of each state that is urban. That information does not exist as a field in the table, so you must build an expression to generate it.

9. In the **Field** drop-down list, select **Expression**. The Expression dialog box displays.

The expression **SumOfTot_pop/Pop_1990 * 100** will give you the answer as a percent.

10. In the **Type an expression** box, type:

    **SumOfTot_pop/Pop_1990*100**

11. Choose **Verify** to ensure that your syntax is correct, and then choose **OK**. The Create Thematic – Step 2 of 3 dialog box redisplays showing the expression you created. Choose **Next** to go on to the Create Thematic Map Step 3 of 3 dialog box.
Updating Columns using Thematic Mapping

12. Click the Ranges button and choose either Equal Count or Equal Ranges to customize the ranges, whichever gives you the best representation of your data. Use Round By to round to a decimal place or whole number. Customize the styles to best illustrate your analysis by clicking the Styles button. Customize your legend by clicking the Legend button.

13. Click OK to display your map in a Map window.

For details about using point or line objects to represent thematic variables, see Bivariate Thematic Mapping in the MapInfo Professional Help System.

Adding Temporary Columns

Use Update Column to add temporary columns to a table by using data from another table.

To add a temporary column:

1. Open at least two tables.

2. Choose Table > Update Column. The Update Column dialog box displays.

3. Choose the table to which the temporary column will be added in the Table to Update list.
4. Choose the table from which MapInfo Professional will retrieve the update information in the Get Value from Table list.

5. To add a temporary column, select the Add new temporary column option from the Column to Update list.

   If necessary, specify the information MapInfo Professional will need to associate the data (join) in the two tables by using their common tabular or graphic data.

6. Choose how to produce the column data by specifying how to calculate the information based on columns and expressions at the Calculate and of lists.

7. Select the Browse Results check box to display the table with its new temporary column in browser format.

8. Click OK. The temporary column is added based on the specified information.

   When you make changes to the data table, the new temporary column is automatically updated.

   To save the table with its new temporary columns, use File > Save As. If the temporary columns are added to a table in a workspace, the changes are automatically saved when you save the workspace.

The Help System contains the following topics about Bivariate Thematic Mapping:

- Types of Bivariate Maps
- Creating a Transparent Bivariate Layer (Ranged Theme)
- Creating a Transparent Bivariate Layer (Individual Value Theme)
- Setting the Default Behavior of the Replace Layer Style Check Box
- Example of Bivariate Thematic Mapping
- Using an Inflection Point to Show Distinction
- Example of an Inflection Point Map
- Controlling the Number of Inflection Values
- Applying Rounding Factors to Inflection Values
- Spreading Inflections by Equal Cell Count

Working with Legends

Legends are an important part of making your map understandable to your audience. In MapInfo Professional, you can create two kinds of legends: cartographic and theme legends. Theme legends are those associated with thematic maps. Cartographic legends enable you to create a legend for any map layer(s) in your Map window. The combination of the two types makes it possible to provide cartographic data for all of your map layers.

Creating a Legend Window

You can create a Legend window based on layers in the active Map window.

- The first dialog box allows you to select the layers that will appear in the legend window
- The second dialog box allows you to set options for each frame in the legend window
Working with Legends

- The third dialog box allows you to create attribute driven legends, save frame settings to metadata, create the Legend with joined information.

To create a legend window:

1. Choose Map > Create Legend. The Create Legend - Step 1 of 3 dialog box displays.

   The primary function of this step is to choose the layers that will contribute to the legend. The legend will have one frame for each layer that appears in the destination list box "Legend Frames". By default, all layers that can contribute to the legend will appear in the “Legend Frames” list box. The frames will be drawn in the order, which they appear in the list, so Up and Down buttons are provided for reordering.

   By default, all layers are selected and appear in the Legend Frames list box. If you want to choose specific layers for the cartographic legend you are creating use the Remove button to move the layer name to the Layers list box. Any layer you move to the Layers list box will not be included in the legend.

   **Note:** A layer must contain style attributes to appear in the list box; therefore raster layers are not included in the list box.

2. Complete the Create Legend - Step 1 of 3 dialog box selecting the layers that will contribute to the legend. Press the dialog box’s Help button for specific dialog box field information.

3. Do one of the following:
   - Choose Finish and a legend is created using one frame for each layer listed in the Legend Frame List box.
   - Choose Next to display the Create Legend - Step 2 of 3 dialog box.

4. Specify the legend properties and legend frame defaults. Press the dialog box’s Help button for specific dialog box field information.

5. Do one of the following:
   - Click Finish to display the legend.
   - Choose Next to display the Create Legend - Step 3 of 3 dialog box.

   You can create legends based on unique map styles, or by unique values in an attribute column. Text descriptions can be generated from attribute columns and/or expressions. Additionally, the process by which the legend was generated can be saved to the map table metadata as a default that will be invoked when the legend is next created. The metadata defaults are used to initialize the Create Legend Step - 3 of 3 dialog box. Override metadata defaults and select your own settings in the dialog box and save your changes by writing them to the map table metadata.

6. Complete the Create Legend - Step 3 of 3 dialog box attributes for each Legend Frame. Click Finish to display the legend.

   - For more specific information, see Creating a Legend Window and Modifying the Legend Window Properties in the Help System.

You can save the Legend window to the map table metadata as a default that will be invoked when the legend is next created. The metadata defaults are used to initialize the Create Legend Step 3 dialog box. To override metadata defaults, select your own settings in the dialog box and save your changes by writing them to the map table metadata.
What are Cartographic Legends?

Cartographic legends display cartographic data for a map layer. A legend is created for each layer in your Map window that you choose to include in the legend. Cartographic legends can be displayed in a layout, expanding MapInfo Professional’s presentation capabilities. You can create a legend for an individual layer, giving it particular emphasis, or you can place legends for several layers in one legend window. You can also customize many elements of the cartographic legend and the legend window, including the window title, legend frame borders, and the legend title and subtitle.

Here is a brief description of how to create a cartographic legend:

1. On the Map menu, click Create Legend. The Create Legend – Step 1 of 3 dialog box displays.
2. Select the layers you want to use in the legend and click Next. The Create Legend – Step 2 of 3 dialog box displays.
3. Specify the legend properties and legend frame defaults and click Finish or click Next to select and set attributes for each legend frame.
   • If you click Finish, your legend displays.
   • If you click Next, the Create Legend – Step 3 of 3 dialog box displays.
4. Specify the legend frames and give titles to them in the fields provided and click Finish to display your legend. For more details on the options available in the cartographic legend feature, see Creating a Cartographic Legend on page 422 or see About Cartographic Legends in the Help System.

Customizing a Thematic Legend

To customize the legend for a thematic map, choose the Legend button in the Create Thematic Map - Step 3 of 3 dialog box. It displays the Customize Legend dialog box where you can customize the legend's title, subtitle, fonts, or range labels. You can also specify if you want to display a legend for this thematic layer.

To customize a legend:

1. Choose File > Open.
2. Choose the map tables with which you want to work.
3. Choose Map > Create Thematic Map to display the Create Thematic Map - Step 1 of 3 dialog box.
4. Choose one of the thematic style buttons and choose Next. The Create Thematic Map - Step 2 of 3 dialog box displays.
5. Choose the table on which you want to base the shading, and choose the fields or expressions containing the data values. Different prompts display depending on what type of thematic map you selected.
6. Choose Next. The Create Thematic Map - Step 3 of 3 dialog box displays.
7. Choose Legend to display the Customize Legend dialog box.
8. Choose the items you want to customize and make the desired changes.
- For specific instructions, see *Customizing a Thematic Legend* and *Displaying or Hiding a Floating Thematic Legend* in the Help System.

**Selecting the Sample Size for a Cartographic Legend Window**

You can control the sample legend sizes that appear in Cartographic Legend windows. This feature does not affect Thematic Legend windows. When creating Legends, the Create Legend window - Step 2 of 3 dialog box allows you to select a **Small** or **Large Style Sample Size**. When adding frames to a Legend window, the style sample size is indicated. The default is **Large**.

![Create Legend - Step 2 of 3](image)

To change the style sample size of an existing Cartographic Legend window:

1. From the **Legend** menu, select **Refresh** to display the Refresh Legend window.
2. Select **Refresh Style Sample Size** and select either **Small** or **Large**.
3. Click **OK** to refresh the legend.

![Refresh Legend](image)

You can also change the default value for style sample size shown in **Create Legend - Step 2 of 3**. In the Legend Preferences window (**Options > Preferences > Legends**), select either **Small** or **Large Style Sample Size**. The initial default is **Large**. After changing the preferences, you can Refresh Styles through the user interface.
What are Thematic Legends?

Theme legends are created automatically when you create a thematic map. They provide a key of the colors, symbols, and styles used in the map. Their display is controlled via the Show/Hide Theme Legend Window command in the Options menu. Use the appropriate command in the Map menu to modify them (on the Map menu, click Modify Thematic Map), or simply double-click the legend to display the Modify Thematic Map dialog box. If a theme legend is part of a cartographic legend, and you click it to modify it, the Modify Thematic Map dialog box displays. Click the Legend button to modify the legend. For more on theme legends and thematic mapping, see Using Thematic Mapping to Analyze Information in Chapter 10 on page 340.

Aligning Thematic Legends and Legend Frames

You can align frames in a thematic legend and align titles within frames in a thematic legend. Additionally you can align titles and labels in both cartographic and thematic frames in the same way.

The Help System contains these related topics:

• Selecting Column Alignment Options within a Legend Window
• Changing the Number of Columns in a Legend Frame
• Selecting Thematic Legend Swatch Sizes
• Selecting a Custom Sort Order for Individual Value Thematic Legends
• Creating Custom Labels for Legends

Important Notes for Creating and Merging Theme Templates:

When you are creating and merging theme templates:

• MapInfo Professional saves the custom label order only when the option to Save Individual Value categories is selected in the Save Theme to a Template dialog box. This implies that when you create a theme based on a template, MapInfo Professional applies the custom label order only when the thematic expression creates the same categories as those in the template.
Working with Grid Surface Maps

The thematic maps we have discussed are based on vector layers. MapInfo Professional takes thematic mapping to a new level with a method that displays data as continuous color gradations across the map. This type of thematic mapping, known as grid mapping or surface theme mapping, is produced by an interpolating point data from the source table. MapInfo Professional generates a grid file from the data interpolation and displays it as a raster image in a Map window.

Grid theme maps are appropriate analytical tools in traditional GIS environments and other industries where the data points have measured values that reflect those locations. For example, use grid shading to illustrate temperature changes, snowfall amounts, or change in elevation.

The next figure shows the light to dark gradual transition across the United States, which represents low to high average annual temperatures. The continuous shading allows you to derive measurements at places other than where measurements were taken.

Figure: Grid Surface Thematic Map

The thematic maps we have discussed are based on vector layers. MapInfo Professional takes thematic mapping to a new level with a method that displays data as continuous color gradations across the map. This type of thematic mapping, known as grid mapping or surface theme mapping, is produced by an interpolating point data from the source table. MapInfo Professional generates a grid file from the data interpolation and displays it as a raster image in a Map window.

Grid theme maps are appropriate analytical tools in traditional GIS environments and other industries where the data points have measured values that reflect those locations. For example, use grid shading to illustrate temperature changes, snowfall amounts, or change in elevation.

The next figure shows the light to dark gradual transition across the United States, which represents low to high average annual temperatures. The continuous shading allows you to derive measurements at places other than where measurements were taken.

Figure: Grid Surface Thematic Map

Grid Image Files

Grid mapping produces a file type called a grid image. When you create a grid thematic map using MapInfo Professional’s grid handler, MapInfo Professional generates a default file name of tablename_fieldname with the extension .MIG (for example, USELEV_ELEVFETE.MIG). In the Step 2 of 3 dialog box MapInfo Professional displays the path and the root file name, where you can change it as necessary.
MapInfo Professional contains one read/write grid handler and a Grid Engine tool kit that shows you how to create your own. Once you have written a grid engine, you place this file in your MapInfo Professional application directory and set the preference in the Map Window dialog box. Specifically, to set the default grid writeable handler, go to the Map window preferences and specify your grid handler file. The available handler formats depend on what grid handlers have been installed. Changing the default grid handler will change the default file extension of the grid file name.

Grid files are stored by default in the data directory specified as a preference. Grid files can be opened from the **File** menu, click **Open** command like other MapInfo Professional supported file types.

When you open a table that has a grid filename associated with it, MapInfo Professional searches for the file if it cannot find it immediately. For example, the search capability can simplify opening tables if your .tab file refers to an image that resides on a CD-ROM drive, and different letters are used to designate the CD-ROM drive on different systems.

MapInfo Professional uses the following search order:

1. Search for the file where specified by the FILE tag in the .tab file.
2. Search for the file in the same directory as the .tab file.
3. Search for the file in the Table Search path specified in the Directories preferences.

MapInfo Professional either opens the table as though it found the file in the specified location, or it will report an error because the file could not be found in any location.

**Working with Grid Handlers**

In addition to the MapInfo Professional read/write grid handler (*.MIG) we also supply READ-ONLY grid handlers to support the direct opening of the following grid file formats:

- DEM–USGS ASCII(*.DEM)
- DTED–levels 1, 2, and 3 (*.DT0, *.DT1, *.DT2)
- GTOPO30 (*.DEM)
- MapInfo Vertical Mapper (*.GRD, *.GRC)

You can open these grid file types directly from the Open dialog box. You will see the file extensions listed next to the Grid Image file type in the **Files of Type** drop-down list in the bottom of the dialog box. Because the handlers are read-only, they cannot be used to create grid files during the thematic mapping process.

If the relief shading option is enabled (Create Thematic Map Step 3 of 3 > **Styles** > **Grid Appearance**), a separate file will be created to store the hill shade information. The hillshade file is stored in the same location as the grid file and has the same base name as the grid but with the extension “.MIH”. If the grid file is read-only, for example, it’s located on a CD, the .MIH files will be created in the same location as the .tab file. The .tab file will contain a new metadata key, for example:

"\Grid\Hillshade File" = "d:\tmp\AntiochSouth.MIH"
Vertical Mapper Grid Handler

MapInfo Professional also includes the Vertical Mapper Grid handler to enable users who have not purchased the full Vertical Mapper add-on product to open, view, and print Vertical Mapper Grid (*.GRD, *.GRC) format files.

The Vertical Mapper Grid files can also be opened directly in MapInfo Professional. The *.GRD or *.GRC extension is listed with the other Grid Image formats in the **Files of Type** drop-down list.

Currently, grids using the Vertical Mapper handler cannot be modified in the Modify Thematic Map dialog box. They are read-only. They must be created or modified in the Vertical Mapper source application, which is available from MapInfo. In addition, you cannot create .GRD or .GRC files in MapInfo Professional, however, you can convert *.GRD files to *.MIG files with Gridtools.MBX.

The Help System contains these related topics:

- Creating Custom Read/Write Grid Handlers
- IDW Interpolator
- TIN Interpolator
- Grid Appearance
- Inflection Methods
- Relief Shading
- Grid Translucency
- Final Adjustments
- Zoom Layering
Buffering and Working with Objects

Two of the most important features in MapInfo Professional are buffers and the tools we provide to work with objects. Buffers allow you to create grouping areas around objects, lines and regions, which is important for providing a visual analysis. You can edit and manipulate objects in a wide variety of ways. The Set Target editing model allows you to apply a wide range of editing operations to an object or a series of objects. Using MapInfo Professional you can also create territories and create objects. This chapter covers these topics and discusses the advanced topics of enclosing, checking, and cleaning objects.

In this Chapter:

- Buffering Your Data .................................................. 378
- Editing Objects using the Set Target Model .......... 385
- Creating Territories by Combining Objects ............. 393
- Creating and Manipulating Objects ....................... 396
Buffering Your Data

If you would like to search for all underground cable wires that are buried within 440 yards of Interstate 490 or you would like to contact all families with pre-school age children who live within five miles of a proposed school district, buffering is the tool for you.

Understanding Buffers

A buffer is a region that surrounds a line object, another region, symbol, or any other object in a Map window. For example, you can create a buffer region that surrounds Interstate 90 by 440 yards on either side. You can create a buffer region that surrounds the proposed school district by five miles on all borders. Both the 440 yards and five miles are their respective regions’ buffer radii. The buffer table is then joined to data associated with the original buffered objects.

Note: The maximum buffer resolution is 500 segments per circle. This affects the entry you can make in the Smoothness field of the Buffer Objects dialog box.

Creating a Buffer

To buffer objects:

1. Select the objects that you want to buffer. Make sure there is an editable layer in the Map window. The output buffered objects will be placed in that layer.

Note: There are certain table variables that you need to be aware of that will determine the aggregation method used in joining the table of buffers to data associated with the original objects. See Table Variables for this information.

2. On the Objects menu, click Buffer. The Buffer Objects dialog box displays.
Chapter 11: Buffering and Working with Objects

3. Select appropriate buffer radius, segments per circle, distance type calculation to use, and buffer method as described.
   
   - **Radius** — The radius is the width of the buffer you want to create around the object you selected. The **Value** and the **From Column** radio buttons give you different ways to specify that width.
   
   - **Value** — Type a value into this field if the radius of the buffer you want to create is a specific distance. Examples might include 10 feet, 20 kilometers, 50 chains.
   
   - **From Column** — Select this radio button if the buffer you want to create is specified in a particular column or is to be calculated by an expression. Then select the column or choose **Expression** from the drop-down list.

   If you select **Expression**, the **Expression** dialog box displays. Specify the expression you want MapInfo Professional to use to calculate the buffer radius and click **OK** to return to the **Buffer Objects** dialog box.

   - **Units** — Select the units for the buffer from this drop-down list. Options include: inches, links, feet, US Survey feet, yards, rods, chains, miles, nautical miles, millimeters, centimeters, meters, kilometers.
   
   - **Smoothness** — Type the number of segments per circle that determines the resolution of the curves in the buffer polygon. You can enter a number between 3 and 100. The default value is 12 segments per circle.

   The more segments you enter, the smoother the curve. The fewer segments, the more jagged the curve. More segments produce a smoother curve; fewer segments make a more jagged curve.

   **Note:** Creating a buffer is time consuming. The higher the smoothness (more segments), the longer it takes to create a buffer.

   - **One buffer of all objects** — Select this option to create one buffer for all of the objects you have selected. For example, if you are buffering Pennsylvania, New York and New Hampshire, one buffer will be created for all three of these objects.
   
   - **One buffer for each object** — Select this option to create one buffer for each object you have selected. For example, if you are buffering Pennsylvania, New York and New Hampshire, each object will have a separate buffer.

   - **Buffer Width Distance using Spherical** — Select this option if you want the buffer to take into account the curvature of the Earth. Using this method, MapInfo Professional converts the data to Latitude/Longitude and then creates a mathematical calculation of the buffer. You cannot use this method for non-Earth projections.

   - **Buffer Width Distance using Cartesian** — Select this option if you want the buffer to be calculated as if the map is on a flat plane. Cartesian coordinates are a pair of numbers, (x, y), defining the position of a point in a two-dimensional space by its perpendicular projection onto two axes which are at right angles to each other. If you are using a Latitude/Longitude projection, this option is disabled.

4. When you have completed your entries and selections in this dialog box, press the **Next** button. The standard **Data Aggregation** dialog box displays.

   **Note:** If the editable layer is the Cosmetic layer, the **Data Aggregation** dialog box will not display because there is no data in the layer to aggregate. The **OK** button displays in place of the **Next** button. Press **OK** to begin the buffer operation.
5. Highlight each of the columns to complete the fields in this dialog box.

- **No Change** — Select this option to keep the value for the selected column in the target row unchanged. This option only displays when you combine objects into a target object.

- **Blank** — Select this option to store blank values in the selected column(s). To store blank values in all displayed columns, select the **No Data** check box. Only choose the **Blank** option to blank out individual columns.

- **Value** — Select this option to store the value that displays in the edit field in the new row. When you select this option, enter an appropriate value in the field.

- **No Data** — Check this check box if you want no data aggregated to any column.

6. After setting the appropriate data aggregation parameters, click **OK**. MapInfo Professional calculates the buffer according to the parameters you set and creates the new objects in the editable layer. The original objects remain unchanged. Once MapInfo Professional has created the buffer region, it puts it in the editable layer.
Table Variables

If the table containing the selected table and the editable table are either the same table, or contain the exact same table structure (same number of columns with each column in both tables having the same name and data type), then the Sum and Average radio buttons do not display. The data is taken from the current selection, and the results are placed in the editable layer.

If the table containing the selection objects and the editable table are different, and the table structures are different, then the Sum and Average radio buttons are displayed. In this case, the data aggregation for the editable destination table column is initially blank, and you needs to select the column from the input selection table to derive the data from.

Saving your Buffer as a New Layer

You can create a buffer and save it as a new table (layer) or as part of another layer in your map. See Saving your Voronoi Polygon as a New Layer in the Help System. This process is also similar to the Combine Using Column process, except that there is no “Group By” functionality for buffers.

Note: The table must be mappable to use this feature.

To create the buffer as a distinct layer:

1. To create a selection to buffer, select the object in the map. This step is not required if you want to buffer all objects in a particular table.

2. On the Table menu, click Buffer. The Table Buffer dialog box displays.

3. Do one of the following:
   - To buffer the selected object, leave the Selection object selected in the Buffer objects in table drop-down list box.
   - To buffer objects from a particular table, select the table in the Buffer objects in table drop-down list box.

4. Select the type of table you want to place the buffer into from the Store results in Table drop-down list box. Select one of the following:
   - New table — allows you to save the buffer in a new table
   - <tablenames> — allows you to save the buffer in one of the currently open tables

After you make this selection, click Next to continue.

Note: You cannot save a buffer to the Cosmetic Layer.

5. Do one of the following:
   - If you chose the New table option, go to Saving a Buffer to a New Table in the Help System.
   - If you chose <tablenames>, go to Saving a Buffer to an Existing Table in the Help System.
Buffering Your Data

Buffer Radius

The buffer radius determines the dimensions of the buffer region. For example, if you want to create a region that covers an area one mile on either side of a freeway, set your buffer radius to 1 mile. If you choose to use a field from the table or an expression, MapInfo Professional will calculate the radius of the buffer based on that value.

You can set the radius to be a constant value or you can choose a data value from the table to be used as the radius. For example, to create buffers around major cities that reflect the size of their population, choose the population field as the value.

You can go even further to calculate the buffer radius using an expression. For instance, you want to create buffers around cities showing the population density. Since you do not have a field containing population density, you will need to write an expression that can calculate density from population and area. This is no different than writing an expression for thematic mapping or query selection.

Buffering - Setting the Number of Segments per Circle

The number of segments per circle determines the level of detail in the buffer region. The more segments per circle, the higher the level of detail. The default level is 12 segments per circle.

Buffer Width Distance

MapInfo Professional’s buffering feature calculates the buffer width to create a buffer that is some measured distance from the outline of the object. This distance is calculated using either the Spherical or Cartesian method.

Spherical calculations measure distance according to the curved surface of the Earth. This means that the distance from the boundary of the original object to the boundary of the new buffered object may vary from node to node.

Cartesian calculations measure distance on data that has been projected onto a flat, X-Y plane. This produces buffers that are exact in width, as long as the data is not in a Latitude/Longitude projection.

The availability of the Spherical and Cartesian buttons depends on the type of calculation that is appropriate to the table’s projection. The Cartesian button will not be available if the table is in a Latitude/Longitude projection. Conversely, the Spherical button will not be available if the table is in a Non-Earth projection.

Buffer Methods

You can create a single buffer to include all selected objects, or create individual buffers for each object. There are two ways you can buffer multiple objects at the same time. The first method is to create one buffer for all objects. Buffers are produced around each input object, and the resulting buffer objects are combined into a single output object.

The more powerful method is to create one buffer for each object. For example, you have a layer of satellite offices. You would like to create a five-mile radius buffer around every satellite office symbol. You select all office symbols (with either the Select All command or Select tool), on the Objects menu, click Buffer, and select the option to create one buffer for each object. MapInfo Professional
creates five mile buffer polygons around each point. With this method, MapInfo Professional considers the resulting buffers as individual region objects and does not combine them into one. Once you create a buffer region, you can search for objects within it, as with any other boundary.

**About Buffer Calculations**

Buffer functionality uses a Width setting to create a Buffer that is some measured distance from the outline of the object. Using Latitude/Longitude data, the perfect buffer width, as defined in native Latitude/Longitude decimal degrees, may change on different portions of an object. This is because the width is provided is some flat measurement unit, (for example, miles, meters), and the decimal degree to measurement transformation will vary depending on the location on the earth. For example, a mile spans a larger number of latitude degrees as you move toward the poles of the earth and away from the equator.

MapInfo Professional calculates a native decimal degree width (converting from the input measurement unit) for one location in the object, typically the center of the bounding box. Thus, the measured On Earth (Spherical) distance from the boundary of the original input object to the boundary of the new buffered object may vary slightly from node to node. On small objects the distance may be negligible. On objects that span a large distance, such as the United States, the distance variation may be measurable.

In MapInfo Professional, you can produce Cartesian calculated buffers. Using this option, the data is considered to be in a flat-projected coordinate system, and the measured buffer widths are calculated using Cartesian distances. This produces exact buffers (as measured by the Cartesian Distance functions) as long as the data in not in a Latitude/Longitude projection.

**Types of Buffers**

There are two basic types of buffers that we support in MapInfo Professional.

- **Concentric ring buffers** allow you to create circles around map object(s) or point(s) and compute aggregated values for underlying data that occur within each ring. You would use concentric ring buffers to determine the number of customers within a certain radius of a store or other location.

- **Convex hull buffers** create a region object that represents a polygon based on the nodes from the input object. You can think of the convex hull polygon as an operator which places a rubber band around all of the points. It will consist of the minimum number of points so that all points lie on or inside the polygon. With convex hull buffers, no inside angle is greater than 180 degrees.

For specific instructions, see *Specifying Buffer Calculations* in the Help System.

**Concentric Ring Buffers**

In the Creating a Buffer on page 378, you learned how to create a buffer around one or more objects. Concentric ring buffers allow you to create multiple buffers of different width (radii) around an object or a set of selected objects. The Concentric Ring Buffer tool can assist you in creating this type of buffer.

- For specific access instructions, see *Concentric Ring Buffer Tool* in the Help System.
To create concentric ring buffers:

1. In the Map window, select the object(s) you want to place buffers around.

2. On the Tools menu, point to Concentric Ring Buffers and click Create Ring Buffers. The Concentric Ring Buffers dialog box displays.

3. To add a ring, specify the radius in the Radius field and click Add Ring. Continue this until you have added all of the rings you want from the smallest to largest.

4. Select the units of each radius in the Units drop-down list.

5. To set the smoothness of the ring buffer, type a number between 3 and 100 in the Smoothness field. The larger the number, the smoother and less jagged the curves of the ring.

6. Type the table name and select the path in which you want to store this buffer information. MapInfo Professional stores the concentric ring buffer information into this table including the columns containing the ring number, radius value, radius units, area, and area units for each ring.

7. When you have finished the buffer settings, click OK.

Use the Modify Ring and Delete Ring buttons to change the ring settings, or click Clear All to start all over and create new concentric rings. To change the style of a buffer ring, select it in the Buffer Radii list, and use the style buttons to change the fill pattern and line style for the buffer. You can also collect data within each buffer ring using the Calculate Ring Statistics button.

**Convex Hull Buffers**

The Convex Hull command provides another means of creating a polygon around a selected object or objects. Convex Hull is similar to creating a buffer in several ways. Like a buffer, the Convex Hull command always creates an object from the input objects, and it will place the result objects into the editable layer. In addition, you have a choice to create one convex hull object from all of the input objects, or to create one convex hull object for each input object.

The resulting region object(s) are based on the nodes from the input object. The Convex Hull operation can be thought of as an operator that places a rubber band around all of the points. It consists of a minimal set of points such that all other points lie on or inside the polygon.
polygon is convex, no interior angles are greater than 180 degrees. No attribute data is aggregated in this operation. To use Convex Hull, a Map window must be active, it must have an editable layer, and objects in the editable layer must be selected.

To create convex hull objects:

1. On the Objects menu, click Convex Hull. The Create Convex Hull dialog box displays.

2. Select the type of convex hull objects you want to create. You have two options:
   - One output object for all input objects button is the default setting. It creates one convex hull object around all of the selected objects.
   - One output object for each input object button creates a convex hull object around each selected object.

3. Click OK. Your map redisplay. The convex hull object(s) is displayed over the input objects. If you want to save this data, save the editable table. The convex hull object is selected when it displays.

4. To change the fill of the convex hull object, do one of the following:
   - Double-click it to display the Region Object dialog box. Click the Style icon at the bottom of the dialog box to display the Region Style dialog box. Make any changes you like and click OK.
   - Select the convex hull object, if it is not already, and on the Options menu, click Region Style. The Region Style dialog box displays. Make the changes you want and click OK.

Editing Objects using the Set Target Model

With MapInfo Professional’s advanced set target editing functionality, you can combine, split, erase map objects, and overlay nodes using a “Set Target – Apply Action” editing model. This model allows you to use objects from the same table or another table to create new objects. Sophisticated data aggregation methods allow you to calculate new data values that match the new objects.

The Set Target editing model in MapInfo Professional allows you to set a map object as the target for editing, then create a modifying object that will act as the cookie cutter that overlays the target and performs the editing action on the target. Set Target is located under the Objects menu.
The Set Target model for editing map objects can be broadly described as a three-step process:

1. Set the object you want to edit as the target.

2. Choose and select another object or objects to act as the modifying object for the editing operation. You can also create a new object.

3. Perform the edit operation (combine, split, erase, erase outside, or overlay nodes).

A new object (or objects) is created in place of the target object.

The following table describes valid cutter/target objects for supported object processing operations:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Overlay Nodes</th>
<th>Split, Erase, Erase Outside</th>
<th>Combine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cutter</td>
<td>Target</td>
<td>Cutter</td>
</tr>
<tr>
<td>Closed</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Linear</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multipoints</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Collections</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You are not limited to working with map objects in the same layer. While the target objects must be in the Editable layer, you can choose the modifying objects from another layer.

The set target process is essentially the same whether you want to combine objects or create new objects by splitting objects or erasing portions of objects. Each operation is discussed individually in this chapter.

In addition to creating new map objects, the Set Target model allows you to control how the data associated with the target object will be transferred to the new object or objects. The next section discusses a number of data aggregation and disaggregation methods that give you tremendous flexibility with editing map objects.

- For specific instructions, see Setting a Map Object as a Target in the Help System.

### Understanding Object Size

Many customers use the contouring process to create signal coverage maps, which requires large object sizes to create highly detailed coverage areas. To accommodate this need, we have increased the limit on number of nodes and the number of polygons or polylines that can be stored in objects.

Theoretically, the size of an object is only limited by the amount of memory in the system, but for practical reasons, a limit is imposed to work within limits of file size and most system memory limits. Currently, the object size limit is 1,073,741,823 bytes in memory. This limit is imposed so that an object of this size can be saved into a MAP file. All MapInfo Professional files have a theoretical limit of 2GB, but due to header size and other required Map file contents, the actual size limit has to be somewhat less.

The node limit is 134,217,724 nodes in any object. This is the actual number of nodes that can fit into this 2GB memory size limit. It will be difficult to reach this node limit because memory allocation may prohibit it. It may not be possible to create a Map this size on a computer being used to accommodate an object this size; the program may throw an error when you try it.

Keep these notes in mind:

- For regions, the theoretical maximum number of polygons in a multi-polygon region or collection is 20,648,881 polygons that can fit into the size limit for all objects given above.
- For polyline objects, the theoretical maximum number of segments in a multi-segment polyline is 24,403,223 that can fit into the size limit for all objects given above.
- For multipoint objects, the theoretical maximum number of nodes is 134,217,724 that can fit into the size limit for all objects given above.

### Aggregating and Disaggregating Data

If you have data attached to map objects that will be edited, you can proportion the data for each field to match the new object(s). This is called data aggregation or disaggregation, depending on whether you are combining or splitting objects. MapInfo Professional calculates new data values for the object depending on how you specify the aggregation or disaggregation.
Editing Objects using the Set Target Model

When combining objects, you can choose from several methods of data aggregation, including:

- **Sum** – adds the field values from the original objects to create a total for the field in the new object.
- **Average** – averages the field values from the original objects.
- **Weighted average** – gives more weight to one value over another when averaging. You can choose a numeric field in your table as the weighting factor or choose area (where the weighted average is based on the relative geographic area of the regions to be combined).
- **Value** – stores a specific value in the field of the new object.
- **No Change** – maintains the value of the target object in the new object.

When splitting or erasing portions of a map object, you can choose from:

- **Blank** – removes the original value of the target object.
- **Value** – maintains the original value of the target object.
- **Area proportion** – removes a portion of the original value based on the size of the new object.

With any of the editing operations under Set Target, you can elect not to bring over any data at all by choosing the **No Data** check box. You might do this, for instance, if you are only editing map objects for presentation purposes and do not need any data associated with the objects.

The **Data Aggregation** (or **Disaggregation**) dialog box displays after you have set the target, chosen the modifying object, and chosen an editing operation. In these dialog boxes, you must specify how you want the data calculated for each field. Once you are satisfied with the aggregation method, you can carry out the editing operation.

### Clipping a Region of a Map

You can use **Map > Set Clip Region** to isolate a region of a map for display and/or printing. The clipped region may be a pre-defined map region, such as a state, or you can use a drawing tool to define a region. Use the Select tool to select a pre-defined region or a region that you defined. Thematic maps and seamless layers, labels, and points displayed on the map will be included in the clipped region.

- For specific instructions, see *Clipping a Region of a Map and Setting Clip Region Options on the Fly* in the **Help System**.

To toggle between the map and the clipped region, you may find it useful to use the Clip Region On / Off command.

**Note:** To clip a raster image, use an object created in the cosmetic layer, or an object from an existing vector layer.
- For specific instructions, see *Saving a Clipped Region of a Map* in the **Help System**.

### Overview of Combining Map Objects

When you choose Combine, MapInfo Professional performs two operations:

1. MapInfo Professional geographically combines the selected objects. The new object represents the geographic union of the original objects. Therefore, if you select two adjacent region objects
and choose Combine, MapInfo Professional combines the regions into a single object, and the border between the regions disappears.

2. MapInfo Professional performs data aggregation. Data aggregation is a process where MapInfo Professional calculates what the column values for the new object should be, based on sums or averages of the values of the original objects.

Perhaps you have a table of sales territories, and the table contains demographic information about the number of households per territory. Using the Combine command, you can combine two of the sales territories into one, large territory. In the same operation, MapInfo Professional also can calculate the number of households in the new territory by adding the values from each of the original territories.

### Combining Objects with Set Target

The Combine operation can work in conjunction with the target feature of MapInfo Professional’s Edit menu. Before you choose Combine, you can select one map object, and designate that object as the editing target. You can then select additional map objects and choose Combine to combine the selected objects with the target. If you set a target before you choose Combine, the Combine operation is more flexible, allowing you to combine objects from different tables.

You should assign a target object if one of the objects you are combining is more important than any of the other objects. For example, if you want to add small, unnamed islands to an existing “mainland” region, you should make the mainland region the target object. If you designate the mainland region as the target, MapInfo Professional is able to retain the mainland region’s name after the objects are combined.

Using Combine with Set Target allows the mainland region to retain its name after the objects are combined. You can only set one object as the target at a time when using Combine with Set Target. The modifying object can consist of more than one object.

Keep in mind that the Objects Combine command works with selected map objects. To apply the combine operation to an entire table, use Select All in the Query menu. To combine into groups rather than objects, or output to a separate table, use Combine Objects Using Column in the Table menu.

To combine map objects using Set Target:

1. Select one object in an editable layer to be the target object.

2. On the Objects menu, click **Set Target**. The object displays in a different style to indicate that it is the target object.

3. Select (or create and select) one or more map objects from any layer in the Map window. This is the modifying object.

4. On the Objects menu, click **Combine**. The **Data Aggregation** dialog box displays.
5. Choose the appropriate aggregation method (or No Data) for each field in the Destination list. See the definitions for these methods in Aggregating and Disaggregating Data on page 387.

Note: To select more than one field in the Data Aggregation dialog box at a time, use these keystrokes:

- Shift-click to apply the same method to consecutive fields
- Ctrl-click for non-consecutive fields.

When you have chosen the aggregation methods for each field, click OK.

6. Select one or more columns by clicking in the list at the top of the Data Aggregation dialog box.

7. Choose a data aggregation method: Blank, No Change, Value, Sum, Average, or Weighted Average. (Depending on whether you specified an editing target, some of these aggregation methods may not be available.) MapInfo Professional updates the column list in the upper half of the dialog box to show the chosen method.

- For example, if you choose Average, you are telling MapInfo Professional to calculate the average of the column values of all the selected objects. This average is stored in the column of the new row.

- Aggregation methods are described below.

8. Repeat steps 6 and 7 for all columns in your table and click OK.

- To simplify this process, select multiple columns at one time by Shift-clicking and/or Ctrl-clicking in the list of columns. If you select multiple columns, and then choose an aggregation method, MapInfo Professional applies that method to all selected columns.
If your table contains a large number of columns, it can be time-consuming to specify aggregation methods for all columns. However, MapInfo Professional remembers your aggregation methods for the remainder of your session; thus, the next time you choose Combine, you do not need to respecify all aggregation options.

MapInfo Professional computes the new object and displays it as a single object. Use the Info tool to view the aggregated data (if any) associated with the object.

- For more information, see Combining Points, Linear, and Closed Objects into a Single Object and Specifying Collection Object Attributes in the Help System.

**Default Data Aggregation Methods**

When the Data Aggregation dialog box first appears, MapInfo Professional automatically assigns a default aggregation method to every column in the table. For numeric columns (Integer, Small Integer, Float, or Decimal), MapInfo Professional assigns Sum as the default aggregation method. For all other types of columns, MapInfo Professional assigns Value as the default method.

You could simply choose OK, without changing any of the default aggregation methods. However, there is no guarantee that the default aggregation methods will produce meaningful results. By default, MapInfo Professional uses the Sum method for all numeric columns; however, depending on your data, it may not make sense to total all of your columns.

For example, perhaps your table contains demographic information, such as median income statistics. If two adjacent regions have different median income values ($30,000 and $35,000), and you combine the two regions, it does not make sense to total the two values; instead, you should choose Average or Weighted Average as the aggregation method.

**Clearing a Target**

If you do not want to edit an object after it has been set as the target, use Clear Target. The object will no longer be highlighted or marked for editing. An object will also be cleared as a target automatically if it has been deleted or modified by Combine, Erase, Erase Outside, Split, Overlay Nodes, or if you have chosen a new target.

To clear a target:

- Choose Objects > Clear Target.

**Combining Objects with Different Table Structures**

If the tables you are combining have the same table structure, the process we have discussed in Combining Objects with Set Target on page 389 works perfectly. When you are working with two tables with different table structures, the Data Disaggregation options are slightly different. When the input table has a different table structure from the output table, the Data Disaggregation dialog box displays a Column Name field to accommodate the table structure.
The Area Proportion radio button is active if the selected field is numeric. Also the Value entry field is enabled when you select the Value radio button and the drop-down list contains “none”.

Splitting Objects
Splitting Objects allows you to divide the target object into smaller objects, using another object as a cutter. You can also combine objects into territories using redistricting. For more about the redistricting process, see Redistricting — Grouping Map Objects into Districts in the MapInfo Professional Help System. For example, you might use Split to separate a large territory into smaller units.

You can split either closed objects (regions, ellipses, rectangles, or rounded rectangles) or open objects (polylines, lines and arcs) using the Split command. You cannot use Split on points or text objects or to cut objects that are not in editable layers.

• For specific instructions, see Splitting Objects in the Help System.

Proportioning Associated Data after Using Split
After using Objects > Split, you may want to proportion (disaggregate) the associated data. Data disaggregation splits the data associated with a map object into smaller parts to match the new map objects. For instance, you may want to split a state into regions and have the data previously associated with the entire state proportioned for each new region. When you initiate the Split command, a Data Disaggregation dialog box appears that allows you to specify how the data will be proportioned.

Splitting Map Objects Using a Polyline
You can split multipoints and collections, as well as closed objects (regions, ellipses, rectangles, and rounded rectangles), and linear objects (polylines, lines and arcs) using the Polyline Split command.

As mentioned previously, splitting objects requires that the cutter be a closed object. With Split Using Polyline, the polyline cutter will first be transformed into a region suitable for the cutter operation. The region created will be displayed for acceptance. The polyline(s) used as the cutter must be
contiguous and non-branching. In general, if the cutter polylines were to be combined, the result would be a one single section polyline. If the cutters are not polylines, and are not contiguous and non-branching, then an error will occur, and the operation will be cancelled.

**Note:** You cannot use Polyline Split on text objects or to cut objects that are not in editable layers.

- For specific instructions, see *Splitting MapObjects Using a Polyline* in the Help System.

### Creating Territories by Combining Objects

Creating territories is one of the most common tasks performed with MapInfo Professional. Most people create territories by combining two or more smaller regions to create a larger one. Police departments combine postal code boundaries to create precinct boundaries. Sales managers combine county boundaries or state boundaries to create sales territories. Political analysts combine census tract boundaries to create voting districts.

Remember, when you are combining regions, you are also combining the data associated with the regions. If you combine regions without somehow aggregating the data associated with the regions, that data will be lost. For some applications, you might not want to save your data. For example, you are merging census tract boundaries to create school districts. The census tract data is of no interest to you; you merely want the boundaries. There is no reason to aggregate the data, but you would want to apportion the demographic data. For most tasks, you’ll want to save the data associated with the regions.

MapInfo Professional gives you three methods for combining regions.

1. The first method, Combine, works with objects that are selected.
2. The second method, Combine Objects Using Column, is used to combine objects into groups based on a specified column.
3. The third method, Redistricting, is covered in *Redistricting — Grouping Map Objects into Districts*.

Most frequently, the Combine Regions options are your easiest and quickest options for combining regions and creating territories.

### Combining Selected Objects

When you choose to combine objects, MapInfo Professional performs two operations:

- MapInfo Professional geographically combines the selected objects. The new object represents the geographical union of the original objects and the border between the regions disappears.
- MapInfo Professional performs data aggregation. As described earlier in this chapter, data aggregation is a process where MapInfo Professional calculates what the column values for the new object should be, based on sums or averages of the original objects.

Your setup of the **Layer Control** dialog box depends on whether you want to copy the result object to another layer (and, thus, save the original objects) or combine the objects in the original layer (and, thus, lose the original objects).
If you want to copy the result object, make the region’s layer Selectable and another layer Editable. Specify a target object, then select the objects using any selection method and on the Objects menu, click Combine. This will display the Data Aggregation dialog box where you tell MapInfo Professional how to combine the data. Fill in this dialog box and click OK to combine the objects to combine the objects’ data. This method was discussed earlier in this chapter.

If you want to combine objects in the original layer, make sure that the layer is editable, select the objects in the layer, and on the Objects menu, click Combine. Do not set a target. The Data Aggregation dialog box displays. After the operation is complete, a new object will be added to the layer, and the original objects will be deleted.

**Combining Objects Using Column**

Combine Objects Using Column allows you to modify geographic data to create new map objects that contain data about the group. This feature is similar to redistricting in that it groups objects together, but goes beyond redistricting to combine a copy of the relevant objects while leaving the original objects untouched.

To access Combine Objects Using Column:

1. On the Table menu, click Combine Objects Using Column.

   For example, you have a layer of states. You want to combine the state boundaries to create sales territories. The data record associated with each state looks like this:

<table>
<thead>
<tr>
<th>SALES_REP</th>
<th>STATE</th>
<th>CUSTOMERS</th>
<th>AVG_SALES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benita</td>
<td>West Virginia</td>
<td>1782</td>
<td>24231.4</td>
</tr>
<tr>
<td>Benita</td>
<td>Ohio</td>
<td>121</td>
<td>33265.0</td>
</tr>
</tbody>
</table>

   - SALES_REP: Sales representative assigned to that state
   - CUSTOMERS: Number of customers per state
   - AVG_SALES: Average spent per customer

   You would like to aggregate the data in the following manner:
   - SALES_REP: Combine all records that list Benita as the sales representative
   - CUSTOMERS Sum up the number of customers in the sales territory
   - AVG_SALES: Average the amount spent per customer in the sales territory

   When performing a Combine Objects Using Column operation, you must specify which column contains the grouping information. In the preceding example, the grouping information is located in the SALES_REP column. We want to combine all of Benita’s individual territories into one large territory.

   2. Choose the appropriate column from the Group Objects by Column popup. In our example, you would choose the SALES_REP column from the Group Objects By Column popup. MapInfo Professional combines all records that have common data in the column. In other words, MapInfo Professional combines all records that have the same sales representative.
3. Specify the table and the grouping column.
   - If you chose <New> from the Store results in table drop-down list to create a new table for the combined objects, a series of dialog boxes prompt you to create the new table.
   - If you specified an existing table, you need to specify how to combine the data. To aggregate your data, click Next to display the Data Aggregation dialog box.

4. Once you have completed both dialog boxes, press OK. MapInfo Professional combines the records based on the column specified in the Group Objects By Column list. MapInfo Professional also aggregates the data and combines any objects associated with the records.
   - For specific instructions, see Combining Object Using Column in the Help System.

Creating a Voronoi Polygon

The Voronoi polygon is a partition of space into cells. Voronoi takes points and produces regions (cells) as output where each cell contains exactly one point. Each cell is an area in which the contained points are closer to the enclosed site than to any others. Use Voronoi to generate these polygons from a designated set of points. It is useful for dividing areas of responsibilities for field offices or possibly postal zones. It ultimately gives you the areas that are closest to your point of interest. You can create a Voronoi polygon within the same layer, or select points from one layer and place the Voronoi polygon in another layer.
   - For specific instructions and additional related topics, see Creating a Voronoi Polygon in the Help System.
Creating and Manipulating Objects

Grouping Objects using Multipoint and Collection Object Types

The Multipoint and Collection object types allow you to group multiple objects into a single object. One way to create multipoints and collections is by using the Combine command (on the Objects menu, click Combine). These object types aid in the translation and live access of other GIS data formats, such as ArcView Shape Files, and are more compatible with GIS standards. This is particularly useful for sharing maps with others using different software.

A Multipoint object consists of a number of points that have been grouped into a single object. The Multipoint object displays in a Browser window as a single record, and all the points within the object have the same symbol. One method you can use to create a multipoint object is to select a group of point objects and combine them.

A Collection object consists of multipoint objects, zero or one polyline objects, and zero or one region objects that have been grouped into a single object.

MapInfo Professional automatically converts homogeneous Collection objects to a more specific type, for example, a Collection object that contains only polylines is automatically converted to a multi-polyline object.

• For specific instructions and additional related topics, see Grouping Objects using Multipoint and Collection Object Types in the Help System.

Creating and Manipulating Objects

The operations in this section do not make use of a target object to perform analysis or data aggregation. These tasks use selections to create new objects so that you can perform further mapping operations on those objects. The results of the operation are placed in the editable layer. The original objects remain unchanged.

See the Help System for related topics including:

• Enclosing Objects
• Checking Regions
• Cleaning Objects
• Snapping Nodes and Thinning Objects
• Disaggregating Objects
• Erasing Objects
• Adding Nodes to an Object
• Displaying and Selecting an Object's Nodes
• Moving an Object's Nodes
• Copying and Pasting an Object's Nodes
• Deleting an Object's Nodes
• Checking Regions/Tables for Incorrect Data
Stylizing Your Map for Presentations and Publishing

Most of us do not get to make maps solely for our own use. We use the maps we create in MapInfo Professional® to create presentations, to publish them on the web, or to include as part of another document. This chapter will help you create presentation quality maps and prepare you for printing and exporting your work.

Sections in this Chapter:

- Changing a Map’s Style ............................................. 398
- Labeling Your Map .................................................. 403
- Working with Layouts ............................................. 411
- Creating a Cartographic Legend ............................. 422
- Printing and Exporting Your Results .................... 424
Changing a Map’s Style

Changing the look of the map is an important part of making it more effective. In this section, we review how to change the way your map looks one piece at a time. For a more comprehensive change in your map’s appearance, see Create Thematic Maps in the Help System.

Changing a Region’s Style

To change the style of a region:

1. Do one of the following:
   - To change the style of one region, click the region and on the Options menu, click Region Style from the main menu.
   - To change the style of all regions in the same layer, click to display the Layer Control dialog box, highlight the layer you want to change and click Display.

Using either method the Region Style dialog box displays.

2. Make the region changes you want to see in your map window in this dialog box and click OK to save them. If you opened Layer Control, click the OK button in that dialog box as well to see the results.

   Fill
   These are the fill options you have in the Region Style dialog box.

   Pattern
   Choose a palette for patterns. If you do not want to use a pattern, choose the letter N, for none; the foreground and background color are disabled. If you choose the solid black pattern, the background color is disabled.
Color
Choose a color for the object(s)’ foreground. The Sample box displays the pattern using the foreground color you chose. The foreground color is applied to the part of the pattern that displays as black. Therefore, to make the object a solid color, choose the solid black pattern in the Fill Pattern palette and a color from the Foreground Color palette. The color you chose displays in the Sample box as a solid-colored region.

Background Color
Select the check box to display a background color; clear for a “transparent” background. Choose a color for the object’s background. The background color is applied to the part of the pattern that displays as white. Background color is grayed if you chose the solid pattern.

Border
These are the border options you have in the Region Style dialog box.

Style
Choose the border line style.

Color
Choose the border line color.

Note: For more information, see Creating Custom Colors in the Help System.

Width
Choose the border line width. In the Pixels field, enter a number from 1-7, each number represents a line width in pixels. In the Points field, select or enter a point size.

Sample
Displays the sample of the pattern and color selections you have made.

Changing a Line's Style
To change the style of a line:

1. Do one of the following to display the Line Style dialog box:
   • To change the style of one line, click the line and on the Options menu, click Line Style from the Main menu.
   • To change the style of all lines in the same layer, click Display to display the Layer Control dialog box, highlight the layer you want to change and click OK.

2. Make the line style changes you want to see in your map window in this dialog box and click OK to save them. If you opened this dialog box from Layer Control, click the OK button in that dialog box as well to see the results.
Changing a Map’s Style

**Style**
Select the new line style from the drop-down list.

**Color**
Choose a color for the line from this drop-down list. The **Sample** box displays the pattern using the color and line style you select.

**Width (in Pixels and Points)**
Choose the line width from one of these drop-down lists. In the Pixels field, select a width of the line in pixels. In the Points field, select a point size from the drop-down list, or enter a point size.

**Interleaved**
If you select a line style that uses multiple passes to create it, MapInfo Professional enables the **Interleaved** check box. Keep in mind these notes:

- The Interleaved option is not enabled for solid lines
- The Interleaved option is not activated for borders
- The Interleaved option is not appropriate for all multiple pass lines

Changing a Symbol’s Style

To change the style of a symbol:

1. Do one of the following:
   - To change the style of one symbol, click the symbol and on the **Options** menu, click **Symbol Style** from the main menu.
   - To change the style of all symbols in the same layer, click ![Layer Control](image) to display the **Layer Control** dialog box, highlight the layer the symbol displays in and click **Display**.

Using either method the **Symbol Style** dialog box displays.

2. Complete your selections and entries in this dialog box and click **OK**. If you opened this dialog box from Layer Control, click the **OK** button in that dialog box as well to see the results.
Font
Choose a font from the drop-down list. In addition to the symbol sets provided by MapInfo, the list displays any fonts installed on Windows. The Custom Symbols category lists those bitmaps you have created and saved to the CUSTSYMB directory.

Size
Choose a size or type a different point size. The maximum size is 240 points.

Symbol
Choose a symbol type from the symbol palette.

Color
Choose a color from this list for the symbol.

Reload
Click this button when you have added your own custom symbols to update the list. If you restarted MapInfo Professional since adding the new custom symbols you do not need to select the Reload button.

Full View
Click this button to display large images in a separate window.

Rotation Angle
Specify number of degrees the symbol should be rotated; 0-360.

Background
In this box, you can specify a background. Select one of these:

- None: Click this option to display no background.
- Halo: Click this option to display the symbol with a white border outline.
- Border: Click this option to display the symbol with a black border outline.

Effects
In this box, you can specify special effects for the symbol. Not all of these options display all the time. You can select one or more of these:

- Bold: Click this check box to draw the symbol in boldface.
- Drop Shadow: Click this check box to draw a drop shadow under the symbol.
- Show Background: Click this check box to display the custom bitmap symbol with the background with which it was created.
- Apply Color: Click this check box to replace all non-white bitmap pixels with the color you select from the Color palette.
- Display at Actual Size: Click this check box to display the image at the actual size.

Sample
When you select a symbol style, it displays in this box to show you a sample of the symbol using the designated selections.
Changing a Map’s Style

Changing the Text Style

To change the style of text:

1. Do one of the following:

   • To change the style of one text entry, click the text and on the Options menu, click Text Style from the main menu.

   • To change the style of all text entries in the same layer, click to display the Layer Control dialog box, highlight the layer the text entries display in and click Display.

Using either method the Text Style dialog box displays.

2. Make your selections and entries in this dialog box and click OK. If you opened this dialog box from Layer Control, click the OK button in that dialog box as well to see the results.

   - **Font**
     Choose a font from the Font drop-down list.

   - **Size**
     Choose a point size from the Point Size drop-down list.

   - **Text Color**
     Display the color palette; choose a text color.

   - **Background**
     In this box, you can specify background options for the selected text. You can select only one of these options:

     - **None** — Set no specific background for the selected text.
     - **Halo** — Display the text outlined in a designated color.
     - **Box** — Surround the text with a box in a designated color.
     - **Color** — Display the color palette; select a color to halo or box the text.

   - **Effects**
     In this box, you can specify special effects for the selected text. Not all of these options display all the time. You can select one or more of these:

     - **Bold** — Select this check box to display text in boldface.
     - **Italic** — Select this check box to display text in italic.
Underline — Select this check box to display text underlined.

All Caps — Select this check box to display text in all upper case letters.

Shadow — Select this check box to display a grey “drop” shadow under the text.

Expanded — Select this check box to insert double spaces between each letter in the text.

Sample
The results of the options you choose show in this box.

Labeling Your Map

The labeling features in MapInfo Professional® make it easier for you to display, edit, and save labels. You can specify whether to display labels automatically when you display the map or display the map without labels. You can edit automatic labels, use the customizing options to make your labels unique, and create individual labels with the Label tool. Haloing and positioning options enable you to get the precise look you want for your labels.

Designing Your Labels

The design of the label feature in MapInfo Professional is important for understanding how to create and manipulate labels on your map. Most important among the design elements are the following:

• Labels are not drawn to the Cosmetic layer.
• Labels are attributes of geographic objects in the map layer. The text is based on data associated with that object.
• Labels are always selectable and editable.
• Labels are saved to a workspace.

Labels are attributes of geographic objects in the map layer. They are not drawn to the Cosmetic layer and they are not Cosmetic objects. Their drawn location is based on the location of the geographic object’s centroid and additional information such as anchor point and offset controlled in the Label Options dialog box.

As attributes, labels are dynamically connected to their map objects. If the layer is closed or is made invisible, the labels no longer display. If the data or geographic information changes, the labels change. If you create an expression for your labels and change the expression, the current labels are dynamically replaced with new ones.

Labels are always selectable and editable, so you do not have to make the map layer editable or selectable to work with them. And, since labels are not Cosmetic objects, you do not have to remember to make the Cosmetic layer selectable or editable to label your map. They are already part of the map layer.

Saving labels is easy. Because labels are attributes of the map object, you do not have to remember to save them to a separate table. Any label edits you have pending, or changes you have made to the Label Options settings, are easily saved to a workspace.

You can label your map automatically through Layer Control, in the Label Options dialog box. All global settings for labels are controlled in the Label Options dialog box.
Labeling Your Map

Choosing the Label Content

When you label your map automatically, or interactively using the Label tool, the content of the labels is determined by the data associated with the geographic object. You can obtain the labels from the columns in your table, or the derived result of an expression using the column information. If the column information or an expression does not suit your needs, you can edit the label content or type in new text. See Editing Labels on page 410 for more information.

Text you create yourself using the Text tool is a text object and behaves like other objects you draw on your map such as squares and circles. Although labels are no longer text objects, text objects are still useful for additional map annotation such as titles. For information on text objects, see Working with Text on the Map in Chapter 8 on page 287.

The Autolabeler tool, available from the Tool Manager (on the Tools menu, click Tool Manager), creates labels as text objects in the Cosmetic Layer. This application may be useful if you need to create labels that can be transferred to a permanent table. In addition, you can create text objects and convert labels into text objects using another tool from the Tool Manager set, the Labeler tool, which is explained later in this chapter.

Labeling with a Column

The content of labels is controlled in the Label with drop down list in the Label Options dialog box. You can label an object with any column from its associated table. For example, you can label the STATES table with the state name, abbreviation, 1990 population, or any other field in the STATES table. Simply choose a column from the list, and the objects in that layer will be labeled with the information contained in that column.

Labeling with Expressions

You can also label objects with an expression. Select Expression from the drop-down list in the Label Options dialog box. Create the expression in the Expression dialog box. You can type the expression directly or use the drop-down lists to create it. For example, you want to label the countries of Africa with their name and population density on two lines. Your table contains the country names and population figures for each country. To figure the population density, divide population by each country’s area. You can let MapInfo Professional calculate the area of each country using the Area function in the Expression dialog box. To create the expression, in Layer Control, highlight the Africa table and choose the Label button. Select Expression from the Label with drop-down list in the Label Options dialog box. The Expression dialog box displays. Using the drop-down lists, create the following expression:

\[ \text{Country} + \text{Chr$(13)} + \text{POPULATION} / \text{Area(Object, “sq mi”)} \]

The Chr$(13) function adds a carriage return to the first line. Using the Label tool, click a country. MapInfo Professional labels it with the result of the expression.

- For instructions and examples of this topic, see Creating Labels using Expressions in the Help System.
Saving Labels to a Workspace

Both automatic and interactive labels are saved as part of a workspace.

To save your objects:

1. Choose **File > Save Workspace**. The **Save Workspace** dialog box displays. The **Save Workspace** dialog box allows you to save information about the tables and windows used in your current session.

2. Select the drive, folder, and file where you want the workspace saved.

3. Type a name for your workspace.

4. Click **Save**.

Packing a Table with Customized Labels

Note that packing a table that contains customized labels can corrupt the labels. For example, you delete one or more rows from your table and save the table. Then you create a map with customized labels and save the labels to a workspace. You pack the table to purge the deleted rows. Since the Pack command closes the Map window, you’ll need to reload the workspace. When you do so, your labels are corrupted.

This problem occurs most often when the deleted rows are located near the top of the Browser. To avoid the problem, pack the table before you create the labels.

Using AutoLabeling

In addition to label content, you control the position, display and look of automatic labels in Layer Control. The settings in the **Label Options** dialog box allow you to set conditions for displaying labels, in what style they will display, and in what position for all the objects in the layer.

Controlling Label Display

The Auto Label attribute in Layer Control is off by default for all map layers.

To activate labels for a layer(s):

- Select the layer or layers in the **Layer Control** dialog box and select the **Auto Label** check box for each layer. When you return to your map, labels display for all layers you selected.

You can easily turn the display of automatic labels on or off. In Layer Control, clear the **Auto Label** check box to turn labeling off. Any settings you have specified in the **Label Options** dialog box will be deactivated. You can also go into the **Label Options** dialog box and click **Off** in the Visibility group. Either way, when you go back to your map, the labels no longer display. These settings also apply to labels you have edited.

To make changes to the labels of a selected layer:

1. Select a layer in the **Layer Control** dialog box and select the **Label** button. The **Label Options** dialog box displays.
2. Select the appropriate options for your new labels and click **OK** to save them.

**Visibility** — Use these options to indicate whether this label should display.

Click **On** to display the labels for this layer.

Click **Off** to hide the labels for this layer.

**Display within Range** — You can also display labels within a specified zoom range, much the same way that you display map layers within a certain zoom range. Select a layer, click **Label**, and in the **Label Options** dialog box, click the **Display within range** button. This activates the Min. and Max zoom boxes. Fill in the minimum and maximum zoom distances in the appropriate boxes.

When labeling a dense table of streets such as a StreetPro Display layer, only a few of the streets will be labeled when the map is zoomed out.

The check boxes on the right side of the Visibility group control which labels display and determine how they appear on the map.

**Allow Duplicate Text** — Select the **Allow Duplicate Text** check box to allow duplicate labels for different objects to display, for example, Portland, OR and Portland, ME. This option is also used with street maps to label street segments individually.

**Allow Overlapping Text** — Select the **Allow Overlapping Text** check box to allow labels to be drawn on top of each other. Some labels do not display because they overlap labels that are have been given higher priority on the map.

**Label Partial Objects** — Select the **Label Partial Objects** check box to label polylines and objects whose centroids are not visible in the Map window.

**Maximum Labels** — To specify the maximum number of labels you want to display on your map, type the number in the **Maximum Labels** box.
Chapter 12: Stylizing Your Map for Presentations and Publishing

**Styles** — In this box, select the styles for the Labels and Lines in the selected layer.

**No** — No line displays extending to the label.

**Simple** — Create a callout by using a simple line that connects the label to the object’s centroid. Label lines display after you move the label from where it was originally created.

**Arrow** — Create a callout by using an arrow and line that connects the label to the object’s centroid. Label lines display after you move the label from where it was originally created.

**Position** — Use the Anchor Point and Offset options to specify the label’s placement. The anchor point is the label’s position relative to the map object. Click one of the buttons to select an anchor point. The next table describes each of the nine anchor point buttons.

<table>
<thead>
<tr>
<th>Anchor Point Button</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Top Left</td>
<td>Places the label above and to the left of the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Top Center</td>
<td>Centers the label directly above the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Top Right</td>
<td>Places the label above and to the right of the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Left</td>
<td>Places the label directly to the left of the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>Centers the label at the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Right</td>
<td>Places the label directly to the right of the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Below Left</td>
<td>Places the label below and to the left of the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Below Center</td>
<td>Centers the label directly below the anchor point.</td>
</tr>
<tr>
<td></td>
<td>Below Right</td>
<td>Places the label below and to the right of the anchor point.</td>
</tr>
</tbody>
</table>

The anchor point is an ongoing attribute of the label. For example, if you anchor a point object’s label at Center Left and you increase the label’s font size, the text will grow to the left. This way, the text can never overwrite the point.

The default anchor point varies with the type of map object you are labeling:

- Regions default to **Center**.
- Lines default to **Above Center**.
- Points default to **Right**.

**Horizontal label**
Select this option to display all labels horizontally.
Labeling Your Map

**Rotate label with segment**
Select this option to run the label text parallel to the line segment. Using this option, a horizontal polyline would display parallel horizontal labels and a vertical polyline would display vertical street labels.

**Curve labels along segments**
Select this option to display the label along the curve of the polyline or arc segment.

**Label Offset**
Designate number of points (a measurement of text size) label should be placed from the anchor point.

If you are working with a layer that has line objects such as a street map, check the Rotate Label with Line or Curve labels along segments box to position the labels along the lines.

Label offset is how far away a label is from its anchor point. Specify the number of points you want the label to be from the anchor point in the Label Offset box.

The label’s anchor point and offset move a label with respect to its current location and the current zoom. Whenever you want to make minor adjustments to the label’s position, you should use these two options.

You can also select and drag a label to move it, but this is not recommended because you are actually moving the label location on the map. If you drag a label a few pixels, the distance you move it is in the current map units, regardless of the zoom. For example, if you are displaying a map of the United States and drag New York state’s label a few pixels, at that zoom, the label looks fine. However, if the Map Units distance is in miles and you zoom in on New York state, the label will display much farther away than at the previous zoom.

**Note:** **Affecting Label Priority:** Labels display following the order of records in the table. To change the order of priority for displaying labels, save a copy of the table, sorted in order of priority -- most important record first -- and use that table for labeling instead of the original.

In a table sorted alphabetically by street (like the StreetPro Display layer) this often means that streets with names beginning with A, B, or C are almost the only labeled streets on your map. Labeling effectively gives a small side street like “Aberdeen Street” priority over “State Highway 177” or other major roads that might actually be useful in navigating or orienting a viewer. This will be true for any dense StreetPro Display layer.

- See *Set Font Anti-Aliasing Options for Labels* for more information in the Help System.

**Creating Call Outs**
Callouts are labels with lines pointing to the objects they are labeling. They are very useful when there are many labels in a relatively small area. For example, if you are labeling a map of Europe, where there are many small countries that are relatively close together, you can use callouts to make the labels easier to read.

1. Choose Map > Layer Control to display the Layer Control dialog box.
2. Make the Cosmetic Layer editable. Choose OK.
3. Click the Text button in the Drawing toolbar.
4. Position the **Text** tool where you want the arrow or line to point and type the text you want as the call-out.

5. Double-click the text with the **Select** tool. The **Text Object Attribute** dialog box displays.

6. Choose **Simple Line** or **Arrow Line**.

   **Note**: Arrow Line has an arrow at one end of the line. A Simple Line does not.

7. Click **OK**.

8. Select the text object and position it where you please. A line is drawn from the new position of the text object to its original position.

   **Note**: You can double-click the text and set the label line in the **Text Object** dialog box.

### Label Styles

The **Text Style** dialog box gives you a number of choices for label and text object styles. You can also change the styles of multiple selected labels at a time.

To make style changes for all the labels, click the **Style** button in the **Label Options** dialog box to display the **Text Style** dialog box.

To change the styles of a selected label or labels, select the label(s) and either on the **Options** menu, click **Text Style**, or click the **Text Style** button in the Drawing toolbar to display the **Text Style** dialog box. If you change the styles of multiple labels at once, hold down the **Shift** key as you select each label.

Make the style changes you want. When you return to the map, the selected labels display with the style changes you specified. The available styles are explained in the next table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Uses bold text to create the label.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Uses italic text to create the label.</td>
</tr>
<tr>
<td><strong>Underline</strong></td>
<td>Places a line underneath the text.</td>
</tr>
<tr>
<td><strong>All Caps</strong></td>
<td>TEXT DISPLAYS IN ALL CAPITAL LETTERS.</td>
</tr>
<tr>
<td><strong>Shadow</strong></td>
<td>Creates a shadow behind the text. (not shown)</td>
</tr>
<tr>
<td><strong>Expanded</strong></td>
<td>A space is placed between each character in the label or text object.</td>
</tr>
</tbody>
</table>

There are also three background options.

- Click **None** to have no background.
- Choose **Halo** to create a halo effect around the text. This puts the text into relief from whatever it covers (for example, part of a region, or a street, etc.).
- Click **Box** to create a background box behind the text.
Labeling Your Map

When you choose either the Box or Halo backgrounds, the Color list is activated. Click it to display a palette of colors for the halo or the background. The color you choose corresponds to the button that is currently activated. The color displays in the box and in the Sample. Click OK to accept a color.

Labeling Interactively

Although you will probably do most of your labeling automatically, you will need interactive labeling to edit and create individual labels.

Editing Labels

It is very easy to edit individual labels, either those you have displayed automatically or those you have created interactively with the Label tool. Using the Select tool, double-click the label. The Label Style dialog box displays. The changes you make in Label Style dialog box apply only to the selected label. Changes you want to apply to all the labels must be done through Layer Control in the Label Options dialog box.

![Label Style dialog box](image)

The Label Style dialog box allows you to make changes to the text, position, and angle of the labels. You can also make changes to callouts, add, or delete them.

To change the label content, simply type the new label text into the Text box. The other controls in this dialog box work the same way as in the Label Options dialog box.

Moving a selected label is the same as moving other objects; simply drag them with the mouse. If you move a label that has a callout, the line will reappear automatically after you move the label.

You can also rotate the label manually about its anchor point. When you select the label, use the rotation edit handle that appears to the lower right of the label.

- For more information, see Moving Labels You Created Manually in the Help System.

Using Text Objects as Labels

While labels in MapInfo Professional are attributes of the map layer, text objects look like labels but behave like other annotations you draw on the map. They are stored in the Cosmetic layer, and you can save them to a table.
Chapter 12: Stylizing Your Map for Presentations and Publishing

The Labeler tool in the MapInfo Professional Tool Manager helps you use text objects to perform several common labeling tasks:

- Convert labels into text objects, so that they can be saved in a permanent table.
- Create labels for only the currently-selected objects.
- Draw text objects one at a time using the Text Label button. This allows you to create multiple annotations for a single map feature, which is something you cannot do using labels.

Creating Labels with the Labeler Tool

Use the Labeler tool to create individual labels. First, make sure that the layer containing the objects you want to label is selectable. Click the Labeler tool to activate it, and click a map object. MapInfo Professional labels the object with the column or expression you specified for that layer in the Map menu, point to Layer Control and click Label Options dialog box. Remember that InfoTips are active for the Labeler tool, so you can view the object’s label before you actually label the object.

- For more information about the Labeler tool, see the Tools section of the Help System.

Saving Labels

Whenever you manually edit automatic labels (including deleting using the Edit menu, and click Clear or press the Delete key), change the settings on automatic labels, or create labels with the Label tool, you will need to save your map to a workspace to have them display in your next session.

For example, label settings are deactivated by default. You check the Auto label attribute in Layer Control to display automatic labels on your map and do not save the change when you close the table. The next time you display your map, the labels do not display because the settings go back to the defaults. As with the other Layer Control options, label settings are temporary unless you save the table to a workspace.

Manually edited labels and labels created with the Label tool behave differently. These are edits to the table, not temporary settings. If you close a window or a table and you have label edits pending, MapInfo Professional will specifically prompt you to save the session to a workspace.

This also applies to labels you have deleted using the Edit menu, click Clear or press the Delete key. You may not have any labels visible on your map, but because deleting a label is an editing operation, MapInfo Professional will ask you if you want to save the edits to a workspace.

- For more information, see Removing Labels in the Help System.

Working with Layouts

Once you have created the perfect map, MapInfo Professional® gives you the tools you need to create high-quality presentations or output. Using the Layout window, you can create and customize a page layout that shows off your maps, browsers and graphs.
What is a Layout Window?

MapInfo Professional’s Layout window is a page layout feature that allows you to combine your Map, Browser and Graph windows on a page and arrange them for output. You can add any currently open window to the layout and move and resize it to find the best look to show off your work. Add text such as titles and labels to pull the entire presentation together.

While you can print individual Map, Browser, and Graph windows directly without the Layout window (on the File menu, click Print), you can only print a thematic legend by first adding it to a Layout window. You can also print the data contained in the Info tool, statistics and message windows from the Layout Window.

The Layout window is available as soon as you open MapInfo Professional. On the Window menu, click New Layout window to access it. When the Layout window is active, MapInfo Professional puts a Layout menu on the menu bar, allowing access to a number of layout features.

When you add your windows to the Layout window, MapInfo Professional places them inside layout frames. Using frames to hold your maps and browsers allows you to resize and reposition your windows with ease. The contents of the frame match the contents of the corresponding Map, Browser or Graph window.

The Layout window provides dynamic linking between it and a parent window. For instance, if you change the zoom in a Map window, that map will be updated in the Layout window once you make the Layout window active again.

The rest of this chapter is devoted to learning how best to create a layout, move around in the Layout window, and customize your layout using a variety of options.
Working in the Layout Window

The Layout window functionality includes a number of options to help make it easier to design and create your layouts.

Adding a Maximized Window to a Layout

You can put a maximized Map window into a frame in a Layout. The frame object's dimensions are created according to the Map window's size instead of the page layout size. MapInfo Professional also allows the map's image to completely fill the frame, preserving the map's center and zoom settings. If you double-click on the frame, you will notice that the Frame Object dialog box has a check box: Fill Frame with Contents. This allows the map image to fill the entire frame. The box is checked by default for all Map windows in frames.

Aligning Objects in the Layout Window

To align one or more objects in the Layout window:

1. Do one of the following:
   - Choose one object
   - Hold down the Shift key and click several objects
   - In the File menu, click Select All to select all of the objects in the Layout
2. Choose Layout > Align Objects. The Align Objects dialog box displays. Use the dialog box's drop-down lists to specify your vertical and horizontal settings.
3. Choose the desired horizontal and vertical settings.
4. Click OK. The selected objects align according to the settings you specified.

Note: Your alignment settings are saved from one use to the next within a session. Be sure to check both the vertical and horizontal settings before you click OK.

Getting Around in the Layout Window

The Layout window includes a rule along the top and left side of the window to assist you when resizing and positioning frames. To hide the rule, on the Layout menu, click Options. The Layout Display Options dialog box displays. Clear the Show Rules check box.

If you are creating a multi-page layout, MapInfo Professional displays the page breaks by default. If you wish to turn off the page breaks, clear the Show Page Breaks box in the Options dialog box.

Controlling Zoom Level

MapInfo Professional displays the Layout window at a zoom level that is a fraction of the actual size of the printed layout. The zoom level is represented as a percent of actual size in the lower left corner of the status bar.

In order to better position or resize layout objects, you may want to change the zoom level of the Layout window to see more detail. Keep in mind that you are changing the overall zoom of the Layout window, not the zoom of individual windows in frames. (If you want to change the zoom level on a frame containing a Map window, change the zoom for the Map window itself.)
There are four ways to change the zoom level of the Layout window:

- Use the Zoom-in and Zoom-out tools. These tools work exactly as they do in the Map window. You can click the Layout window with the tools or draw a marquee box around the areas of the Layout window.
- On the Layout menu, click Change Zoom to set the zoom. You can set the zoom anywhere between 6.3% and 800%.
- Use the number keys (1–8) on your keyboard to set the zoom level. As the numbers increase, the zoom increases geometrically. For example, press 1 to get a zoom of 6.3%, press 2 to get a zoom of 12.5%, and press 3 to get a zoom of 25%. (Remember to use the number keypad, and make sure Num Lock is on.)
- Use the View commands in the Layout menu: View Actual Size, View Entire Layout, Previous View.

Ordering Overlapping Objects

You may add enough windows to the Layout window to cause objects to overlap one another. In the Layout window all objects are ordered from front to back. Think of them as being stacked in the Layout. When you draw a new object, it is automatically the front most object, even if it is not overlapping any other objects in the layout.

In order to display your objects properly, you may need to bring an object forward in front of other objects.

You can use the Bring to Front and Send to Back commands to change the order of objects. Click an object with the Select tool. Choose the Bring to Front option to move the object into the foreground. Choose the Send to Back object to move the object into the background.

When you select an object using the Ctrl key along with the Select tool, MapInfo Professional selects the object one layer down. Selecting again chooses the next layer.

Before You Create a Layout

The first step in generating quality output is creating good Map windows. MapInfo Professional is set up to do a great deal of on-screen data entry, object editing, geocoding, and geographic analysis. There are many windows available to work with that can be easily arranged on the screen. When you prepare any MapInfo Professional window for output using a Layout window, you must change the way you think of using MapInfo Professional.

For example, in a MapInfo Professional session, if you want two views of a map, you may simply use the Grabber tool and shift to a different location, and then return via Map menu (click Previous View). To get two views of the same map for a Layout, you must have two separate Map windows. There are many techniques that can be used to prepare the windows to make output easier.
Creating Multiple Views of the Same Map

One very popular way to display maps is to have a detailed map with an inset of an overview map representing the general area. For example, government planners have a detailed flood plain map thematically shaded for an area around a major city. They want to include an inset map showing the location of that city in relation to the entire region. We can simulate this exercise with the WORLD.tab table included with MapInfo Professional.

**Note:** Some of the files described in this example may refer to MapInfo Professional Tutorial data, which is available on the MapInfo web site, www.mapinfo.com/miprotutorial.

To create multiple views of the same map:

1. Open the WORLD.tab and WORLDCAP.tab tables from the MapInfo/Data/World directory. The tables display in a Map window.
2. Choose the area you want to show in detail and zoom in on it. The Map window contains the detailed view.
3. As stated previously, there must be a separate Map window for each view you want to include in a layout. Instead of re-opening the tables to re-create the Map window, on the Map menu, click **Clone View** to create a duplicate Map window.
4. A new Map window displays. Zoom out on this map to create the overview map.
Working with Layouts

The new Map window is independent of the original Map window. You may add or remove layers without changing the original map.

Getting Labels Right for your Layout Window

There are many considerations in getting labels to look good on your maps. As with changing views of the map, there is a significant difference between using labels in a MapInfo Professional session and using them in a layout. Labeling in a MapInfo Professional session is best handled using the Auto Label check box in Layer Control.

When you create a map to place in a Layout window, you usually need to spend more time making your labels look aesthetically pleasing. It is also more likely that you will want to save these labels to a separate layer. With the default labeling, label styles can be changed; however, customized labels are not saved in their own layer for future use or editing. To create labels that can be easily saved, use Autolabel.mbx or Labeler.mbx. These MapBasic applications allow you to create labels that can be saved to a separate layer for future use.

- For instructions on using the AutoLabeler tool, see the Tools section of the Help System.

Creating a Layout Window

Creating a layout involves adding your Map, Legend, Graph, and Browser windows to the Layout window, positioning these items where you want them, and adding any annotations such as text and titles so that your final layout presents the message you want to send.

You bring your windows into the Layout window by adding them to placeholders, or frames. A frame is a graphic object through which you can view a window. Each frame may contain the contents of one Map, Graph, Browser, or Legend window.

First, decide what you want to put in the Layout window. You can choose whether you want to display all, some, or none of your open windows.
To create a Layout window:

1. Choose **Window > New Layout Window**.

   When no windows are open, MapInfo Professional creates a blank Layout. When there are windows open, MapInfo Professional displays the **New Layout Window** dialog box.

2. Choose one of the options.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Frame for Window</td>
<td>MapInfo Professional places a single open frame in the center of the layout. You select the contents of this frame through the drop-down menu that lists all open windows. If you choose a Map or Graph window from this list and there is an active map legend, MapInfo Professional automatically places the legend in the layout. You can reposition or delete this legend from the layout. Legends are positioned in the same way as Map, Browser, and Graph windows. Their relative locations are preserved on the screen.</td>
</tr>
<tr>
<td>Frames for all Currently open Windows</td>
<td>This option tells MapInfo Professional to place all open windows in the layout. Since MapInfo Professional places windows in the approximate location and size as they appear in the MapInfo Professional window, you should arrange and size the windows before you bring them into the layout.</td>
</tr>
<tr>
<td>No Frames</td>
<td>If you prefer, you can create a blank layout by choosing the No Frames option. If you do not have any windows open, choosing New Layout Window automatically creates a blank layout. The <strong>New Layout Window</strong> dialog box does not display.</td>
</tr>
</tbody>
</table>

Since a frame is a graphic object, you can:

- Reposition it using the Select tool.
- Change its fill, and the line style of its border.
- Copy or cut the frame and paste it into another Layout window.

You can also position frames so that they overlap one another or overlap other graphic objects. To change which window is displayed in a frame, double-click the frame with the Select tool. Use the drop-down list in the **Frame Object** dialog box to change the frame’s contents.

3. Click **OK**. MapInfo Professional opens and displays that Layout.

When MapInfo Professional first opens a Layout, it sets the page size and orientation (portrait or landscape) according to the current setting for your printer. The current setting for your printer is determined by the printer specifications designated in **Options > Preferences > Printer**. You can change the printer settings for the active Layout window through **File > Page Setup**, or by using the **Set Window Printer** command in the MapBasic window. When you later open that Layout when the printer setup is different, the Layout uses the page size and orientation for that printer setup. The sizes and positions of objects in the Layout are the same, but the way the Layout is broken into pages is different.
After you create a Layout, that Layout is the currently active window. MapInfo Professional places the Layout menu item on the menu bar. Use the Layout menu to choose options for working with Layouts.

Adding a Maximized Map Window to a Layout

You can place a maximized Map window into a frame in a Layout. The frame object’s dimensions are created according to the Map window’s size instead of the page layout size. MapInfo Professional also allows the map’s image to completely fill the frame, preserving the map’s center and zoom settings. If you double-click the frame, you will notice that the Fill Frame with Map check box in the Frame Object dialog box is checked. This allows the map image to fill the entire frame. The box is checked by default for all Map windows in frames.

Adding a Map to a Layout

After you have created a layout, you may decide that you want to add other maps to it. You do not have to create a new layout to do this. You can create frames by hand to contain other windows. Use the Frame tool to draw window frames where you want them. The Frame tool is available whenever the Layout window is active.

Note: If you draw a frame when no windows are open, MapInfo Professional places a blank frame in the Layout window.

To add a window to a layout you are already working with:

1. Click the Frame button in the Drawing toolbar and the cursor becomes a small cross.
2. Move the cursor to where you want to begin drawing.
3. Click and hold the mouse button and drag the cursor diagonally until the dashed box outlines the area where you want the frame.
4. Release the mouse button. When there are no windows open, an empty frame displays with "No Window" inside. When there are one or more open windows, the Frame Object dialog box displays.

This dialog box is slightly different for each type of frame. The Map Scale options are only available when you select a Map window in the frame.
Chapter 12: Stylizing Your Map for Presentations and Publishing

Note: The Fill Frame check box does not display for Browser, Cartographic Legend, and Graph windows.

The Frame Object dialog box allows you to change the width, height, and center of the frame and to set a specific scale for a map. When there are several windows open on the screen, MapInfo Professional displays its choice in the Window drop-down list. This list allows you to choose which window you would like in your frame.

5. In the Window drop-down list, select the window you want to add and review the options for creating this frame.

• Bounds X1 and 2, Bounds Y1 and Y2 — Use these fields to define the x and y boundaries for the new frame. When you change bounds entries, the Center, Width, and Height entries change accordingly. When you change the bounds entries, the Map Scale changes as well.

• Center X, Y — Use these fields to define and adjust the center point of your new frame.

Note: When you make a change to the Center X or Y entries, the Width and Height bounds do not change.

• Width, Height — Use these fields to define and adjust the width and height of the new frame.

• Change Map Zoom — Click this radio button to implement the correct map scale without changing the size of the frame. This option changes the zoom of the actual Map window so that the Layout frame is in the correct scale. This option is selected by default. Type the scale you want within this frame in the Scale. The units are set by the Paper Unit setting in the System Preferences dialog box.

Note: Changing the map scale with this option will not change the values in the Bounds fields or the Width and Height fields because there is no change to the size of the frame, only the look of the map within the frame. To undo the change to the map zoom, return to the Map window and click Previous View.

6. Select one of these options:

• Resize Frame — Click this radio button to change the size of the frame based on the data you enter into the Scale field. When you change this entry, the bounds, Center, Width, and Height entries change accordingly.

• Fill Frame with Contents — Click this check box to display as much of the Map window as fits in the frame. When you do not select this button, the frame may be only partially filled but it will have the same contents as the window it contains.

7. Click OK to choose MapInfo Professional’s choice and that window is placed into the frame.

8. Choose a window from the dialog box’s Window drop-down list.

9. Click OK and the window is placed in the frame.

Note: When you click the Change Map Zoom or Resize Frame radio button, you set your selection as the default for the rest of the session. If you change it during the session, the change becomes the default.

Once you have created a frame, you treat it much like any other graphic object. You can change its size and position, its line style and fill pattern, and you can cut, copy, and paste it.

• You can access instructions for making a frame transparent in the Help System.
Using Legends in a Layout

You can use both cartographic and theme legends in your layout. Both types of windows display in the layout at the same size as they do on the MapInfo Professional desktop.

When you resize a legend frame to make it smaller, it crops the legend rather than shrinking it to fit. The text styles (for example, font, size) used in the cartographic and theme legend windows are preserved in the layout.

Adding a legend to the Layout window is a different process, depending on the type of legend. You can add a theme legend to a layout even when no theme legend displays in the MapInfo Professional desktop.

To do this, make sure the Layout window is active and click the Frame button.

1. In the Layout window, click and drag to draw the frame for your theme legend. When you release the mouse, the Frame Object dialog box displays.

2. In the Window drop-down list, select the theme legend and click OK. The theme legend displays in the layout frame. This is also how you add other types of windows on your desktop to the current layout.

In cartographic legends, you must create the legend on your desktop (on the Map menu, click Create Legend) before you can add it to the Layout window.

Moving Frames in a Layout Window

Once you have brought in the windows you wish to include in the layout, you can reposition or resize them to create a professional looking product.

To move a frame:

1. Click the frame with the Select tool and hold down the mouse button.

2. When the cursor becomes a four-headed arrow (after about one second), drag the frame to the new location and release the mouse button.

Aligning Objects in a Layout Window

MapInfo Professional includes a command to help you perfectly align objects in the Layout window. You can align objects to each other horizontally and vertically or to the Layout window itself.

Choose the objects you want to align and on the Layout menu, click Align Objects. The Align Object dialog box displays.

Specify the appropriate vertical and horizontal alignment. Choose from the following options:

<table>
<thead>
<tr>
<th>Horizontal Alignment</th>
<th>Vertical Alignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Don’t change alignment</td>
<td>Don’t change alignment</td>
</tr>
<tr>
<td>Align left edges of</td>
<td>Align top edges of</td>
</tr>
</tbody>
</table>
Each alignment can be performed with respect to each object or to the entire layout. When you choose the entire layout, the objects are aligned with respect to the top, bottom, left, and right edges or margins of the layout.

If you want to align objects with respect to each other, the objects are aligned with respect to an imaginary rectangle, called the bounding rectangle, that completely encloses the objects. The horizontal and vertical settings you choose position the objects at the top, bottom, left, right, and horizontal or vertical center lines of the bounding rectangle, rather than at the edges of the layout.

The Distribute option tells MapInfo Professional to distribute the vertical and horizontal space between objects evenly. You can perform multiple alignments in one layout.

- For more examples, see Examples of Aligning Objects in a Layout Window in the Help System.

### Setting the Map Scale for a Layout Window

One of the most difficult tasks in generating good output is setting the scale of the map. There are two ways to set the map scale. The first method is to choose Map menu and click Change View. This scale setting affects the on-screen scale of your map according to your monitor size. This scale setting isn’t used as often, because generally the scale on screen does not need to be exact. Use the on-screen scale when you are making a presentation that will be viewed directly in MapInfo Professional.

**Note:** The Map Window Preference setting Use Cartographic Scale affects the entries in the Change View dialog box.

Accurate scale is more important on the printed map. To get the correct scale for output, you must coordinate the Map window with the Layout window. You must also decide on the desired end result. For example, you may want a map that has a 1:25000 scale and fits in a nine inch Layout frame. If this is the case, you will have to alter the zoom level of your map to fit these conditions. Or, in the case where you must show a set distance across the map, you may have to allow for a larger page size. The following two formulas will help you set the right map zoom, scale, and frame width.

#### Limiting Frame Size When Setting the Layout Scale

The following formula calculates the zoom that must be set in your Map window in order to have a map meet set scale and frame width criteria.

$$\frac{((\text{Frame Width in Inches } \times \text{ Scale})/12)}{5280} = \text{Map Zoom in Miles}$$
Creating a Cartographic Legend

For example, you need to make a map that will be in a scale of 1:24000 and fit in an eight inch frame. You need to determine the zoom level that will accommodate the map scale and frame width. Calculate the following:

\[
\frac{(8 \times 24000)}{12} \div 5280 = 3.03
\]

On the Map menu, click Change View and enter 3.03 miles as your new zoom level.

Limiting Map Zoom when Setting the Layout Scale

The following formula calculates the number of inches to make the frame for a map in order to meet set scale and zoom level criteria.

\[
\frac{\text{Map Zoom in Miles} \times 5280 \times 12}{\text{Scale}} = \text{Necessary Frame Width}
\]

For example, you need to make a map that will be in a scale of 1:100000, and you must view a twenty mile zoom level. You need to determine the frame size that will accommodate the scale and zoom. Calculate the following:

\[
\frac{20 \times 5280 \times 12}{100000} = 12.67
\]

Your frame needs to be 12.67 inches wide. If your printer is not large enough to handle this, change your layout size to spread over two pages.

• For more information, see Creating a Simple Scale Bar in the Help System.

Cloning a Map View

You can create a second view of your map with the Clone View command. Clone View creates a duplicate Map window that you can then alter to create a different view of your map, for example, a street map of a city and a zoomed in view of a major intersection, or use a different kind of thematic analysis for each view. It is particularly useful when you are creating a Layout and you want to present side-by-side views of the same location.

Note: Cloned windows in a workspace are written as MapBasic commands to the .WOR file. These command statements cannot exceed 32,000 bytes.

Now that you have completed your professional looking layout, printing is a simple matter.

Creating a Cartographic Legend

You can utilize the cartographic legend feature in a variety of ways. This feature enables you to create a legend for any map layer(s) in your Map window. Many of the elements in the cartographic legend and legend window can be customized, allowing you to enhance your map presentation. You have the added proficiency of being able to use the table metadata in your cartographic legend text as well as save legend attributes to the metadata. You are also able to align all of the legend frames in your Map window. Furthermore, the cartographic legend feature has the ability to join tables “on-the-fly”, thus allowing you to obtain legend feature descriptions from another table while you are creating the legend.
What is a Cartographic Legend?

Cartographic legends are based on the map layers in your Map window. Each legend in the legend window corresponds to a layer on the map, and each legend is enclosed in a legend frame within the legend window. The attributes for each legend frame, such as the title and label styles can be derived from several sources. These are:

- Map table metadata
- Map table attributes
- Joined tables
- Manual creation

A legend frame is another way to refer to a particular layer’s legend. You can create an individual legend window for each layer in your map, or you can have several legend frames in one legend window. The properties for each legend frame can be edited individually.

- For instructions, see Creating a Cartographic Legend or Changing a Cartographic Legend in the Help System.

Steps to Creating a Cartographic Legend

To create a legend, follow these steps:

1. Selecting Layers

   The layers listed in the Legend Frames group of the Create Legend – Step 1 of 3 dialog box are all the layers that will be included in your legend. All the layers in your Map window are included by default.

2. Defining Window Properties and Frame Defaults

   In Step 2 of the Create Legend wizard, you specify the settings for your Legend window and the default settings for the legend frames.

3. Legend Attributes

   The Create Legend wizard allows you to create attribute-driven legends. This makes creating text descriptions easier because they can be automatically generated from values in an attribute column. In addition, the process by which the legend is generated can be saved to the map table metadata in the underlying map layer, or from a joined table. The metadata is then used as the default attribute settings for the selected legend frame. These settings can be different for each frame. The metadata defaults override the Legend Frame defaults in Step 2 of the wizard. If no metadata keys exist in the table, the Legend Frame defaults from Step 2 are used as the default values.

- For more information and related topics, see Creating a Cartographic Legend and Saving Legend Attributes to Metadata in the Help System.
Printing and Exporting Your Results

This section covers the printing and exporting options in MapInfo Professional.

Printing Your Project

When you need to create presentation materials, you can print out the MapInfo Professional layouts you have created.

Page Setup

First check that your page setup is what you want. Any changes to the page setup will likely affect the layout, so it is a good idea to view the effect of the changes on your layout before printing. On the File menu, click Page Setup. Here, you can specify the page orientation (portrait or landscape) and margins. You can also specify the paper size and its source.

In addition, you can override your default printer setting and choose a different printer for this print job. Click the Printer button to display the Page Setup dialog box for your printer. The printer that initially displays is the default printer that you set in the Printer preferences (on the Options menu, point to Preferences and click Printer). This will either be the Windows default printer, or the MapInfo Professional preferred printer that you selected. Make any changes you want to the printer and its properties, and click OK. The settings available in the Printer Properties dialog box will vary according to the printer you are using.

Printing Options

Changes you make to these settings override the default settings from the Output Preferences.

When you are ready to print:

1. Make sure the Layout window is active. On the File menu, click Print. The Print dialog box displays.

2. Choose the number of copies you want to print and whether you want all pages or a specific range of pages to print. As in the Page Setup dialog box, the Print dialog box also allows you to override the default printer settings.

3. Click the Name drop-down list in the Print dialog box to select a printer. All of the printers available on your system display in the list. You can specify printer properties here as well, plus specify whether to print to a file.

4. To use the advanced print settings to take advantage of additional output options that help you control transparency and color, particularly for raster images, click the Advanced button. The Advanced Printing Options dialog box displays.
Chapter 12: Stylizing Your Map for Presentations and Publishing

5. Click OK to return to the Print dialog box.

5. Click OK to print.

More and more often, users want to export their maps electronically to files rather than print them.

Exporting a Layout

The easiest way to make electronic copies of maps and layouts from MapInfo Professional is to use the Save Window As command. You can export to Windows Bitmap, Windows Metafile, Windows Enhanced Metafile, JPEG File Interchange Format, JPEG 2000, Portable Network Graphics Format, Tagged Image file Format (TIFF), CMYK, and Photoshop 3.0. When using the Save Window As command, keep in mind that all additions and edits must be made in the Map window. When you have the Map window the way you want it, then create the Layout window. You can use the advanced export options to produce better quality output. The same transparency and raster options are available when you print your Layout as when you export the Layout. Click the Advanced button in the Save Window As dialog box to display the Advanced Exporting Options dialog box. The same check box settings are available.
Changes you make to the Advanced Export settings override the default settings in the Output preferences. See Setting your Output Setting Preferences in Chapter 3 on page 130 for more.

**Save Window As Supports Raster Formats**

You can save your map images as GIF, TIFF LZW, and TIFF CCITT Group 4 images.

To save your data as a raster format:

1. Open a Map, Layout, Browser or Graph window you want to save in the new format.
2. From the File menu, click Save Window As to display the Save Window to File dialog box.
3. Select the type you want to save it in from the Save as type drop-down list.
   - GIF
   - TIFF LZW
   - TIFF CCITT Group 4
4. Type the name of the file in the Filename field and click Save to save your entries.

**Creating an Encapsulated Postscript File**

If the available Save Window As formats are not appropriate for your needs, or you want to use the options in the Layout window, you may want to send your output to an encapsulated postscript (EPS) file. This file type is widely used by service bureaus and print shops. There is not a set export or save command for EPS files. You must set up a postscript printer driver and print the map or layout to a file.

1. From the Windows Control Panel, select Printers.
3. Follow the wizard for the setup. Choose a postscript printer from the printer list, and select FILE as the available port. Enable the option to specify EPS.
4. Once the postscript driver is installed on your system, use that printer to print the map or layout to a file from MapInfo Professional.
5. From the File menu, select Print. The Print dialog box displays.
6. Under printer name, select the postscript printer. Click OK.
7. The Print to File dialog box displays. Give your file a name and choose Save.
Chapter 12: Stylizing Your Map for Presentations and Publishing

Smoothing the Edges of Images During Export

To give you more control over map images when exporting MapInfo Professional maps, you can use anti-aliasing methods. This is particularly important when you are saving maps created in MapInfo Professional for use in other Windows-based applications, in particular in slide presentations or for web pages.

We have added the ability to smooth or anti-alias images during the export process. You can use this capability with all types of windows such as Map windows, layouts, legends, and graphs.

Note: You cannot anti-alias images you are exporting to .EMF or .WMF format, because these are not true raster formats.

There are three smoothing options you can use to customize your raster image:

1. **Smooth using a Filter value.** You can set a flag that selects one of six filters that allow you to choose the direction the filter is applied to the image from.

2. **Smooth using a Mask value.** You can select a value that indicates the size of the area you want to smooth. For example, to create a 3x3 pixel mask value, you would enter a 3 in this field. This would limit the amount of change in the color of the pixels. Typically mask sizes would be 2-3 pixels when exporting at screen resolution. If you are exporting at a higher resolution, a larger mask might be appropriate.

3. **Smooth using a Threshold value.** You can select a threshold value to indicate which pixels to smooth. Each pixel in an image has a value based on its color. The smaller the pixel value, the darker the color. Select this option to smooth all of the pixels above the threshold you enter in this field. When you set this value to 0, MapInfo Professional will smooth all of the pixels.

You must either set a global preference for these anti-aliasing options or set them locally during the export process (using the Advanced button).

To set the anti-aliasing preference for exporting images:

1. From the Options menu, select Preferences and Output Settings to display the newly configured Output Preferences dialog box.

2. Click the Exporting tab to display the anti-aliasing options.

3. To use anti-aliasing automatically, select the Use Anti-aliasing check box and select from these options:

   **Smooth using a Filter value**
   Choose a filter for the smoothing you want to use. Select from these filters:
   - Vertically and Horizontally (Smoothes the image vertically and horizontally)
   - All Directions (1) (Smoothes the image in all directions)
   - All Directions (2) (Smoothes the image in all directions using a different algorithm)
   - Diagonally (Smoothes the image diagonally)
   - Horizontally (Smoothes the image horizontally)
   - Vertically (Smoothes the image vertically)
**Smooth using a Mask value**
Choose the pixel size of the mask you want MapInfo Professional to use in this field. For example, to create a 3x3 pixel mask value, you would enter a 3 in this field. This would limit the amount of change in the color of the pixels to the three pixels around the basic pixel.

**Smooth using a Threshold value**
Select a threshold value to indicate which pixels to smooth. Colors are 0 for black and 255 for white (in an 8 bit image). Entering a low number changes the look of your map by smoothing the darker colors and the lighter colors. Choosing a higher number changes the way the lighter colors display.

To set the anti-aliasing options locally during export:

1. When you have completed your work on a window, select the File > Save Window As menu option. The Save Window to File dialog box displays.

2. Type the name and indicate the path of the file you are saving in this dialog box. Click Save to continue. The Save Window As dialog box displays.

3. Select the Use Anti-aliasing check box and do one of the following:
   - Click Save to use the anti-aliasing options you selected in the Output Preferences dialog box
   - Click Advanced and choose new anti-aliasing options for this particular map. Click OK to return to the Save Window As dialog box. Click Save to save these settings and the file.

**Note:** If you do not select the Use Anti-aliasing check box, the anti-aliasing options in the Advanced Exporting Options dialog box are disabled.
Registering Raster Images

Raster images can provide context to your maps by giving them detail and definition. This chapter reviews the details of registering and working with raster image files.

In this Chapter:

• Working with Raster Images .................. 430
• Opening a Raster Image ...................... 433
• Printing/Exporting Translucent Raster Images ........... 438
Working with Raster Images

There are a number of ways you can obtain raster image files. If you have a scanner and scanner software, you can use the scanner to create raster image files. MapInfo Professional can read and display the raster image files created with the scanner software.

Some graphics software packages let you save or export images into raster file formats, such as TIFF (Tagged Image File Format). So if you can create a TIFF file with your draw or paint package, you can display it in MapInfo Professional.

You can also purchase raster images from MapInfo Professional or other commercial vendors. Some data vendors also offer scanning services.

Determining Map Coordinates

When registering your raster image, you need to know the map coordinates that correspond to your image. If your raster map image shows a graticule (a grid of longitude/latitude lines), you can determine map coordinates by noting the longitude/latitude labels along the graticule.

If your map does not show a graticule, you may be able to determine map coordinates by locating prominent map features, for example, the Northwest corner of a region, and then using another MapInfo Professional table as a reference to determine the coordinates of those prominent features. For a discussion of this process, see Choosing Control Points from an Existing Map in the Help System.

An Introduction to Raster Image Registration

What Is a Raster Image?

A raster image is a type of computerized image that consists of row after row of tiny dots (pixels). If you have a scanner and scanner software, you can create a raster image by scanning a paper map. After you scan a map image and store the image in a file, you can display the file using MapInfo Professional.

There are many different raster image file formats. MapInfo Professional can read the following types of raster image files: JPEG, GIF, TIFF, PCX, BMP, TGA (Targa), and BIL (SPOT satellite).

What Does It Mean To Register a Raster Image?

When you register a raster map image, you enter map coordinates (e.g. longitude/latitude degrees), and you indicate which locations on the raster image correspond to those coordinates. You must register each raster image before displaying the image in MapInfo Professional, so that MapInfo Professional can perform geographic calculations, such as distance and area calculations, when displaying the raster map.

The first time you open a raster image file within MapInfo Professional, MapInfo Professional displays the Register Raster Image dialog box. By completing this dialog box, you tell MapInfo Professional how to register the raster image and determine the coordinate system for the image.
MapInfo Professional stores the raster image's registration information in a table file for future re-use. The next time you run MapInfo Professional, you can re-open the raster table without repeating the registration process. Thus, you only need to register each raster image once.

Raster image files provided by MapInfo Professional are already registered. You do not need to perform the registration process when you display the sample raster data included with MapInfo Professional.

**Understanding Raster Images in MapInfo Professional**

Using raster image files, you can bring paper maps, photographs, and other graphic images into MapInfo Professional. For example, if you work with paper maps, you probably want to use those paper maps as the foundation for the maps you create in MapInfo Professional. Once you scan your paper map into a raster image file, you then can display it in a Map window.

**Using Raster Images As a Backdrop for MapInfo Professional Maps**

Using a raster image as the base layer of your map gives you a detailed backdrop for your other map layers. You can easily change the size, scale, or center point of the displayed image. For example, if you want to enlarge part of the image, use the Zoom-in tool. Keep in mind, however, that as you increase the image's size, the display will become grainier if you exceed a 1-1 pixel ratio. Each pixel in the image becomes more distinct, causing the image to look more like a series of blocks instead of the intended picture.

**Using Raster Images As a Stand-Alone Image**

You may have a satellite image of topography that would be impossible to duplicate as a vector image that you want to use for a presentation. You can display the image in MapInfo Professional and then incorporate it into a page layout.

**Map Editing with Raster Images**

Once you have superimposed map layers on top of your raster image, you can use the raster image as a reference while you edit your map layers. The process of editing based on a screen image is known as heads-up digitizing. (To minimize image distortion, only digitize from map images with known projections or rectified aerial photographs.)

**Placing a Logo on a Page Layout with Raster Images**

Most raster images displayed in MapInfo Professional are images of paper maps or aerial photographs, but almost any image can be scanned and made into a raster image. For example, with an image like your company logo, you can open and display the raster file in MapInfo Professional without registering it because control point coordinates are irrelevant. You can then place it in a frame in a Layout window and incorporate the logo into your page layout.
Raster Image Format Details

There are many different raster image file formats. MapInfo Professional can read the following types of raster files:

- `filename.ADF`
- `filename.FLT`
- `filename.TXT`
- `filename.ASC`
- `filename.GIF` (Graphics Interchange Format)
- `filename.JPG` (JPEG format)
- `filename.JP2` (JPEG 2000 format)
- `filename.TIF` (Tagged Image File Format)
- `filename.PCX` (ZSoft Paintbrush)
- `filename.BMP` (Windows bitmap)
- `filename.TGA` (Targa)
- `filename.BIL` (SPOT satellite images)
- `filename.SID` (MrSID format)
- `filename.WMF` (Windows Metafile format)
- `filename.EMF` (Enhanced Metafile) format
- `filename.PNG` (Portable Network Graphics format)
- `filename.PSD` (Photoshop 3.0)
- `filename.ECW` (ECW 2.0 format handler)
- `filename.GEN` (ADRG format)
- `filename.GEN` (ASRP 1.2 format)
- `filename.*` (CADRG format)
- `filename.*` (CIB format)
- `filename.NTF` (NITF format)

MapInfo Professional also supports AirPhotoUSA raster images taken at different elevations for particular areas in the United States. The AirPhotoUSA map handler allows MapInfo users to open and display the imagery contained in AirPhotoUSA Map files as a layer. MapInfo Professional treats these images like any other raster file. The MAPINFOW.PRJ file has been updated to accommodate the AirPhotoUSA changes.

**Note:** The maximum supported image size is 16,000 by 16,000 pixels, regardless of the format.

ARC Grid Format Support

MapInfo Professional uses the Arc Grid Handler to use and display of ESRI grid files. You will see the file extension options in the Open Table dialog box when you choose the Files of Type option Grid Image. This allows you to open both ASCII and Binary Continuous and Classified grid formats but you can only hillshade the Continuous grid files. These types of data files are available from the USGS Seamless Data Distribution System.

**Note:** The Arc Grid Handler does not support the Arc Grid Export format (*.e00 extension) in MapInfo Professional.

- For more information, see Color Options for Raster Images in the Help System.
Chapter 13: Registering Raster Images

Opening a Raster Image

When you open a raster file you need to register it to identify coordinate point references for the image. Using a vector map as a reference, you identify the coordinates of the vector map and match them with equivalent points on the raster image. This coordinate information allows MapInfo Professional to determine the position, scale and rotation of the image so that you can overlay vector data on top of the image. The coordinate information is stored in a TAB file created during the registration process. The TAB file enables you to re-open the raster file in MapInfo Professional format.

You usually register the image the first time you open it. However, you do not need to register the image if you do not plan to use vector data with it, or if it already contains georegistration information.

Raster images usually fall into one of three categories:

- A fully registered image, containing control points and a projection (for example, GeoTIFF file).
- A partially registered image containing control points, but missing a projection (for example, an image with an associated World file).
- An unregistered image missing control points and a projection.

Once the image is registered, opening it again requires a slightly different procedure. Opening both unregistered and registered images is explained in the next section.

For more information, see these related topics in the Help System.

- Opening a Registered Raster Image
- Opening an Unregistered Raster Image
- Opening a Georeferenced Raster Image

Registering the Coordinates of a Raster Image

Before you can overlay vector data on top of a raster image, you must first register the raster image so that MapInfo Professional can position it properly in a Map window. In the Image Registration dialog box, you can identify control point coordinates and specify the appropriate projection for the raster image.

Control points are the coordinates you identify on the raster image that MapInfo Professional can use later to match up to other layers. It is very important to provide accurate control point information when registering a raster image, so MapInfo Professional can display raster images without distorting or rotating them. Later, when you overlay vector data, MapInfo Professional distorts and rotates the vector data so both layers can line up properly. Identifying significant control points makes this match up process easier. We suggest you use highway/street intersections and prominent landmarks as control points, as they rarely move.

Specifying the correct projection of the raster image is also important for accurate display. Images that do not have known projections, such as unrectified aerial photographs, are less suitable for use with vector data.
There are two ways to register a raster image in MapInfo Professional. Each involves specifying the map coordinates of control points on a reference map and matching them with equivalent points on the raster image. To determine map coordinates, you can:

- Identify a point’s coordinates from the paper map.
- Determine a raster image’s control point coordinates on screen and automatically transfer the information to the Image Registration dialog box.

**Note:** If you scanned in the image from a paper map, the map most likely contains a graticule (latitude and longitude grid). You can choose those coordinates for prominent features and enter them in the Image Registration dialog box.

- For specific instructions, see Registering the Coordinates of a Raster Image and Choosing Control Points from an Existing Map in the Help System.

**Reprojecting a Raster Map**

From time to time, you will need to use a raster map registered in one projection in another map in a different projection. You can reproject the raster image, that is, change the coordinate system and the way the raster image displays to accommodate the new vector map. Typically, the open map dictates the projection of the successively displayed images. You can also reproject the raster using the projection of a vector table.

**Reprojecting a Raster based on a Vector Map**

If you are working with registered raster data such as satellite and aerial photo images, scanned maps, grids, seamless tables and WMS data, you might want to reproject that raster data to accommodate a vector map.

MapInfo Professional performs the raster reprojection when you open a registered raster image inside of an existing Map window with a different projection or when you change the projection of a Map window. During the raster reprojection process, MapInfo Professional recalculates the pixel values of the source image to make them display correctly in the destination image. In this resampling process, MapInfo Professional tries to restore every pixel value of the image based on the pixels around it. In MapInfo Professional there are two methods for calculating the pixel values of the destination image: Cubic Convolution and Nearest Neighbor. These are industry-standard terms used by GIS professionals all over the world. These methods are described later in this section.

Due to this feature, these are the precedence rules for Map window projection.

Both vector and raster layers have “equal rights”, that is, every new layer (without regard for type) is reprojected into the current Map window’s projection. That is, which ever map is opened first takes precedence for projection.

**Note:** You can change the projection of a Map window containing a mix of raster and vector layers by setting the image processing reprojection preference to Always or Optimized.

When you are working with palette raster images (like a scanned map), an image might contain all 256 colors. If you display this image in the Adjust Image Styles dialog box and clear the Transparent check box, the color “white” becomes transparent. If you do not want this display behavior, select the Transparent check box and choose another transparent color (using Select Color).
Transferring Vector Map Coordinates Directly to a Raster Map

To transfer the coordinates automatically from a vector map to a raster image, you need a vector map of the same image. Then, you display the vector map side by side with the Image Registration dialog box, which shows a preview of the raster image. Click a prominent feature in the vector map to determine its coordinates and transfer this control point to the Image Registration dialog box.

To transfer a vector map’s coordinates to a raster image:

1. On the File menu, click Open and Raster Image file format.
2. Choose the raster image file and click Open. The Display/Register dialog box displays.
3. Click Register. The Image Registration dialog box displays. A preview of the raster image appears in the lower half of the dialog box.
4. Choose the Projection button to specify the image’s projection. If you do not set the projection, MapInfo Professional defaults to Longitude/Latitude or to the default table projection set in the Map Window Preferences.
5. To add control points, click the Add button to add a control point entry to the Control Points list.
6. Click the Pick from Map button and select a location in the Map window that matches a location in your raster image. MapInfo Professional updates the Map X and Map Y fields in the Edit Control dialog box with the new coordinates. Click OK to save this entry and close the dialog box.
   
   Note: When the Pick from Map button is disabled, you can select locations directly from the open map. If a map is not open, you can select another tool (like the Select tool) and use that tool instead of the Pick from Map functionality.
7. Highlight the entry in the Control Points list and click the matching control point location in the image pane. The Edit Control Point dialog box displays showing the control point’s location in pixels in the Image X and Image Y fields. Click OK to save these entries.
   
   Note: Remember to type a meaningful description of this location in the Label field.
8. Repeat this process until you have identified three or four non-linear points in the preview pane of the Image Registration dialog box.
9. After you have defined all of the control points, click OK in the Image Registration dialog box. The raster image displays in the Map window under the vector layer.
   
   Use the Layer Control feature to position the raster map appropriately with your vector layers.

   • For details on converting degree/minutes/seconds coordinates to decimal degrees, see the Help System.

Modifying Control Points for Raster Images

If you must adjust the coordinates of a control point because the error is unacceptable, highlight the point in the Image Registration dialog box and choose another location for it in the Map window. To delete control points, click the point and choose the Delete button.
**Opening a Raster Image**

### Raster Image Display Options

You can display more than one raster image in a window at a time. This is limited only by your computer’s memory. However, if you want to digitize from the raster image, it is best to use only one image in a Map window. This is because two raster images will probably have slightly different rotations.

When using two raster images with different projections, keep in mind that MapInfo Professional will use the projection of the image that is opened first. This means that the second image is only positioned approximately.

**Color (Raster Image)**

Once you have displayed a raster image file in a Map window, you can make adjustments to the colors in the image. On the **Table** menu, point to **Raster** and click **Adjust Image Styles** to change the settings for that .tab file. On the **Map** menu, point to **Layer Control** and click **Display** and select **Style Override** to adjust the raster style only in this Map window. The **Adjust Image Styles** dialog box lets you set the contrast and brightness of the image, set translucency, display color raster images in shades of gray, and make one color in the image transparent.

Using the **Adjust Image Styles** dialog box does not modify the raster image file; instead, it changes the way MapInfo Professional displays the raster image file. If you change an image’s display style, MapInfo Professional records the new display style in the table file (for example PARCELS.tab) or in the workspace for per layer styles, but MapInfo Professional does not alter the contents of the raster image file (PARCELS.GIF) in any way.

If you change an image’s display style and choose **OK**, the new display style is applied immediately. It will also affect all Map windows in which the image is displayed if you select the **Table** menu, and point to **Raster** and click **Adjust Image Styles**. You do not need to choose **Save** to save the changes.
Style Override for Raster Images

MapInfo Professional provides the ability to change the display style for raster and grid images on a per-layer basis through the Layer Control dialog box. The Style Override option for raster images works the same way as it does for other map layers. Just choose the Map menu, and click Layer Control, and select a raster layer in the Layer list. Click the Display button. The Display Options dialog box for the image displays. Select the Style Override check box and click the Style button. The Adjust Image Styles dialog box displays. You can change any of the raster image style settings.

Zoom Layering for Raster Images

Zoom layering for raster images controlled from preferences (in the Options menu, point to Preferences and click Map Windows and select Automatic Raster Zoom Layering). To change the zoom layering setting for a raster layer that you are currently working with, go to the Display Options dialog box (in the Map menu, and point to Layer Control and click Display) and to either activate or turn off zoom layering. The setting is turned on by default.

Limitations in Using Raster Images

Many of MapInfo Professional’s features cannot be applied to raster image tables. As a general rule, you cannot use MapInfo Professional to modify a raster image file. Specific limitations of raster tables include:

• *No Data Saved with Raster Images* A raster table does not have columns, therefore, you cannot attach text or numeric data directly to a raster table, and you cannot perform queries, such as Find, on a raster table. You can, however, overlay a conventional (vector-based) MapInfo Professional table on top of the raster image, and attach data to the conventional table.

• *Map Projections and Reprojections with Raster Images:* When a raster image file displays in a Map window, the file that is opened first determines the projection of the map. If two raster images in a Map window use different map projections, MapInfo Professional will use the projection of the map that is opened first. The Map window will redraw slowly when you overlay other map layers on top of a raster image. The map redraws slowly because MapInfo Professional is re-calculating map coordinates so that the vector map objects conform to the projection of the raster image.

Adjusting the Contrast or Brightness of a Raster Image

The Adjust Image Styles dialog box lets you control how a raster image appears but does not modify the raster image file; instead, it changes the way MapInfo Professional *displays* the raster image file.

Every raster image table consists of two files: a raster image file (e.g. photo.gif), and a table file (e.g. photo.tab). When you change the image display styles, MapInfo Professional stores the new style settings by modifying the table file. MapInfo Professional does not modify the raster image file in any way.

If you change the display options and choose OK, MapInfo Professional stores the new display styles immediately; you do not need to choose File > Save.

• For instructions, see Adjusting the Contrast or Brightness of a Raster Image in the Help System.
Adjusting the Translucency of a Raster Image

You can adjust the percentage that layers show through raster images. A translucent image allows you to partially see through the image. Translucent images can be layered on top of other layers so that the lower layers are partially visible through the image.

- For specific instructions, see Adjusting the Translucency of a Raster Image in the Help System.

Printing/Exporting Translucent Raster Images

When printing or exporting a translucent raster image, take advantage of Advanced options.

To print a translucent raster image:

1. Do one of the following:
   - On the File menu, click Print
   - On the File menu, click Save Window As

2. Click Advanced and choose from the following settings according to your printing and exporting requirements.
   - Print/Export Border — Select to include the black rectangle border when exporting.
   - Internal Handling for Transparent Vector Fills and Symbols — Select to allow MapInfo Professional to perform special handling when exporting transparent fill patterns or transparent bitmap symbols. If unchecked, the process is handled by Windows.
   - Use ROP Method to Display Transparent Raster — Use this option to print the raster image as a metafile (EMF or WMF). Using the ROP method allows any underlying data to be rendered in the original form. Select this check box to allow the internal ROP (Raster Overlay by Pixel) to manage the transparent pixels for the raster.

   Since the ROP Method is largely a display method, not all printers and plotters can use it. We recommend that you experiment with this setting until you get the results you want when printing raster images. This check box is cleared by default.
   - Print/Export Raster in True Color When Possible — Select this check box to print your 24-bit raster images in true color. Make sure your printer settings are greater than 256 colors. This check box is selected by default.

3. When you have completed these selections and returned to the Print dialog box, click OK to begin printing.
Maps at their base are a visual representation in two dimensions of a section of the three-dimensional Earth. Being able to use maps in an electronic format in many ways frees us from the constrictions of the two-dimensional map because we can use mathematical formulas to compensate for the curvature of the Earth. In this chapter, we cover the coordinate systems and projections that are standard in MapInfo Professional and provide the tools with which you can create a custom projections to meet your organization’s needs. Whether you are a local government trying to establish new tax rolls or a large company trying to define your sales territory more precisely, creating a custom projection may be a solution you want to explore.

Sections in this Chapter:

- Working with Coordinate Systems ......................... 440
- Building Blocks of a Coordinate System .................. 445
- Adding Projections to the MAPINFOW.PRJ File ........ 453
- Understanding Precision in MapInfo Professional ........ 456
- Understanding Affine Transformations .................... 456
- Using Earth and Non-Earth Maps .......................... 459
- For more information, see Using Ocean and Grid Tables and Frequently Asked Projection File Questions in the Help System.
Working with Coordinate Systems

The terms “projection” and “coordinate system” are often used interchangeably, however they do not mean the same thing.

**Projection** - An equation or set of equations that contain mathematical parameters for a map. The exact number and nature of the parameters depends upon the type of projection. You can think of a projection as a method of reducing a map’s distortion caused by the curvature of the Earth, or more precisely, a projection compensates for the shortcomings of depicting maps in two dimensions when the coordinates exist in three dimensions.

**Coordinate System** - When parameters of a projection are assigned specific values, they become a coordinate system. A coordinate system is a collection of parameters that describe coordinates, one of which is a projection.

Displaying Coordinates

There are two places where coordinates display:

- In the **Status Bar** by cursor location (set in the **Map Options** dialog box or by clicking on the **Status Bar**).
- In dialog boxes that display area measurements, such as a **Point Object**, **Region Object** etc.

**Note:** Coordinates can only be entered in the **Object Info** dialog boxes when a layer is editable.

You can display coordinates in one of the following formats:

- Decimal degrees (e.g., 75.123456 degrees);
- Degrees, minutes, seconds (e.g., 75 degrees 12’ 48")
- Military Grid Reference (WGS 1984 datum e.g., 41VLG3270555205 for 60 degrees longitude and 60 degrees latitude).

The default is Decimal degrees.

Elements of a Coordinate System

A coordinate system in MapInfo Professional is made up of many elements which need to be specified in advance. Once these elements are in place, you can be sure that your maps are as accurate as possible. These are the projection elements you need to set in the MAPINFOW.PRJ file:

- **Projection Types**
- **Datums**
- **Units**
- **Coordinate System Origin**
- **Standard Parallels (Conic Projections)**
- **Oblique Azimuth (Hotine Oblique Mercator)**
- **Scale Factor (Transverse Mercator)**
Chapter 14: Working with Coordinate Systems and Projections

- False Easting and False Northing
- Range (Azimuthal Projections)

Note: For datum and unit tables, see Projection Datums on page 527 and Units on page 535.

Understanding Coordinate Systems

You can make a map out of any globe without distorting the points on the surface by placing the globe into an imaginary cylinder.

Figure: Globe with Longitude/Latitude Projection

If you transfer the touch points from the globe surface onto the cylinder and roll out the cylinder onto graph paper, the result is a map as in the figure below. In the map that would be created from this cylinder, the Equator is 0 degrees all the way around the globe and the points on that line are completely accurate.

Figure: Longitude/Latitude Projection Map
When you add longitude and latitude lines at 15 degree increments to each side of the Equator and the Prime Meridian you create a reference grid. The lines furthest from the Prime Meridian are +180 degrees toward the right and -180 degrees to the left. This map projection is commonly called the Longitude/Latitude projection.

This is often considered the default projection. It is the most effective map for areas nearest the Equator but measurements further away tend to increase in distortion.

Because many people do not live near the Equator, other projections came into use to create more accurate local maps. Accuracy depends upon how you project the globe onto the cylinder. If you turn the cylinder so that it touches the Prime Meridian instead (or any line of longitude, 90 degrees away from the Equator) you have a Transverse Projection. The closer you are to the place the cylinder touches the globe, the more accurate the measurements are.

**Figure: Globe Demonstrating the Transverse Projection**

Transverse projections allow us to make maps that are more North-South line accurate, as long as you compensate for the distance from the new “Equator” which in this case is the Prime Meridian.

**Figure: Transverse Mercator Projection Map**
A third type of projection attempts to resolve the distortion problem in another way. Conic projections use a cone shape instead of a cylinder to create the “touch points”.

**Figure: Globe with Conic Projection**

This type of projection is much more accurate for large regions or countries that wider in the East-West direction than in the North-South direction. There is much less distortion regionally because the touch points of a cone are closer to the map surface than those of a cylinder.

**Figure: Brazilian Polyconic Projection Map**

As you can see from the previous figure, the conic maps are best for small regional areas. The larger-scale map has too much distortion to be useful.
A fourth type of projection, the Azimuthal projection, does not use cones or cylinders but a simple circle that goes all the way around the globe over a particular point. This projection provides a “view from space” over a particular point.

**Figure: Globe with Azimuthal Projection**

This type of projection is most useful when you need to work with a particular hemisphere. A hemisphere need not be North-South or East-West based. The next figure uses the North Pole as the center point for the Azimuthal Projection.

**Figure: Lambert Azimuthal Projection Map**

You can use more than one projection that rotates a cylinder slightly along the Equator. This style is used in the Universal Transverse Mercator (UTM) projection. UTM maps the Earth with a transverse cylinder projection to create standard "UTM Zones”. By rotating the cylinder around the globe in six
degree increments, the UTM assures that all spots on the Earth are within 3 degrees of the center line. (The Gauss-Kruger system is a European system akin to UTM that also uses a transverse cylinder rotated in six degree steps).

**Figure: Universal Transverse Mercator Projection Map (UTM Zone 29)**

Almost all projections you will use are one of these types. They are either cylindrical (regular or transverse), conic, or azimuthal projections and are customized by slightly different projection parameters. Projection parameters are options that describe how the projection is arranged.

You can further customize projections by specifying different parameters for the projection you want to use. For example, you can specify the longitude and latitude of any point on the Earth to create your own Azimuthal projection of that point. You can customize conic projections by specifying the parallel of latitude at which the cone should be tangent.

**Building Blocks of a Coordinate System**

In this section, we provide the tables required to create your own coordinate systems using map projections, datums, units, Origins, Standard Parallels, Azimuths, Scale Factors, False Eastings, False Northings, and Ranges. You might want to create your own coordinate system if accuracy is crucial to understanding your data or if your data is specified in relation to a non-standard point, and you would prefer to keep your data in that custom coordinate system.

**Coordinate Systems, Projections, and their Parameters**

By specifying a projection type and various required parameters, you create a mathematical algorithm for producing equivalent coordinates in degrees for the projected coordinate system. Each projection has specific parameters you can customize to make your maps more geographically accurate. The following table details each major coordinate system type and the parameters you can use to customize that system. The parameters are listed in the order they appear in the relevant projection entries in the MAPINFOW.PRJ file. To create your own coordinate system using a particular projection, you must add an entry into the MAPINFOW.PRJ file.
The parameters of a coordinate system are (in this order):

- Coordinate System Name
- Projection Type
- Datum
- Units
- Original Longitude
- Original Latitude
- Standard Parallel 1
- Standard Parallel 2
- Azimuth
- Scale Factor
- False Easting
- False Northing
- Range

*Note:* Each of these headings is described in detail in the next few pages.

For a complete list of common coordinate systems and their necessary parameters, see *Projections and Their Parameters in Chapter C on page 524*

### Projection Types

The following list names the projection types used in the MAPINFO.W.PRJ file. These projection types indicate the type of map you are using as the basis for your projection.

<table>
<thead>
<tr>
<th>Number</th>
<th>Projection</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Albers Equal-Area Conic</td>
</tr>
<tr>
<td>28</td>
<td>Azimuthal Equidistant (all origin latitudes)</td>
</tr>
<tr>
<td>5</td>
<td>Azimuthal Equidistant (polar aspect only)</td>
</tr>
<tr>
<td>30</td>
<td>Cassini-Soldner</td>
</tr>
<tr>
<td>2</td>
<td>Cylindrical Equal-Area</td>
</tr>
<tr>
<td>14</td>
<td>Eckert IV</td>
</tr>
<tr>
<td>15</td>
<td>Eckert VI</td>
</tr>
<tr>
<td>6</td>
<td>Equidistant Conic, also known as Simple Conic</td>
</tr>
<tr>
<td>17</td>
<td>Gall</td>
</tr>
<tr>
<td>7</td>
<td>Hotine Oblique Mercator</td>
</tr>
<tr>
<td>4</td>
<td>Lambert Azimuthal Equal-Area (polar aspect only)</td>
</tr>
<tr>
<td>29</td>
<td>Lambert Azimuthal Equal-Area</td>
</tr>
</tbody>
</table>
Chapter 14: Working with Coordinate Systems and Projections

Specifying the Bounds for Coordinate Systems
You can specify the bounds for coordinate systems in the MAPINFO PROFESSIONALW.PRJ file. To do so, add 2000 to the projection number and list the bounds after the projection parameters. The general form is:

name, projectionnum + 2000, projection parameters, x1, y1, x2, y2

For example, to define a UTM Zone 10 coordinate system with bounds of (100000, 400000) to (200000, 450000), use this line:

“UTM Zone 10”, 2008, 74, 7, -123, 0, 0.9996, 500000, 0, 100000, 400000, 200000, 450000

<table>
<thead>
<tr>
<th>Number</th>
<th>Projection</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Lambert Conformal Conic</td>
</tr>
<tr>
<td>19</td>
<td>Lambert Conformal Conic (modified for Belgium 1972)</td>
</tr>
<tr>
<td>1</td>
<td>Longitude/Latitude</td>
</tr>
<tr>
<td>10</td>
<td>Mercator</td>
</tr>
<tr>
<td>11</td>
<td>Miller Cylindrical</td>
</tr>
<tr>
<td>13</td>
<td>Mollweide</td>
</tr>
<tr>
<td>18</td>
<td>New Zealand Map Grid</td>
</tr>
<tr>
<td>31</td>
<td>Prince Edward Island Double Stereographic</td>
</tr>
<tr>
<td>27</td>
<td>Polyconic</td>
</tr>
<tr>
<td>26</td>
<td>Regional Mercator</td>
</tr>
<tr>
<td>12</td>
<td>Robinson</td>
</tr>
<tr>
<td>16</td>
<td>Sinusoidal</td>
</tr>
<tr>
<td>20</td>
<td>Stereographic</td>
</tr>
<tr>
<td>25</td>
<td>Swiss Oblique Mercator</td>
</tr>
<tr>
<td>8</td>
<td>Transverse Mercator (also known as Gauss-Kruger)</td>
</tr>
<tr>
<td>21</td>
<td>Transverse Mercator (modified for Danish System 34 Jylland-Fyn)</td>
</tr>
<tr>
<td>22</td>
<td>Transverse Mercator (modified for Danish System 34 Sjaelland)</td>
</tr>
<tr>
<td>23</td>
<td>Transverse Mercator (modified for Danish System 34/45 Bornholm)</td>
</tr>
<tr>
<td>24</td>
<td>Transverse Mercator (modified for Finnish KKJ)</td>
</tr>
</tbody>
</table>

User Guide 447
To define a Longitude / Latitude coordinate system with bounds of (-50, 30) to (-48, 35), use this line:

"Longitude / Latitude", 2000, 0, -50, 30, -48, 35

You can also define a coordinate system with bounds and an affine transformation. In that case, add 3000 to the projection number, and list the bounds after the affine transformation constants. The general form is:

name, projectionnum + 3000, projection parameters, unitnum, A, B, C, D, E, F, x1, y1, x2, y2

**Accounting for Affine Transformations and Explicit Bounds in Projection Types**

You can modify projection type entries in the MAPINFO.W.PRJ to add a constant value to account for affine transformations and explicit bounds. Valid constant values are listed in the next table:

<table>
<thead>
<tr>
<th>Constant</th>
<th>Coordinate System has:</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>Affine transformations</td>
<td>Affine units specifier and coefficients appear after the regular parameters for the system.</td>
</tr>
<tr>
<td>2000</td>
<td>Explicit bounds</td>
<td>Bounds appear after the regular parameters for the system.</td>
</tr>
<tr>
<td>3000</td>
<td>Both affine transformations and bounds</td>
<td>Affine parameters follow system’s parameters; bounds follow affine parameters.</td>
</tr>
</tbody>
</table>

**Example:**

In this example we use the Transverse Mercator coordinate system with the NAD 1983 datum. You might have this line in your MAPINFO.W.PRJ file:

"UTM Zone 1 (NAD 83)", 8, 74, 7, -177, 0, 0.9996, 500000, 0

If you want to account for an affine transformation for this system, you would add the constant to the projection type and append the parameters of the affine transformation as listed below:

Units=meters; A=0.5; B=-0.866; C=0; D=0.866; E=0.5; and F=0

Therefore, the new entry to append the parameters of the affine transformation would be:

"UTM Zone 1 (NAD 83) - rotated 60 degrees", 1008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0

where:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1008</td>
<td>Achieved by adding the constant (1000) to the projection type (8)</td>
</tr>
<tr>
<td>7</td>
<td>Units for the affine transformation (7 = meters)</td>
</tr>
<tr>
<td>0.5, -0.866, 0, 0.866, 0.5, 0</td>
<td>Affine parameters.</td>
</tr>
</tbody>
</table>
To supply explicit bounds to the coordinate system \((x1, y1, x2, y2)=(-500000, 0, 500000, 1000000)\), the required line entries would be:

"UTM Zone 1 (NAD 83) - bounded", 2008, 74, 7, -177, 0, 0.9996, 500000, 0, -500000, 0, 500000, 1000000

where:

<table>
<thead>
<tr>
<th>Entry Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
</tr>
<tr>
<td>-500000, 0, 500000, 1000000</td>
</tr>
</tbody>
</table>

To customize the coordinate system using both the affine transformation and explicit bounds, the entry in the MAPINFOW.PRJ would be:

"UTM Zone 1 (NAD 83) - rotated and bounded", 3008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0, -500000, 0, 500000, 1000000

where:

<table>
<thead>
<tr>
<th>Entry Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3008</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>0.5, -0.866, 0, 0.866, 0.5, 0</td>
</tr>
<tr>
<td>-500000, 0, 500000, 1000000</td>
</tr>
</tbody>
</table>

**Datums**

A datum is established by tying a reference ellipsoid to a particular point on the earth. The following Datums table lists the details for each datum:

- The number used to identify the datum in the MAPINFOW.PRJ file.
- The datum’s name
- The maps for which the datum is typically used
- The datum’s reference ellipsoid

For a comprehensive list of supported projection datums, see Projection Datums in Chapter C on page 527. For a list of datum changes by version, see Coordinate System Enhancements by Version on page 538.

**Note:** To create a custom datum, see Defining Custom Datums in the Help System.
Converting Coordinates from One Datum to Another

When converting coordinates from one datum to another, MapInfo Professional has used the Molodensky (3-parameter) and Bursa-Wolfe (7-parameter) methods. These are general-purpose methods that can convert coordinates from any datum to any other datum.

After the NAD 83 datum was introduced, NOAA developed a program called NADCON, which stands for North American Datum CONversion. This is a very specialized program that converts coordinates only from NAD 27 to NAD 83 and vice versa. For this specialized task, it's much more accurate than the Molodensky general-purpose method; NADCON is accurate to about 0.1 meter, and Molodensky is accurate to only 10-30 meters. Most U.S. government agencies, including the Census Bureau, have standardized on NADCON for converting between NAD 27 and NAD 83.

The NADCON algorithm is used to convert coordinates between NAD 27 and NAD 83 if those coordinates lie within the areas covered by NADCON (United States, Puerto Rico, and the Virgin Islands). If the coordinates lie outside those areas, or if they use datums other than NAD 27 or NAD 83, MapInfo Professional uses the Molodensky or Bursa-Wolfe conversion methods.

Due to the file access required, the NADCON conversion method can be slightly slower than the Molodensky method. If you want to turn off the NADCON conversion, add a "NADCON" entry to the registry. The registry entry should have this path:

```
HKEY_LOCAL_MACHINE\Software\MapInfo\MapInfo\Common\NADCON
```

If this entry is set to zero, then the Molodensky conversion method will be used instead of NADCON.

NADCON=0

Units

The units indicate the measurement that the projection uses to keep track of space. To find a complete list of units and their corresponding projection entries, see Units in Chapter C on page 535.

Coordinate System Origin

The coordinate system origin is the point on the Earth (specified as longitude and latitude degrees) from which all coordinate distances are to be measured. X = 0 and Y = 0 at the origin point, unless a false easting and/or false northing is used (see below). It is chosen to optimize the accuracy of a particular coordinate system. As we move north from the origin, Y increases; X increases as we move east. These coordinate values are generally called northing and eastings.

For the Transverse Mercator projection, the origin’s longitude defines the central meridian. In constructing the Transverse Mercator projection a cylinder is positioned tangent to the earth. The central meridian is the line of tangency. The scale of the projected map is true along the central meridian.

In creating a Hotine Oblique Mercator projection it is necessary to specify a great circle that is not the equator nor a meridian. MapInfo Professional does this by specifying one point on the ellipsoid and an azimuth from that point. That point is the origin of the coordinate system.
Chapter 14: Working with Coordinate Systems and Projections

Standard Parallels (Conic Projections)

In conic projections a cone is passed through the earth intersecting it along two parallels of latitude. These are the standard parallels. One is to the north and one is to the south of the projection zone. To use a single standard parallel specify that latitude twice. Both are expressed in degrees of latitude.

Oblique Azimuth (Hotine Oblique Mercator)

When specifying a great circle (such as the Hotine Oblique Mercator) using a point and an azimuth (arc), the azimuth is called the Oblique Azimuth and is expressed in degrees.

Scale Factor (Transverse Mercator)

A scale factor is applied to cylindrical coordinates to average scale error over the central area of the map while reducing the error along the east and west boundaries. The scale factor has the effect of recessing the cylinder into the earth so that it has two lines of intersection. Scale is true along these lines of intersection.

You may see the scale factor expressed as a ratio, such as 1:25000. In this case it is generally called the scale reduction. The relationship between scale factor and scale reduction is:

\[
\text{scale factor} = 1 - \text{scale reduction}
\]

In this case the scale factor would be 1-(1/25000) or 0.99996.

False Easting and False Northing

As you can see in the Longitude/Latitude Projection Map on page 441, X and Y coordinate parameters are commonly designated in relationship to a single point. Points to the left of that center point are negative and points to the right are positive. Points above that center point are positive and points below that point are negative.

In the days of the tall ships, these calculations and computations were done by hand. Using positive and negative signs made these calculations more complicated. The terms “false easting” and “false northing” were used to remove these signs and refer to the absolute value of the X and Y coordinates. MapInfo Professional handles these computations, but these parameters still have to be accounted for in the projections that use them.

Range (Azimuthal Projections)

The range specifies, in degrees, how much of the Earth is visible. The range can be between 1 and 180. When you specify 90, you see a hemisphere. When you specify 180 you see the whole earth, though much of it is very distorted.
Building Blocks of a Coordinate System

About Polyconic Coordinate Systems

The following description has been copied from "Map Projections – A Working Manual", USGS Professional Paper 1395, by John P. Snyder.

The Polyconic projection, usually called the American Polyconic in Europe, achieved its name because the curvature of the circular arc for each parallel on the map is the same as it would be following the unrolling of a cone which had been wrapped around the globe tangent to the particular parallel of latitude, with the parallel traced onto the cone. Thus, there are many ("poly-") cones involved, rather than the single cone of each regular conic projection.

The Polyconic projection is neither equal-area nor conformal. Along the central meridian, however, it is both distortion free and true to scale. Each parallel is true to scale, but the meridians are lengthened by various amounts to cross each parallel at the correct position along the parallel, so that no parallel is standard in the sense of having conformality (or correct angles), except at the central meridian. Near the central meridian, distortion is extremely small.

This projection is not intended for mapping large areas. The conversion algorithms used break down when mapping wide longitude ranges. For example, World.tab, from the sample data shipped with MapInfo Professional, may exhibit anomalies if reprojected using Polyconic.

Examples of Projection Entries in the MAPINFOW.PRJ File

The MAPINFOW.PRJ file lists the parameters for each coordinate system on a separate line, as in the following examples:

“Mollweide (Equal Area)”, 13, 62, 7, 0

“Albers Equal–Area Conic (Alaska)”, 9, 63, 7, –154, 50, 55, 65, 0, 0

“UTM Zone 9 (NAD 27 for Canada)”, 8, 66, 7, –129, 0, 0.9996, 500000, 0

This is a basic list of the elements of a coordinate system, for review. There are some projections that do not require all of the elements in the list. Following this list, you can see some entries from the .PRJ file.

1. The first element in each list is the name of the projection in quotes.
2. The second element in each list is the number that identifies the projection number as indicated in Projection Types on page 446.
3. The third element in each list is the datum ID that identifies the appropriate datum for the projection. See Datums on page 449 for a complete list of supported datums.
4. The fourth element in each list is the units, which indicate the units of the projection. See Units on page 535 for a current list of the supported units.
5. The next element in some lists is the coordinate system origin. See Coordinate System Origin on page 450 for a complete description of this entry.
6. The remaining elements are specific to particular types of projections. You can see their descriptions in Standard Parallels (Conic Projections) on page 451, Oblique Azimuth (Hotine Oblique Mercator) on page 451, Scale Factor (Transverse Mercator) on page 451,

Note: Each element in a projection entry is separated by a comma.

Let's look at some specific coordinate systems to prepare you to create your own projection. It is important to remember that the elements of a projection are different for each projection. Here are some examples we have already seen:

Note: There are additional examples in the Help System.

Example: “Mollweide (Equal Area)”, 13, 62, 7, 0

where:

<table>
<thead>
<tr>
<th>Where</th>
<th>Refers to:</th>
<th>For More Information, See:</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Mollweide (Equal Area)&quot;</td>
<td>Name of Coordinate System</td>
<td>Projections and Their Parameters on page 524</td>
</tr>
<tr>
<td>13,</td>
<td>Projection type used</td>
<td>Projection Types on page 525</td>
</tr>
<tr>
<td>62,</td>
<td>Datum used</td>
<td>Datums on page 449</td>
</tr>
<tr>
<td>7,</td>
<td>Units used</td>
<td>Units on page 535</td>
</tr>
<tr>
<td>0</td>
<td>Origin Longitude used</td>
<td>Coordinate System Origin on page 450</td>
</tr>
</tbody>
</table>

**Adding Projections to the MAPINFOW.PRJ File**

Once you understand the structure of the entries in the MAPINFOW.PRJ file, you are ready to create a new projection entry for your coordinate system. You may want to make a copy of the MAPINFOW.PRJ file in case you want to revert back to it later.

To create a new projection entry for the coordinate system in the MAPINFOW.PRJ file:

1. Open MAPINFOW.PRJ in a text editor or word processor. In this file, you are going to add the new projection entries.

**Figure: MAPINFOW.PRJ in Notepad**
Adding Projections to the MAPINFOW.PRJ File

2. Scroll down in this list to find the type of projection you want to base your map on. See Understanding Coordinate Systems on page 441 for descriptions of the different projection types.

3. Add a new line at the end of the projection list you are modifying.

   For example, to add a new Universal Transverse Mercator projection (Australian Map Grid using AGD66 datum), scroll down to that entry and type the new projection at the end of the list.

   Figure: Adding a Line in the MAPINFOW.PRJ File

4. On a new line, type the new parameter entries based on the required parameters described for that projection type in the table Projections and Their Parameters on page 524.
   
   • If the name of your projection does not appear in the Common Map Projections list, consider the kind of projection you are creating (Latitude/Longitude, Conic, Transverse, etc.) and follow the table entries for the type of projection you want.
   
   • Remember to include constant values (Accounting for Affine Transformations and Explicit Bounds in Projection Types on page 448) to indicate an affine transformation, specific bounds, or both if appropriate or necessary.

   Note: The order of parameters is vitally important. Remember to separate each parameter with a comma.

5. Save your edited MAPINFOW.PRJ file in the directory in your user directory.

   Note: In the past the MAPINFOW.PRJ file was saved in your installation directory but this did not allow different users to have different PRJ files. This new file placement permits this.

Things to keep in mind when editing the MAPINFOW.PRJ file:

• You must record the X and Y coordinates of the origin point in decimal degrees.
• Remember to include a negative sign for west longitudes and south latitudes.
• You must list the origin longitude first in the MAPINFOW.PRJ file entry.
• Carry out decimals to at least five (5) places for greater accuracy.
• Do not use commas to represent thousands or millions in large numbers. Only use commas to separate parameters from one another.
• When specifying projection, datum and units, use the number that represents the parameter. These numbers are listed in the table for each parameter earlier in this appendix. In our example, 6 represents Equidistant Conic projection; 74 represents NAD 83 datum, and 7 represents meters.
Using the New Projection in a Coordinate System

Once you have created this new projection, you can use it in a Map window to replace the coordinate system you are using.

1. Open the map for which you want to change projections.
2. From the Map menu, select Options to display the Map Options dialog box.
3. Click the Projections button to display the Choose Projection dialog box.

**Note:** To change the projection of a tab file and all of the map objects in it, use the File > Save Copy As command and select the new projection.

4. Select the new projection from the list and click OK to confirm. The Map Options dialog redisplays.

5. Click OK to implement the new projection in the Map window.

Entering a New Coordinate System (Example)

To illustrate this process in another way, create the following coordinate system using these parameters by adding a new entry to the MAPINFOW.PRJ file:

<table>
<thead>
<tr>
<th>Parameter Type</th>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>“Equidistant Conic Plus”</td>
<td>Name of the new coordinate system</td>
</tr>
<tr>
<td>Projection Type</td>
<td>6,</td>
<td>Equidistant Conic</td>
</tr>
<tr>
<td>Datum</td>
<td>74,</td>
<td>(NAD 83)</td>
</tr>
<tr>
<td>Units</td>
<td>7,</td>
<td>meters</td>
</tr>
<tr>
<td>Origin Longitude</td>
<td>-90.5,</td>
<td>90°30’W</td>
</tr>
<tr>
<td>Origin Latitude</td>
<td>30,</td>
<td>30°N,</td>
</tr>
<tr>
<td>Standard Parallel 1</td>
<td>10.33333,</td>
<td>10°20’N</td>
</tr>
<tr>
<td>Standard Parallel 2</td>
<td>50,</td>
<td>50°N</td>
</tr>
<tr>
<td>False Easting</td>
<td>10000000,</td>
<td>10,000,000 m</td>
</tr>
<tr>
<td>False Northing</td>
<td>500000</td>
<td>500,000 m</td>
</tr>
</tbody>
</table>

1. Open MAPINFOW.PRJ in a text editor or word processor.
2. Go to the Equidistant Conic section and add a new line.
3. Type the name of your new coordinate system in quotes, followed by a comma.
4. Enter the following information to represent your coordinate system:
   
   6, 74, 7, -90.5, 30, 10.33333, 50, 10000000, 500000
5. Save your edited MAPINFOW.PRJ file.

You can use your custom coordinate system just as you would use any of the coordinate systems that come with MapInfo.

There are other ways you can edit this file. To shorten the list, remove coordinate systems from the file. You can also change the names, change group headings and reorder the file to suit your needs.

**Note:** Group headings are distinguished by the hyphen at the beginning of the name. Names of coordinate systems cannot begin with a hyphen or a space.

---

**Understanding Precision in MapInfo Professional**

MapInfo Professional is a very good tool for working at a high precision level. But the onus is on the user to discover the practical limits of the program in various circumstances and how to set the work environment in order to obtain the desired precision level. Millimeter level precision can be easily attained and maintained with projected maps in the metric system.

**What is Precision?**

The most basic component of any GIS is the spatial data that defines the map features. This spatial data could not exist without the coordinate systems that are used to specify the location information. Coordinate precision is a measure of storing spatial data as accurately as possible. Of course, this can be no more precise than the original data provided. Precision is a measurement of how accurately you can store and retrieve the spatial data and has nothing to do with the quality of the data. The number of reliable digits in your coordinate is termed significant digits. Precision is measured in terms of these significant digits.

- For topics related to precision and map bounds, see *Understanding Precision in MapInfo Professional* in the Help System.

where

---

**Understanding Affine Transformations**

An affine transformation allows you to match the points on two vector maps that use different coordinate systems so they can be used together. The base map stays the same while the derived map is transformed mathematically to match up coordinates to the base map.

MapInfo Professional provides the definitions for scale, translation, rotation, reflection, and shearing necessary to support an optional affine transformation for any coordinate system definition. You can also define a coordinate system with bounds and/or with an affine transformation. This is described in detail in *Accounting for Affine Transformations and Explicit Bounds in Projection Types on page 448.*
Description of an Affine Transformation

There are several basic types of transformation that can be applied to the base map using an affine transformation. These include scaling, translation, rotation, shearing, and reflection.

- For more information, see Understanding Affine Transformations in the Help System.

The scale factor of a transformation indicates the distance between the fixed points of one map versus the fixed points of the second map. If the only difference between two maps is the scale, the affine transformation of the derived map is only the same map zoomed in or out around a fixed point. The orientations of the lines connecting the points, and the angles between these lines, remain the same. The scaling in the case of the figure below is around the 0,0 point.

The difference between these images is the scale. To create an affine transformation that maps the base image (A) to the derived image (B), change only the scale.

The translation factor of a transformation is when every point on an image follows a parallel path and no rotation takes place.

The difference between these two images is the translation.

The rotation factor of a transformation indicates that the image turns on a particular point. The next figure shows a 25-degree rotation of the map around the 0,0 point.
The difference between these two images is not the scale, because the size of each image is the same. The difference is the rotation of the derived image (B).

The shearing factor of a transformation indicates that one of the coordinates of one image should change proportionally to the other. You can apply a shear transformation either on the x-axis as shown in the next figure or on the y-axis. As you can see the vertical scale of the image has not changed, and the corner of the figure at 0,0 has not moved -- but points higher up on the figure are shifted progressively further to the right.

The difference is the shearing of the derived image (B).

The reflection factor of a transformation indicates that the derived image is the mirror image of the base image, that is, all the points in the base image should be reflected across some straight line, such as the x-axis or y-axis. In the figure below, the derived image (B) is the reflection of the base image (A).

The difference between these two images is that the derived image (B) is a reflection of the base image (A) along the x-axis.
Using Earth and Non-Earth Maps

Earth maps and non-earth maps generally require different treatment. The following section on projections apply only to earth maps. An *earth map* contains objects that have a particular location on the earth’s surface. All maps that MapInfo Professional sells are earth maps. Coordinates typically represent an object’s location in longitude and latitude, although other coordinate systems (using various projections) may be used instead.

![Sinusoidal (Equal-Area)](image)

**Sinusoidal (Equal-Area)**

Use earth maps to:

- Overlay your map onto any maps that MapInfo Professional supplies.
- Use or change projections.
- Specify objects on the map in terms of longitude and latitude.

A *non-earth map* contains objects that have no specific location on the earth’s surface. Floor plans are typical examples of non-earth maps. A non-earth map has a coordinate system, but since its map points are not referenced to locations on earth, the coordinate system does not contain a projection. Even though the floor plan describes a building that may be located somewhere on the Earth, the coordinates of objects in the floor plan are generally not referenced to positions on the Earth. Rather, the object’s coordinates are referenced to the floor plan itself, generally representing distance from the lower left corner of the floor plan. The next figure depicts a floor plan and is an example of a non-earth map.

**Specifying Coordinates for a Non-Earth Map**

To specify coordinates for a non-earth map:

1. Ensure that your non-earth map is open and that it is the active window.
2. Choose **Map > Options**. The **Map Options** dialog box displays.
3. Click the **Projection** button. The **Choose Projection** dialog box displays.
Using Earth and Non-Earth Maps

4. Choose **Non-Earth** from the **Category** drop-down list, and choose a unit from the **Category Members** drop-down list to specify the bounds and units for your non-earth coordinate system.

5. Click **OK**. The **Non-Earth Coordinate Bounds** dialog box displays.

The Non-Earth Coordinate Bounds dialog box allows you to specify the bounds and units for your non-earth coordinate system. You can use positive or negative numbers to specify the minimum and maximum X and Y values.
Working with Web Services

A web service is a software system that is accessible using an intranet or Internet connection. MapInfo Professional® supports the Web Map Service and Web Feature Service, which allow you to retrieve data that others are sharing internally or world-wide. The power of web services is that you can use them to create more powerful maps or in the case of geocoding services get more accurate and precise results using the same data.

Subsequently we added Geocoding and Driving Region web services. A Geocoding web service allows you to geocode with greater accuracy because the maps on a service are more precise. A Driving Region web service allows you to create time- and distance-based buffers around a site for determining proximity to a particular location. You might use this service to find the customers closest to a store, or to determine which insured customers are closest to a weather pattern.

Sections in this Chapter:

- Introduction to Web Services . . . . . . . . . . . . . . . . . . . . . . . . . . . .462
- Enhancing Map Data using a Web Map Service . . . . . . . . . . . . .463
- Enhancing Map Data using a Web Feature Service . . . . . . . . . . .466
- Geocoding using a Geocoding Server . . . . . . . . . . . . . . . . . . . . . .469
- Creating Routing Distance and Time Buffers . . . . . . . . . . . . . .473
- Accessing Envinsa Online Services at MapInfo . . . . . . . . . . . . .476
Introduction to Web Services

MapInfo Professional web services can add detail and precision to the maps you are creating and analyzing. Currently, you can use four web services from within MapInfo Professional:

- Web Map Service
- Web Feature Service
- Geocoding Service
- Routing or Driving Region Service

Accessing Web Services in MapInfo Professional

To make it easier to access these web services, there is a Web Services toolbar. These toolbar buttons display frequently used web services dialog boxes.

To display the toolbar:

1. From the Options menu, select Toolbars to display the Toolbar Options dialog box.
2. Select the Web Services check box in the Show column. Click OK.

Figure: Web Services Toolbar

1 Open WMS Table button 2 Open WFS Table button 3 Find Address button
4 Geocode Using Server button 5 Create Driving Regions button
6 Web Services Preferences button

For more information about these buttons, see the Accessing Web Services in MapInfo Professional topic in the Help System.

Server-Side Authentication for WMS and WFS

You can access WFS and WMS servers that require basic authentication using the built-in standard mechanism for internet servers. To connect to a WFS or WMS server that requires authentication, complete the Connect dialog box that displays.
Enter the appropriate user name and password and select the Remember my password check box to have the site “remember” your password for you. Click OK to enter the site. If you do not have a valid user name and password, you cannot connect to the site.

**Accessing Secure Web Sites**

SSL is an international standard security protocol for exchanging sensitive information between a web site and your computer. You know SSL-enabled sites by the https: address. When you connect to an SSL-enabled WFS or WMS server, your computer and the server exchange digital certificates, which minimize the threat of theft of sensitive data. If you try to connect to a WFS or WMS server and you have a valid SSL certificate, you should be able to connect to the web site.

**Enhancing Map Data using a Web Map Service**

Web Services can provide more data for you to work with in MapInfo Professional. A Web Map Service (WMS) allows you to access maps and data through your local intranet or the Internet. This innovation is based on a specification from the Open GIS Consortium (OGC) that allows you to use raster map images from servers that also comply with the specification. You must specify the coordinate system within your data request to ensure that the images you retrieve “sync up” or register with your other map data.

**How Does MapInfo Professional Use WMS Servers?**

When you create a .tab file from WMS layer(s), you are actually creating a pointer to an XML file that keeps track of the data you selected, (the server address, the selected layer(s), the styles, the format, and the projection settings). You never actually retrieve the data and save it on your computer. Every time you add a WMS table as a layer to your map or you change the view of the map, the system generates a map request and retrieves the layer information. To do this, the .tab file points to an XML file which retrieves the information from the WMS Server and displays it on your computer. If you are not connected to the Internet, the server is unavailable, or the WMS layer(s) you are retrieving are not available, you cannot use the WMS .tab file.

**Note:** The WMS sites that MapInfo includes in this documentation or in the standard installation of MapInfo Professional have been verified as part of the testing process. We cannot guarantee that these sites will remain active, only that they were active as of this writing.

**WMS Maps Display in Current Map Window’s Coordinate System by Default**

Many times, when you are retrieving a WMS map, you are adding it to enhance the detail of a Map window that you are already working on. We have changed the default behavior of the Projection drop-down box. Now, this list defaults to the projection that matches the front-most map window, if that projection is available in the list.
But What if a WMS Definition Already Exists or I am not Working in a Map Window?

- If you are retrieving a WMS map and there was a previous WMS definition (or you are modifying a WMS map), MapInfo Professional uses the coordinate system that matches the current projection (not necessarily the Map window’s coordinate system).
- If there was no previous WMS definition, the current Map window's coordinate system is selected if it can be found in the Projection list.
- If the Map window’s coordinate system is not in the Projection list or you are retrieving a WMS map when you are not working in a Map window, MapInfo Professional tries to default to EPSG:4326.
- Finally, if none of these projections are found, the first item in the Projection list is selected.

Supported Image Formats for WMS

MapInfo Professional supports the following image formats for WMS:

- PNG
- JPEG (JPG)
- TIFF (GeoTIFF AND TIFF)
- GIF.

*Note:* Not every format will be available from every Web Map Service.

The OGC WMS specification supports transparent pixel definition for image formats. This allows you to use the images you retrieve as overlays and not solely as the bottom layer of your map.

To set the background to transparent, click the **Transparent** check box in the **Open WMS Table** or the **WMS Table Properties** dialog boxes. You can also control the transparency and translucency of the image via **Layer Control > Display > Style Override > Adjust Image Styles**.

The **Help System** contains these related topics:

- Adding a WMS Server
- Editing the WMS Servers List
- Retrieving Data from Web Map Services
- Setting the Projection for WMS Layers
- Projection Issues with WMS Map Data
- Editing WMS Layer Settings
- Opening WMS .TAB Files
- Info Tool Support for WMS Layers
- Controlling WMS Image Quality When Printing
Understand WMS Error Messages

Data returned to the WMS client depends on the availability and status of the WMS server and on the characteristics and status of the maps on the WFS server. These conditions are beyond the control of MapInfo.

The following table lists and explains WMS-related error messages. Some messages consist of two parts, separated by a colon. The information up to the colon is generated by the MapInfo WMS client. The raw data following the colon comes directly from the WMS server. For clarification on those messages, please contact the service provider of the WFS server.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Parsing Error: <code>&lt;message from XML parser&gt;</code></td>
<td>The most likely cause is badly formed XML from the server. The raw data following the colon is transmitted by the MSXML 4.0 parser.</td>
</tr>
<tr>
<td>The WMS Server issued the following exception: <code>&lt;message from server&gt;</code></td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The WMS server generated an error. For clarification, contact the service provider of the WFS server.</td>
</tr>
<tr>
<td>The following error was issued while attempting to access the WMS server: <code>&lt;message from server&gt;</code></td>
<td>There could be a problem with the URL, the server may not be available, or it may have timed out.</td>
</tr>
<tr>
<td>The WMS Server returned no data in response to the request.</td>
<td>MapInfo issued a service request, but nothing was received from the server.</td>
</tr>
<tr>
<td>Unable to retrieve capabilities from the WMS Server.</td>
<td>The GetCapabilities request from the server failed. This message usually appears paired with another message in the same message window.</td>
</tr>
<tr>
<td>The WMS Server returned HTML data rather than the requested format. The specified address may not be a WMS Server or the server could not process the request: <code>&lt;message from server&gt;</code></td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The server you are accessing may not be a WMS server. You may see this message after accessing a WFS server and seeing a list of WFS layers. This can occur because the Capabilities document provided by the server may contain additional URLs that redirect you to another server (not the one you explicitly selected). That “redirected” server may be down or have another problem.</td>
</tr>
</tbody>
</table>
Enhancing Map Data using a Web Feature Service

MapInfo Professional 8.0 and later provides a Web Feature Service (WFS) client to retrieve geospatial GML (Geography Markup Language) data using HTTP GET and HTTP POST requests over the Internet or through a private intranet. The WFS client was developed in accordance with the 1.0.0 OpenGIS® Web Feature Service Implementation Specification, which is available online: http://www.opengis.org/docs/02-058.pdf.

WFS is similar to WMS (Web Map Service), in that both can provide geographic data via the Internet. But while a WMS server provides raster maps, a WFS server provides raw coordinate data that the client uses to produce a map.

Note: The MapInfo WFS client has been developed in accordance with OGC WFS Specification 1.0.0. Using this client you cannot retrieve data from sites that are compliant with earlier or later versions of the OGC specification.

---

## WMS-Related Error Messages (continued)

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description and Explanation of Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>The WMS Server returned data which was neither in the requested format nor a recognized WMS service exception: <code>&lt;message from server&gt;</code></td>
<td>The raw data following the colon is transmitted by the WMS server. This may help you analyze the problem. The exception message from the server could not be understood. For example, the exception message may not have been in XML format.</td>
</tr>
<tr>
<td>Error accessing temporary file.</td>
<td>It is possible that your disk is full or you might have deleted the temp file while Mapinfo Pro was running.</td>
</tr>
<tr>
<td>The WMS Server does not return GetFeatureInfo data in a format supported by MapInfo.</td>
<td>The server may not support GetFeatureInfo.</td>
</tr>
<tr>
<td>The WMS Server does not support GetFeatureInfo requests.</td>
<td>The server may not provide GetFeatureInfo in a format understood by MapInfo Pro.</td>
</tr>
<tr>
<td>There are no queryable layers in the WMS table for GetFeatureInfo request.</td>
<td>The server may not have a queryable layer. It is possible that a queryable layer changed between the time that you first created the WMS table and subsequently reopened the table.</td>
</tr>
<tr>
<td>The WMS Server returned data in <code>&lt;formatA&gt;</code> rather than the requested format of <code>&lt;formatB&gt;</code>.</td>
<td>MapInfo requested data in the format that the server claims it supports, however the server is returning a different format. For clarification, contact the service provider of the WMS server.</td>
</tr>
<tr>
<td>Unable to retrieve feature information from the WMS server.</td>
<td>The GetFeatureInfo request from the server failed. This message usually appears paired with another message in the same message window.</td>
</tr>
</tbody>
</table>
Chapter 15: Working with Web Services

The WFS client supports GML2 (OGC GML V2.1.1). The OGS WFS Specification states that all servers should support GML2, but may also support other formats. The server provides information on the formats available, and the client makes the request for the data in the format it can use. If the server does not support GML2, it will not be supported by the MapInfo WFS client.

GML2 does not contain any style information. You can provide style information to associate with a particular WFS table.

A WFS request contains a description of query operations that can be applied to one or more features. The client generates the request and posts it to a WFS using HTTP. The web feature server then reads and executes the request.

The **GetCapabilities** operation queries the WFS server for capabilities. Then the MapInfo Professional WFS client can generate a query appropriate for the WFS server and table.

Each table in the WFS server can result in a single MapInfo table. The mapping is always 1-to-1 (unlike WMS, which is many-to-1).

The TAB file retrieved from a WFS server resembles a read-only DBMS linked table. It contains a MAP file and a DAT file, and acts like a read-only native table. Information is stored so that the table can be refreshed from the WFS server.

The sequence of actions can be summarized as follows:

1. After sending a **GetCapabilities** request to a WFS server, the server returns a list of WFS layers (FeatureTypes) that it can provide.
2. The user picks a WFS layer to fetch from the server, MapInfo Professional then sends a **DescribeFeatureType** request to the server. This response is an XML schema that describes the feature.
3. The user can then select which columns and/or rows to fetch.
4. MapInfo Professional sends a **GetFeature** request to the WFS. If the user did not select a subset of columns, all columns will be requested by default.
5. The response is a GML document containing the feature collection. Each feature represents one "record" in the MapInfo table.

There is a list of WFS servers in the client to help you get started in using this functionality.

**Note:** Since the data you retrieve using the WFS is remote, it may change from time to time. You can refetch your WFS data manually using the refresh process. See *Refreshing your WFS Data* in the Help System for more information.

**WFS Server Requirements**

You must have a working Internet connection whenever you retrieve WFS data. To display GML2 data correctly in the MapInfo Professional Web Feature Service, the server you are requesting information from must:

- **Support V1.0.0 of WFS.** The MapInfo Professional WFS client sends the initial GetCapabilities and specifies version 1.0.0. If the server you are requesting information from does not support the 1.0.0 version, MapInfo Professional cannot use that server and no further operations will be allowed.
• **Respond to GetCapabilities request using Http GET in XML.**

• **Respond to the GetFeature request by returning GML2 (OGC GML V2.1.1).** The server’s GetCapabilities response should include this information. If the server does not claim to use GML2 as the Result Format for GetFeature, then MapInfo Professional cannot use the server and no further operations will be allowed.

• **Conform to the OGC GetCapabilities schema.** If the server GetCapabilities response does not conform to the schema, MapInfo Professional may not be able to read portions of it. This may mean that MapInfo Professional misses items that the server is trying to communicate, such as feature types (tables), or filters. In some cases, MapInfo Professional won't be able to deal with the server, since necessary information cannot be found. In other cases, MapInfo Professional may miss functionality that the server is trying to provide, such as filters.

• **Support HTTP GET and/or HTTP Post for the DescribeFeatureType and GetFeature requests.** The MapInfo Professional client supports both HTTP GET and HTTP POST. The server should advertise what it accepts for each request in its GetCapabilities response. MapInfo Professional prefers HTTP POST for both operations, so if the server advertises that it supports both HTTP POST and HTTP GET methods for these operations, MapInfo Professional uses HTTP POST.

• **Supply the URL for both the DescribeFeatureType and GetFeature in their GetCapabilities response.** The URL provided must be valid for that request. If the server provides an invalid URL, MapInfo Professional’s WFS client cannot work and displays a suitable error message.

The DescribeFeatureType response should be:

• **An XML Schema that contains the information for the table specified only.** If the server returns a schema that contains descriptions for multiple tables, MapInfo Professional cannot parse it correctly, and the operation will fail.

• **A Valid XML Schema.** If not, no further operations can be allowed for that feature type. Without a valid schema, MapInfo Professional cannot create or populate the table. In this case you can either select another table, select another server, or cancel the WFS dialog box.

**Note:** MapInfo Professional may not handle schemas that are “well formed” but contain invalid XML.

MapInfo Professional checks that the schema returned for DescribeFeatureType is well formed XML, but does not validate the XML. Our WFS client works correctly with many servers that return schema’s which contain invalid items, and our developers thought that eliminating these servers because they didn't contain 100% valid XML was too limiting.

**Note:** MapInfo Professional cannot successfully handle schemas that contain invalid items, such as an invalid character in an element name - for example, "City Type" where the space in the element name isn't valid XML.

While MapInfo Professional may be able to process a schema that contains well-formed but invalid XML, this may cause problems elsewhere, such as during the GetFeature processing. This may cause some confusion. If the XML returned during GetFeature doesn't match the schema, MapInfo Professional may create an empty table without displaying an error.

MapInfo Professional:

• **Doesn't process xsd:include.** All element types must be defined in the schema returned from the DescribeFeatureType request or derived from GML base types.
• **Supports all row filters that the server advertises in the GetCapabilities response with the following constraints:**
  • The filters are OGC-defined filters as specified in the OGC WFS Specification or the OGC Filter Encoding Implementation specification.
  • The filter takes 0 or 1 arguments beyond the column name. This is a user interface constraint. MapInfo Professional’s interface is currently not set up to address such filters. This includes the A Between filter, which requires 2 values.

• **Supports MaxFeatures, but not all WFS servers seem to support this option.** While the OGC WFS Specification states that the server should implement this option, our experience has been that some servers ignore MaxFeatures.

• **Treats the Geometry column as mandatory.** While you can filter specific columns, MapInfo Professional always requests the Geometry column from the server. Many servers seem to treat the Geometry column as mandatory and return this column whether it is requested or not.

**Note:** The GML returned during the GetFeature request should validate against the schema returned during the DescribeFeatureType request. If this is not the case, then MapInfo Professional may not be able to create a table.

If a MapInfo WFS table is open, the user interface automatically enables the refresh process. During the refresh process, users can not change the query that is sent to the WFS server. The data will be refetched from the server using the original query. This refreshed information can then be saved to the table.

The Help System contains these related topics:

• Adding a WFS Server
• Adding WFS Client Support
• Opening a Web Feature Service Layer
• Selecting and Filtering a WFS Layer
• Controlling WFS Maximum Features
• Changing a WFS Coordinate System
• Changing WFS Layer Styles
• Handling Retrieved WFS Data
• Refreshing your WFS Data
• Adding Column Indices to WFS Tables
• Overiding WFS Default Timeout Values Locally

### Geocoding using a Geocoding Server

Not everyone in a flood zone loses their homes in a disaster. Accuracy in address matching (geocoding) can mean the difference between an insured being in a flood plain or on dry land. Knowing that information quickly and precisely can mean the difference in thousands of dollars of risk or no risk at all.

For retail customers, an advanced geocoder could be the difference between finding your product in a local store or wasting a trip.

For financial services customers, it could mean locating your best customers quickly when you have an opportunity to share with them.
You can use MapInfo Professional to connect to MapMarker and Envinsa servers to handle advanced geocoding functions.

Geocoding is the process of assigning geographic coordinates to your data, which can be street addresses. Point values assigned to each address turn each record into a geographic object that MapInfo Professional can display on a map. Visualizing your records on a map can make the relationships among your data clearer. You can display your geocoded records against a street map, a postal code centroid map, a county map, or whatever is most appropriate to your needs. You can then use the wide variety of functions available in MapInfo Professional mapping software to perform querying, create thematic maps, create territories, and perform many other types of geographic analysis.

Using the MapMarker and Envinsa Web Services, you have more choices for geocoding. For example, you can choose to geocode your records by street address or by postal code centroid, or by geographic centroids. If you have geocoded some records and some did not geocode successfully, you can set fallback conditions to locate those records. If you geocode and there are no results, poor results, or multiple equal close results, the geocoding server can present you with interactive options so you can select among possible matches or change your input. Further, these web services allow you to set multiple matching conditions when more than one record matches the records you are geocoding and set offsets for placing points right in the geocode properties.

For companies and organizations that use MapMarker and Envinsa servers as a geocoding engine, you can take advantage of the geocoding servers available to your whole enterprise. If your organization makes this server available on your intranet or over the Internet, you can use our geocoding web services from within MapInfo Professional to perform more sophisticated and accurate data geocoding.

**Note:** IMPORTANT: MapInfo may not have a Geocoding Server with data that includes the geography you are interested in. Please check with your local MapInfo sales personnel to ensure that web services exist for your geography.

**What Are MapMarker and Envinsa Geocoding Services?**

MapMarker is a powerful geocoding product that assigns coordinates to an address based on how well it matches entries in an Address Dictionary. The precision of the match can vary. For each address you geocode, you may get back a single perfect, street-level match, a list of street-level match candidates from which you choose the best match, or a less precise postal code centroid match, where the point would be located near the center of the postal code area. In the case of a ZIP + 4 centroid match, the location of the point corresponds to the address which is closest to the mid-address of the ZIP + 4 address range. You must have MapMarker 4.0 core to use this web service.

Envinsa provides a wider range of web services than MapMarker and can even provide access to earlier versions of MapMarker. Envinsa can determine these values from a street address or postal code. Envinsa servers require more security than MapMarker, so you will need a user name and password to access them. Keep in mind that the services that are available on an Envinsa server depends on what was installed.

There are many reasons why using a geocoding service with MapInfo Professional is a good business solution.
Chapter 15: Working with Web Services

- **Multiple Data Formats OK!** Since MapInfo Professional can import or open data in many different formats, you can geocode almost any kind of geographically enabled file. You can take advantage of MapMarker or Envinsa’s advanced geocoding options using Shapefiles, Excel files, ASCII, Access tables, Oracle and SQL Server tables.

- **Data filtering.** You can use the selection and subselection capabilities of MapInfo Professional to create input for the service using any MapInfo Professional "table," including queries created using SQL Select or tools. For example, if you want to geocode your data based on more than one column, you can specify an input address based on a MapBasic expression that could skip irrelevant characters.

- **Geocode a Little or a Lot.** You can geocode individual records or in batch mode.

- **Choose your own Symbols.** You have the full range of MapInfo Professional symbols to choose from when plotting your points, or you can create your own custom symbols for the points you are geocoding.

- **Undo works!** Because all of the geocoded results are transacted, you can use MapInfo Professional’s revert capabilities to undo the transactions. You can save the geocoded results in the source table or into a completely new table.

**Note:** IMPORTANT: MapInfo may not have online services with data that includes the geography you are interested in. Please check with your local MapInfo sales personnel to ensure that web services exist for your geography.

### Geocoding a Single Address using a Geocoding Service

The process for geocoding a single address for an Envinsa or MapMarker service. Keep in mind that you must set up a geocoding service before you can use this type of geocoding. See **Setting up a Geocoding Server on page 145** and **Setting the Geocoding Server Preferences on page 140** for these instructions.

- For specific instructions, see Geocoding a Single Address using a Geocoding Service in the Help System.

### Understanding the Geocoding Result Codes

The geocoding service returns a result code for each address it attempts to match. The code indicates whether a match was made, the type of match it was, and conveys information about the quality of the match. The result code is an alphanumeric code of 1-10 characters. There are four categories:

- Single close match to street level (S category)
- Postal Code centroid match (Z category)
- Multiple matches during automatic geocoding (M category)
- Non-matches (N category)

Matches in the M category indicate that there is more than one match candidate for the record and the geocoding service has chosen the best one of those candidates. This category displays when you select the automatic option and the geocoding service finds more than one strong match candidate.
For S and Z categories, the first two characters represent the positional accuracy of the match, that is, where the point for the record would spot on a street map. For the S category matches there are eight additional characters that indicate the individual components in the input address that matched. If the geocoding service did not match on a particular address component, the code would contain a dash for that element. For example, a single close match to a street address that matched to all address components except house number would look like: S5-PNTSCZA.

### S Category: Single Close Match to Street Level

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S6</td>
<td>matched to a point located at a Postal Code centroid</td>
</tr>
<tr>
<td>S5</td>
<td>matched to a street address</td>
</tr>
<tr>
<td>S4</td>
<td>matched to an interpolated point on the street segment</td>
</tr>
<tr>
<td>S3</td>
<td>matched to a Secondary Postal Code centroid (centerpoint of the Secondary Postal Code boundary)</td>
</tr>
<tr>
<td>S2</td>
<td>matched to a Primary Postal Code centroid (centerpoint of the Primary Postal Code boundary)</td>
</tr>
<tr>
<td>S1</td>
<td>matched to a Postal Code centroid (centerpoint of the Postal Code boundary)</td>
</tr>
<tr>
<td>SX</td>
<td>matched to a street intersection</td>
</tr>
<tr>
<td>S0</td>
<td>single close match, no coordinates available</td>
</tr>
<tr>
<td>H</td>
<td>matched to house number</td>
</tr>
<tr>
<td>P</td>
<td>matched to street prefix</td>
</tr>
<tr>
<td>N</td>
<td>matched to street name</td>
</tr>
<tr>
<td>T</td>
<td>matched to street type</td>
</tr>
<tr>
<td>S</td>
<td>matched to street suffix</td>
</tr>
<tr>
<td>C</td>
<td>matched to city name</td>
</tr>
<tr>
<td>Z</td>
<td>matched to ZIP Code</td>
</tr>
<tr>
<td>A or U</td>
<td>match came from MapMarker Address Dictionary (A) or customized user dictionary (U)</td>
</tr>
</tbody>
</table>

### Z Category: Postal Code Match

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z6</td>
<td>Postal Code centroid match</td>
</tr>
<tr>
<td>Z3</td>
<td>Secondary Postal Code centroid match</td>
</tr>
<tr>
<td>Z2</td>
<td>Primary Postal Code centroid match</td>
</tr>
</tbody>
</table>
Creating Routing Distance and Time Buffers

To find out how many customers are within ten minutes drive of your stores to find all of the suppliers within 15 to 30 miles of your warehouse location, use a Driving Regions web service.

The Drivetime web service uses the latest road networks and fast search algorithms to show the buffer boundaries in time (isochrone) or distance (isodistance) from a specified location. These buffers are different from other MapInfo Professional object or table buffers because they are based on road networks and not straight line distances. Driving region time and distance buffers are calculated based on the speed limits of the individual roads and highways in the road network and the distance or time values you request. Isochrones and isodistances are collectively called isograms.

You can only access this Drivetime data and calculation functionality on an Envinsa 4.0 routing server. The Driving Regions web service helps you create isochrone and isodistance buffers using points in your own data.

An isochrone or a time buffer is a region that shows the area that a driver can reach from a starting point in a specific amount of time based on the speeds specified in the routing network. For example, if you wanted to put together an event and invite the customers who live within an hour’s
drive of the event site, you could create a time buffer for known customers within an hour’s drive. The service would then use the average driving speeds defined in the road network to calculate the time buffer from your event. You can then display your data within those buffer regions using a Select or SQL Select statement.

An *isodistance* or a *distance buffer* is a region that shows the area that a driver can reach from the starting point in the same distance. For example, if you want to contact all of the customers who live within 50 miles of the event instead of one hour, you could calculate the distance using the Drivetime web service, using similar logic.

Effectively, you are creating buffers from a point or table of points based on the server’s road network for specified times or distances. Using the Driving Region service options, you can control the way this information displays and the number of time and distance buffers you create at a time.

- For more information, see *Creating Time or Distance Buffers for a Table and Rules when Adding a Driving Value* in the Help System.

**How are Time and Distance Buffers Calculated?**

This is a raster map of a portion of a major city, but it could just as easily be your community.

You can travel further on a limited access highway than a local road in the same amount of time due to the difference in speed limits.

In it, you can see limited access highways, major roads with buildings on them, and local streets with homes. The speed limits on these streets vary depending upon their size and use. The routing server manages the speeds for each road type and uses those speeds to calculate the distance a driver could travel in a specific amount of time. For example a driver could get further in an hour on a highway, than on a local road, due to the average speed limits on those roads.
If you think of these speed limits and distances in spatial terms, starting from a particular point, the region the web service could create along a highway would be longer and narrower than the region you would create using a more local road based on the same amount of time or distance request.

That is the concept behind the Driving Region functionality.

**Using Driving Region Buffers to Display Data**

You can create a driving region buffer (time or distance) to find out how far away your customers are from a particular event or location. We recommend that you add a server as described in the Setting the Routing Server Preferences instructions before attempting to create time or distance buffers.

Here are some definitions that may be useful for you as you use this feature.

**Holes**
Areas within the larger boundary that cannot be reached within the specified time or distance, based on the road network.

**Island**
Small areas outside the main boundary that can be reached within the specified time or distance.

**Offroad Travel**
Offroad travel refers to streets that are not part of the server’s road network, such as driveways, private roads, or access roads.

**Creating Time or Distance Buffers for Objects**

You can use a routing server’s driving regions network to create time or distance buffers around map objects to see your data in a new way. Keep in mind that these buffers are not like standard straight line circle buffers, but are rather based on the speed that a driver can travel on a particular road network. If you want to create time and distance buffers for an entire table of objects, see Creating Time or Distance Buffers in the Help System.

Before you begin this process, we recommend that you set up your own default routing server using the instructions in Setting the Routing Server Preferences on page 142. If you do not have access to your own routing server, you can access and subscribe to Envinsa Online Services from MapInfo to take advantage of this functionality. To activate your free Envinsa Online Services trial account, see Accessing Envinsa Online Services at MapInfo on page 476.

**Note:** IMPORTANT: MapInfo may not have online services with data that includes the geography you are interested in. Please check with your local MapInfo sales personnel to ensure that web services exist for your geography.

- For specific instructions and related topics, see creating Time or Distance Buffers for Objects in the Help System.
Accessing Envinsa Online Services at MapInfo

If you want to try out these Geocoding or Driving Region features, but don’t have access to a MapMarker or an Envinsa server, MapInfo is providing both trial and subscription access to our public Envinsa server, called Envinsa Online Services or EOLS.

There are two ways to access these web services from within MapInfo Professional. First, when you enter the geocoding or driving regions dialog boxes for the first time, the Configure Service dialog box displays.

To sign up for this service click Activate and follow the instructions to receive a user ID and password, which you can enter into this dialog box. Decide whether you want the system to remember your password\(^1\) and whether you want to use a secure server\(^2\). Then click Add Account to begin using the EOLS server.

You can also access the EOLS is through the Help menu. Select Help > Connect to Envinsa Online Services to get started. A landing page will provide you with further instructions, including user name and password information. When you complete your trial period, the Envinsa Online Services will stop accessing the server and you will have the option of subscribing for further use of this service.

**Note:** IMPORTANT: MapInfo may not have online services with data that includes the geography you are interested in. Please check with your local MapInfo sales personnel to ensure that web services exist for your geography.

---

1. The password will be saved in the MapInfo services configuration file (MIRoutingModuleServers.xml). These passwords are encrypted.
2. When you choose the secure connection option, you add the step of encrypting all of the communication to and from the server. Consider whether you prefer this option to the standard HTTP connection.
Specialized Topics in MapInfo Professional

The topics in this chapter cover the advanced use of MapInfo Professional®. There are more advanced topics pertaining to embedding maps in other applications, Internet connectivity, working with the MapBasic window, redistricting, and digitizing maps in the MapInfo Professional Help System.

Sections in this Chapter:

- Embedding MapInfo Professional Maps ................. 478
- Internet Connectivity and MapInfo Professional .... 480
- Redistricting — Grouping Map Objects into Districts ..... 482
- Creating Expressions ............................................ 485
- Working with the MapBasic Window ...................... 494
Embedding MapInfo Professional Maps

MapInfo Professional® brings its power of map display, creation and editing right into your favorite application so that you may build a map where you need it. This chapter covers the basics of OLE and the MapInfo Professional features that you may use in other applications to create dynamic maps.

MapInfo Professional’s OLE embedding capability turns your applications such as word processors and spreadsheets into “mini-MapInfo” programs where you can create, display and edit a map for presentation, reporting or publishing. OLE is a process known as Object Linking and Embedding whereby a server application (such as MapInfo Professional) provides information that is stored in a client application that can accept OLE information (such as a word processor). MapInfo Professional’s OLE embedding functionality allows you to embed a Map window in any application that accepts OLE objects and use some of MapInfo Professional’s features to create, display and edit the map directly in that application.

With MapInfo Professional OLE Embedding you can build the map directly in your OLE container application, or you can create it in MapInfo Professional and drag the Map window into your application for additional editing or output. Because the MapInfo Map Object is a live OLE object, you are in fact running MapInfo Professional in the background. When the Map window is active in the container, the menu and toolbar of your application change to reflect the MapInfo Professional features that become available. This subset of features is called MapInfo Map. (Some OLE containers will create a separate window for the object.) With the click of a button or by choosing a menu command, you have MapInfo Professional functionality in your application where you need it.

• For more information about OLE features and requirement in MapInfo Professional, see the MapInfo Professional Help System.

What You Should Know First

Before you get started, it is good to review the system requirements and the registration statement to ensure that you understand where to look for your MapInfo Map Objects.

System Requirements

MapInfo Map is an OLE server application that runs under 32-bit MapInfo Professional. You must install MapInfo Professional 32-bit to engage MapInfo Map. On the client side, only container applications that support OLE embedded objects can run MapInfo Map.

Registering OLE Objects with Containers

Once MapInfo Professional has been installed on your system, the MapInfo Map Object will be registered automatically and listed as a choice in the Object dialog box of any container application that accepts OLE objects.
Menus and Commands Available While Using the MapInfo Map

MapInfo Map replaces all container menus except **File** and **Window** with five MapInfo Professional menus: **Edit**, **View**, **Table**, **Map** and **Help**. Under each menu, selected MapInfo Professional features have been included, as outlined in this section. This section contains summaries of MapInfo Map’s menu commands and tools. Be sure to refer to other chapters in this Guide and the rest of the MapInfo Professional documentation set for more complete discussions.

- For more about the specific commands available when working with Map windows, see the *Help System*.

Limitations of OLE

Although MapInfo Map enables you to build a map very easily in your container application, not all of MapInfo Professional’s features are available in the context of map embedding. Among them are editing map objects such as regions or polylines, querying a table for further analysis, geocoding to a table in the Map window, or displaying tables in other types of windows (Browser, Graph or Layout windows).

However, with MapInfo Professional’s drag and drop capabilities you can still perform these functions in MapInfo Professional and bring over the Map window to your OLE container application for final viewing, formatting and editing enhancements.

Working with Embedded Maps

Now that you have had an introduction to MapInfo Map Object and what it can do for you as you work in another application, let’s get down to the specifics of embedding an OLE object.

Although containers vary in their handling of OLE objects, there are some behaviors that are common to all. There are three ways that containers accept embedded OLE objects such as a Map window:

- On the **Insert** menu, click **Object** to choose the object to embed from a list.
- On the **Edit** menu, click **Paste** (or **Paste Special**) to embed an object that was previously copied to the Clipboard.
- Drag and drop from the application to the container using the Drag Map Window tool.

The method you choose depends on which application you are in at the moment (server or client) and how much you want to do to create the final map.

- For more information and related topics, see *Creating a New Map Window in your Container and Bringing a Map Window into your Application* in the *Help System*.

Sharing Documents with Embedded Maps

Once you have created a map in your document, you may want to share it with a colleague. Or you might want to use it on another system. When the document is opened on another system, the MapInfo Map Object displays as a metafile, or picture of the map, in the inactive state. The map is like any other graphic image at this point. If no map editing is necessary, the document can be
Internet Connectivity and MapInfo Professional

print, reformatted, reorganized, and saved with no special handling required for the map. The map itself can even be resized or repositioned. You cannot, however, change the content of the map since it is not an active OLE object.

To activate the map for editing on another system, your colleague must have access to 32-bit MapInfo Professional and the data used to create the map. Double-click the map to activate the OLE object. MapInfo Professional will prompt for the location of the data files if it cannot find the original location. If the data is not available, cancel out of the Locate Data dialog box. The metafile image is replaced with the MapInfo Professional world map in the active state. To retrieve the original metafile image, close the document without saving and reopening it.

Note: Sharing MapInfo Professional and map data on other systems is limited to the extent of your license agreement(s).

- For more information, see MapInfo Map Objects vs. Data Map Objects in the Help System.

Using MapInfo Tables with Data Map

Data Map uses MapInfo Professional tables. All of the sample maps provided with Data Map are actually MapInfo Professional tables.

If you have created your own MapInfo Professional tables, you can use your tables in Data Map. However, before you can display your table in Data Map, you must set up your table using the Data Map Data Installer. To launch the Data Installer, double-click the file DATAINST.EXE. (To locate this file, click the Windows Start button, and then click Find.) Once you have launched the Data Installer, complete the dialog boxes that appear on the screen.

Note that some MapInfo Professional tables cannot be used with Data Map. Specifically:

- Data Map cannot display raster image underlay tables.
- Data Map cannot display a table that is actually defined as a relational join of other tables (such as a MapInfo StreetPro table). To use a street table with Data Map, use MapInfo Professional’s Save Copy As command, which saves a street table in a “flat” form that Data Map can use.
- Data Map cannot display point objects that use MapInfo Professional “Custom” symbol styles. (Custom symbols are selected by displaying MapInfo Professional’s Symbol Style dialog box, and then selecting “Custom Symbols” from the Font drop-down list.) If your MapInfo Professional table contains points with custom symbol styles, those points will be invisible in Data Map.

For more information about Data Map, see the Data Map online Help. For more information about the Data Installer, see the Data Installer online Help.

Internet Connectivity and MapInfo Professional

MapInfo Professional contains options that allow you to bring the Internet into your mapping sessions, and to bring your maps to the Internet.

Using active objects and the HotLink tool, you can launch files and Internet URLs directly from objects or labels on your map. Active objects provide you with a powerful display tool that allows you to bring information from the Web and other applications together in your map.
These additional sources of information can give your analysis or presentation greater impact. For example, you can link a location on your map to a Web site that gives more information about the location or to an image file that shows certain aspects of the location in more detail.

In addition, you can use the maps you create in MapInfo Professional in your Web pages. The HTML Image Map tool converts a MapInfo Professional map into an HTML image map. Visitors to your Web page will be able to click any region to link to other HTML pages specific to that region.

**What Are Active Objects?**

Active objects are map objects that are associated with files or URLs. The file can be a bitmap, a MapInfo Professional workspace or table, a MapBasic program, or any type of executable file whose extension is associated with an application installed on your system.

![Image of Mexico map with active object]

The active object in this map (red triangle) is linked to a webcam web site that displays an erupting volcano.

The **Help System** contains these and other related topics:

- Creating Active Objects
- Using the HotLink Tool in a Map Window
- Adding URL Information to your Table
- Combining a District's Objects
- Saving a New District and Exiting the Redistricter
HTML Landing Pages

The Landing Pages option allows you to click any region in the HTML image map and link to an HTML landing page specific to that region. You can put whatever content you want into the landing pages, including column information from your table. The user interface enables you to select the columns you want to use and customize the text.

- For more about selecting columns for landing pages and Tooltips, see the Help System.

Redistricting — Grouping Map Objects into Districts

One popular use of MapInfo Professional® is to group map objects with a common field into districts or territories. MapInfo Professional’s Redistricting feature allows you to create new districts, realign existing districts, all the while doing calculations of the attached data on the fly for instant analysis and decision-making.

What is Redistricting and How Can I Use It?

Redistricting is the process of assigning map objects to groups. As you assign map objects to groups, MapInfo Professional automatically calculates totals for each group of objects, and displays the totals in a special Browser window called the Districts Browser. This process is sometimes known as load-balancing.

When you perform redistricting, you create a number of districts. The exact number of districts needed depends on the nature of your work. You can assign a unique name to each district; thus, if you want to work with four districts, you might call the districts Northeast, Southeast, Northwest, and Southwest. Each district appears as one row in the Districts Browser.

The Districts Browser is different from other Browser windows in several respects:

- You only can select one row at a time from the Districts Browser. You cannot shift-click to select multiple rows.
- The Districts Browser always has one row selected; you cannot cancel the selection of this row by choosing Unselect All.
- When you select a row from the Districts Browser, that row becomes the target district. The target district is the district that will be affected by subsequent redistricting operations.

Once you have selected a target district, you assign map objects to that district by selecting the map objects. You can select objects by pointing and clicking, or by performing queries such as SQL Select.

When you select map objects, MapInfo Professional tentatively assigns the selected objects to the target district. MapInfo Professional then recalculates the totals for each district, and displays the new totals in the Districts Browser. You can then examine the contents of the Districts Browser to decide whether you want to make the district assignments permanent.

To cancel the tentative district assignment, cancel the selection of the map objects.
To make the tentative district assignment permanent, choose **Redistrict > Assign Selected Objects**. When you choose Assign Selected Objects, MapInfo Professional stores the target district's name in the rows of the selected objects. Thus, if you assign map objects to a district called Northwest, MapInfo Professional stores Northwest in each object's row.

Each district has its own set of fill, line, and symbol styles. When you assign a map object to a district, the object subsequently appears in the style of the district. Thus, if you choose a solid blue fill for the Northeast district, objects that you assign to Northeast appear in solid blue.

For example, if you have a layer of states, you might want to combine the state boundaries to create sales territories. Each state record includes a field, TOT_SALES, which contains the total sales for the previous year. You would ultimately like to sum up the TOT_SALES field for each state in a given sales territory. Redistricting is gives you the tools for creating the sales territory and combining those TOT_SALES fields from each state’s data into one table.

![States Map](image)

**Note**: The STATES table used in this example is from the MapInfo Professional Tutorial data, which is available from the MapInfo web site, www.mapinfo.com/miprotutorial.

But that is only one part of the redistricting process. The real power lies in the Districts Browser where you can see on-the-fly updates of district record counts and data totals when you click a map object and assign it to another district. This allows you to perform visual “what if” analysis to achieve district realignments, a process sometimes referred to as load balancing.

When you are satisfied with the distribution, you can make the district assignments permanent. Later, as the need arises, you can change the assignments and try out new distributions.

Redistricting does not create new map objects or permanently change the style of the map objects. Redistricting is simply a dynamic grouping tool that displays map objects that share the same district information as a group. While the map objects are not permanently affected, you can make the district assignments permanent by saving the table.

You can redistrict any mappable table containing region, line, or point objects. The redistrict map will reflect the appropriate fill, line, or symbol style for the objects. The Redistricter limits the number of districts in a table to 594.

You can use redistricting in a wide variety of applications such as creating and managing sales territories, school or voter districts, emergency service coverage areas, delivery routes, natural resource management areas, etc. Use it wherever there is a high degree of fluctuating data and the need to try out different realignment scenarios.
You can use redistricting whether you need to create districts from scratch or realign existing districts.

Before we get into the process, however, there are two key concepts to introduce: the Districts Browser and Target District.

**Using the Districts Browser**

The Districts Browser is the key to the process of creating and changing districts. While looking like other Browsers in MapInfo Professional, the Districts Browser is actually a dynamic window that allows you to make changes to the groups and recalculates total values on the fly. You can immediately see the results of your changes. You then have the option to make the changes permanent or continue to try out new district realignments.

The Browser window lists the districts as specified in your table, the record count for each district, and aggregate expression columns that contain the net total values of your data. You specify these columns in the New Redistrict window dialog box when you begin the redistricting session.

![Districts Browser](image)

- For more instructions about creating and adding redistricting features and other related topics, see the Help System.

For additional topics in Redistricting, see Setting up the Target District in the Help System.

**Using Redistricting**

When you calculate the percentage of partial columns (such as population columns that cite income, gender, age, ethnic background, or religious affiliation) you have two calculation methods available. One method calculates the percentage by column so that the sum of all of the entries in every column would be 100%. Another method calculates the percentage by row based on your selected row entry (or sum of entries) so that each percentage entry in the row is calculated based on that row (or sum of entries). For example, in the following table:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

The Column method determines the percentages of entries in Column A:

\[
\text{Percentage (A1)} = \frac{A1}{(A1 + A2)} \times 100\%; \quad \text{Percentage (A2)} = \frac{A2}{(A1 + A2)} \times 100\%
\]

The Row method determines the percentage for entries A1 and B1 based on C1 as a total column:
Percentage (A1) = A1/C1 x 100%; Percentage (B1) = B1/C1 x 100%

**Note:** Selecting a valid base entry (or the sum of the entries) is crucial to returning meaningful results. For example, if you choose a value in a population column and a base value from an income column, your results will not be meaningful.

- For more information, see *Creating New Districts and Redistricting using the Row Method* in the Help System.

### Options in Redistricting

To control the order of districts in the Districts Browser, on the Redistrict menu, click **Options**. The Redistrict Options dialog box displays. Choose your preferred sort order from among: most recently used, alphabetical, or unordered. You can also choose to show the Browser grid lines and save the options as your default.

As mentioned earlier, the Most Recently Used option can greatly aid you if you have more districts than the Districts Browser can display in a window. Whenever you select a map object that belongs to a district that is not currently visible in the Browser, MapInfo Professional will move that record near the top of the Browser window. You can then more easily set the new target district or view the changes in the data fields as you carry out your load-balancing scenario.

Changing the display of your districts is simple. Click the fill pattern, line style, or symbol in the Districts Browser that represents the district. The Region Style, Line Style, or Symbol Style dialog box displays, where you can change the tools used to display the district.

To save the style changes, you must save the redistricting session as a workspace. **Save Table** will only save the district assignment changes. The styles belong to a thematic layer, not to the table itself. The district changes are applied to the table and, thus, can be saved to the table.

### Records with No Graphic Objects

Redistricting involves grouping map objects into districts. If you are redistricting a table that contains records that do not have graphic objects associated with them, keep in mind that MapInfo Professional includes them as well in the Districts Browser. You cannot assign these records to new districts. They will affect your data calculations when you move objects into new districts.

If you have numerous records without graphic objects in your table, it may be best to create and save a subset of the table and run the Redistricter on the new table.

### Creating Expressions

Formulating expressions is something like writing sentences. There is a vocabulary of words from which you can draw, and these words have to be combined according to syntactic rules. The syntax of expressions is much simpler than the syntax of English, and the vocabulary is vastly smaller. However, most of us have been using English for years and so it seems easy and natural whereas formulating expressions is, at first, sometimes a bit difficult.
Creating Expressions

However, just as English has simple sentences and complex sentences, so there are simple expressions and complex ones. Even if you don’t get the hang of formulating complex expressions, you can still use all the MapInfo Professional® commands that use expressions. That is because formulating simple expressions is very easy and, at the same time, allows you to work with your data in powerful ways.

• Most of the procedural information for Creating Expressions is available in the Help System.

Where Expressions Can Be Used

Use the Expression dialog box to formulate mathematical and alphanumeric expressions in several MapInfo Professional dialog boxes. See the Help topic, Specifying an expression.

Expressions are used in the following commands: Select, Update Column, Thematic Mapping, and Layer Control (Labels > Label Options, Label drop-down list). The expression serves a different purpose in different commands.

For example:

• In the Select command the expression states a condition that a record in a table must meet in order to be included in a query table.
  • In Update Column the expression calculates a value that is then entered into a table.
  • In Thematic Mapping the expression calculates a value that is then displayed on a map.
  • In Label Options, you use expressions containing string functions to fine tune your labels.

The expressions fall into two broad categories:

• Expressions that must evaluate to true or false.
• Expressions that simply calculate some value.

Expressions that must evaluate to true or false always have a comparison operator and may have multiple clauses connected by logical operators. Use these expressions for selecting objects.

Expressions that simply calculate some value never have a comparison operator and generally do not have multiple clauses. Use these expressions to calculate values for Thematic Mapping, Update Column, and Label With Column in Layer Settings.

Constructing Simple Expressions

You formulate expressions using column (field) names and constants (i.e. specific data values), on the one hand, and functions and operators, on the other. Think of the column names and constants as nouns, and functions and operators as verbs, prepositions and conjunctions. You always need at least one column name or a constant in an expression. How many operators and functions you need depends on what you want to do with your expression.

The simplest possible expression consists of a column name, for example:

1. POP_1990
2. STATE
You could use such an expression in Thematic Mapping to indicate what data is to be represented on the map. In Update Column such an expression would tell MapInfo Professional what data to use in updating a column in the target table.

Here are some slightly more complex expressions:

3. POP_1990 > 17893
4. POP_1990 <= POP_1980
5. COUNTY <> "Orange"
6. POP_1980 * 1.2
7. POP_1990 / TOTAL_AREA
8. round(POP_1990/TOTAL_AREA,.1)

The first three examples use comparison operators. The first tests to see whether the 1990 population is greater than (>) some constant (17893). The second tests to see whether the value of one column, POP_1990, is less than or equal to (<=) the value of another column, POP_1980. The third tests to see whether or not the county is Orange. When the county does not equal (<>) “Orange” the record is selected. You could use any of these expressions in Select or in the Where Condition clause of SQL Select. These commands allow you to select a subset of the records in a table. The expression defines the characteristics of the subset.

Examples 6 and 7 use arithmetic operators. Example 6 multiplies (*) the value of POP_1980 by a constant (1.2) while example 7 divides one column, POP_1990, by the value of another column, AREA.

Example 8 uses the round function to round the value of the expression “POP_1990/TOTAL_AREA” to the nearest tenth (.1).

Expressions 6, 7 and 8 don’t have comparison operators and therefore they would not be suitable for use in Select or in the Where Condition clause of SQL Select. However, you could use them alone in Thematic Mapping, Update Column, or Select columns in SQL Select.

**Setting Filter Criteria for Expressions**

A filter criterion is a logical expression that usually compares a column value against some other value. For example, the following filter criterion uses the greater-than operator (>) to test whether the Order_Amount column has a value greater than one hundred:

Where Condition: Order_Amount > 100

If a query includes the preceding Where Condition clause, MapInfo Professional selects only the rows that have an Order_Amount value greater than one hundred.

The Where Condition field can contain two or more logical expressions if the expressions are separated by the word And or by the word Or. If the expressions are joined by the word And, MapInfo Professional only selects the rows that satisfy both criteria. If the expressions are joined by the word Or, MapInfo Professional selects any row that satisfies either criterion.

Filter criteria can use any column in your base table(s), regardless of whether you included the column in the Select Columns field.
Creating Expressions

Columns can be referred to by name or by number, where the number designates the order the column has in Select Columns. Thus, "col1" and "col6" refer to the first and sixth columns, respectively. The number must be preceded by the letters "col".

- For more instructions and related topics, see the Using Expressions to Create a New Column topic in the Help System.

Using Mathematical Operators in Expressions

Use the Expression dialog box to formulate mathematical and alphanumeric expressions in several MapInfo Professional dialog boxes. Mathematical operators are often used in creating expressions. The following chart shows the operator's symbol, name, example, and how the operators handle different data types.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Example</th>
<th>Detailed Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>plus</td>
<td>A + B</td>
<td>Date + Number: Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>04/01/2007 + 4: 04/05/2007</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FloatNumber + Date: Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 + 232: 236</td>
</tr>
<tr>
<td>-</td>
<td>minus</td>
<td>A - B (subtraction)</td>
<td>Date - Number: Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Number - Date: Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>236 - 4: 232</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>some number - some number: Float</td>
</tr>
<tr>
<td>*</td>
<td>times</td>
<td>A * B</td>
<td>some integer *some integer: Integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>some number * some number: Float</td>
</tr>
<tr>
<td>/</td>
<td>divided by</td>
<td>A / B</td>
<td>some number / some number: Float</td>
</tr>
<tr>
<td>^</td>
<td>exponentiation</td>
<td>A ^ B</td>
<td>some number ^ some number: Float</td>
</tr>
</tbody>
</table>

The following calculations are possible:
- Adding numbers to dates to yield another date.
- Subtracting a number from a date to yield another date.
- Subtracting a date from a date to yield a number.

When you add numbers to dates or subtract numbers from dates, MapInfo Professional treats the numbers as specifying a number of days. When you add or subtract a week, you use the number 7.

When you add or subtract a month, you use 30 or 31. When MapInfo Professional subtracts a date from a date, the result indicates a number of days.
Using String Operators in Expressions

Strings must be enclosed in double quotes. Consider the following example:

"Ms." + Last_Name

When MapInfo Professional evaluates this as part of an expression it places “Ms. “ in front of each last name. Note that the string constant (“Ms. “) is in quotes. Similarly,

"Hello," + "world"

gives you “Hello, world.” And

"4"+"5"

gives you “45.”

Using Comparison Operators in Expressions

Use the Expression dialog box to formulate mathematical and alphanumeric expressions in several MapInfo Professional dialog boxes. Comparison operators are often used in creating expressions. The following chart shows the comparison operator symbols and a description.

<table>
<thead>
<tr>
<th>Operators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>“equals”</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>“not equals”</td>
</tr>
<tr>
<td>&gt;</td>
<td>“greater than”</td>
</tr>
<tr>
<td>&lt;</td>
<td>“less than”</td>
</tr>
<tr>
<td>&gt;=</td>
<td>“greater than or equal to”</td>
</tr>
<tr>
<td>&lt;=</td>
<td>“less than or equal to”</td>
</tr>
</tbody>
</table>

The Help System contains these related topics:

- Numerical Comparison
- String Comparison
- Date Comparison
- Logical Comparison
Creating Expressions

Using Geographic Operators in Expressions

MapInfo Professional has several geographic operators. Use them to select objects on the basis of their spatial relationship to some other object. MapInfo Professional has a special keyword you use with geographical operators: “obj” or “object”. This keyword tells MapInfo Professional that it has to get values based on the graphical objects in the table rather than the tabular data.

The geographic operators go between the objects being specified. Select the geographic operators from the Operators menu. Here are the geographic operators:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains</td>
<td>Object A Contains object B if B’s centroid is anywhere within A’s boundary.</td>
</tr>
<tr>
<td>Contains Entire</td>
<td>Object A Contains Entire object B if B’s boundary is entirely within A’s boundary.</td>
</tr>
<tr>
<td>Contains Part</td>
<td>Object A Contains Part object B if B’s boundary is partly within A’s boundary.</td>
</tr>
<tr>
<td>Within</td>
<td>Object A is Within object B if its centroid is inside B’s boundary.</td>
</tr>
<tr>
<td>Entirely Within</td>
<td>Object A is Entirely Within object B if A’s boundary is entirely within B’s boundary.</td>
</tr>
<tr>
<td>Partly Within</td>
<td>Object A is Partly Within object B if A’s boundary is partly within B’s boundary.</td>
</tr>
<tr>
<td>Intersects</td>
<td>Object A Intersects object B if they have at least one point in common.</td>
</tr>
</tbody>
</table>

“Contains Part” and “Partly Within” are exactly equivalent to “Intersects” — these are all treated the same way by MapInfo Professional, so the standard syntax “Intersects” is almost universally used.

“Contains” and “Within” are concerned only with objects’ centroids.

“Contains Entire” and “Entirely Within” are concerned with the area covered by a region object; the location of the centroid doesn’t matter.

Similarly, a polyline can not contain a point, but it can intersect a point; a point can not be within a polyline, but it can intersect a polyline.

**Note:** MapInfo Professional can perform a simple Contains or Within comparison more rapidly than a Contains Entire or Entirely Within. Therefore, unless you must be absolutely sure that objects are completely inside other objects you should use Contains and Within rather than Contains Entire or Entirely Within.
Using Logical Operators in Expressions

“And”, “or”, and “not” are logical operators. You use them to combine expressions in Select and the Where Condition clause of SQL Select. MapInfo Professional treats each such an expression as a test, which it applies to each record in the table. For each test it gets a yes/no (true/false) answer. MapInfo Professional uses the logical operators to tell it how to combine the individual yes/no answers into an overall yes/no answer: Does the current record meet the selection condition?

Suppose you want to select all properties that are worth $250,000 or more and are in Columbia county. Each record has to meet two criteria, each of which can be formulated as a simple expression:

9. \( \text{VALUE} \geq 250000 \)

10. \( \text{COUNTY} = \text{“Columbia”} \)

You could perform one selection for all properties worth $250,000 or more. Then you could perform another selection on that result, looking for all properties in Columbia county. However, it is easier to combine the two operations into one using the logical operator “and”.

11. \( \text{COUNTY} = \text{“Columbia”} \) and \( \text{VALUE} \geq 250000 \)

When MapInfo Professional examines a record to see whether or not it meets the condition set by this expression, it makes the two tests: Does COUNTY equal Columbia? Is the VALUE equal to or greater than 250000? When the answer to both of these questions is true (or yes), then the record is accepted into the current selection. When the answer to one or both of the questions is no (or false), then the record is not accepted into the current selection.

Now, what if you want all properties worth $250,000 or more and not in Columbia county? You can use “not” to negate the first clause of expression 33, yielding expression 34:

12. \( \text{not} (\text{COUNTY} = \text{“Columbia”}) \) and \( \text{VALUE} \geq 250000 \)

Only records where the county is not Columbia satisfy the first clause of expression 34. Now consider expression 35:

13. \( \text{not} (\text{COUNTY} = \text{“Columbia”} \) and \( \text{VALUE} \geq 250000) \)

Expression 35 is simply the negation of expression 33. Any record that would satisfy 33 does not satisfy 35. Any record that does not satisfy 33 satisfies 35.

You can use “or” when you want to specify alternative conditions, such as:
14. COUNTY="Columbia" or COUNTY="Greene"

Any record evaluated against this condition is accepted if its county is any one of the two specified counties. One could, of course, use numerical tests as well. For example:

15. TOTAL_AREA>40 or VALUE>250000

This tests to see whether the area is greater than 40 or the value is greater than 250000. When either one is true of a record, then that record is accepted into the selection.

In formulating expressions using logical operators you have to be careful how you use them. The following expression, while it seems OK, does not work:

16. COUNTY="Columbia" or "Greene"

Judging from its English translation—COUNTY equals Columbia or Greene—this expression should operate just like expression 36 and give us any record containing Columbia County or Greene County. But the rules of computational logic and the rules of English are a bit different.

When MapInfo Professional reads expressions it reads them from left to right. One of the things it has to do is to determine how the items in the expression are grouped. Think of this operation as inserting parentheses into the expression. MapInfo Professional reads expression 35 as though it were grouped like expression 39, which is what we intend.

It reads expression 38 as though it were grouped like 40, which is not at all what we want.

17. (COUNTY="Columbia") or (COUNTY="Greene")

18. (COUNTY="Columbia") or ("Greene")

Both 39 and 40 have the same first clause. But their second clauses (after the “or”) are quite different. The second clause of 40 is simply a literal string, “Greene.” By convention, MapInfo Professional evaluates a record against a literal string as being true if that record is not blank. When MapInfo Professional evaluates records against expression 40, all non-blank records are evaluated as true and be accepted into the selection. It does not make any difference how a record evaluates on the first clause. Any non-blank record evaluates as true on the second clause, and one “true” is all it takes to evaluate the entire expression as true.

Let us consider one final example, which is the negation of expression 36:

19. not (COUNTY="Greene" or COUNTY="Columbia")

Expression 39 is satisfied if the county is Greene or if it is Columbia, but not if it is Montgomery or Warren. Expression 41 is satisfied by any county other than Greene or Columbia, including Montgomery and Warren.

The Help System contains these related topics:

• Numeric Clauses
• String Clauses
• Date Clauses
• Keyword Clauses
Understanding Operator Precedence

When MapInfo Professional evaluates expressions it needs to know which components of an expression to evaluate first. This is called precedence. By convention, certain operators are assigned different levels of precedence. Those with the highest level are evaluated first. The following table lists MapInfo Professional’s operators in the order in which they are evaluated. Exponentiation evaluates from the right. This affects expressions with multiple exponents: \(2^{-(3^{-4})} = 2^{-(3^{-4})}\)

Operators at the same level of precedence are evaluated from left to right.

<table>
<thead>
<tr>
<th>Highest Priority:</th>
<th>Parenthesis</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Exponentiation</td>
</tr>
<tr>
<td></td>
<td>Negation</td>
</tr>
<tr>
<td></td>
<td>Multiplication, Division</td>
</tr>
<tr>
<td></td>
<td>Addition, Subtraction</td>
</tr>
<tr>
<td></td>
<td>Geographic operators, Comparison operators</td>
</tr>
<tr>
<td></td>
<td>Not</td>
</tr>
<tr>
<td></td>
<td>And</td>
</tr>
<tr>
<td>Lowest Priority:</td>
<td>Or</td>
</tr>
</tbody>
</table>

For example, the expression \(3 + 4 \times 2\) produces a result of 11. That is because multiplication has a higher precedence than addition and is performed first, in effect:

\[
3 + 4 \times 2 =
3 + 8 =
11
\]

We can add parenthesis to force MapInfo Professional to do the addition first:

\[
(3 + 4) \times 2 =
7 \times 2 =
14
\]

Now consider expression 60, which is intended to select all records July or September of 1989.

20. \text{year(RECEIVED)} = 89 \text{ and month(RECEIVED)} = 7 \text{ or month(RECEIVED)} = 9

Because “and” has higher precedence than “or”, MapInfo Professional treats this expression as though “\text{year(RECEIVED)} = 89 \text{ and month(RECEIVED)} = 7” was enclosed in parentheses.

21. \text{(year(RECEIVED)} = 89 \text{ and month(RECEIVED)} = 7 \text{ or month(RECEIVED)} = 9

In this case, any record for July of 89 or for September of any year would be selected. That’s probably not what you want. However, by adding parentheses to the second expression, you can get this:
22. \text{year(RECEIVED)}=89 \text{ and } (\text{month(RECEIVED)}=7 \text{ or } \text{month(RECEIVED)}=9)\)

In this expression, the parentheses tell MapInfo Professional that “\text{month(RECEIVED)}=7” and “\text{month(RECEIVED)}=9” are alternatives in the second clause of the expression. MapInfo Professional treats this the same as it treats number 53 above.

\textbf{Note:} When you are not sure how MapInfo Professional evaluates an expression with several operators, you should use parentheses to group elements as you want them.

\section*{Using Functions in Expressions}

Functions take data values and perform some operation on them to produce a new value. Functions have the following form:

\text{SomeFunction(parameters)}

Most of MapInfo Professional’s functions take one or two parameters. A parameter can be a column or another expression. MapInfo Professional uses the keyword “\text{obj}” or “\text{object}” with the geographic functions: \text{Area}, \text{CentroidX}, \text{CentroidY}, \text{ObjectLen}, and \text{Perimeter}. This keyword tells MapInfo Professional that it has to get values based on graphical objects in the table rather than tabular data.

• For more information about specific functions, see the \textit{Help System}.

\section*{Working with the MapBasic Window}

This section allows advanced MapInfo Professional\textsuperscript{®} users to go behind the scenes and take advantage of functions that enhance the use of MapInfo Professional through the MapBasic window. MapBasic\textsuperscript{®} is MapInfo Professional’s programming language that allows you to customize and automate MapInfo Professional functionality. When MapBasic was created, the MapBasic Window feature was added to MapInfo Professional as a means of testing and debugging code for an application. It became apparent that the MapBasic window is also a useful tool to MapInfo Professional users for doing certain tasks such as complex selections and queries based on object information.

The MapBasic window is limited to selected commands from the MapBasic programming language. The MapBasic window can take commands line by line. It does not include the capability for looping, interapplication communication, and other more complex commands. If you find yourself using the MapBasic window often, you may want to consider transferring your code to a MapBasic application that will automate the process.

\textbf{Note:} There is a comprehensive list of MapBasic functions and statements you can use from the MapBasic window in the \textit{Help System}.

\section*{Accessing the MapBasic Window}

To access the MapBasic window, on the \textbf{Options} menu, click \textit{Show MapBasic Window}. The MapBasic window displays on your screen. As with any other window, you may resize it or move it to a new location. The window allows you to enter MapBasic code or to view MapBasic code as it is generated by MapInfo Professional.
To see how MapInfo Professional carries out a select statement:

1. Open the MapBasic window and then open the WORLD table.

2. On the Query menu, click Select.

3. Type in the expression \texttt{Pop\_1994 > 1000000}. Make sure that the Browse Results box is checked.

4. Click OK. The syntax for these commands appears in the MapBasic window as follows:

\begin{verbatim}
Open Table "C:\MAPINFO\DATA\WORLD\WORLD.tab" Interactive
Map From World
select * from World where Pop\_1994 > 1000000 into Selection
browse * from Selection
\end{verbatim}

The first line is a result of opening the WORLD table. The second line of code is written automatically because the WORLD table displays in a Map window by default. The third line is the syntax for the select statement. The fourth line is the result of checking the Browse results box.

You can also enter MapBasic commands into the MapBasic window. Position your cursor under the browse from Selection line. Type the following:

\begin{verbatim}
Map from Selection
\end{verbatim}

Press Enter after the line, and the command executes. You should see your selection displayed in a Map window.

As stated before, the MapBasic window was primarily designed to assist MapBasic programmers. You can statements and functions in the MapBasic window such as \texttt{Buffer( )} function or Insert statement.

Refer to the MapBasic Reference Guide, which is located in the Documentation subfolder of your installation directory to find the appropriate usage and syntax for these statements and functions. It provides a comprehensive guide to MapBasic programming statements and functions along with examples.

### Running a MapBasic Program

Use Run in the Tools menu to run a MapBasic program. MapBasic is a programming language that you can use to customize or automate MapInfo Professional. To create MapBasic applications, you need the MapBasic compiler, which is a separate product. However, you do not need the MapBasic compiler to run a completed MapBasic application.

MapInfo Professional comes with an assortment of completed MapBasic applications. Some examples include:

- Symbol application (symbol.mbx). Creates custom symbol shapes.
- Scale Bar application (scalebar.mbx). Annotates a map with a distance scale.
- Named Views application (nviews.mbx). Assigns a name to the current map view and use that name to return to that view later.
- Overview application (overview.mbx). Opens a second Map window that displays an overview of the current map (also referred to as an area detail map).
To run a MapBasic application:

1. Choose **Tools > Run MapBasic Program**. The **Run MapBasic Program** dialog box displays.
2. Choose a directory.
3. Choose an application from the list (MapBasic applications have an .mbx extension).
4. Click **OK**.

MapInfo Professional then runs the MapBasic application.

**Running a MapBasic Program Using a Startup Workspace**

You can use a startup workspace to run a MapBasic application. However, you cannot create this kind of workspace using Save Workspace As. When you want to run a MapBasic application in your startup workspace, you need to create the workspace with a text editor.

1. Place the following into an ASCII file:

   ```
   !workspace
   !version 700
   run application "someprog.mbx"
   ```

2. Replace "Someprog.app" with the name of the MapBasic application you want to launch from the startup workspace.

3. Name this file STARTUP.WOR.

4. Place this file in your MapInfo Professional program directory or in your home directory.

The *Help System* contains these and other related topics:

- Copying the Contents of the MapBasic Message Window
- Issuing Commands through the MapBasic Window
- Examples of MapBasic Programs
- Creating Circles around Points using the MapBasic Window
- Most of the procedural information for *Digitizing Maps with MapInfo Professional* is available in the *Help System*. 

Glossary of Terms
### Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DMap</td>
<td>A window that allows you to view your maps containing continuous grids from various viewpoints in 3D Format.</td>
</tr>
<tr>
<td>Add Node Button</td>
<td>Use the Add Node button to add a node to regions, polylines, and arcs. You can add nodes when the Reshape tool is in effect. Adding nodes can give more precision to your object.</td>
</tr>
<tr>
<td>Address Dictionary</td>
<td>The search dictionary used for matching addresses during geocoding.</td>
</tr>
<tr>
<td>Alias</td>
<td>The name assigned to an expression or a column when you are working in the Select Columns field in the SQL Select dialog box. This name appears as the column title for that expression or column in a Browser.</td>
</tr>
<tr>
<td>Application</td>
<td>A computer program used for a particular kind of work, such as word processing. Application is often interchangeable with the word program.</td>
</tr>
<tr>
<td>Arc Button</td>
<td>The Arc button allows you to access the Arc tool. Use the Arc tool to draw an arc the size and shape of one quarter of an ellipse. Once you have created an arc, you can reshape it to the desired size.</td>
</tr>
<tr>
<td>ASCII</td>
<td>The acronym for American Standard Code for Information Interchange. ASCII is a standard code used in most microcomputers, computer terminals, and printers for representing characters as numbers. It not only includes printable characters, but also control codes to indicate carriage return, backspace, and so forth.</td>
</tr>
<tr>
<td>Assign Selected Objects Button</td>
<td>Use this button to permanently assign all selected map objects to the target district.</td>
</tr>
<tr>
<td>Axis</td>
<td>Used in a graph, these are graduated lines bordering the plot area of a graph. Location coordinates are measured relative to the axes. By convention the X-axis is horizontal, the Y-axis is vertical.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>A type of thematic map that displays a bar chart of thematic variables for each record in a table from which the map is based.</td>
</tr>
<tr>
<td>Base Map</td>
<td>Usually the dominant or underlying layer in a given map. (These are typically the data layers that MapInfo® offers as ready products.) Users usually layer their own data on top of these base maps or use these base maps to geocode or to make new layers. Examples are joining industry data to postal code boundaries for analysis and then combining arrangements of the postal codes into new territory layers.</td>
</tr>
<tr>
<td>Base Table</td>
<td>A permanent table, which is part of a map, as opposed to a query table, which is temporary. You can edit the contents of base tables, and you can change their structure (by editing, deleting, reordering columns and adding or deleting graphic objects).</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bitmap</td>
<td>A screen image displayed as an array of dots or bits. Software usually generates either bit-mapped (raster) or object-oriented (vectored) files. MapInfo Professional can work with both.</td>
</tr>
<tr>
<td>Boundary Region</td>
<td>In GIS a boundary is a region on a map enclosed by a border. Cambria County, Manitoba, and Argentina would all be represented as boundaries on a map. Note that a single boundary could encompass several polygons. Thus, Indonesia is a single boundary but consists of many polygons.</td>
</tr>
<tr>
<td>Boundary Select Button</td>
<td>The Boundary Select button allows you to access the Boundary Select tool. Use the Boundary Select Tool to search for and choose all the objects within a given region, such as a state or county boundary, a police patrol district, a sales territory, and so forth.</td>
</tr>
<tr>
<td>Browser</td>
<td>A window for viewing a table (or database, spreadsheet or text file) in tabular form.</td>
</tr>
<tr>
<td>Buffer</td>
<td>A type of proximity analysis where areas or zones of a given distance are generated around selected map objects. Buffers are user-defined or can be generated for a set of objects based on those objects' attribute values. The resulting buffer zones form region objects representing the area that is within the specified buffer distance from the object.</td>
</tr>
<tr>
<td>Cadastral</td>
<td>A map set used to graphically define the cadastre or land ownership in a given area. A tax map is an example of a cadastral map. The land registration, assessment roles, and tax maps comprise the cadastre.</td>
</tr>
<tr>
<td>Cancel Button</td>
<td>A command button for closing a dialog box without making changes.</td>
</tr>
<tr>
<td>Cartesian</td>
<td>A coordinate system using an x,y scale not tied to any “real-world” system. Most CAD drawing uses this method of registering objects (for example, a drawing of a ball-bearing assembly, floor plans). If a drawing uses Cartesian coordinates, one corner of the drawing probably has coordinates 0, 0.</td>
</tr>
<tr>
<td>Cartesian Coordinates</td>
<td>The conventional representation of geometric objects by x and y values on a plane.</td>
</tr>
<tr>
<td>Cartographic Legend</td>
<td>A MapInfo Professional legend window that enables you to display cartographic information for any map layer in the Map window.</td>
</tr>
<tr>
<td>Cartography</td>
<td>The art and science of making maps. In GIS it is also the graphic presentation and visual interpretation of data.</td>
</tr>
</tbody>
</table>
### Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Centroid</strong></td>
<td>Usually the center of a map object. For most map objects, the centroid is located at the middle of the object (the location halfway between the northern and southern extents and halfway between the eastern and western extents of the object). In some cases, the centroid is not at the middle point because there is a restriction that the centroid must be located on the object itself. Thus, in the case of a crescent-shaped region object, the middle point of the object may actually lie outside the limits of the region; however, the centroid is always within the limits of the region. In MapInfo Professional, the centroid represents the location used for automatic labeling, geocoding, and placement of thematic pie and bar charts. If you edit a map in Reshape mode, you can reposition region centroids by dragging them.</td>
</tr>
<tr>
<td><strong>Change View Button</strong></td>
<td>This button allows you to change the zoom, map scale, and window centering aspects of the Map or Layout that currently displays.</td>
</tr>
<tr>
<td><strong>Check Box</strong></td>
<td>A small square box that appears in a dialog box. You can click in the check box or on the text in order to select the option. Check boxes are generally present when multiple options can be selected at one time.</td>
</tr>
<tr>
<td><strong>Click</strong></td>
<td>To press and release a mouse button quickly.</td>
</tr>
<tr>
<td><strong>Column</strong></td>
<td>A column in a Browser corresponds to a field in a table. A column contains a specific type of information about an object, such as Name, Abbreviation, Land area, Price, Population, and so forth. The information for each object is listed on a row in the Browser.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td>A word or phrase, usually found in a menu, that displays a dialog box and/or carries out an action.</td>
</tr>
<tr>
<td><strong>Conflict Resolution</strong></td>
<td>When conflicts exist between the data residing on a remote database and new data that you want to upload to the remote database via a MapInfo Professional linked table. The conflict resolution process is invoked whenever an attempt to save the linked table detects a conflict in an update.</td>
</tr>
<tr>
<td><strong>Control Menu</strong></td>
<td>A menu activated through the Control Menu Box located in the upper left corner of all windows. The control menu is used to resize, move, maximize, minimize, or close the window.</td>
</tr>
<tr>
<td><strong>Control Points</strong></td>
<td>The points on a raster image whose coordinates serve as a reference for associating earth coordinates with any location on the image. See Registration on page 510.</td>
</tr>
<tr>
<td><strong>Coordinate</strong></td>
<td>An x,y location in a Cartesian coordinate system, or a Latitude, Longitude location in an earth coordinate system. Coordinates represent locations on a map relative to other locations. Earth coordinate systems may use the equator and the Greenwich prime meridian as fixed reference points. Plane coordinate systems describe a two-dimensional x,y location in terms of distance from a fixed reference and are usually in the first quadrant so that all coordinates are positive numbers.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Coordinate System</td>
<td>A coordinate system is used to create a numerical representation of geometric objects. Each point in a geometric object is represented by a pair of numbers. Those numbers are the coordinates for that point. In cartography, coordinate systems are closely related to projections. You create a coordinate system by supplying specific values for the parameters of a projection. See <a href="#">Cartesian Coordinates on page 499</a>, <a href="#">Projection on page 509</a>, and <a href="#">Spherical Coordinates on page 511</a>.</td>
</tr>
<tr>
<td>Cosmetic Layer</td>
<td>The topmost layer of a Map window. Objects may be placed in this layer such as map titles and graphic objects. It is always displayed, and all objects placed in the Cosmetic Layer must be saved to a new or existing layer.</td>
</tr>
<tr>
<td>Data Aggregation</td>
<td>A process that occurs when combining separate map objects into a single object. MapInfo Professional calculates what the column values for the new object should be, based on sums or averages of the values of the original objects.</td>
</tr>
<tr>
<td>Data Disaggregation</td>
<td>A process that occurs when splitting a map object(s) into smaller parts where MapInfo Professional splits the data associated with the map object(s) into smaller parts to match the new map objects.</td>
</tr>
<tr>
<td>Data Sources</td>
<td>An ODBC data source is an SQL database and the information you need to access that database. For example, an SQL Server data source is the SQL Server database, the server on which it resides, and the network used to access that server.</td>
</tr>
<tr>
<td>Database</td>
<td>Any organized collection of data. The term is often used to refer to a single file or table of information in MapInfo Professional.</td>
</tr>
<tr>
<td>Decimal Degree</td>
<td>The decimal representation of fractions of degrees. Many paper maps express coordinates in degrees, minutes, seconds (for example, 40.30/10), where minutes and seconds are fractions of degrees. 30 minutes equal half a degree, and 30 seconds equal half a minute. MapInfo Professional, however, expresses coordinates in decimal degrees (for example, 72.558 degrees), where fractions of degrees are expressed as decimals. Thus, the longitude: 40 degrees, 30 minutes, would be expressed in MapInfo Professional as 40.5 degrees.</td>
</tr>
<tr>
<td>Default</td>
<td>The value or option used in the absence of explicit specification. Often the original setting or value for a variable.</td>
</tr>
<tr>
<td>Degrees Longitude,</td>
<td>Degrees (longitude and latitude) are coordinates used to represent locations on the surface of the earth. Longitude, or X-coordinate, represents a location’s east-west position, where any location west of the prime meridian has a negative X value. Latitude, or Y-coordinate, represents a location’s north-south position, where any location south of the equator has a negative Y value.</td>
</tr>
<tr>
<td>Degrees Latitude,</td>
<td></td>
</tr>
<tr>
<td>Degrees Decimal Degrees</td>
<td></td>
</tr>
<tr>
<td>Derived Column</td>
<td>In a table created through the SQL Select, a derived column is one created by using an expression. The column is derived in the sense that it isn’t just a copy of the data in one of the tables being accessed by the SQL Select command.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Derived Field</td>
<td>The same as a derived column.</td>
</tr>
<tr>
<td>Deselect</td>
<td>The process of undoing a selection. The object or area you deselect will not be affected by subsequent commands. Performed by selecting another area, by clicking in a blank area, or by executing the Unselect All command.</td>
</tr>
<tr>
<td>Digitizer, Digitizing Tablet</td>
<td>An electronic device that lets you trace a paper map into a GIS or CAD package. The digitizer consists of a table (or tablet) onto which you attach a paper map. You then can trace the map by moving a hand-held, mouse-like device known as a cursor, or puck, across the surface. Digitizing a map produces vector data as the end result.</td>
</tr>
<tr>
<td>Districts Browser</td>
<td>A special browser that displays when redistricting. It differs from other Browser windows in the following respects: one row can only be selected at one time, one row is always selected, and the selected row becomes the target district into which you can add other objects.</td>
</tr>
<tr>
<td>Dot Density Map</td>
<td>A type of thematic map that carries information by showing a large number of tiny dots, wherein each dot represents some specific unit quantity. For example, for a population dot density map each dot might represent 10,000 people.</td>
</tr>
<tr>
<td>Drawing Toolbar</td>
<td>A MapInfo Professional window containing twelve buttons that access tools for drawing and modifying objects on your map or layout.</td>
</tr>
<tr>
<td>Edit Handle</td>
<td>The small boxes that appear at the four corners of the minimum bounding rectangle of an object in an editable layer of a Map window or in a Layout window.</td>
</tr>
<tr>
<td>Ellipse Button</td>
<td>The Ellipse button allows you to access the Ellipse tool. Use the Ellipse tool to create elliptical and round objects.</td>
</tr>
<tr>
<td>Export</td>
<td>The process whereby a program saves information in a file to be used by another program.</td>
</tr>
<tr>
<td>Expression</td>
<td>A statement containing two parts: 1) column names and constants (i.e., specific data values), and 2) functions (for example, area) and operators (for example, +, -, &gt;), in order to extract or derive information from a database. Expressions are used in Select, SQL Select, Update Column, Create Thematic Map, and Label with Column.</td>
</tr>
<tr>
<td>Field</td>
<td>A field in a table corresponds to a column in a Browser. A field contains a specific type of information about an object, such as, name, abbreviation, land area, price, population, and so forth. The record for each object consists of that object’s values for each of the fields in the database.</td>
</tr>
<tr>
<td>File</td>
<td>A collection of information that has been given a name and is stored on some electronic medium such as a tape or disk. A file can be a document or an application.</td>
</tr>
<tr>
<td>Fill Pattern</td>
<td>The design and color used to fill a closed object.</td>
</tr>
<tr>
<td>Font</td>
<td>A character set based on a particular style used for text characters.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Frame Button</td>
<td>The Frame button allows you to create frames in a layout. Each frame can display a map, graph, Browser, map legend, graph legend, Info window, statistics window, and message window or, it can be an empty frame.</td>
</tr>
<tr>
<td>Generalization</td>
<td>The process of simplifying a data set to a size that can be easily manipulated and represented. For example, a river may have many twists and turns; however, if a map covers a very large area, the river may be represented as a straight line. Similarly, in a map of a very large area, a city might be represented as a point marker.</td>
</tr>
<tr>
<td>Geocode</td>
<td>The process of assigning X and Y coordinates to records in a table or database so that the records can be displayed as objects on a map.</td>
</tr>
<tr>
<td>Geographic Information System (GIS)</td>
<td>An organized collection of computer hardware and software designed to efficiently create, manipulate, analyze, and display all types of geographically or spatially referenced data. A GIS allows complex spatial operations that are very difficult to do otherwise.</td>
</tr>
<tr>
<td>Grabber Button</td>
<td>The Grabber Button allows you to access the Grabber tool. Use the Grabber tool to reposition a map or layout within its window.</td>
</tr>
<tr>
<td>Graduated Symbols Map</td>
<td>A type of thematic map that shows symbols (point objects) in a variety of sizes to indicate which objects have higher or lower numerical values.</td>
</tr>
<tr>
<td>Graph window</td>
<td>A window that displays numerical data in the form of a graph.</td>
</tr>
<tr>
<td>Graticule</td>
<td>A grid of horizontal (latitude) and vertical (longitude) lines displayed on an earth map, spaced at a regular distance (for example, every five degrees, every fifteen degrees). Used to establish a frame of reference.</td>
</tr>
<tr>
<td>Grid Surface Map</td>
<td>A type of thematic map that displays data as continuous color gradations across the map. This type of thematic map is produced by an interpolation of point data from the source table. A grid file from the data interpolation is generated and is displayed as a raster image in a Map window.</td>
</tr>
<tr>
<td>Heads-Up Digitizing</td>
<td>A method of digitizing where the user creates vector objects by tracing over a raster image displayed on the screen. Thus, heads-up digitizing does not require a digitizing tablet.</td>
</tr>
<tr>
<td>Help Button Bar</td>
<td>A bar located at the top of the Help Window that contains buttons you use to move to Help topics.</td>
</tr>
<tr>
<td>Horizontal Scroll Bar</td>
<td>The Horizontal scroll bar appears at the bottom of the MapInfo Professional window. Use the horizontal scroll bar to move left and right. The scroll box inside the scroll bar indicates your horizontal location. You can use the mouse to scroll to other parts of the window.</td>
</tr>
<tr>
<td>Hot Views</td>
<td>MapInfo Professional technology that automatically updates all the windows you have open for a particular table when you make a change in any one of the windows. For example, if an item is selected in a Map window, it will be selected in all other Map windows and Browsers you have open for that table.</td>
</tr>
<tr>
<td>Import</td>
<td>The process whereby a program loads a file that is the output of another program.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Individual Values Map</td>
<td>A type of thematic map that shades records according to individual values.</td>
</tr>
</tbody>
</table>
| Inflection        | The process of deviating the color in ranged thematic maps to emphasize some numerical significance. In thematic mapping we insert a new color between the top and bottom color for second interpolation of data.  
For example, suppose we were showing population growth with blue representing an increase in population growth and red representing a decrease in population growth.  
We could have white as the inflection color for a range that has zero or almost zero population growth, so that lighter shades of blue would represent a smaller population growth and lighter shades of red would represent a smaller decline in population. |
<p>| Info Button       | The Info button allows you to access the Info tool. Use the Info tool to select a location on your map, including multiple overlapping objects and display a list of all objects at that location. You can then choose an object from the list and view the tabular data for that object. |
| Islands           | Small areas outside the main boundary that can be reached within the specified time or distance.                                                                                                             |
| IsoChrone         | An IsoChrone is a polygon or set of points representing an area that can be traversed from a starting point in a given amount of time along a given road network.                                                 |
| IsoDistance       | An IsoDistance is a polygon or set of points representing an area that can be traversed from a starting point travelling a given distance along a given road network.                                             |
| Isogram           | An Isogram is a map that displays a set of points that satisfy a distance or time condition. Isograms are either IsoChrones or IsoDistances.                                                                      |
| Join              | The process of creating a relational link between two tables (databases).                                                                                                                                       |
| Latitude          | The horizontal lines on a map that increase from 0 degrees at the Equator to 90 degrees at both the North (+90.0 degrees) and South (-90.0 degrees) poles. Used to describe the North-South position of a point as measured usually in degrees or decimal degrees above or below the equator. |
| Layer             | A layer is a basic building block of MapInfo Professional maps and consists of a table with graphic and text settings like style override, labeling, and zoom layering. Maps are made of one or more superimposed layers (for example, a layer of street data superimposed over a layer of county or postal code boundaries) which you can design to convey geographical or statistical information. Typically, each map layer corresponds to one open table. Cosmetic Layers contain map objects that represent temporary map annotations (for example, text objects). Cosmetic Layers contain map objects that represent temporary map annotations (for example, labels). See Cosmetic Layer on page 501 and Table on page 512. |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer Control Button</td>
<td>The Layer Control Button allows you to access the Layer Control dialog box. This dialog box allows you to specify how the various tables in a Map window are layered and displayed. See Accessing Layer Control on page 162.</td>
</tr>
<tr>
<td>Layout Window</td>
<td>A window where you arrange and annotate the contents of one or several windows for printing.</td>
</tr>
<tr>
<td>Legend</td>
<td>The part of a map, which explains the meaning of different colors, shapes, or fill patterns used on the map. See also Cartographic Legend on page 499.</td>
</tr>
<tr>
<td>Legend Frames</td>
<td>Each legend window contains one or more legend frames each corresponding to a style or theme layer in the Map window.</td>
</tr>
<tr>
<td>Legend Window</td>
<td>A window containing legend frames. You can create more than one legend window for each map. The legend window can contain more than one frame. For example, you can have one legend window containing four legend frames, or you can have four legend windows, each containing one legend frame.</td>
</tr>
<tr>
<td>Legend Window Button</td>
<td>Use the Legend Window button to display the Legend window associated with maps or graphs.</td>
</tr>
<tr>
<td>Line, Line Object</td>
<td>A map object defined by a set of sequential coordinates that may represent the generalized shape of a geographic feature (for example, street centerlines, railroads, cables). A MapInfo street map is a collection of thousands of line objects.</td>
</tr>
<tr>
<td>Line Button</td>
<td>The Line button allows you to access the Line tool. Use the Line tool to draw straight lines.</td>
</tr>
<tr>
<td>Line Style Button</td>
<td>Use the Line Style button to access the Line Style dialog box. The Line Style dialog box allows you to set the line type, thickness and color of line objects (lines, arcs and polylines) and borders of closed objects. You can also change the type, thickness and color of objects you are editing.</td>
</tr>
<tr>
<td>Linked Table</td>
<td>A linked table is a special kind of MapInfo table that is downloaded from a remote database and retains connections to its remote database table. You can perform most operations on a linked table that you do for a regular MapInfo table.</td>
</tr>
<tr>
<td>Longitude</td>
<td>The vertical lines on a map, running from the North to South poles, used to describe the east-west position of a point. The position is reported as the number of degrees east (to -180.0 degrees) or west (to +180.0 degrees) of the prime meridian (0 degrees). Lines of longitude are farthest apart at the Equator and intersect at both poles, and therefore, are not parallel.</td>
</tr>
<tr>
<td>Longitude/Latitude</td>
<td>MapInfo Professional's default coordinate system for representing geographic objects in a map.</td>
</tr>
<tr>
<td>Main Toolbar</td>
<td>A window containing buttons for choosing tools, accessing dialog boxes, and showing or hiding windows.</td>
</tr>
</tbody>
</table>
## Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Map Catalog</strong></td>
<td>The MapInfo map catalog stores information about the location of spatial columns on the DBMS. There must be one catalog per database. The EasyLoader application can create this catalog for each database: Oracle 8, 9, Informix, SQL Server, and MS Access. Additionally, you can create a map catalog manually with instructions in the MapInfo Professional User Guide. This is a one-time only task per database and is required before any tables on that database can be mapped in MapInfo Professional.</td>
</tr>
<tr>
<td><strong>Map Scale</strong></td>
<td>A statement of a measure of the map and the equivalent measure on the earth. Often expressed as a representative ratio of distance, such as 1:10,000. This means that one unit of distance on the map (for example, one inch) represents 10,000 of the same units of distance on the earth. The term <em>scale</em> must be used carefully. Technically, a map of a single city block is <em>large-scale</em> (e.g., 1:12,000), while a map of an entire country is <em>small-scale</em> (e.g., 1:1,000,000). A 1:1,000,000 map is considered small-scale because of the small numeric value obtained when you divide 1 by 1,000,000.</td>
</tr>
<tr>
<td><strong>Map Segment</strong></td>
<td>In a street map, a segment is a single section of the street. In urban maps, segments are generally one block long. Address ranges are stored at the segment level.</td>
</tr>
<tr>
<td><strong>MapBasic</strong></td>
<td>The programming language used to customize and/or automate MapInfo Professional. To create MapBasic applications, you need the MapBasic compiler, which is a separate product. However, you do not need the MapBasic compiler to run a compiled MapBasic application.</td>
</tr>
<tr>
<td><strong>Map Scale</strong></td>
<td>A statement of a measure of the map and the equivalent measure on the earth and often expressed as a representative ratio of distance, such as 1:10,000. This means that one unit of distance on the map (e.g., one inch) represents 10,000 of the same units of distance on the earth. The term <em>scale</em> must be used carefully. Technically, a map of a single city block is <em>large-scale</em> (e.g., 1:12,000), while a map of an entire country is <em>small-scale</em> (e.g., 1:1,000,000). A 1:1,000,000 map is considered small-scale because of the small numeric value obtained when you divide 1 by 1,000,000.</td>
</tr>
<tr>
<td><strong>Map window</strong></td>
<td>A window that allows you to view a table as a map.</td>
</tr>
<tr>
<td><strong>Meridian</strong></td>
<td>A line or a portion of a line running from the North to the South pole. A longitudinal line.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Military Grid Reference System</strong></td>
<td>The U.S. Military Grid Reference System (MGRS) is a grid reference system that MI Pro supports when displaying maps in a Map window. It is the military version of the civilian-use Universal Transverse Mercator (UTM) grid system. Military grid references are very similar to the mathematical Cartesian x,y system in which coordinates are giving in terms of x (easting) and y (northing). In this system, the world is generally divided into 6° by 8° geographic areas, each of which is given a unique identification, called the Grid Zone Designation. These areas are covered by a pattern of 100,000-meter squares. Each square is identified by two letters called the 100,000-meter square identifications. A reference keyed to a gridded map of any scale is made by giving the 100,000- meter square identification together with the numerical location. Numerical references within the 100,000-meter square are given to the desired accuracy in terms of the easting (E) and northing (N) grid coordinates for the point. The Grid Zone Designation usually is prefixed to the identification when references are made in more than one grid zone designation area.</td>
</tr>
<tr>
<td><strong>Minimum Bounding Rectangle (MBR)</strong></td>
<td>For any given map object, the smallest rectangle that completely encompasses the object.</td>
</tr>
<tr>
<td><strong>Native Projection</strong></td>
<td>The projection in which a map’s coordinate points are stored. MapInfo Professional allows you to display maps in other projections, but not as fast as displaying maps in their native projection.</td>
</tr>
<tr>
<td><strong>Node</strong></td>
<td>An end-point of a line object, or an end-point of a line segment which is part of a polyline or region object.</td>
</tr>
<tr>
<td><strong>Non-Earth Map</strong></td>
<td>A map in which objects are not explicitly referenced to locations on the earth’s surface. Floor plans are typical examples.</td>
</tr>
<tr>
<td><strong>ODBC Drivers</strong></td>
<td>An ODBC driver is a dynamic-link library (.DLL) file that MapInfo Professional uses to connect to an SQL database. Each type of SQL database requires a different ODBC driver.</td>
</tr>
<tr>
<td><strong>ODBC Table</strong></td>
<td>An ODBC table is a table residing in a remote SQL database.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OSGB MasterMap GML Files</td>
<td>Many of our international customers want to display MasterMap GML files developed by the Ordnance Survey of Great Britain (OSGB). We provide support for some of the Topography features (OSGB version 2.0), Topographic Area, Lines and Points, Cartographic Symbols and Boundary Lines. We maintain support for these features and add support for Cartographic Text and Departed Features. MapInfo Professional will continue to support GML files as the OSGB updates the schema that underlies the GML technology. As the GML format gets more sophisticated in its support of additional layers, feature types, and attributes, we will continue to provide full support for those changes. Currently, we support the OSGB recommended styles by mapping the style definitions to existing MI Pro styles. Where it is not possible to render complicated fill patterns, we use the simple dot screen that the OSGB recommended to us. The OSGB style mapping to MapInfo styles is hard coded so it cannot be changed. For more information about OS MasterMap see <a href="http://www.ordsvy.gov.uk/os_mastermap/home/home.htm">www.ordsvy.gov.uk/os_mastermap/home/home.htm</a>.</td>
</tr>
<tr>
<td>Outer Join</td>
<td>A type of multi-table join where all the records in the specified tables are included in the result table, even records that do not match the join criteria. MapInfo Professional does not perform outer joins.</td>
</tr>
<tr>
<td>Pack</td>
<td>The process of compressing MapInfo tables so that they use less disk space.</td>
</tr>
<tr>
<td>Pie Chart Map</td>
<td>A type of thematic map that displays a pie chart of thematic variables for each record in the table from which the map is based.</td>
</tr>
<tr>
<td>Pin Map, Push-Pin Map</td>
<td>A type of map named after the practice of inserting push-pins into a wall map. A pin map features point objects. Geocoding a database is one way of creating a pin map.</td>
</tr>
<tr>
<td>Pixel</td>
<td>The acronym for picture element. The smallest dot that can be displayed on a computer screen. If a screen is described as having a resolution of 1,024 x 768, the screen shows 1,024 pixels from right to left, and 768 pixels from top to bottom. Each character, object, or line on the screen is composed of numerous pixels.</td>
</tr>
<tr>
<td>Point, Point Object</td>
<td>A map object defined by a single X,Y coordinate pair. Each point object is represented by a symbol style (for example, circle, square, triangle, etc.).</td>
</tr>
<tr>
<td>Point Size</td>
<td>A unit of measurement equal to 1/72 of an inch. Used to measure character size.</td>
</tr>
<tr>
<td>Pointer</td>
<td>An arrow-shaped cursor on the screen that can be manipulated by a mouse.</td>
</tr>
<tr>
<td>Polygon, Polygon Object</td>
<td>A simple bounded region, simple in the sense that it does not consist of more than one polygon (where a boundary can consist of more than one polygon). The Polygon tool creates a single polygon.</td>
</tr>
<tr>
<td>Polygon Button</td>
<td>The Polygon button allows you to access the Polygon tool. Use the Polygon tool to draw polygons one side at a time.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Polygon Overlay</td>
<td>A spatial operation that merges overlapping polygons from two layers to analyze those intersected areas or to create a third layer of new polygons.</td>
</tr>
<tr>
<td>Polyline, Polyline Object</td>
<td>A linetype object made up of many line segments. It contains more than two nodes, that is, more than its end points. The Polyline tool creates a single polyline. In contrast, the Line tool only draws a single straight line (that is, a line defined by two nodes).</td>
</tr>
<tr>
<td>Polyline Button</td>
<td>The Polyline button allows you to access the Polyline tool. Use the Polyline Tool to draw polylines (a connected sequence of lines that are not closed).</td>
</tr>
<tr>
<td>Projection</td>
<td>A mathematical model that transforms the locations of features on the earth's surface to locations on a two-dimensional surface, such as a paper map. Since a map is an attempt to represent a spherical object (the earth) on a flat surface, all projections have some degree of distortion. A map projection can preserve area, distance, shape or direction but only a globe can preserve all of these attributes. Some projections (for example, Mercator) produce maps well suited for navigation. Other projections (for example, equal-area projections, such as Lambert) produce maps well suited for visual analysis.</td>
</tr>
<tr>
<td>Query Table</td>
<td>A temporary table produced as the result of a Select, SQL Query, or by choosing objects in a Map window or records in a Browser and mapping, graphing, or browsing that selection. You cannot make edits and structural changes on query tables, but you can edit a selected set of rows in your source table through a query table. See Selection on page 511 and Base Table on page 498.</td>
</tr>
<tr>
<td>Radius Select Button</td>
<td>The Radius Select button allows you to access the Radius Select tool. Use this tool to select all of the objects within a certain radius. See Using the Radius Select Tool on page 306.</td>
</tr>
<tr>
<td>Ranged Map</td>
<td>A type of thematic map that displays data according to ranges set by the user. The ranges are shaded using colors or patterns.</td>
</tr>
<tr>
<td>Raster Image</td>
<td>A type of computerized picture consisting of row after row of tiny dots (pixels). Raster images are sometimes known as bitmaps. Aerial photographs and satellite imagery are common types of raster data found in GIS. A computer image can be represented in raster format or in vector format. See Scanning on page 510 and Vector Image on page 514.</td>
</tr>
<tr>
<td>Record</td>
<td>All the information about one object in a database or table. A record in a table corresponds to a row in a Browser.</td>
</tr>
<tr>
<td>Rectangle Button</td>
<td>The Rectangle button allows you to access the Rectangle tool. Use the Rectangle tool to draw rectangles and squares.</td>
</tr>
<tr>
<td>Redistricting</td>
<td>The process of assigning map objects to groups. As you assign map objects, MapInfo Professional automatically calculates totals for each group and displays the totals in a special Districts Browser. This process is sometimes known as load-balancing.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Region, Region Object</td>
<td>An enclosed area defined by one or more polygons. If a region contains one or more lakes or islands, each lake or island is a separate polygon. A region is an object created with the Polygon tool.</td>
</tr>
<tr>
<td>Region Style Button</td>
<td>Use the Region Style button to access the Region Style dialog box. The Region Style dialog box allows you to specify the color, pattern, and borderline style of closed objects. You can also change the color and pattern of objects you are currently editing.</td>
</tr>
<tr>
<td>Registration</td>
<td>Usually the first stage of the digitizing process or when opening a raster image for the first time in MapInfo Professional. Before you can digitize a paper map or work with a raster image, you must point to several control points across the map, and enter their coordinates (for example, longitude, latitude). After you have registered the map, MapInfo Professional can associate a longitude, latitude position with any point on the map surface; this allows MapInfo Professional to perform area and distance calculations, and overlay multiple map layers in a single map. CAD systems as well as GIS systems utilize this process. See Control Points on page 500.</td>
</tr>
<tr>
<td>Reshape Button</td>
<td>The Reshape button toggles you in and out of Reshape mode. Use reshape to edit regions, polylines, lines, and points by moving, adding, and deleting nodes that define line segments. You can also copy and paste selected nodes to create new polylines. Reshape is very useful when you are creating sales territories or other merged boundaries. For example, you are merging ZIP Code boundaries to create school districts. Some ZIP Code boundaries fall into more than one school district. Use the Reshape button to reshape the school district to incorporate a section of the ZIP Code boundary. See Reshaping Map Objects on page 293.</td>
</tr>
<tr>
<td>Result Code</td>
<td>Result codes indicate whether a geocode match was made and the type of match it was, and conveys information about the quality of the match. The result code is an alphanumeric code of 1-10 characters.</td>
</tr>
<tr>
<td>Rounded Rectangle Button</td>
<td>The Rounded Rectangle button allows you to access the Rounded Rectangle tool. Use the Rounded Rectangle tool to draw rounded rectangles and squares.</td>
</tr>
<tr>
<td>Ruler Button</td>
<td>The Ruler button allows you to determine the distance between two points and the length of some path.</td>
</tr>
<tr>
<td>Run MapBasic Program Button</td>
<td>The Run MapBasic Program button accesses the Run MapBasic Application dialog box where you specify the MapBasic program you want to run.</td>
</tr>
<tr>
<td>Scale Bar</td>
<td>A map element that graphically depicts the map scale (for example, 0 —— 5 —— 10 km).</td>
</tr>
<tr>
<td>Scanning</td>
<td>The process of inputting data into a raster format using an optical device called a scanner.</td>
</tr>
<tr>
<td>Scroll Bar</td>
<td>Bars along the right and bottom sides of each window that allow you to scroll the window view. Clicking on the shaded area moves one window screen at a time.</td>
</tr>
</tbody>
</table>

510 MapInfo Professional v. 9.0
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Button</td>
<td>The Select button allows you to access the Select tool. Use the Select tool to select one or more objects or records for analysis. You can also use the Select tool to edit a map, layout or browser. See Selecting a Single Object from a Map or Layout on page 305.</td>
</tr>
<tr>
<td>Selection</td>
<td>A data item or set of data items chosen for inspection and/or analysis. Regardless of the kinds of windows on the screen, selections can be made using the Select and SQL Select Query commands in MapInfo Professional's Query menu. In Browsers and Map windows, items can be placed in the selection set by clicking on them individually. Map windows also have special tools for selecting multiple items on a spatial basis.</td>
</tr>
<tr>
<td>Set Target District from Map Button</td>
<td>Use this button to make the selected object's district the new target district. See Redistricting on page 509.</td>
</tr>
<tr>
<td>Show MapBasic Window Button</td>
<td>The MapBasic window button allows you to display or hide the MapBasic window. You can perform many different tasks by typing commands into the MapBasic window. Choosing items from MapInfo Professional's menus could instead perform those same tasks. There are times, however, when it is easier to type commands into the command window.</td>
</tr>
<tr>
<td>Snap To Nodes</td>
<td>A feature that helps in drawing, moving and positioning map objects. In Snap mode (S key) the cursor snaps to a node of a map object when it comes within a certain distance.</td>
</tr>
<tr>
<td>Source Table</td>
<td>A permanent table, as opposed to a query table, which is temporary. You can edit the contents of source tables and you can change their structure (by editing, deleting, reordering columns and adding or deleting graphic objects). You cannot make edits and structural changes on query tables but you can edit a selected set of rows in your source table through a query table.</td>
</tr>
<tr>
<td>Spatial Analysis</td>
<td>An operation that examines data with the intent to extract or create new data that fulfills some required condition or conditions. It includes such GIS functions as polygon overlay or buffer generation and the concepts of contains, intersects, within or adjacent.</td>
</tr>
<tr>
<td>Spherical Coordinates</td>
<td>Latitude and longitude values that represent objects on the surface of the globe.</td>
</tr>
<tr>
<td>SQL (Structured Query Language)</td>
<td>A standard language used for analyzing information stored in relational databases. MapInfo Professional's database engine is based on the SQL standard.</td>
</tr>
<tr>
<td>SQL Query</td>
<td>The selection of information from a database according to the textual attributes and object relationships of the items. In MapInfo Professional, queries are created with the SQL Select and Select commands or with MapBasic commands in the MapBasic window.</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>A measurement of the variation of a set of data values around the mean.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Standard Toolbar</strong></td>
<td>A window containing buttons for quick access to the most commonly used menu commands such as Cut, Copy, and Paste.</td>
</tr>
<tr>
<td><strong>Statistics Button</strong></td>
<td>Use the Statistics button to display the Statistics window. The Statistics window tallies the sum and average of all numeric fields for the currently chosen objects/records. The number of records chosen is also displayed. As the selection changes, the data is re-tallied, and the statistics window is updated automatically. See Redistricting on page 509.</td>
</tr>
<tr>
<td><strong>Statistics Window</strong></td>
<td>A window containing the sum and average of all numeric fields for the currently selected objects/records. The number of records selected is also displayed. As the selection changes, the data is re-tallied, and the statistics window updates automatically.</td>
</tr>
<tr>
<td><strong>StatusBar</strong></td>
<td>A bar at the bottom of the screen that displays messages that help in using MapInfo Professional. The StatusBar also displays messages that pertain to the active window. In a Map window, the StatusBar indicates what layer is editable, the zoom display of the map, and the status of Snap and Digitizing modes. In a Browser window, the StatusBar indicates the number of records currently displaying and the total number of records. In a Layout window, the StatusBar indicates the zoom display as a percentage of the actual size of the map.</td>
</tr>
<tr>
<td><strong>Structured Query Language (SQL)</strong></td>
<td>A standard language used for analyzing information stored in relational databases. MapInfo Professional’s database engine is based on the SQL standard.</td>
</tr>
<tr>
<td><strong>Subselect</strong></td>
<td>A select statement that is placed inside the Where Condition field of the SQL Select dialog box. MapInfo Professional first evaluates the subselect and then uses the results of the subselect to evaluate the main SQL Select statement.</td>
</tr>
<tr>
<td><strong>Symbol, Symbol Object</strong></td>
<td>A small, relatively simple shape (for example, square, circle, star, push-pin) used to graphically represent a point object (for example, a customer location).</td>
</tr>
<tr>
<td><strong>Symbol Button</strong></td>
<td>The Symbol button allows you to access the Symbol tool. Use the Symbol tool to place point symbols (push pins) on your map.</td>
</tr>
<tr>
<td><strong>Symbol Style Button</strong></td>
<td>Use the Symbol Style button to access the Symbol Style dialog box. The Symbol Style dialog box allows you to display symbols and specify attributes for symbols. The attributes you can specify are size, color, and symbol type. You can change the attributes of existing symbols and specify attributes for new point objects before you create them. The point objects must reside, or be created in an editable layer. See Symbol, Symbol Object.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>A table is made up of data in rows and columns. Each row contains information about a particular geographic feature, event, etc. Each column contains a particular kind of information about the items in the table. You can display tables with graphic information stored in them as maps. See Base Table on page 498 and Query Table on page 509. See also Layer on page 504.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Row</td>
<td>In a table, a row contains all the information for a single item. It corresponds to a record in a table.</td>
</tr>
<tr>
<td>Target District</td>
<td>The district that is selected in a Districts Browser to be affected by subsequent redistricting operations.</td>
</tr>
<tr>
<td>Text Button</td>
<td>Use the Text Button to add titles, labels, and annotations to maps and Layouts. You can also use the Text Tool to rotate text with its edit handle.</td>
</tr>
<tr>
<td>Text Cursor</td>
<td>A blinking vertical bar that shows the position where text can be edited, inserted, or deleted.</td>
</tr>
<tr>
<td>Text Style Button</td>
<td>Use the Text Style button to access the Text Style dialog box. The Text Style dialog box allows you to choose a font and font settings for your text.</td>
</tr>
<tr>
<td>Thematic Layer</td>
<td>A layer containing the thematic settings for a map layer. Thematic layers are drawn directly over the map layer on which the thematic settings are based. They are also drawn in a particular order, depending on the number of thematic layers you have and the type of thematic map objects you are creating.</td>
</tr>
<tr>
<td>Thematic Map</td>
<td>A type of map that uses a variety of graphic styles (for example, colors or fill patterns) to graphically display information about the map's underlying data. Thus, a thematic map of sales territories might show one region in deep red (to indicate the region has a large number of customers), while showing another region in very pale red (to indicate the region has relatively few customers).</td>
</tr>
<tr>
<td>Thematic Shading</td>
<td>Map objects — points, lines, regions — that have been shaded, using a pattern and/or color, according to some point of information about the object, or theme (population, size, annual rainfall, date, and so forth).</td>
</tr>
<tr>
<td>Thematic Variable</td>
<td>The data values displayed on a thematic map. A thematic variable can be a field or expression.</td>
</tr>
<tr>
<td>Theme Legend</td>
<td>MapInfo Professional's original style legend that allows you to display legends for thematic maps and graphs. MapInfo Professional automatically creates a theme legend window for a thematic map. Customize its display through the Modify Thematic Map dialog box. See Cartographic Legend on page 499.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>MapInfo Professional windows that contain a variety of buttons used to access tools and commands for mapping and drawing. There are four Toolbars: the Standard Toolbar provides tools for commonly performed tasks, the Main Toolbar provides primary tools (for example, Zoom-in, Select, Info, etc.) and the Drawing Toolbar contains all drawing tools. The Tools Toolbar contains the Run MapBasic Program and the Show/Hide MapBasic Window buttons. Toolbars may be reshaped and hidden.</td>
</tr>
<tr>
<td>Transformation</td>
<td>The process of converting coverage coordinates from one coordinate system to another through programmatic translation. The transformation of CAD generated Cartesian coordinates into earth coordinates is an example.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ungeocode</td>
<td>The process of removing X and Y coordinates from records in a table or database. Can also describe a table that has not been geocoded, such as an ungeocoded table.</td>
</tr>
<tr>
<td>Vector Image</td>
<td>A coordinate-based data structure commonly used to represent map features. Each object is represented as a list of sequential x,y coordinates. Attributes may be associated with the objects. A computer image can be represented in vector format or in raster format. See Raster Image on page 509.</td>
</tr>
<tr>
<td>Vertical Scroll Bar</td>
<td>The Vertical scroll bar appears at the right of the most windows. Use the vertical scroll bar to move up and down. The scroll box inside the scroll bar indicates your vertical location. You can use the mouse to scroll to other parts of the window.</td>
</tr>
<tr>
<td>Web Feature Services</td>
<td>A Web Feature Service (WFS) client retrieves geospatial GML (Geography Markup Language)2 data using HTTP GET and HTTP POST requests over the Internet or through a private intranet. The WFS client was developed in accordance with the 1.0.0 OpenGIS® Web Feature Service Implementation Specification, which is available online: <a href="http://www.opengis.org/docs/02-058.pdf">http://www.opengis.org/docs/02-058.pdf</a>.</td>
</tr>
<tr>
<td>Web Map Services</td>
<td>A Web Map Service (WMS) is a technology that gives you a source for data over your Intranet or over the Internet. This innovation is based on a specification from the Open GIS Consortium (OGC) and allows you to use raster map images from servers that also comply with the specification. An important element of this is that the WMS images are registered using the data's coordinate system so the WMS layer can be used with vector and other registered raster images. This specification supports transparent pixel definition for image formats as well. This allows you to use the images you retrieve as overlays and not solely as the bottom layer of your map. This is a very new technology and WMS may not exist for the geography you are looking for. Further, the WMS Server determines the data that is provided. See Retrieving Map Data from Web Map Services in the Help System.</td>
</tr>
<tr>
<td>Web Service</td>
<td>A web service is a software system that is accessible using an intranet or Internet connection. Web services allow you to retrieve data that others are sharing internally or world-wide. The power of web services is that you can use them to create more powerful maps or in the case of geocoding or drive region services get more accurate and precise results using the same data.</td>
</tr>
<tr>
<td>Weighted Average</td>
<td>An average that gives more weight to one value over another when averaging. A method of averaging that uses a separate column of information to define the relative importance of each data value. The formula for a weighted average is: ( \frac{\text{SUM(DATA} \times \text{WEIGHT)}}{\text{SUM(WEIGHT)}} ) where DATA is the column of data values and WEIGHT is the column of weights. If WEIGHT contains all 1’s (or other non-zero values) this reduces to a simple average.</td>
</tr>
<tr>
<td>Window</td>
<td>In MapInfo Professional, Map windows, Browser windows, Graph windows and Layout windows are the major types of windows. They display the data stored in tables. The Toolbars, map legends, and the Info tool window are other types of windows.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workspace</td>
<td>A saved configuration of open MapInfo tables and windows.</td>
</tr>
<tr>
<td>Zoom-in Button</td>
<td>The Zoom-in button allows you to access the Zoom-in tool. Use the Zoom-in Tool to get a closer area view of a map or a layout. See Zoom Layering.</td>
</tr>
<tr>
<td>Zoom-out Button</td>
<td>The Zoom-out button allows you to access the Zoom-out tool. Use the Zoom-out tool to get a wider area view of a map or a layout. See Zoom Layering.</td>
</tr>
<tr>
<td>Zoom Layering</td>
<td>A setting that determines the range (for example, 0–3 miles, 2–5 miles, etc.) at which a layer is visible in a Map window.</td>
</tr>
</tbody>
</table>
Directory of MapInfo Professional Shortcuts

This Appendix contains a comprehensive list of the shortcuts available in the MapInfo Professional application. You can create custom shortcuts by editing the MAPINFO.MNU file using a text editor.

**CAUTION:** Making changes to the MAPINFO.MNU file may cause the default shortcuts you change to stop working. Make these changes carefully and record your changes so you can change them back, if necessary.

In this Appendix:

- Shortcuts for File Menu Items ........................................ 518
- Shortcuts for Edit Menu Items ........................................ 518
- Shortcut to Tools Menu Items ........................................ 518
- Shortcuts to Objects Menu Items ................................. 519
- Shortcuts for Query Menu Items .................................. 519
- Shortcuts for Options Menu Items ................................. 519
- Shortcuts for Map Menu Items .................................... 519
- Shortcut for Layout Menu Item .................................... 520
- Shortcuts for Window Menu Items .............................. 520
- Shortcuts by Keystroke ............................................... 521
### Shortcuts for File Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; New Table</td>
<td>Ctrl+N</td>
<td></td>
</tr>
<tr>
<td>File &gt; Open</td>
<td>Ctrl+O</td>
<td></td>
</tr>
<tr>
<td>File &gt; Save Table</td>
<td>Ctrl+S</td>
<td></td>
</tr>
<tr>
<td>File &gt; Save Workspace</td>
<td>Ctrl+K</td>
<td></td>
</tr>
<tr>
<td>File &gt; Print</td>
<td>Ctrl+P</td>
<td></td>
</tr>
<tr>
<td>File &gt; Exit</td>
<td>Alt+F4</td>
<td></td>
</tr>
</tbody>
</table>

### Shortcuts for Edit Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit &gt; Undo</td>
<td>Ctrl+Z</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Cut</td>
<td>Ctrl+X</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Copy</td>
<td>Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Paste</td>
<td>Ctrl+V</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Clear</td>
<td>Del</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Reshape</td>
<td>Ctrl+R</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; New Row</td>
<td>Ctrl+E</td>
<td></td>
</tr>
<tr>
<td>Edit &gt; Get Info</td>
<td>F7</td>
<td></td>
</tr>
</tbody>
</table>

### Shortcut to Tools Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools &gt; Run MapBasic Prog</td>
<td>Ctrl+U</td>
<td></td>
</tr>
</tbody>
</table>
## Shortcuts to Objects Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objects &gt; Set Target</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Objects &gt; Clear Target</td>
<td>Ctrl+Delete</td>
</tr>
</tbody>
</table>

## Shortcuts for Query Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query &gt; Unselect All</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Query &gt; Find</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Query &gt; Find Selection</td>
<td>Ctrl+G</td>
</tr>
</tbody>
</table>

## Shortcuts for Options Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options &gt; Line Style</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Options &gt; Region Style</td>
<td>Ctrl+F8</td>
</tr>
<tr>
<td>Options &gt; Symbol Style</td>
<td>Alt+F8</td>
</tr>
<tr>
<td>Options &gt; Text Style</td>
<td>F8</td>
</tr>
</tbody>
</table>

## Shortcuts for Map Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map &gt; Layer Control</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Map &gt; Create Prism Map</td>
<td>F10</td>
</tr>
<tr>
<td>Map &gt; Create 3D Map</td>
<td>F11</td>
</tr>
</tbody>
</table>
### Directory of MapInfo Professional Shortcuts

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map &gt; Create Thematic Map</td>
<td>F9</td>
</tr>
<tr>
<td>Map &gt; Modify Thematic Map</td>
<td>Alt+F9</td>
</tr>
<tr>
<td>Map &gt; Previous View</td>
<td>Alt+Left Arrow</td>
</tr>
</tbody>
</table>

**Shortcut for Layout Menu Item**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout &gt; Previous View</td>
<td>Alt+Left Arrow</td>
</tr>
</tbody>
</table>

**Shortcuts for Window Menu Items**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window &gt; New Browser</td>
<td>F2</td>
</tr>
<tr>
<td>Window &gt; New Mapper</td>
<td>F3</td>
</tr>
<tr>
<td>Window &gt; New Grapher</td>
<td>F4</td>
</tr>
<tr>
<td>Window &gt; New Layout</td>
<td>F5</td>
</tr>
<tr>
<td>Window &gt; Redraw Window</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Window &gt; Tile Windows</td>
<td>Shift+F4</td>
</tr>
<tr>
<td>Window &gt; Cascade Windows</td>
<td>Shift+F5</td>
</tr>
</tbody>
</table>
Appendix B: Directory of MapInfo Professional Shortcuts

# Shortcuts by Keystroke

<table>
<thead>
<tr>
<th>Menu Items</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map &gt; Previous View and Layout &gt; Previous View</td>
<td>Alt+Left Arrow</td>
</tr>
<tr>
<td>File &gt; Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Window &gt; Redraw Window</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>File &gt; New Row</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Query &gt; Find</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Query &gt; Find Selection</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>File &gt; Save Workspace</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>Map &gt; Layer Control</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>File &gt; New Table</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>File &gt; Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>File &gt; Print</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>File &gt; Reshape</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>File &gt; Save Table</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Objects &gt; Set Target</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Tools &gt; Run MapBasic Program</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>File &gt; Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Query &gt; Unselect All</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>File &gt; Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>File &gt; Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Objects &gt; Clear Target</td>
<td>Ctrl+Delete</td>
</tr>
<tr>
<td>Window &gt; New Browser</td>
<td>F2</td>
</tr>
<tr>
<td>Window &gt; New Mapper</td>
<td>F3</td>
</tr>
<tr>
<td>Window &gt; New Grapher</td>
<td>F4</td>
</tr>
<tr>
<td>Window &gt; New Layout</td>
<td>F5</td>
</tr>
<tr>
<td>Menu Items</td>
<td>Keystrokes</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>File &gt; Get Info</td>
<td>F7</td>
</tr>
<tr>
<td>Options &gt; Text Style</td>
<td>F8</td>
</tr>
<tr>
<td>Map &gt; Create Thematic Map</td>
<td>F9</td>
</tr>
<tr>
<td>Map &gt; Create Prism Map</td>
<td>F10</td>
</tr>
<tr>
<td>Map &gt; Create 3D Map</td>
<td>F11</td>
</tr>
<tr>
<td>File &gt; Exit</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Options &gt; Symbol Style</td>
<td>Alt+F8</td>
</tr>
<tr>
<td>Map &gt; Modify Thematic Map</td>
<td>Alt+F9</td>
</tr>
<tr>
<td>Options &gt; Region Style</td>
<td>Ctrl+F8</td>
</tr>
<tr>
<td>Window &gt; Tile Windows</td>
<td>Shift+F4</td>
</tr>
<tr>
<td>Window &gt; Cascade Windows</td>
<td>Shift+F5</td>
</tr>
<tr>
<td>Options &gt; Line Style</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>Edit &gt; Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>
Elements of a Coordinate System

In this Appendix:

- Projections and Their Parameters ....................... 524
- Projection Datums ......................................... 527
- For More Information on Projections .................... 543
The next table indicates the parameters applicable to each projection, which are listed in the order they appear in the relevant coordinate system lines in the MAPINFOW.PRJ file.

<table>
<thead>
<tr>
<th>Projection Type</th>
<th>Datum</th>
<th>Units</th>
<th>Origin, Longitude</th>
<th>Origin, Latitude</th>
<th>Standard Parallel 1</th>
<th>Standard Parallel 2</th>
<th>Azimuth</th>
<th>Scale Factor</th>
<th>False Easting</th>
<th>False Northing</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Albers Equal-Area Conic</td>
<td>9</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azimuthal Equidistant</td>
<td>28</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>*</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cassini-Soldner</td>
<td>30</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cylindrical Equal Area</td>
<td>2</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Double Stereographic</td>
<td>14</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eckert IV</td>
<td>15</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eckert VI</td>
<td>6</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equidistant Conic</td>
<td>17</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gall</td>
<td>7</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hotine Oblique Mercator</td>
<td>4</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lambert Azimuthal Equal-Area</td>
<td>3</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lambert Conformal Conic</td>
<td>1</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Longitude-Latitude</td>
<td>10</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mercator</td>
<td>11</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Miller</td>
<td>13</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mollweide</td>
<td>18</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Zealand Map Grid</td>
<td>27</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polyconic</td>
<td>31</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Regional Mercator</td>
<td>26</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Robinson</td>
<td>12</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix C: Elements of a Coordinate System

* MapInfo supports the Azimuthal Equidistant and Lambert Azimuth Equal-Area projections in the polar aspect only. The Origin Latitude for these projections must be either 90 or -90.

† Versions of MapInfo prior to 6.0 support the Azimuthal Equidistant and Lambert Azimuthal Equal-Area projections in the polar aspect only. The Origin Latitude for these projections must be either 90 or -90. An Oblique Azimuthal Equidistant projection supports all Origin Latitudes, including the poles. A new Lambert Azimuthal Equal-Area projection has been added that also supports all Origin Latitudes, including the poles.

Projection Types

The projection type is the equation or equations used by a coordinate system. The following list names the projections MapInfo uses and gives the number used to identify the projection in the MAPINFOW.PRJ file:

<table>
<thead>
<tr>
<th>Number</th>
<th>Projection Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Albers Equal-Area Conic</td>
</tr>
<tr>
<td>28</td>
<td>Azimuthal Equidistant (all origin latitudes)</td>
</tr>
<tr>
<td>5</td>
<td>Azimuthal Equidistant (polar aspect only)</td>
</tr>
<tr>
<td>30</td>
<td>Cassini-Soldner</td>
</tr>
<tr>
<td>2</td>
<td>Cylindrical Equal-Area</td>
</tr>
<tr>
<td>31</td>
<td>Double Stereographic</td>
</tr>
<tr>
<td>14</td>
<td>Eckert IV</td>
</tr>
<tr>
<td>15</td>
<td>Eckert VI</td>
</tr>
<tr>
<td>6</td>
<td>Equidistant Conic, also known as Simple Conic</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Projection Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sinusoidal</td>
</tr>
<tr>
<td>Stereographic</td>
</tr>
<tr>
<td>Swiss Oblique Mercator</td>
</tr>
<tr>
<td>Transverse Mercator</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number</th>
<th>Projection Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Albers Equal-Area Conic</td>
</tr>
<tr>
<td>28</td>
<td>Azimuthal Equidistant (all origin latitudes)</td>
</tr>
<tr>
<td>5</td>
<td>Azimuthal Equidistant (polar aspect only)</td>
</tr>
<tr>
<td>30</td>
<td>Cassini-Soldner</td>
</tr>
<tr>
<td>2</td>
<td>Cylindrical Equal-Area</td>
</tr>
<tr>
<td>31</td>
<td>Double Stereographic</td>
</tr>
<tr>
<td>14</td>
<td>Eckert IV</td>
</tr>
<tr>
<td>15</td>
<td>Eckert VI</td>
</tr>
<tr>
<td>6</td>
<td>Equidistant Conic, also known as Simple Conic</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Datum</th>
<th>Units</th>
<th>Origin, Longitude</th>
<th>Origin, Latitude</th>
<th>Standard Parallel 1</th>
<th>Standard Parallel 2</th>
<th>Azimuth</th>
<th>Scale Factor</th>
<th>False Easting</th>
<th>False Northing</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sinusoidal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereographic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swiss Oblique Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transverse Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Projection Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Gall</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Hotine Oblique Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Lambert Azimuthal Equal-Area (polar aspect only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Lambert Azimuthal Equal-Area</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Lambert Conformal Conic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Lambert Conformal Conic (modified for Belgium 1972)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Longitude/Latitude</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Miller Cylindrical</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Mollweide</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>New Zealand Map Grid</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Polyconic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Regional Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Robinson</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Sinusoidal</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Stereographic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Swiss Oblique Mercator</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Transverse Mercator, (also known as Gauss-Kruger)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Transverse Mercator, (modified for Danish System 34 Jylland-Fyn)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Transverse Mercator, (modified for Danish System 34 Sjaelland)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Transverse Mercator, (modified for Danish System 34/45 Bornholm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Transverse Mercator, (modified for Finnish KKJ)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Projection numbers in the MAPINFOW.PRJ may be modified by the addition of a constant value to the base number listed in the Projection table, above. Valid values and their meanings are in the next table:

<table>
<thead>
<tr>
<th>Constant</th>
<th>Meaning</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>System has affine transformations</td>
<td>Affine units specifier and coefficients appear after the regular parameters for the system.</td>
</tr>
<tr>
<td>2000</td>
<td>System has explicit bounds</td>
<td>Bounds appear after the regular parameters for the system.</td>
</tr>
<tr>
<td>3000</td>
<td>System with both affine and bounds</td>
<td>Affine parameters follow system’s parameters; bounds follow affine parameters.</td>
</tr>
</tbody>
</table>

Example:

Assume you want to work with a simple system based on the Transverse Mercator projection and using the NAD 1983 datum. You might have a line such as the following in your MAPINFOW.PRJ file:

"UTM Zone 1 (NAD 83)", 8, 74, 7, -177, 0, 0.9996, 500000, 0

Now let’s say that you want a system based on this, but with an affine transformation specified by the following parameters (see Affine Transformations in the Help System: Units=meters; A=0.5; B=-0.866; C=0; D=0.866; E=0.5; and F=0. The required line in the MAPINFOW.PRJ file is:

"UTM Zone 1 (NAD 83) - rotated 60 degrees", 1008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0

Alternatively, if you want to bound the system to (x1, y1, x2, y2)=(-500000, 0, 500000, 1000000), the required line is:

"UTM Zone 1 (NAD 83) - bounded", 2008, 74, 7, -177, 0, 0.9996, 500000, 0, -500000, 0, 500000, 1000000

To customize the system using both of these modifications, the line is:

"UTM Zone 1 (NAD 83) - rotated and bounded", 3008, 74, 7, -177, 0, 0.9996, 500000, 0, 7, 0.5, -0.866, 0, 0.866, 0.5, 0, -500000, 0, 500000, 1000000

**Projection Datums**

The datum is established by tying a reference ellipsoid to a particular point on the earth. The following table lists these details for each datum. More specific datum information is available in Basic and Custom Datums in the Help System.

- The number used to identify the datum in the MAPINFOW.PRJ file.
- The datum’s name
- The maps for which the datum is typically used
- The datum’s reference ellipsoid
<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adindan</td>
<td>Ethiopia, Mali, Senegal, Sudan</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>2</td>
<td>Afgooye</td>
<td>Somalia</td>
<td>Krassovsky</td>
</tr>
<tr>
<td>1007</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, A.C.T.</td>
<td>Australian National</td>
</tr>
<tr>
<td>1008</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, Tasmania</td>
<td>Australian National</td>
</tr>
<tr>
<td>1009</td>
<td>AGD 66, 7 parameter</td>
<td>Australia, Victoria/NSW</td>
<td>Australian National</td>
</tr>
<tr>
<td>1006</td>
<td>AGD 84, 7 parameter</td>
<td>Australia</td>
<td>Australian National</td>
</tr>
<tr>
<td>3</td>
<td>Ain el Abd 1970</td>
<td>Bahrain Island</td>
<td>International</td>
</tr>
<tr>
<td>118</td>
<td>American Samoa</td>
<td>American Samoa Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>4</td>
<td>Anna 1 Astro 1965</td>
<td>Cocos Islands</td>
<td>Australian National</td>
</tr>
<tr>
<td>119</td>
<td>Antigua Island Astro 1943</td>
<td>Antigua, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>5</td>
<td>Arc 1950</td>
<td>Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>6</td>
<td>Arc 1960</td>
<td>Kenya, Tanzania</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>7</td>
<td>Ascension Island 1958</td>
<td>Ascension Island</td>
<td>International</td>
</tr>
<tr>
<td>9</td>
<td>Astro B4 Sorol Atoll</td>
<td>Tern Island</td>
<td>International</td>
</tr>
<tr>
<td>8</td>
<td>Astro Beacon “E”</td>
<td>Iwo Jima Island</td>
<td>International</td>
</tr>
<tr>
<td>10</td>
<td>Astro DOS 71/4</td>
<td>St. Helena Island</td>
<td>International</td>
</tr>
<tr>
<td>11</td>
<td>Astronomic Station 1952</td>
<td>Marcus Island</td>
<td>International</td>
</tr>
<tr>
<td>12</td>
<td>Australian Geodetic 1966 (AGD 66)</td>
<td>Australia and Tasmania Island</td>
<td>Australian National</td>
</tr>
<tr>
<td>13</td>
<td>Australian Geodetic 1984 (AGD 84)</td>
<td>Australia and Tasmania Island</td>
<td>Australian National</td>
</tr>
<tr>
<td>120</td>
<td>Ayabelle Lighthouse</td>
<td>Djibouti</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>1019</td>
<td>Belgian 1972 (7 parameters)</td>
<td>Belgium</td>
<td>International 1924</td>
</tr>
<tr>
<td>110</td>
<td>Belgium</td>
<td>Belgium</td>
<td>International</td>
</tr>
<tr>
<td>14</td>
<td>Bellevue (IGN)</td>
<td>Efate and Erromango Islands</td>
<td>International</td>
</tr>
<tr>
<td>15</td>
<td>Bermuda 1957</td>
<td>Bermuda Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>16</td>
<td>Bogota Observatory</td>
<td>Colombia</td>
<td>International</td>
</tr>
<tr>
<td>121</td>
<td>Bukit Rimpah</td>
<td>Bangka and Belitung Islands</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>17</td>
<td>Campo Inchauspe</td>
<td>Argentina</td>
<td>International</td>
</tr>
<tr>
<td>18</td>
<td>Canton Astro 1966</td>
<td>Phoenix Islands</td>
<td>International</td>
</tr>
<tr>
<td>19</td>
<td>Cape</td>
<td>South Africa</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>20</td>
<td>Cape Canaveral</td>
<td>Florida and Bahama Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>1005</td>
<td>Cape, 7 parameter</td>
<td>South Africa</td>
<td>WGS 84</td>
</tr>
<tr>
<td>21</td>
<td>Carthage</td>
<td>Tunisia</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>22</td>
<td>Chatham 1971</td>
<td>Chatham Island (New Zealand)</td>
<td>International</td>
</tr>
<tr>
<td>23</td>
<td>Chua Astro</td>
<td>Paraguay</td>
<td>International</td>
</tr>
<tr>
<td>122</td>
<td>Coordinate System 1937 of Estonia</td>
<td>Estonia</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>24</td>
<td>Corrego Alegre</td>
<td>Brazil</td>
<td>International</td>
</tr>
<tr>
<td>123</td>
<td>Dabola</td>
<td>Guinea</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>124</td>
<td>Deception Island</td>
<td>Deception Island, Antarctica</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>1000</td>
<td>Deutsches Hauptdreicksnetz (DHDN) Potsdam/Rauenberg</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>25</td>
<td>Djakarta (Batavia)</td>
<td>Sumatra Island (Indonesia)</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>26</td>
<td>DOS 1968</td>
<td>Gizo Island (New Georgia Islands)</td>
<td>International</td>
</tr>
<tr>
<td>27</td>
<td>Easter Island 1967</td>
<td>Easter Island</td>
<td>International</td>
</tr>
<tr>
<td>115</td>
<td>EUREF 89</td>
<td>Europe</td>
<td>GRS 80</td>
</tr>
<tr>
<td>28</td>
<td>European 1950 (ED 50)</td>
<td>Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland</td>
<td>International</td>
</tr>
<tr>
<td>29</td>
<td>European 1979 (ED 79)</td>
<td>Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland</td>
<td>International</td>
</tr>
<tr>
<td>108</td>
<td>European 1987 (ED 87)</td>
<td>Europe</td>
<td>International</td>
</tr>
</tbody>
</table>
## Elements of a Coordinate System

<table>
<thead>
<tr>
<th>Number</th>
<th>Datum Name</th>
<th>Area of Coverage</th>
<th>Ellipsoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>125</td>
<td>Fort Thomas 1955</td>
<td>Nevis, St. Kitts, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>30</td>
<td>Gandajika Base</td>
<td>Republic of Maldives</td>
<td>International</td>
</tr>
<tr>
<td>116</td>
<td>GDA 94</td>
<td>Australia</td>
<td>GRS 80</td>
</tr>
<tr>
<td>33</td>
<td>Geodetic Reference System 1980 (GRS 80)</td>
<td>Worldwide</td>
<td>GRS 80</td>
</tr>
<tr>
<td>126</td>
<td>Graciosa Base SW 1948</td>
<td>Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)</td>
<td>International 1924</td>
</tr>
<tr>
<td>34</td>
<td>Guam 1963</td>
<td>Guam Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>35</td>
<td>GUX 1 Astro</td>
<td>Guadalcanal Island</td>
<td>International</td>
</tr>
<tr>
<td>150</td>
<td>Hartbeesthoek 94</td>
<td>South Africa</td>
<td>WGS 84</td>
</tr>
<tr>
<td>127</td>
<td>Herat North</td>
<td>Afghanistan</td>
<td>International 1924</td>
</tr>
<tr>
<td>128</td>
<td>Hermannskogel</td>
<td>Yugoslavia (Prior to 1990), Slovenia, Croatia, Bosnia and Herzegovina, Serbia</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>36</td>
<td>Hito XVIII 1963</td>
<td>South Chile (near 53°S)</td>
<td>International</td>
</tr>
<tr>
<td>37</td>
<td>Hjorsey 1955</td>
<td>Iceland</td>
<td>International</td>
</tr>
<tr>
<td>38</td>
<td>Hong Kong 1963</td>
<td>Hong Kong</td>
<td>International</td>
</tr>
<tr>
<td>1004</td>
<td>Hungarian Datum of 1972 (HD 72)</td>
<td>Hungary</td>
<td>GRS 67</td>
</tr>
<tr>
<td>39</td>
<td>Hu-Tzu-Shan</td>
<td>Taiwan</td>
<td>International</td>
</tr>
<tr>
<td>40</td>
<td>Indian</td>
<td>Thailand and Vietnam</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>41</td>
<td>Indian</td>
<td>Bangladesh, India, Nepal</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>129</td>
<td>Indian</td>
<td>Pakistan</td>
<td>Everest (Pakistan)</td>
</tr>
<tr>
<td>130</td>
<td>Indian 1954</td>
<td>Thailand</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>131</td>
<td>Indian 1960</td>
<td>Vietnam</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>132</td>
<td>Indian 1975</td>
<td>Thailand</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>133</td>
<td>Indonesian 1974</td>
<td>Indonesia</td>
<td>Indonesian 1974</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>42</td>
<td>Ireland 1965</td>
<td>Ireland</td>
<td>Modified Airy</td>
</tr>
<tr>
<td>134</td>
<td>ISTS 061 Astro 1968</td>
<td>South Georgia Island</td>
<td>International 1924</td>
</tr>
<tr>
<td>43</td>
<td>ISTS 073 Astro 1969</td>
<td>Diego Garcia</td>
<td>International</td>
</tr>
<tr>
<td>44</td>
<td>Johnston Island 1961</td>
<td>Johnston Island</td>
<td>International</td>
</tr>
<tr>
<td>45</td>
<td>Kandawala</td>
<td>Sri Lanka</td>
<td>Everest (India 1830)</td>
</tr>
<tr>
<td>46</td>
<td>Kerguelen Island</td>
<td>Kerguelen Island</td>
<td>International</td>
</tr>
<tr>
<td>47</td>
<td>Kertau 1948</td>
<td>West Malaysia and Singapore</td>
<td>Everest (W. Malaysia and Singapore 1948)</td>
</tr>
<tr>
<td>1016</td>
<td>KKJ</td>
<td>Finland</td>
<td>International</td>
</tr>
<tr>
<td>135</td>
<td>Kusaie Astro 1951</td>
<td>Caroline Islands, Federated States of Micronesia</td>
<td>International 1924</td>
</tr>
<tr>
<td>48</td>
<td>L.C. 5 Astro</td>
<td>Cayman Brac Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>136</td>
<td>Leigon</td>
<td>Ghana</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>49</td>
<td>Liberia 1964</td>
<td>Liberia</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>113</td>
<td>Lisboa (DLx)</td>
<td>Portugal</td>
<td>International</td>
</tr>
<tr>
<td>1018</td>
<td>Lithuanian Pulkovo 1942</td>
<td>Latvia, Lithuania</td>
<td>International 1924</td>
</tr>
<tr>
<td>50</td>
<td>Luzon</td>
<td>Philippines (excluding Mindanao Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>51</td>
<td>Luzon</td>
<td>Mindanao Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>138</td>
<td>M’Poraloko</td>
<td>Gabon</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>52</td>
<td>Mahe 1971</td>
<td>Mahe Island</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>53</td>
<td>Marco Astro</td>
<td>Salvage Islands</td>
<td>International</td>
</tr>
<tr>
<td>54</td>
<td>Massawa</td>
<td>Eritrea (Ethiopia)</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>114</td>
<td>Melrica 1973 (D73)</td>
<td>Portugal</td>
<td>International</td>
</tr>
<tr>
<td>55</td>
<td>Merchich</td>
<td>Morocco</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>56</td>
<td>Midway Astro 1961</td>
<td>Midway Island</td>
<td>International</td>
</tr>
<tr>
<td>57</td>
<td>Minna</td>
<td>Nigeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
<td>-------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>137</td>
<td>Montserrat Island Astro 1958</td>
<td>Montserrat, Leeward Islands</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>58</td>
<td>Nahrwan</td>
<td>Masirah Island (Oman)</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>59</td>
<td>Nahrwan</td>
<td>United Arab Emirates</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>60</td>
<td>Nahrwan</td>
<td>Saudi Arabia</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>61</td>
<td>Naparima, BWI</td>
<td>Trinidad and Tobago</td>
<td>International</td>
</tr>
<tr>
<td>109</td>
<td>Netherlands</td>
<td>Netherlands</td>
<td>Bessel</td>
</tr>
<tr>
<td>1010</td>
<td>New Zealand Geodetic Datum 194, 7 parameter</td>
<td>New Zealand</td>
<td>International</td>
</tr>
<tr>
<td>31</td>
<td>New Zealand Geodetic Datum 1949 (NZGD 49)</td>
<td>New Zealand</td>
<td>International</td>
</tr>
<tr>
<td>62</td>
<td>North American 1927 (NAD 27)</td>
<td>Continental U.S.</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>63</td>
<td>North American 1927 (NAD 27)</td>
<td>Alaska</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>64</td>
<td>North American 1927 (NAD 27)</td>
<td>Bahamas (excluding San Salvador Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>65</td>
<td>North American 1927 (NAD 27)</td>
<td>San Salvador Island</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>66</td>
<td>North American 1927 (NAD 27)</td>
<td>Canada (including Newfoundland Island)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>67</td>
<td>North American 1927 (NAD 27)</td>
<td>Canal Zone</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>68</td>
<td>North American 1927 (NAD 27)</td>
<td>Caribbean (Turks and Caicos Islands)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>69</td>
<td>North American 1927 (NAD 27)</td>
<td>Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras, Nicaragua)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>70</td>
<td>North American 1927 (NAD 27)</td>
<td>Cuba</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>71</td>
<td>North American 1927 (NAD 27)</td>
<td>Greenland (Hayes Peninsula)</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>72</td>
<td>North American 1927 (NAD 27)</td>
<td>Mexico</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>73</td>
<td>North American 1927 (NAD 27)</td>
<td>Michigan (used only for State Plane Coordinate System 1927)</td>
<td>Modified Clarke 1866</td>
</tr>
<tr>
<td>74</td>
<td>North American 1983 (NAD 83)</td>
<td>Alaska, Canada, Central America, Continental U.S., Mexico</td>
<td>GRS 80</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------</td>
<td>---------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>139</td>
<td>North Sahara 1959</td>
<td>Algeria</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>107</td>
<td>Nouvelle Triangulation Francaise (NTF)</td>
<td>France</td>
<td>Modified Clarke 1880</td>
</tr>
<tr>
<td>1002</td>
<td>Nouvelle Triangulation Francaise (NTF)</td>
<td>France</td>
<td>Modified Clarke 1880</td>
</tr>
<tr>
<td>111</td>
<td>NWGL 10</td>
<td>Worldwide</td>
<td>WGS 72</td>
</tr>
<tr>
<td>117</td>
<td>NZGD 2000</td>
<td>New Zealand</td>
<td>GRS 80</td>
</tr>
<tr>
<td>140</td>
<td>Observatorio Meteorologico 1939</td>
<td>Corvo and Flores Islands (Azores)</td>
<td>International 1924</td>
</tr>
<tr>
<td>75</td>
<td>Observatorio 1966</td>
<td>Corvo and Flores Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>76</td>
<td>Old Egyptian</td>
<td>Egypt</td>
<td>Helmert 1906</td>
</tr>
<tr>
<td>77</td>
<td>Old Hawaiian</td>
<td>Hawaii</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>78</td>
<td>Oman</td>
<td>Oman</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>79</td>
<td>Ordnance Survey of Great Britain 1936</td>
<td>England, Isle of Man, Scotland, Shetland Islands, Wales</td>
<td>Airy</td>
</tr>
<tr>
<td>80</td>
<td>Pico de las Nieves</td>
<td>Canary Islands</td>
<td>International</td>
</tr>
<tr>
<td>81</td>
<td>Pitcairn Astro 1967</td>
<td>Pitcairn Island</td>
<td>International</td>
</tr>
<tr>
<td>141</td>
<td>Point 58</td>
<td>Burkina Faso and Niger</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>142</td>
<td>Pointe Noire 1948</td>
<td>Congo</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>143</td>
<td>Porto Santo 1936</td>
<td>Porto Santo and Madeiras Islands</td>
<td>International 1924</td>
</tr>
<tr>
<td>1000</td>
<td>Potsdam</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>82</td>
<td>Provisional South American 1956</td>
<td>Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela</td>
<td>International</td>
</tr>
<tr>
<td>xxx</td>
<td>Provisional South Chilean 1963</td>
<td>South Chile (near 53°S)</td>
<td>International</td>
</tr>
<tr>
<td>83</td>
<td>Puerto Rico</td>
<td>Puerto Rico and Virgin Islands</td>
<td>Clarke 1866</td>
</tr>
<tr>
<td>1001</td>
<td>Pulkovo 1942</td>
<td>Germany</td>
<td>Krassovsky</td>
</tr>
<tr>
<td>84</td>
<td>Qatar National</td>
<td>Qatar</td>
<td>International</td>
</tr>
<tr>
<td>85</td>
<td>Qornoq</td>
<td>South Greenland</td>
<td>International</td>
</tr>
<tr>
<td>Number</td>
<td>Datum Name</td>
<td>Area of Coverage</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>1000</td>
<td>Rauenberg</td>
<td>Germany</td>
<td>Bessel</td>
</tr>
<tr>
<td>86</td>
<td>Reunion</td>
<td>Mascarene Island</td>
<td>International</td>
</tr>
<tr>
<td>112</td>
<td>Rikets Triangulering 1990 (RT 90)</td>
<td>Sweden</td>
<td>Bessel</td>
</tr>
<tr>
<td>1011</td>
<td>Rikets Triangulering 1990 (RT 90), 7 parameter</td>
<td>Sweden</td>
<td>Bessel</td>
</tr>
<tr>
<td>87</td>
<td>Rome 1940</td>
<td>Sardinia Island</td>
<td>International</td>
</tr>
<tr>
<td>1012</td>
<td>Russia PZ90</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>1012</td>
<td>Russia PZ90</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>1013</td>
<td>Russia SK42</td>
<td>Russia</td>
<td>SK95</td>
</tr>
<tr>
<td>1014</td>
<td>Russia SK95</td>
<td>Russia</td>
<td>PZ90</td>
</tr>
<tr>
<td>88</td>
<td>Santo (DOS)</td>
<td>Espirito Santo Island</td>
<td>International</td>
</tr>
<tr>
<td>89</td>
<td>São Braz</td>
<td>São Miguel, Santa Maria Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>90</td>
<td>Sapper Hill 1943</td>
<td>East Falkland Island</td>
<td>International</td>
</tr>
<tr>
<td>91</td>
<td>Schwarzeck</td>
<td>Namibia</td>
<td>Modified Bessel 1841</td>
</tr>
<tr>
<td>144</td>
<td>Selvagem Grande 1938</td>
<td>Salvage Islands</td>
<td>International 1924</td>
</tr>
<tr>
<td>145</td>
<td>Sierra Leone 1960</td>
<td>Sierra Leone</td>
<td>Clarke 1880</td>
</tr>
<tr>
<td>146</td>
<td>S-JTSK</td>
<td>Czech Republic</td>
<td>Bessel 1841</td>
</tr>
<tr>
<td>92</td>
<td>South American 1969</td>
<td>Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay, Peru, Venezuela, Trinidad and Tobago</td>
<td>South American 1969</td>
</tr>
<tr>
<td>93</td>
<td>South Asia</td>
<td>Singapore</td>
<td>Modified Fischer 1960</td>
</tr>
<tr>
<td>94</td>
<td>Southeast Base</td>
<td>Porto Santo and Madeira Islands</td>
<td>International</td>
</tr>
<tr>
<td>95</td>
<td>Southwest Base</td>
<td>Faial, Graciosa, Pico, Sao Jorge, Terceira Islands (Azores)</td>
<td>International</td>
</tr>
<tr>
<td>1003</td>
<td>Switzerland (CH 1903)</td>
<td>Switzerland</td>
<td>Bessel</td>
</tr>
</tbody>
</table>
### Units

The following table lists the available coordinate units and the number used to identify the unit in the MAPINFO.W.PRJ file:

<table>
<thead>
<tr>
<th>Number</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Centimeters</td>
</tr>
<tr>
<td>31</td>
<td>Chains</td>
</tr>
<tr>
<td>3</td>
<td>Feet (also called International Feet)(^1)</td>
</tr>
</tbody>
</table>
Coordinate System Origin

The origin is the point specified in longitude and latitude from which all coordinates are referenced. It is chosen to optimize the accuracy of a particular coordinate system. As we move north from the origin, Y increases. X increases as we move east. These coordinate values are generally called northings and eastings.

For the Transverse Mercator projection the origin’s longitude defines the central meridian. In constructing the Transverse Mercator projection a cylinder is positioned tangent to the earth. The central meridian is the line of tangency. The scale of the projected map is true along the central meridian.

In creating a Hotine Oblique Mercator projection it is necessary to specify a great circle that is not the equator nor a meridian. MapInfo Professional does this by specifying one point on the ellipsoid and an azimuth from that point. That point is the origin of the coordinate system.

Standard Parallels (Conic Projections)

In conic projections a cone is passed through the earth intersecting it along two parallels of latitude. These are the standard parallels. One is to the north and one is to the south of the projection zone. To use a single standard parallel specify that latitude twice. Both are expressed in degrees of latitude.

<table>
<thead>
<tr>
<th>Number</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Inches</td>
</tr>
<tr>
<td>1</td>
<td>Kilometers</td>
</tr>
<tr>
<td>30</td>
<td>Links</td>
</tr>
<tr>
<td>7</td>
<td>Meters</td>
</tr>
<tr>
<td>0</td>
<td>Miles</td>
</tr>
<tr>
<td>5</td>
<td>Millimeters</td>
</tr>
<tr>
<td>9</td>
<td>Nautical Miles$^2$</td>
</tr>
<tr>
<td>32</td>
<td>Rods</td>
</tr>
<tr>
<td>8</td>
<td>US Survey Feet (used for 1927 State Plane)$^3$</td>
</tr>
<tr>
<td>4</td>
<td>Yards</td>
</tr>
</tbody>
</table>

1 One International Foot equals exactly 30.48 cm.
2 One Nautical Mile equals exactly 1852 meters.
3 One US Survey Foot equals exactly 12/39.37 meters, or approximately 30.48006 cm.
Appendix C: Elements of a Coordinate System

Oblique Azimuth (Hotine Oblique Mercator)

When specifying a great circle (Hotine Oblique Mercator) using a point and an azimuth (arc), the azimuth is called the Oblique Azimuth and is expressed in degrees.

Scale Factor (Transverse Mercator)

A scale factor is applied to cylindrical coordinates to average scale error over the central area of the map while reducing the error along the east and west boundaries. The scale factor has the effect of recessing the cylinder into the earth so that it has two lines of intersection. Scale is true along these lines of intersection.

You may see the scale factor expressed as a ratio, such as 1:25000. In this case it is generally called the scale reduction. The relationship between scale factor and scale reduction is:

\[ \text{scale factor} = 1 - \text{scale reduction} \]

In this case the scale factor would be 1-(1/25000) or 0.99996.

False Northings and False Eastings

Calculating coordinates is easier if negative numbers aren’t involved. To eliminate this problem in calculating State Plane and Universal Transverse Mercator coordinates, it is common to add measurement offsets to the northings and eastings. These offsets are called False Northings and False Eastings. They are expressed in coordinate units, not degrees. (The coordinate units are specified by the Units parameter.)

Range (Azimuthal Projections)

The range specifies, in degrees, how much of the earth you are seeing. The range can be between 1 and 180. When you specify 90, you see a hemisphere. When you specify 180 you see the whole earth, though much of it is very distorted.

Polyconic Projection

The following description is copied from “Map Projections – A Working Manual”, USGS Professional Paper 1395, by John P. Snyder.

The Polyconic projection, usually called the American Polyconic in Europe, achieved its name because the curvature of the circular arc for each parallel on the map is the same as it would be following the unrolling of a cone which had been wrapped around the globe tangent to the particular parallel of latitude, with the parallel traced onto the cone. Thus, there are many (“poly-”) cones involved, rather than the single cone of each regular conic projection.

The Polyconic projection is neither equal-area nor conformal. Along the central meridian, however, it is both distortion free and true to scale. Each parallel is true to scale, but the meridians are lengthened by various amounts to cross each parallel at the correct position along the parallel, so that no parallel is standard in the sense of having conformality (or correct angles), except at the central meridian. Near the central meridian, distortion is extremely small.
Elements of a Coordinate System

This projection is not intended for mapping large areas. The conversion algorithms used break down when mapping wide longitude ranges. For example, WORLD.TAB, from the sample data shipped with MapInfo Professional, may exhibit anomalies if reprojected using Polyconic.

Coordinate System Enhancements by Version

This section describes the coordinate system enhancements by product version. The MAPINFO.W.PRJ file has been updated to support these changes. The datum details of these systems have been added to the Basic Datums in the Help System.

Coordinate System Additions for MapInfo Professional 8.5

ETRS-based Coordinate Systems Added. We added the following ETRS-based projections to our PRJ file: Transverse Mercator Zone 26-39, Lambert Conformal Conic, and Azimuthal Equal Area.

Lithuanian and Latvian Coordinate Systems. We added the following Latvian Coordinate Systems to the PRJ file: LKS-92, and Longitude/Latitude (LKS-92). We added EPSG codes to the following Lithuanian Coordinate Systems: LKS-94, Baltija-92, Longitude / Latitude (LKS-94) and KS-1942 Zone 4. These are the coordinate system parameters:

"LKS-92 (EUREF89)"
8, 115, 7, 24, 0, 0.9996, 500000, 0

"LKS-94 (EUREF89)"
8, 115, 7, 24, 0, 0.9998, 500000, 0

"Baltija-92 (EUREF89)"
8, 115, 7, 24, 0, 0.9996, 500000, 0

"UTM Zone 34 (EUREF89)"
8, 115, 7, 21, 0, 0.9996, 500000, 0

"UTM Zone 35 (EUREF89)"
8, 115, 7, 27, 0, 0.9996, 500000, 0

"Longitude / Latitude (EUREF89)"
1, 115

"KS-1942 Zone 4 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 21, 0, 1, 4500000, 0

"KS-1942 Zone 5 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 27, 0, 1, 5500000, 0

"KS-1963 Zone 0 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 21.95, 0, 1, 2500000, -11057.63

"KS-1963 Zone 1 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 24.95, 0, 1, 1250000, -11057.63

"KS-1963 Zone 2 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 27.95, 0, 1, 2250000, -11057.63

"KS-1942 (3 Degree) Zone 7 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 21, 0, 1, 7250000, 0

"KS-1942 (3 Degree) Zone 8 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 24, 0, 1, 8250000, 0

"KS-1942 (3 Degree) Zone 9 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 27, 0, 1, 9250000, 0

"KS-1942 Central Meridian 24 (Lithuanian Pulkovo 1942)"
8, 1018, 7, 24, 0, 1, 0, 0

"Vilnius (Lithuanian Pulkovo 1942)"
8, 1018, 7, 24, 0, 1, -53799.7, -6040600

"Kaunas (Lithuanian Pulkovo 1942)"
8, 1018, 7, 24, 0, 1, 17981.7, -6073803

"Longitude / Latitude (Lithuanian Pulkovo 1942)"
1, 1018
Coordinate System Additions for MapInfo Professional 8.0

Chinese Coordinate Systems. We added a new Xian 1980 ellipsoid # 53 and two new datums: Xian 1980 - #1017 and Beijing 1954 - #154. These are the coordinate system parameters:

"GK Zone 25 (Xian 1980)\p2349", 8, 1017, 7, 75, 0, 1, 25500000, 0
"GK Zone 26 (Xian 1980)\p2350", 8, 1017, 7, 78, 0, 1, 26500000, 0
"GK Zone 27 (Xian 1980)\p2351", 8, 1017, 7, 81, 0, 1, 27500000, 0
"GK Zone 28 (Xian 1980)\p2352", 8, 1017, 7, 84, 0, 1, 28500000, 0
"GK Zone 29 (Xian 1980)\p2353", 8, 1017, 7, 87, 0, 1, 29500000, 0
"GK Zone 30 (Xian 1980)\p2354", 8, 1017, 7, 90, 0, 1, 30500000, 0
"GK Zone 31 (Xian 1980)\p2355", 8, 1017, 7, 93, 0, 1, 31500000, 0
"GK Zone 32 (Xian 1980)\p2356", 8, 1017, 7, 96, 0, 1, 32500000, 0
"GK Zone 33 (Xian 1980)\p2357", 8, 1017, 7, 99, 0, 1, 33500000, 0
"GK Zone 34 (Xian 1980)\p2358", 8, 1017, 7, 102, 0, 1, 34500000, 0
"GK Zone 35 (Xian 1980)\p2359", 8, 1017, 7, 105, 0, 1, 35500000, 0
"GK Zone 36 (Xian 1980)\p2360", 8, 1017, 7, 108, 0, 1, 36500000, 0
"GK Zone 37 (Xian 1980)\p2361", 8, 1017, 7, 111, 0, 1, 37500000, 0
"GK Zone 38 (Xian 1980)\p2362", 8, 1017, 7, 114, 0, 1, 38500000, 0
"GK Zone 39 (Xian 1980)\p2363", 8, 1017, 7, 117, 0, 1, 39500000, 0
"GK Zone 40 (Xian 1980)\p2364", 8, 1017, 7, 120, 0, 1, 40500000, 0
"GK Zone 41 (Xian 1980)\p2365", 8, 1017, 7, 123, 0, 1, 41500000, 0
"GK Zone 42 (Xian 1980)\p2366", 8, 1017, 7, 126, 0, 1, 42500000, 0
"GK Zone 43 (Xian 1980)\p2367", 8, 1017, 7, 129, 0, 1, 43500000, 0
"GK Zone 44 (Xian 1980)\p2368", 8, 1017, 7, 132, 0, 1, 44500000, 0
"GK Zone 45 (Xian 1980)\p2369", 8, 1017, 7, 135, 0, 1, 45500000, 0

"--- China - Gauss-Kruger (Xian 1980 6-degree zone) ---"

"GK Zone 13 (Xian 1980)\p2327", 8, 1017, 7, 75, 0, 1, 13500000, 0
"GK Zone 14 (Xian 1980)\p2328", 8, 1017, 7, 81, 0, 1, 14500000, 0
"GK Zone 15 (Xian 1980)\p2329", 8, 1017, 7, 87, 0, 1, 15500000, 0
"GK Zone 16 (Xian 1980)\p2330", 8, 1017, 7, 93, 0, 1, 16500000, 0
"GK Zone 17 (Xian 1980)\p2331", 8, 1017, 7, 99, 0, 1, 17500000, 0
"GK Zone 18 (Xian 1980)\p2332", 8, 1017, 7, 105, 0, 1, 18500000, 0
"GK Zone 19 (Xian 1980)\p2333", 8, 1017, 7, 111, 0, 1, 19500000, 0
"GK Zone 20 (Xian 1980)\p2334", 8, 1017, 7, 117, 0, 1, 20500000, 0
"GK Zone 21 (Xian 1980)\p2335", 8, 1017, 7, 123, 0, 1, 21500000, 0
"GK Zone 22 (Xian 1980)\p2336", 8, 1017, 7, 129, 0, 1, 22500000, 0
"GK Zone 23 (Xian 1980)\p2337", 8, 1017, 7, 135, 0, 1, 23500000, 0

--- China - Gauss-Kruger (Beijing 1954 6-degree zone) ---
"Beijing 1954 zone 13\p21413", 8, 154, 7, 75, 0, 1, 13500000, 0
"Beijing 1954 zone 14\p21414", 8, 154, 7, 81, 0, 1, 14500000, 0
"Beijing 1954 zone 15\p21415", 8, 154, 7, 87, 0, 1, 15500000, 0
"Beijing 1954 zone 16\p21416", 8, 154, 7, 93, 0, 1, 16500000, 0
"Beijing 1954 zone 17\p21417", 8, 154, 7, 99, 0, 1, 17500000, 0
"Beijing 1954 zone 18\p21418", 8, 154, 7, 105, 0, 1, 18500000, 0
"Beijing 1954 zone 19\p21419", 8, 154, 7, 111, 0, 1, 19500000, 0
"Beijing 1954 zone 20\p21420", 8, 154, 7, 117, 0, 1, 20500000, 0
"Beijing 1954 zone 21\p21421", 8, 154, 7, 123, 0, 1, 21500000, 0
"Beijing 1954 zone 22\p21422", 8, 154, 7, 129, 0, 1, 22500000, 0
"Beijing 1954 zone 23\p21423", 8, 154, 7, 135, 0, 1, 23500000, 0
"Beijing 1954 zone 13N\p21473", 8, 154, 7, 75, 0, 1, 500000, 0
"Beijing 1954 zone 14N\p21474", 8, 154, 7, 81, 0, 1, 500000, 0
"Beijing 1954 zone 15N\p21475", 8, 154, 7, 87, 0, 1, 500000, 0
"Beijing 1954 zone 16N\p21476", 8, 154, 7, 93, 0, 1, 500000, 0
"Beijing 1954 zone 17N\p21477", 8, 154, 7, 99, 0, 1, 500000, 0
"Beijing 1954 zone 18N\p21478", 8, 154, 7, 105, 0, 1, 500000, 0
"Beijing 1954 zone 19N\p21479", 8, 154, 7, 111, 0, 1, 500000, 0
"Beijing 1954 zone 20N\p21480", 8, 154, 7, 117, 0, 1, 500000, 0
"Beijing 1954 zone 21N\p21481", 8, 154, 7, 123, 0, 1, 500000, 0
"Beijing 1954 zone 22N\p21482", 8, 154, 7, 129, 0, 1, 500000, 0
"Beijing 1954 zone 23N\p21483", 8, 154, 7, 135, 0, 1, 500000, 0

--- China - Gauss-Kruger (Beijing 1954 3-degree zone) ---
"Beijing 1954 - 3-degree GK zone 25\p2401", 8, 154, 7, 75, 0, 1, 25500000, 0
"Beijing 1954 - 3-degree GK zone 26\p2402", 8, 154, 7, 78, 0, 1, 26500000, 0
"Beijing 1954 - 3-degree GK zone 27\p2403", 8, 154, 7, 81, 0, 1, 27500000, 0
"Beijing 1954 - 3-degree GK zone 28\p2404", 8, 154, 7, 84, 0, 1, 28500000, 0
"Beijing 1954 - 3-degree GK zone 29\p2405", 8, 154, 7, 87, 0, 1, 29500000, 0
Appendix C: Elements of a Coordinate System

"Beijing 1954 - 3-degree GK zone 30\p2406", 8, 154, 7, 90, 0, 1, 30500000, 0
"Beijing 1954 - 3-degree GK zone 31\p2407", 8, 154, 7, 93, 0, 1, 31500000, 0
"Beijing 1954 - 3-degree GK zone 32\p2408", 8, 154, 7, 96, 0, 1, 32500000, 0
"Beijing 1954 - 3-degree GK zone 33\p2409", 8, 154, 7, 99, 0, 1, 33500000, 0
"Beijing 1954 - 3-degree GK zone 34\p2410", 8, 154, 7, 102, 0, 1, 34500000, 0
"Beijing 1954 - 3-degree GK zone 35\p2411", 8, 154, 7, 105, 0, 1, 35500000, 0
"Beijing 1954 - 3-degree GK zone 36\p2412", 8, 154, 7, 108, 0, 1, 36500000, 0
"Beijing 1954 - 3-degree GK zone 37\p2413", 8, 154, 7, 111, 0, 1, 37500000, 0
"Beijing 1954 - 3-degree GK zone 38\p2414", 8, 154, 7, 114, 0, 1, 38500000, 0
"Beijing 1954 - 3-degree GK zone 39\p2415", 8, 154, 7, 117, 0, 1, 39500000, 0
"Beijing 1954 - 3-degree GK zone 40\p2416", 8, 154, 7, 120, 0, 1, 40500000, 0
"Beijing 1954 - 3-degree GK zone 41\p2417", 8, 154, 7, 123, 0, 1, 41500000, 0
"Beijing 1954 - 3-degree GK zone 42\p2418", 8, 154, 7, 126, 0, 1, 42500000, 0
"Beijing 1954 - 3-degree GK zone 43\p2419", 8, 154, 7, 129, 0, 1, 43500000, 0
"Beijing 1954 - 3-degree GK zone 44\p2420", 8, 154, 7, 132, 0, 1, 44500000, 0
"Beijing 1954 - 3-degree GK zone 45\p2421", 8, 154, 7, 135, 0, 1, 45500000, 0
"Beijing 1954 - 3-degree GK CM 75E\p2422", 8, 154, 7, 75, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 78E\p2423", 8, 154, 7, 78, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 81E\p2424", 8, 154, 7, 81, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 84E\p2425", 8, 154, 7, 84, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 87E\p2426", 8, 154, 7, 87, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 90E\p2427", 8, 154, 7, 90, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 93E\p2428", 8, 154, 7, 93, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 96E\p2429", 8, 154, 7, 96, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 99E\p2430", 8, 154, 7, 99, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 102E\p2431", 8, 154, 7, 102, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 105E\p2432", 8, 154, 7, 105, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 108E\p2433", 8, 154, 7, 108, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 111E\p2434", 8, 154, 7, 111, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 114E\p2435", 8, 154, 7, 114, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 117E\p2436", 8, 154, 7, 117, 0, 1, 50000000, 0
"Beijing 1954 - 3-degree GK CM 120E\p2437", 8, 154, 7, 120, 0, 1, 50000000, 0
Elements of a Coordinate System

"Beijing 1954 - 3-degree GK CM 123E", 8, 154, 7, 123, 0, 1, 500000, 0
"Beijing 1954 - 3-degree GK CM 126E", 8, 154, 7, 126, 0, 1, 500000, 0
"Beijing 1954 - 3-degree GK CM 129E", 8, 154, 7, 129, 0, 1, 500000, 0
"Beijing 1954 - 3-degree GK CM 132E", 8, 154, 7, 132, 0, 1, 500000, 0
"Beijing 1954 - 3-degree GK CM 135E", 8, 154, 7, 135, 0, 1, 500000, 0

**Guernsey Grid Coordinate System.** We added a new transverse mercator coordinate system called the Guernsey Grid to the .PRJ file. This coordinate system is comprised of these 8 parameters: 8, 104, 7, -2.416667, 49.500000, 0.999997, 47000, 50000

**Hellenic Geodetic Reference System.** We added a new datum called the Hellenic Geodetic Reference System # 153. This coordinate system is comprised of these 8 parameters: 8, 153, 7, 24, 0, 0.9996, 500000, 0

**Baltic Projections (Lithuanian and Latvian).** We added a new datum called the Lithuanian Pulkovo 1942 # 1018.

**New Zealand Geodetic Datum 2000.** We added 28 new meridional circuits in terms of NZGD2000 on Transverse Mercator projections.

"New Zealand Transverse Mercator (NZGD2000)", 8, 117, 7, 173, 0, 0.9996, 1600000, 10000000
"Amuri Circuit 2000", 8, 117, 7, 173.010000000, -42.688888889, 1, 400000, 800000
"Bay of Plenty Circuit 2000", 8, 117, 7, 176.466111111, -37.761111111, 1, 400000, 800000
"Bluff Circuit 2000", 8, 117, 7, 168.342777778, -46.600000000, 1, 400000, 800000
"Buller Circuit 2000", 8, 117, 7, 171.581111111, -41.810555556, 1, 400000, 800000
"Collingwood Circuit 2000", 8, 117, 7, 172.671944444, -40.714722222, 1, 400000, 800000
"Gawler Circuit 2000", 8, 117, 7, 171.360555556, -43.748611111, 1, 400000, 800000
"Grey Circuit 2000", 8, 117, 7, 171.549722222, -42.333611111, 1, 400000, 800000
"Hawkes Bay Circuit 2000", 8, 117, 7, 176.673611111, -39.650833333, 1, 400000, 800000
"Hokitika Circuit 2000", 8, 117, 7, 170.979722222, -42.886111111, 1, 400000, 800000
"Jacksons Bay Circuit 2000", 8, 117, 7, 168.606111111, -43.977777778, 1, 400000, 800000
"Karamea Circuit 2000", 8, 117, 7, 172.108888889, -41.289722222, 1, 400000, 800000
"Lindis Peak Circuit 2000", 8, 117, 7, 169.467500000, -44.735000000, 1, 400000, 800000
"Marlborough Circuit 2000", 8, 117, 7, 173.801944444, -41.544444444, 1, 400000, 800000
"Mt. Eden Circuit 2000", 8, 117, 7, 174.764166667, -36.879722222, 0.9999, 400000, 800000
"Mt. Nicholas Circuit 2000", 8, 117, 7, 168.39861111, -45.132777778, 1, 400000, 800000
Appendix C: Elements of a Coordinate System

"Mt. Pleasant Circuit 2000", 8, 117, 7, 172.726944444, -43.590555556, 1, 400000, 800000
"Mt. York Circuit 2000", 8, 117, 7, 167.738611111, -45.563611111, 1, 400000, 800000
"Nelson Circuit 2000", 8, 117, 7, 173.299166667, -41.274444444, 1, 400000, 800000
"North Taieri Circuit 2000", 8, 117, 7, 170.282500000, -45.861388889, 0.99996, 400000, 800000
"Observation Pt. Circuit 2000", 8, 117, 7, 170.628333333, -45.816111111, 1, 400000, 800000
"Okarito Circuit 2000", 8, 117, 7, 170.260833333, -43.110000000, 1, 400000, 800000
"Poverty Bay Circuit 2000", 8, 117, 7, 177.885555556, -38.624444444, 1, 400000, 800000
"Timaru Circuit 2000", 8, 117, 7, 171.057222222, -44.401944444, 1, 400000, 800000
"Tuahirangi Circuit 2000", 8, 117, 7, 175.640000000, -39.512222222, 1, 400000, 800000
"Wairarapa Circuit 2000", 8, 117, 7, 175.647222222, -40.925277778, 1, 400000, 800000
"Wanganui Circuit 2000", 8, 117, 7, 175.488055556, -40.241944444, 1, 400000, 800000
"Wellington Circuit 2000", 8, 117, 7, 174.776388889, -41.301111111, 1, 400000, 800000

Belgian Coordinate System. We have added a new 7-parameter datum called the Belgian National System 1972 # 1019. There are 7 parameters: 3, 1019, 7, 4.367486667, 90, 49.8333339000, 51.1666672333, 51.1666672333, 5400000000.13, 540000000.438

British National Grid Coordinate System. We have added a second British National Grid coordinate system that has tighter bounds than the original. The new coordinate system is called British National Grid (1 mm accuracy) and are comprised of these 7 parameters: 2008, 79, 7, -2, 49, 0.9996012717, 400000, -100000, 0, 0, 2000000, 2000000

For More Information on Projections

The first three publications listed are relatively short pamphlets. The last two are substantial books. We’ve also given addresses and phone numbers for the American Congress of Surveying and Mapping (the pamphlets) and the U.S. Geological Survey (the books).


Elements of a Coordinate System


Contact Information

The Department of Geography at the University of Colorado at Boulder has made available "The Geographer's Craft" project, a website devoted to explanations of map projections, geodetic datums, and coordinate systems. It is particularly valuable because many of the explanations were presented using MapInfo Professional.

The materials may be used for study, research, and education. If you link to or cite the materials below, please credit the author: Peter H. Dana, The Geographer's Craft Project, Department of Geography, The University of Colorado at Boulder.

For geodetic datum information and explanations, go to:

http://www.colorado.edu/geography/gcraft/notes/datum/datum.html

For information on coordinate systems and associated topics, go to:

http://www.colorado.edu/geography/gcraft/notes/coordsys/coordsys.html

For information on map projections, go to:

http://www.colorado.edu/geography/gcraft/notes/mapproj/mapproj.html
Introductory Data

Copyrights

In this Appendix:

- Understanding your Introductory and Sample Data .............. 546
- Asia ................................................................. 546
- Europe ............................................................. 547
- North America .................................................. 548
- World .............................................................. 550
Understanding your Introductory and Sample Data

If you install the data from the data CD that is shipped with MapInfo Professional, you will notice that it has the following directory structure and data presentation. We use the term Introductory Data to describe the data you can use to geocode locally and to enhance the maps you create in every session. The Sample Data folder provides examples of other types of data that are available from MapInfo Corporation.

Africa

Source: MapInfo Corporation From National Imagery and Mapping Agency (NIMA)

Data: Country and Surrounding country boundaries

Source: http://data.geocomm.com (Free off the internet) All countries appended to one table and thinned for size purposes)

Asia

Australia

Source: Copyright and Intellectual Property in the attached data sets rests with one of the following: The Australian Government represented by the Australian Bureau of Statistics; The Government of New South Wales represented by The Land Information Centre. MapInfo Australia Pty Ltd and PSMA Australia Ltd.

Data: Locations of the state boundaries and capitals and over 4000 major and minor cities. Map of major rivers and major roads.

Local government area boundary for Manly.

Tasmania area boundaries, feature points and water boundaries.

Map of New South Wales.

Sydney feature points, rivers, suburbs, towns, census collection district and postcode boundaries, and customer database.

Component street table and grid surrounding for Sydney.

Streetworks samples

Source: MapInfo from Digital Chart of the World

Data: Generalized map of major highways

Source: SPOT Image Corporation © CNES 1995

Data: Raster map of Sydney
Appendix D: Introductory Data Copyrights

Source: MapInfo Corporation from National Imagery and Mapping Agency (NIMA)
Data: Country boundary

Source: Hervey Bay City Council, 2000
Data: Point Vernon and Hervey Bay, Australia

**China**

Source: MapInfo from Digital Chart of the World
Data: Over 5,000 major and minor cities and major highways.

Source: MapInfo Corporation from National Imagery and Mapping Agency (NIMA)
Data: Country and surrounding country boundaries.

**Japan**

Source: GisNET data licensed to MapInfo by GISdata Limited. © GDC Ltd 1993
Data: Water, highway, rivers, lakes and major railroads.
Source: MapInfo from Digital Chart of the World.
Data: 142 major and minor cities including all prefecture capitals.
Source: MapInfo Corporation from National Imagery and Mapping Agency (NIMA)
Data: Country boundary.

**India**

Source: Risk Management Solutions, Inc.
Data: State, country and district boundaries.
Source: MapInfo from Digital Chart of the World
Data: Major and minor cities and state capitals.

**Europe**

**Austria, Belgium, Denmark, Deutschland, Espana, France, Italy, Netherlands, Norway, Portugal, Sweden, Switzerland, United Kingdom**

Data: StreetPro Austria, Belgium, Denmark, Deutschland, Espana, France, Italy, Netherlands, Norway, Portugal, Sweden, and Switzerland.

Source: GisNET data licensed to MapInfo by GISdata Limited. © GDC Ltd 1993
Data: Water and highway/roadway maps.
Source: MapInfo Corporation from National Imagery and Mapping Agency (NIMA)

Data: Country Boundaries (Austria, Belgium, Denmark, Deutschland, Espana, France, Italy, Netherlands, Norway, Portugal, Sweden, Switzerland, Europe and United Kingdom.)

Great Britain
Source: 2001 Tele Atlas B.V. 's-Hertogenbosch. All Rights Reserved. This product includes mapping data licensed from Ordnance Survey (R). (c) Crown 2001. License number 100020348
Data: StreetPro Great Britain

North America

Canada
Source: Portions (c) 2004 GDT-Canada, Inc.
Data: (Prince Edward Island) Airports, Census subdivisions, Major Primary and Secondary Highways, Institutions, Large Areas land use, Parks, Road Buffers, Streets, Transportation points, Urban Agglomeration, Province, Railways, Utility lines and Water areas.
Source: MapInfo from Digital Chart of the World
Data: Over 3000 major and minor cities and generalized map of major highways.
Source: MapInfo Corporation
Data: Country and Province boundaries and surrounding water.

Mexico
Source: MapInfo Corporation
Data: Surrounding water and country boundary.
Source: MapInfo from the Bureau of Transportation Statistics
Data: State boundaries.
Source: MapInfo from Digital Chart of the World
Data: Generalized map of major highways and locations of all state capitals, major and minor cities.

United States, DC
Source: Tele Atlas (GDT, Inc.) Portions (c) 2004 Tele Atlas, Inc. (GDT, Inc.)
Data: Postal code boundaries.
Source: MapInfo Canada
Appendix D: Introductory Data Copyrights

Data: 2000 Demographic data Blockgroup.
Source: Tele Atlas (GDT, Inc.) Portions (c) 2004 Tele Atlas, Inc. (GDT, Inc.)

Data: StreetPro and 5 digit postal codes
Source: © MapInfo Corporation 2001. Aerial Photography used with permission of RSC Group, LLC 2001. All rights reserved.

Data: 5 mile by 5 mile area of 1m and 3m ground resolution raster images.
Source: MapInfo Corporation

Data: Shields in StreetPro. Listing of NPA/NXXs covered in DC. Competitive, Local Exchange Carriers (CLEC), Personal Communications Services (PCS) markets, cellular telephone service areas as defined by the FCC, Local Exchange Carriers (LEC), Local Access Transport Areas (LATAs), Competitive Local Exchange Carriers (CLEC), rate center locations and wire center serving boundaries, Point Of Presence (POP) locations for long distance telephone carriers. Area Codes. POPINFO and ObstacleInfo.

Point file showing wireless (Cellular, Paging, PCS and SMR) switch locations.
Records of hurricanes between 1988 - 1996
Gas, electric utilities and cable franchise areas.
StreetPro - component tables (updated to January 2007).

Wireless samples for Sprint, ATT, Bell Atlantic, PGNT_P, PGMT_P, Nextel and GTE.
Current hazardous waste notifiers, Superfund Cleanup and National Priority List sites as defined by the EPS.

United States

Data: Orthophoto Image of Seattle Airport.
States.tab and USA.tab to include the Census 2000 data. Further, there is a point ZIP codes file (US_ZIPS.tab) to assist you with more accurate geocoding. This file contains the data from our popular ZipInfo product. Source: Tele Atlas, Inc. (GDT, Inc.)

Data: Postal code boundaries (updated to October 2005) and Postal code points (updated to April 2007).
Source: MapInfo Canada

Data: 1990 Demographics by states and counties.
Source: MapInfo Corporation

Data: Sample customer database in various database formats. State boundaries with the states of Alaska and Hawaii inset.
Source: MapInfo from Digital Chart of the World

Data: Location of the state capitals and the location of 8875 cities. Point elevation data in feet and meters.
Source: MapInfo from NOAA
Data: Annual temperature and rainfall.

Source: MapInfo from the Bureau of Transportation Statistics
Data: A very generalized version of the Roadnet interstate data

Source: MapInfo from the US Census Bureau
Data: Updated County boundaries from Census 2000 including Puerto Rico. Map containing the location of 125 major cities and locations of 208,857 points of interest and landmarks.

Source: MapInfo from USGS
Data: MapInfo grid file of Washington DC – East and West

Source: Public Domain - OSU
Data: MapInfo grid file of Mt. St. Helens before and after eruption. MapInfo grid file of Crater Lake, Oregon

Source: Sure!MAPS ® RASTER © HTI 1995

**World**

Source: MapInfo Corporation
Data: Military Grid Reference System 84 NL to 80 SL, North & South Polar Regions. Grid of latitude and longitude at 15 degree increments.

Source: MapInfo from Digital Chart of the World
Data: Location of world capitals and point locations for major and minor cities.

Source: MapInfo Corporation from National Imagery and Mapping Agency (NIMA)
Data: World Boundaries.
Index

Numerics

3DMaps
  defined 498
  setting hardware acceleration defaults 122

A

Access tables
  creating .tab files from 202
  opening 179
accessing secure Web sites 463
active objects, definition 481
Add Node button 498
Add Nodes button 276
adding
  layers to Map windows 163
  nodes 276
  ODBC drivers 90
  open windows to layouts 417
  records in browser windows 245
  rows to tables 240
  temporary columns to tables 234
Address Dictionary 498
Address Matching preferences 129
address ranges, matching to street number 218
addresses, geocoding precision 214
ADRG Format (*.gen) files
  raster format 432
advanced options and settings, registry 113
Affine Transformations
  coordinate systems 456
  description 457
aggregate functions
  with update column command 244
aggregating data
  SQL select command 328–329
  with set target model 387–388
AirPhotoUSA Conterminous Coordinate System 178
AirPhotoUSA raster support 178
aliases
  defined 498
  for columns 327–328
aligning objects in a Layout window 420
application data files
  mode.ini 115
  per-user install 85
  specifying installation location 114
Arc button 498
Arc Grid handler 432
area calculation default settings 123
arrow keys, positioning selected objects 289
ASCII export 194
ASCII tables
  opening 179
  registering 206
ASCII, defined 498
ASRP Format (*.gen) files
  raster format 432
Assign Selected Objects button 498
attributes
  cartographic legends 423
  graduated symbols 350
  map object 292
AutoCAD
  opening in MapInfo Professional 34
  refreshing 38
AutoCAD DXF export 193
Autolabeler tool
  creating labels as text objects 195, 404
automatic labeling 405–409
autoscrolling windows 111
autotrace, tracing existing objects 297
Axis 498
Azimuthal projections, range 451, 537

B

bar charts
  defined 498
  maps 347
  template 356
base maps definition 498
base tables definition 498
*.bil files, raster format 432
Index

bitmap (*.bmp) files
  definition 499
  export format 193
  raster format 432
borrowing a concurrent license 104–105
bound objects, spatial queries 271
boundaries
  boundary region definition 499
  geocoding 215, 219
Boundary Select button 308, 499
bring to front command 414
Browser windows
  adding records 245
  defined 499
  displaying tables in 245
  format 186
  mouse wheel support 187, 240
  opening tables in 186
  seamless tables 175
  viewing graphic information 239
buffer regions
  calculation types 383
  concentric ring 383–384
  convex hull 384
  creating 378–381
  defined 499
  methods in creating 382
  radius 382
  saving as new layer 381
  segments per circle 382
  width distance 382

c
cadastral
  defined 499
CADRG Format files
  raster format 432
callout lines 408
Cancel command 499
cancelling selections 309
Cartesian calculations
  as default setting 123
  buffer regions 382
Cartesian coordinates definition 499
cartographic legends
  attributes and metadata 423
  choosing layers 423
  creating 371
  defined 499
  description 371
  in layouts 420
cartography definition 499
centroids
  defined 500
  displaying 166
  selecting using snap mode 295
Change View button 500
cib format files
  raster format 432
clearing a target 391
Clip Region preferences
  setting defaults 121
cloning a map view 422
closing tables 192
COGOline tool 196
collection objects
  grouping objects using 396
color
  raster image options 436–437
column aliases
  creating 327–328
columns
  adding temporary columns 234
  combining objects with 394
  creating expressions 316
  deriving 327
  finding duplicate values in 335–336
  labeling with 404
  placing graphic information in 239
  spatial index 252
combining map objects
  overview 388
combining objects
  creating territories 394
  multipoint and collection 396
  set target 389
concentric ring buffers 196, 383
concurrent licenses
  borrowing 104
  connecting to a server 101–104
  returning borrowed license 105
conflict resolution 263–265, 500
Conic projections 451
conic projections 536
control points
  defined 500
  raster image registration 433
converting
  objects into polyline objects 283
convex hull buffers 385
Coordinate Extractor tool 196
coordinate systems
  converting coords from one datum to another 450
  creating 456
  defined 501
Index

elements of 457
enhancements by product version 538–543
entering a new projection for 455
origin point 450, 536
parameters of 445
projection types 525–527
projections ??–445, ??–448
specifying the bounds in 447
using a new projection in 455
coordinates
defined 500
determining map 430
displaying 440
geocoding 211
raster image control points 433
setting display defaults 123
specifying in non-earth maps 459
Coordsys Bounds Manager tool 195
copying objects to clipboard 118
Cosmetic layer 166
courtesy period, concurrent licenses 103
Create Line By Length tool 196
creating
a table, using subset of a file 320
layouts 416–417, 419
reports 245
tables 240
creating expressions 316–317
constructing 487
operator precedence 493
using Expression dialog 315–317
using Select command 316
creating points
displaying points a map 225
displaying points on a map 225
for intersections 224
placing longitude/latitude coordinates 223
vs. geocoding 200
creating territories
combining objects 395
see also redistricting
cropping images 194
Crystal Reports
installing user guide 112
setting default open and save directories 130
crystal reports, creating reports 245
CSV, opening comma delimited files 203
Curved Labels
editing 32
rules 33
setting the option for 31
understanding 31
understanding your data and 33
custom symbols 285
creating 286
Custom Workstation Installation 88
D
data
file import formats supported 150
obtaining new 110
data aggregation
defined 501
SQL Select command 328–329
data disaggregation definition 501
Data Map, with MapInfo tables 480
data sources
connecting to 253
defined 501
databases
defined 501
defining terminology in 176
what databases are supported 83
DateTime Data Type
and the server 73
downloading to MapInfo Professional 72
remote database support 72
DateTime feature
adding data types to existing data 24
converting to a new data type 24
creating a _ column from two separate columns 26
creating thematic maps using 27
interpreting Access data 30
interpreting dBase data 30
interpreting Excel data 30
understanding 23
using arithmetic operators with 29
using comparison operators with 29
using logical operators with 29
using the new data type for 23
datum projection parameter 527–535
datums, mapinfo.prj id numbers 449
Dbase files
creating .tab files from 204
opening 179
DBMS Catalog tool 196
DBMS connections, specifying default 128
DBMS Count Rows In Table tool 196
DBMS dDrivers 249
DBMS SQL queries
setting default open and save directories 130
DBMS tables
conflict resolution 263–265
connecting to a data source 253
creating 259
disconnecting from database 266
linked 249
linked tables 249
live remote access 250
opening 182, 258–259, 273
per-row styles 249, 267
requirements 248
saving 264
spatial index columns 252
storing and retrieving spatial objects 251
storing coordinate values 251
symbol styles in mappable tables 267
unlinking 229

DBMS Toolbar 157
decimal degrees
defined 501
setting display coordinate defaults 123
default, defined 501
Degree Converter tool 196
degrees latitude definition 501
degrees longitude definition 501
degrees/minutes/seconds
setting default coordinate display 123
deleting
nodes 278
tables 243
derived columns
defined 501
described 323
using 327
Digitizer
defined 502
virtual tablet interface features 496
digitizing
raster images 436
tablet 502
Directory Preferences
definition 116
specifying 129
disaggregating data
data disaggregation definition 501
with set target model 387–388
Disperse Points tool 196
distance calculations
buffer regions 382
setting default 123
Distance Calculator tool 196
districts
grouping map objects into 482
ordering and grid display 388
districts browser
defined 502
using 484
documentation set 18
dot density maps
defined 502
description 351
dot shape and size 352
dot style options 352
template 356
thematic 352
drawing objects on a map
commands 276
custom symbols 285
styles 280
symbols 284
types of shapes 280
using ruler window 279
Drawing toolbar 157
defined 502
region style button 157
Drivetime web service 473
driving regions
creating buffers for objects 475
routing server setup and preferences 148

E
Earth maps 459
Easyloader tool 196
ECW raster handler
(*.ecw) raster format 432
installing ECW Compressor 110
edit handles definition 502
editing
labels 410
mapinfo.prj file 453–456
read-only tables 167
table structure 242
editing objects
attributes 292
autotracing 297
commands 276
creating territories by combining 393
deleting 288
multipoint and collection 396
object conversion 298
object offset 289
positioning and sizing 289
procedure 288
reshaping 293–295
rotating 291–292
set target model 388
smoothing/unsmoothing polylines 298
snap mode 296
splitting 392
Index

**embedded maps**
  - sharing documents 479–480

**embedding**
  - OLE objects 479

**encapsulated postscript (*.eps) files** 426

**Enhanced Metafile Format (*.emf) files** 432
  - export format 193

**Envinsa**
  - geocoding web service 470
  - routing and geocoding constraints 74

**Envinsa Online Services (EOLS)** 476

**equal count range type** 345

**equal range type** 346

**ESRI ArcInfo Export**
  - opening in MapInfo Professional 34
  - refreshing 38

**ESRI ArcSDE**
  - opening in MapInfo Professional 34
  - refreshing 38

**ESRI grid files** 432

**ESRI Personal Geodatabase**
  - opening in MapInfo Professional 34
  - refreshing 38

**ESRI shapefiles**
  - opening 204
  - setting default open and save directories 130

**Excel files**
  - creating tab files from 201
  - opening 179

**exiting MapInfo Professional** 149

**exporting files**
  - export definition 502
  - GeoTIFF format 65
  - layouts 425
  - setting output preferences 132
  - supported file formats 193
  - supported formats 193
  - to comma delimited (csv format) 203
  - translucent images 438

**expressions**
  - creating 315–317, 487
  - defined 502
  - labeling with 404
  - operator precedence 493
  - where you can use them 486

**F**

**false easting parameter** 537
  - coordinate systems 451

**false northing parameter** 537
  - coordinate systems 451

**fields definition** 502

**file formats**
  - MapInfo Professional supported 177, 200
  - raster images 432
  - supported export 193
  - supported types 150

**files**
  - defined 502
  - opening 179

**fill patterns**
  - defined 502
  - printing 280
  - region styles dialog 398

**find**
  - an object or street address 311
  - find selection in one window or all windows 226

**Find command**
  - remote tables and 69

**Find Selection**
  - preferences for copying/pasting 70

**fonts**
  - defined 502
  - emergency response 62

**frame tool button** 418

**frames**
  - drawing in layouts 419
  - layout window 413, 418, 420

**G**

***.gen files**
  - raster format 432

**General Tab** 260

**generalization definition** 503

**Geocode command**
  - remote tables and 70

**geocoded points**
  - displaying on a map 221, 225
  - street inset and offset 217

**geocoding**
  - a single address using a server 471
  - appropriate map detail 212
  - assigning coordinates to records 211
  - defined 503
  - finding exact street matches 216
  - geographic accuracy 212
  - matching address numbers 218
  - matching street names 217
  - matching to regions 219
  - precision 215
  - process overview 213
  - result codes 471
  - selecting ungeocoded records 220
  - setting up a server 145
ungeocoding 222
vs. creating points 200
geocoding server
  adding a 147
  preferences 140
  setting up 145
Geographic Information System (GIS) definition 503
geographic operators 490
GeoTIFF
  export requirements 65
  exporting 66
  exporting to 67
  exporting to a map window 65
  image rotation and 66
  raster and grid images and 68
  supported projections and 65
  unsupported projections 67
GeoTracker tool 196
Get Info command 292
*.gif files
  raster format 432
  web map service format 464
Global Positioning Software 111
*.gml files
  importing 207
GML2 data
  web feature service client 466
graduated symbol maps
  customizing 350
  defined 503
  description 349
  template 356
graph support files
  setting default directories 130
Graph windows, defined 503
graticule definition 503
grid image files
  setting default display 131
  setting default open and save directories 130
  using 374
grid layers
  opening 183
  setting zoom layering defaults 121
  using layer control with 171
Grid Maker tool 196
grid surface maps
  adjusting translucency 172
  defined 503
  specifying default handlers 122
  uses 374
  vertical mapper grid handler 376
grid template 357
grid thematic map, direct support 150
grid tools 197
grouping by columns
  creating subtotals 325
H
heads-up digitizing definition 503
Help button bar definition 503
help system, using 19
highlighting objects 136
hot views, defined 503
Hotine Oblique Mercator projection 451
  Oblique Azimuth 537
HotLinks
  accessing more than one 58
  adding more than one 57
  changing the order of 59
  creating multiple 56
  notes on multiple 59
  removing from a map 58
HTML Image Map tool 197
I
Image Processing preferences, definition 116
importing files
  graphic files 207
  import definition 503
  parsing data across multiple columns 237
  setting default open and save directories 130
  types supported 150
  web map service data 211
index files 179
individual values maps
  defined 504
  saving categories in templates 364
  template 356
  thematic 353
inflection
  ranged thematic maps 369
Info tool
  changing a record’s data, font, and style 187
  seamless layers 174
  using 168
Informix
  converting unsupported geometries 267
  geometry conversion 268
installation
  application data files 84
  before you install 84
  changes to (9.0) 22
  custom workstation 88
Index

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>data 109</td>
</tr>
<tr>
<td>ECW Compressor 110</td>
</tr>
<tr>
<td>Global Positioning Software (GPS) 111</td>
</tr>
<tr>
<td>location of application data files 114</td>
</tr>
<tr>
<td>modifying MapInfo.prf for directories 84</td>
</tr>
<tr>
<td>navigating CD 85</td>
</tr>
<tr>
<td>network 90</td>
</tr>
<tr>
<td>online references 112</td>
</tr>
<tr>
<td>per-user installs 85</td>
</tr>
<tr>
<td>procedure 85</td>
</tr>
<tr>
<td>running from C drive 112</td>
</tr>
<tr>
<td>setting up clients 92</td>
</tr>
<tr>
<td>troubleshooting 112</td>
</tr>
<tr>
<td>typical workstation 88</td>
</tr>
<tr>
<td>interactive labelling 410</td>
</tr>
<tr>
<td>interleaved line styles</td>
</tr>
<tr>
<td>editing 280</td>
</tr>
<tr>
<td>styles 400</td>
</tr>
<tr>
<td>introductory data</td>
</tr>
<tr>
<td>copyright information 546–550</td>
</tr>
<tr>
<td>inverting selections 309, 332</td>
</tr>
<tr>
<td>J</td>
</tr>
<tr>
<td>joining tables</td>
</tr>
<tr>
<td>geographically using geographic operators 332</td>
</tr>
<tr>
<td>join definition 504</td>
</tr>
<tr>
<td>order of clauses 331</td>
</tr>
<tr>
<td>through thematic mapping 342</td>
</tr>
<tr>
<td>two or more tables 334</td>
</tr>
<tr>
<td>using SQL select 330</td>
</tr>
<tr>
<td>joins 235</td>
</tr>
<tr>
<td>geographic and descriptive 235</td>
</tr>
<tr>
<td>JPEG 2000 format (*.jp2) files</td>
</tr>
<tr>
<td>export format 193</td>
</tr>
<tr>
<td>raster format 432</td>
</tr>
<tr>
<td>jpeg file interchange format (*.jpg)</td>
</tr>
<tr>
<td>export format 193</td>
</tr>
<tr>
<td>web map service format 464</td>
</tr>
<tr>
<td>L</td>
</tr>
<tr>
<td>Labeler tool 197</td>
</tr>
<tr>
<td>labels</td>
</tr>
<tr>
<td>automatic 405–409</td>
</tr>
<tr>
<td>callout lines 408</td>
</tr>
<tr>
<td>content 404</td>
</tr>
<tr>
<td>controlling display 407</td>
</tr>
<tr>
<td>curved 31</td>
</tr>
<tr>
<td>curved labels and data 33</td>
</tr>
<tr>
<td>curved, editing 32</td>
</tr>
<tr>
<td>curved, rules for 33</td>
</tr>
<tr>
<td>customized 405</td>
</tr>
<tr>
<td>design 403</td>
</tr>
<tr>
<td>editing 410</td>
</tr>
<tr>
<td>interactive 410</td>
</tr>
<tr>
<td>label tool button 411</td>
</tr>
<tr>
<td>map 403</td>
</tr>
<tr>
<td>position 164</td>
</tr>
<tr>
<td>saving 405, 411</td>
</tr>
<tr>
<td>setting a global font for 56</td>
</tr>
<tr>
<td>size 165</td>
</tr>
<tr>
<td>styles 409</td>
</tr>
<tr>
<td>using column information 404</td>
</tr>
<tr>
<td>using text objects 410</td>
</tr>
<tr>
<td>with expressions 404</td>
</tr>
<tr>
<td>zoom layering 406</td>
</tr>
<tr>
<td>Lambert Azimuthal Projection Map example 444</td>
</tr>
<tr>
<td>latitude definition 504</td>
</tr>
<tr>
<td>Layer Control command</td>
</tr>
<tr>
<td>adding a layer to a map 163</td>
</tr>
<tr>
<td>ordering thematic layers 170</td>
</tr>
<tr>
<td>raster and grid layers 171</td>
</tr>
<tr>
<td>seamless layers 174</td>
</tr>
<tr>
<td>selectable layers 169</td>
</tr>
<tr>
<td>selecting objects in a layer 169</td>
</tr>
<tr>
<td>thematic layers 169</td>
</tr>
<tr>
<td>zoom layering 165</td>
</tr>
<tr>
<td>Layer Control dialog box, about 162</td>
</tr>
<tr>
<td>layers</td>
</tr>
<tr>
<td>adding to a map 163</td>
</tr>
<tr>
<td>characteristics of seamless 174</td>
</tr>
<tr>
<td>creating buffer 381</td>
</tr>
<tr>
<td>defined 160</td>
</tr>
<tr>
<td>displaying layer of current selection 19</td>
</tr>
<tr>
<td>displaying object attributes 166</td>
</tr>
<tr>
<td>making layers selectable 169</td>
</tr>
<tr>
<td>objects in 161</td>
</tr>
<tr>
<td>opening seamless 173</td>
</tr>
<tr>
<td>reordering using layer control 163</td>
</tr>
<tr>
<td>saving thematic map 364</td>
</tr>
<tr>
<td>seamless 173</td>
</tr>
<tr>
<td>selecting for cartographic legends 423</td>
</tr>
<tr>
<td>selecting objects in 169</td>
</tr>
<tr>
<td>thematic 343–344</td>
</tr>
<tr>
<td>with Info tool 168</td>
</tr>
<tr>
<td>working with thematic 169</td>
</tr>
<tr>
<td>layout templates</td>
</tr>
<tr>
<td>configuring 47–52</td>
</tr>
<tr>
<td>creating 40–41, 43, 45</td>
</tr>
<tr>
<td>editing 46–47</td>
</tr>
<tr>
<td>saving 45–46</td>
</tr>
<tr>
<td>Layout window preferences</td>
</tr>
<tr>
<td>definition 116</td>
</tr>
</tbody>
</table>
Index

Layout windows
  adding a logo to 431
  adding a maximized window to 413
  aligning objects in 413, 421
  browser display in 187
  changing a map’s border and proportions in 361
  creating 417
  creating from a template 52–54
  creating multiple map views 415
  defined 505
  exporting 425
  frames 418
  map scale 421–422
  opening maps in 189
  ordering overlapping objects 414
  page layout 412
  printing 424
  selecting an object from 305
  setting the default preferences 60
  text size in 229
  using legends 420
  with labels 416
  zoom level 413

legend frames, defined 505
Legend Manager tool 197
Legend window button 505
Legend window preferences
  definition 116
  setting default 126

Legend windows
  alignment of 373
  cartographic 371
  creating 369
  creating for live tables 271
  defined 505
  thematic 373
  using in layouts 420

legends
  deleting a frame from 327
  thematic maps 360, 371

licensing, node-locked 92–99
line direction 166
line objects 505
line styles 399
  change styles tool button 276
  editing 399
  interleaved 280

Link Utility for Google Earth 197
linked tables 249
  conflict resolution 263
  defined 505
  using 249
  live access tables 250

logical operators 317, 491
logos, adding to a layout 431
longitude, defined 505
longitude/latitude coordinates
  creating points on a map 223
  longitude/latitude definition 505
Longitude/Latitude Projection Map example 441
Lotus 1-2-3 tables
  creating .tab files from 204

M
Main toolbar 155
  defined 505
map layers
  adding 163
  characteristics of seamless 174
  displaying object attributes 166
  making layers selectable 169
  objects in 161
  opening seamless 173
  reordering using layer control 163
  selecting objects in 169
  using Layer Control 161
  with Info tool 168
  working with thematic 169
map scale 361
  defined 506
  displaying in status bar 19
  in Layout windows 421
map segment definition 506
Map window preferences
  definition 116
  setting default 120–121

Map windows
  defined 506
  navigating in 185
  opening tables in 184
  printing 228

MapBasic language
  defined 506

MapBasic programs
  running using a startup workspace 496
  setting default open and save directories 130

MapBasic window
  accessing 494–495

MapInfo Map
  commands 479
  limitations 479
  system requirements 478

MapInfo Map objects
  sharing 479–480

MapInfo Places 182
Index

MapInfo Professional
  documentation set 18
  exiting 149
  features 17
  improving performance 114
  installation procedure 85
  introductory data 546–550
  new features and enhancements 21, 55, 63, 65, 69
  new features and enhancements 22
  program maintenance 112
  purpose 16
  removing 112
  starting 149
  supported file formats 177
  technical support 20
  understanding the files associated with 178
  uninstalling 112
  window types 183
  Windows 2000 support 81
  Windows compatibility 17
  working with coordinate systems 440
  working with coordinate systems/projections 439

MapInfo tables
  creating 240
  editing structure 242
  with data map 480

mapinfow.prj file
  datum ID numbers 527–535
  datum id numbers 449
  editing 453–456
  projection ID numbers 446–447, 525–526
  unit ID numbers 450, 535–536

MapMarker geocoding web service 470

Mapping Wizard tool 197

maps
  determining coordinates 430
  earth and non-earth 459
  inverting a selection 332
  making labels call-outs 313
  opening in Layout windows 189
  printing 228
  selecting an object from 305
  specifying coordinates for non-earth 459
  specifying projection of 459
  text size in 230
  thematic types 344

MapX Geoset tool 197

Marquee Select tool button 307

Mastermap Topography Layer 208

menu shortcuts 518–522

metadata
  cartographic legends 423
  linked tables 249

Microsoft Access tables
  opening 179

Microsoft Data Map
  with MapInfo tables 480

Microsoft Data Map, with MapInfo tables 480

Microsoft Windows compatibility 17

Microstation Design
  opening in MapInfo Professional 34
  refreshing 38

Military Grid Reference System
  definition 507
  setting default 123

minimum bounding rectangle (mbr) definition 507

mode.ini file, example in application data files 115

modifying
  raster image control points 435
  thematic maps 362

MrSID Raster Handler
  raster format 432

multipoint objects
  grouping objects using 396

N

Named Views tool 197

native projections definition 507

natural break range type 346

network installation 90

new features and enhancements 21–22, 55, 63, 65, 69

NITF Format (*.ntf) files
  raster format 432

node-locked licenses
  product activation 92–99
  transferring 99, 101

nodes
  add node tool button 276
  defined 507
  deleting 278
  displaying 166
  duplicate 122
  maximum number of 294
  moving duplicate 296
  reshape mode 294
  selecting multiple 294
  selecting using snap mode 295
  using Overlay Nodes command 277

non-earth maps
  defined 507
  specifying coordinates of 459
  using 459
North Arrow tool 197
*.ntf files
raster format 432

O

object linking and embedding (OLE)
registering objects with containers 478

objects
adding objects to search within polygon 308
clear target 391
converting to polyline objects 283
converting to region objects 178, 369
deselecting 306
drawing 280
finding 311
finding selected 312
highlighting 136
object size 387
overview of combining 388
proportioning associated data after split 392
selecting from a layout or map 305
selecting with tool buttons 305
selecting, using selectable layers 169
setting default style for 135
specifying geographic attributes 278
splitting polyline at node 283

objects, editing
attributes 292
autotracing 297
combining with set target 389
creating territories by combining 393
deleting 288
multipoint and collection 396
object conversion 298
object offset 289
positioning and sizing 289
procedure 288
reshaping 293–295
rotating 289, 291–292
set target model 388
smoothing/unsmoothing polylines 298
snap mode 296
splitting 392
styles 280

Oblique Azimuth parameter
coordinate systems 451
Oblique Azimuth projection parameter 537

ODBC connections, data sources 253
ODBC drivers 90
defined 507
ODBC error messages 266

ODBC tables
defined 507
offsetting map objects 289

OGC
GML2 data 466
web map services 463

online reference guides
Adobe Acrobat Reader 112
Crystal Reports 112
installing 112

Opening
an existing report 246
ASCII files (.txt) 179
data files 179
dbase (.dbf) files 179
ESRI shapefiles 204
Excel (.xls) files 179
file formats supported 177
grid layers 183
MapInfo Professional grid files 206
maps in Layout windows 189
raster images 433
remote tables 182
tables 179
tables in Browser windows 186
tables in Map windows 184

Opening vs. Importing 192
operators
expressions 317
geographic 490
logical 491
operator precedence 493
string 489

Oracle
converting unsupported geometries 267
geometry conversion behavior 268
object map verification to support validation 270

Oracle Call Interface (OCI) error messages 266
Oracle Spatial 270–271
origin projection parameter 536
outer joins
defined 508
Output Settings preferences
definition 116
specifying 130–132
overview of combining map objects 388

Overview tool 197

P
packing a table 243, 405, 508
page layout
Layout windows 412
Index

page setup
  Layout windows 424
  preparing to print 227
panning documents 111
Parameters, projections 452
*.pcx files
  raster format 432
performance 114
per-row styles 249
per-user installation 85
Photoshop 3.0 (*.psd) files
  export format 193
  raster format 432
pie chart maps 348
  template 356
pin map definition 508
pixel definition 508
*.png files
  raster format 432
  web map service
  format 464
point object definition 508
point size definition 508
pointer definition 508
points
  creating for intersections 224
  creating from coordinates 223
  dispersing 224
  displaying geocoded 221
Polyconic coordinate systems 452
Polyconic projection 452, 537–538
Polyconic Projection Map example 443
polygon objects
  creating Voronoi 395
  defined 508
  drawing 281
  drawing orthogonal 281
  tracing 282
polygon overlay definition 509
Polygon Select tool button 308
polyline objects
  converting regions to 298
  converting to regions 282
  defined 509
  drawing 281
  node limits 294
  smoothing and unsmoothing 298
  splitting at node 283
  splitting map objects using 392
  tracing 282
population density
  computing with SQL select 323
Portable Network Graphics Format (*.png) files 432
  export format 193
preferences
  Address Matching 116, 129
  detting default Legend Window 125
  directories 326
  Directory Definition 116
  layout 60
  Legend Window 116
  Map Window 116
  Output Settings 116, 130, 132
  Printer 116, 134
  setting 117
  setting default directory search options 130
  setting Directory 129
  setting find selection copying/pasting 70
  setting Legend Window 126
  setting Map Window 120–121
  setting Startup 126
  setting System 118
  setting two-digit years 120
  setting Web Services 136
  Startup 116, 127
  Style 116, 136
  System Settings 116
  Web Services 116
Printer preferences
  definition 116
  specifying 134
  storing information in workspaces 160
printing
  fill patterns 280
  layout windows 424
  map windows 228
  page setup 227
  setting defaults 132
  text 229
  translucent images 438
  troubleshooting 230
prism maps
  viewing a previous prism map 229
product activation
  node-locked licenses 92–99
projection types
  mapinfof.prj ID numbers 446–447
projections
  additional resources 543
  creating mapinfof.prj file 453
  datums 449, 527–535
  defined 509
  examples of mapinfof.prj entries 452
  mapinfof.prj ID numbers 525–526
  origin point 450, 536
parameters 524–538
raster images 437
resources 446
units 450
Proportion Weighted Average function
   Update Column command 245
proxy server 143
*.psd files
   raster format 432
push-pin map definition 508
Q
quantile range type 347
queries
   bound objects in spatial 271
   collecting and deriving data 310
   creating using SQL Select command 314
   displaying results in Map window 312
   saving as query tables 325
   saving in workspaces 326
   saving in workspaces startup preference 127
   Select command 310, 318
   using templates 326
   using the Select command 313
query tables
   defined 509
   saving 325
   setting default open and save directories 130
query templates 326
Quick Start dialog
   displaying on startup 128
R
Radius Select tool button 307
radius, calculating buffer 382
range parameter
   coordinate systems 451
range projection parameter 537
ranged maps
   defined 345
   template 356
   types 345
raster
   save window as supports more formats 426
raster format
   Arc Grid format 432
   ECW format handler 432
   emf files, (*.emf) 432
raster images
   adjusting the contrast or brightness of 437
   adjusting translucency 438
   color options 436–437
data limitations in 437
defined 509
displaying multiple images 436
modifying control points 435
opening 433
placing a logo on a page layout 431
projection limitations 437
registering 430, 433
setting default display 131
setting default ROP display method 132
setting zoom layering defaults 121
style override 437
support for 178
supported file formats 432
transferring vector coordinates to 435
translucent images 438
what are 430
what is registering 430
zoom layering 437
read-only tables
   making editable 167
record definition 509
redistricting
   defined 509
definition and purpose 482
district styles 485
   grouping map objects into districts 482
   records with no graphic objects 485
region objects
   converting polylines to 282
defined 510
geocoding matches 219
node limits 294
region styles 398
   change styles tool button 276
Register Vector tool 197
registering
   ASCII data 206
   OLE objects with containers 478
registering a raster image
   control point coordinates 433
   modifying control points 435
   registration definition 510
registry settings
   advanced 113
   modifying 113
remote database tables
   conflict resolution 263–265
disconnecting from 266
disconnecting from database 266
find command in 69
geocode command and 70
linked tables 249
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>live access 250</td>
</tr>
<tr>
<td>opening 182, 258–259, 273</td>
</tr>
<tr>
<td>per-row styles 267</td>
</tr>
<tr>
<td>requirements 248</td>
</tr>
<tr>
<td>saving 264</td>
</tr>
<tr>
<td>setting default open and save directories 130</td>
</tr>
<tr>
<td>spatial index columns 252</td>
</tr>
<tr>
<td>storing and retrieving spatial objects 251</td>
</tr>
<tr>
<td>storing coordinate values 251</td>
</tr>
<tr>
<td>symbol styles in mappable tables 267</td>
</tr>
<tr>
<td>time and date/time support of 72</td>
</tr>
<tr>
<td>removing</td>
</tr>
<tr>
<td>MapInfo Professional 112</td>
</tr>
<tr>
<td>renaming</td>
</tr>
<tr>
<td>tables 243</td>
</tr>
<tr>
<td>reports</td>
</tr>
<tr>
<td>opening 246</td>
</tr>
<tr>
<td>opening an existing 246</td>
</tr>
<tr>
<td>reports, creating 245</td>
</tr>
<tr>
<td>reshape mode 295</td>
</tr>
<tr>
<td>moving duplicate nodes 122</td>
</tr>
<tr>
<td>reshape tool button 276</td>
</tr>
<tr>
<td>reshaping map objects 293–294</td>
</tr>
<tr>
<td>result codes 221</td>
</tr>
<tr>
<td>geocoding 471</td>
</tr>
<tr>
<td>understanding 471</td>
</tr>
<tr>
<td>ROP display method</td>
</tr>
<tr>
<td>printing/exporting transparent images 438</td>
</tr>
<tr>
<td>Rotate Label tool 197</td>
</tr>
<tr>
<td>Rotate Map Window tool 197</td>
</tr>
<tr>
<td>Rotate Symbols tool 197</td>
</tr>
<tr>
<td>rotating</td>
</tr>
<tr>
<td>map objects 291–292</td>
</tr>
<tr>
<td>objects 289</td>
</tr>
<tr>
<td>rows</td>
</tr>
<tr>
<td>adding to tables 240</td>
</tr>
<tr>
<td>appending to a table 236</td>
</tr>
<tr>
<td>Ruler window</td>
</tr>
<tr>
<td>with drawing tools 279</td>
</tr>
</tbody>
</table>

### T

| S key 295                                                           |
| saving                                                               |
| copies of tables 191                                                 |
| DBMS tables 264                                                      |
| labels 411                                                           |
| MapInfo workspaces 190                                               |
| printer information to a workspace 160                               |
| queries 325                                                          |
| queries in workspaces, preference 127                               |
| query templates 327                                                  |
| thematic map layers 364                                              |
| thematic templates 364                                              |
| workspace as an XML-based file 190                                   |
| scale                                                                |
| displaying in status bar 19                                          |
| layout windows 422                                                   |
| scale bar definition 510                                             |
| scale factor parameter 537                                           |
| coordinate systems 451                                               |
| Scale Factor, Transverse Mercator projection 451                    |
| Scalebar tool 197                                                    |
| scanning definition 510                                             |
| scroll bars                                                          |
| defined 510                                                          |
| setting default display 121                                          |
| scrolling documents 111                                              |
| seamless map layers 172                                              |
| available features 174                                               |
| info tool 174                                                        |
| opening 173                                                          |
| turning on and off 173                                               |
| Seamless Table Manager tool 197                                     |
| Search and Replace tool 197                                          |
| searching                                                            |
| adding objects to a selection set 308                                 |
| Select tool button 305                                               |
| selecting by querying                                                |
| aggregating data 328                                                 |
| calculating distance to a fixed point 337                           |
| expressions 315–317                                                  |
| finding duplicate values in a column 335–336                        |
| joining tables 330–331                                               |
| query templates 326                                                  |
| saving queries 325                                                   |
| Select command 318                                                   |
| SQL Select command 303, 321                                          |
| SQL Select examples 323                                              |
| ungeocoded records 220                                               |
| where condition 332                                                  |
| selecting from the screen                                           |
| a single object from a map or layout 305                             |
| in browser windows 245                                               |
| making layers selectable 304                                         |
| multiple nodes 294                                                   |
| selectable layers 304                                                |
| tool buttons 305                                                     |
| selection tools                                                      |
| seamless layers 174                                                  |
| selections                                                           |
| cancelling 309                                                       |
| defined 302                                                          |
| inverting 309                                                        |
| specifying map highlighting 136                                      |
| Send to Back command 414                                             |
Send to MapX Mobile tool 198
server authentication
  web services 462–463
servers
  web feature service 467, 469
Set the Minimum Bounding Rectangle tool 198
shapefiles
  opening 204
  setting default open and save directories 130
Shields tool 198
shortcuts 518–522
SID files
  raster format 432
smoothing polylines 298
snap
  selecting nodes and centroids 295
snap and thin settings
  saved in metadata 295
Snap Radius, display preference 296
Snap to nodes 295
snapshot
  defined 511
snap tolerance
  map window preference 296
  setting preference for 122
spatial analysis definition 511
spatial index columns 252
spatial objects
  storing and retrieving requirements 251
spatial queries
  bound objects 271
Spatial Tab 261
Spatialize SQL Server Table tool 198
SpatialWare
  bound objects in spatial queries 271
  live access limitations in v. 4.6 250
specifying
  a map projection 459
  bounds of coordinate systems 447
  coordinates for a non-earth map 459
spherical calculations
  buffer regions 382
spherical calculations, as default setting 123
spherical coordinates definition 511
SpiderGraph tool 198
splitting objects 392
Spot Image files
  raster format 432
SQL queries
  defined 511
SQL Select command
  calculating distance to a fixed point 337
  finding duplicate values in a column 335–336
  formulating queries 314
  joining tables 330–331
  population density 323
  selecting by querying 321
  where condition 332
SQL Server
  converting unsupported geometries 267
  geometry conversion 268
SSL protocol 463
standard deviation
  defined 511
  ranged thematic maps 347
standard parallels parameter 536
  coordinate systems 451
Standard toolbar 154
starting MapInfo Professional 149
Startup preferences
  definition 116
  specifying 127
  specifying default 126
Statistics button definition 512
Statistics window definition 512
status bar
  defined 512
  using 19
street
  finding exact matches 216
  geocoding precision 214
  inset, placing geocoded points 217
  names, geocoding matches 217
  numbers, matching to address range 218
street address, finding 311
string operators 489
Structured Query Language (SQL) definition 512
Style preferences
  definition 116
  specifying 135
styles
  changing symbol 284
  custom symbols 286
  districts 485
  drawn objects 280
  interleaved line 280
  labels 409
  line 399
  overriding for raster and grid images 437
  region 398
  symbol 400–401
  text 402
  using per row 267
Styles Tab 261
subselect definition 512
support, technical support 20
supported file formats
  opening files in MapInfo Professional 200
  raster images 432
Symbol button definition 512
Symbol Maker tool 198
Symbol Style button definition 512
symbol styles 401
  changing 284, 400
  mappable DBMS tables 267
  style change tool button 277
symbols
  custom 285
  defined 512
  drawing 284
  supported fonts 285
Synchronize Windows tool 198
system requirements
  MapInfo Map application 478
  Oracle Spatial 270
System Settings preferences
  advanced options and settings 113
  definition 116
  setting 118–119
T
Table Manager tool 198
table row definition 513
tables
  adding new temporary columns 368
  appending one table to another 237
  associated files 178
  closing 192
  creating 240
  creating a new DBMS 259
  creating using Combine Objects Using Column command 242
  creating, using subset of a file 320
  defined 512
  inverting a selection 332
  renaming 159
  ungeocoding 222
  unlinking a dbms table 229
  variables 381
  viewing a list of open 208
tables, managing
  browsing 245
  deleting 243
  exporting 502
  importing 503
  indices 179
  making read-only tables editable 167
  packing 243
  renaming 243
  setting preferred view 181
  updating 235
tables, modifying
  adding rows 240
  adding temporary columns 234
  appending rows to 236
  collecting data using update column 244
  editing structure 242
  joining 330, 342
  parsing data to multiple columns 237
tables, opening
  in browser windows 186
  in workspaces 130
  procedure for 179
  setting default directories 130
  setting preferred view options 181
tables, remote database
  conflict resolution 263–265
  disconnecting from database 266
  linked tables 249
  live access 250
  opening 182, 258–259, 273
  per-row styles 267
  requirements 248
  saving 264
  spatial index columns 252
  storing and retrieving spatial objects 251
  storing coordinate values 251
  symbol styles in mappable tables 267
tables, saving
  setting default directories 130
Tagged Image file format (*.tif) files 432
  export format 193
Targa (*.tga) files
  raster format 432
target district
  defined 513
technical support
  obtaining 20
  offerings 20
templates
  deleting 327
  renaming 326
  samples 362
  saving thematic 364
temporary tables. See selecting by querying, selections
Terminal Services/Citrix support 82
territories
  creating by combining objects 395
text box size limits 126
text cursor definition 513
text objects
  using text in maps 287
  with labels 410
Text Style button 513
text styles 277, 402
text, viewing and printing 229
*.tga files
  raster format 432
thematic layers
  setting order using layer control 170
  using with layer control 169
thematic maps
  as layers 360
  defined 513
  expressions with 341
  grid surface 374
  inflection points 369
  joining tables in 342
  layers 343–344, 513
  modifying 362
  multi-variable 358
  obtaining data 342
  one-variable 357
  saving 363
  shading 513
  step 1 choosing a template type 355
  step 2 choosing thematic values 357
  step 3 customizing 359
  thematic mapping definition 340
  types of 344
  using Update Column command 365
  variables 513
theme legends
  defined 513
  in layouts 420
theme templates
  saving 364
  setting default open and save directories 130
thin
  settings saved in metadata 295
TIF files
  raster format 432
*.tiff files
  web map service format 464
TIFF CMYK (*.tif) files
  export format 193
Time Data Type
  and the server 73
  downloading to MapInfo Professional 72
  remote database support 72
Time feature
  adding data types to existing data 24
  converting to a new data type 24
  creating a datetime column from two columns 26
  creating thematic maps using 27
  interpreting Access data 30
  interpreting dBase data 30
  interpreting Excel data 30
  understanding 23
  using arithmetic operators with 29
  using comparison operators with 29
  using logical operators with 29
  using the new data type for 23
TOC tool 198
Tool Manager
  listing of tools 195, 197–198
toolbars 513
  DBMS toolbar, buttons on 157
  drawing toolbar buttons 157
  hide/display 154
  main toolbar buttons 155
  removing 154
  reshaping 154
  standard toolbar buttons 154
  web services 462
tools
  autolabeler defined 195
  cogoline defined 196
  concentric ring buffers defined 196
  coordinate extractor defined 196
  coordsys bounds manager defined 195
  create line by length defined 196
  DBMS catalog defined 196
  DBMS count rows in table defined 196
  degree converter defined 196
  disperse points defined 196
  distance calculator defined 196
  easyloader defined 196
  geotracker 196
  grid defined 197
  grid maker defined 196
  HTML image map defined 197
  labeler defined 197
  legend manager defined 197
  link utility to Google Earth defined 197
  mapping wizard defined 197
  MapX geoset defined 197
  named views defined 197
  north arrow defined 197
  overview defined 197
  register vector defined 197
  rotate label defined 197
  rotate map defined 197
  rotate symbols defined 197
  scalebar defined 197
Index

seamless table manager defined 197
search and replace defined 197
send to MapX mobile defined 198
set the minimum bounding rectangle defined 198
shields defined 198
spatialize SQL server table defined 198
spidergraph tool defined 198
split polyline at node 283
symbol maker defined 198
synchronize windows 198
table manager defined 198
toc tool defined 198
universal translator defined 198
workspace packager defined 198

Topography layer 208
trazing polylines and polygons 282
transferring node-locked licenses 99, 101
transformation definition 513
translucent images
printing and exporting 438
transparent images
rop display method 438
Transverse Mercator projection
example 442
scale factor 451, 537
two-digit years 120

U
Undo command 119
ungeocoding
ungeocode definition 514
ungeocoding tables 222
uninstalling
license transfer 101
units
mapinfow.prj ID numbers 450
units projection parameter 535–536
Universal Data
avoiding out of disk space errors with 38
coordinate systems and 38
extending MapInfo Professional with FME Suite 39
opening 34
opening more formats with 39
refreshing 38
working with FME Suite 39
Universal Translator
file types supported 150
Unselect All button 306
unselect all tool 306
unsmoothing polylines 298
Update Column command
adding temporary columns 234
parsing data to multiple columns 237
placing graphic information in columns 239
updating tables 235
using aggregate functions 244
using proportion weighted average 245
with thematic mapping 342

US_ZIPS.TAB
geocoding to postal code centroids 215
USGS Spatial Data Transfer Standard
opening in MapInfo Professional 34
refreshing 38
UTM Projection Map example 445

V
vector image definition 514
vector maps, transferring coordinates to raster 435
Vertical Mapper Grid Handler 376
Voronoi polygons 395
VPF NIMA/NGA Data
opening in MapInfo Professional 34
refreshing 38

W
warning messages
controlling display of 122
web feature service
defined 514
retrieving coordinate data 466
server authentication 462–463
server requirements 467, 469
setting preferences 136
web map service
defined 514
error messages 465–466
importing files 211
layers, default projection 463–464
obtaining raster map images from servers 463
server authentication 462–463
setting preferences 136
supported image formats 464
web services
accessing 462
geocoding 470
preferences 116
proxy server 143
setting access to timeouts and proxy server 136
types 462
weighted average definition 514
where condition 331
wildcard characters 317
window definition 514
Window Manager tool 198

Windows Bitmap (*.bmp) files
  raster format 432

Windows Metafile format (*.wmf) files 432
  export format 193
  raster format 432

Windows registry
  advanced settings 113
  modifying 113

Workspace Packager tool 198

workspaces
  default open and save directories 130
  default search paths 130
  defined 515
  opening 159
  printer information 127
  saving as .mws file (xml-based) 190
  saving as xml-based file 190
  saving printer information in 160
  saving queries 127
  saving queries to 326
  thematic maps 363
  using 160
  with renamed tables 159

Workstations
  custom installation 88

Z

zoom layering
  defined 515
  labeling 406
  raster layers 437
  setting raster and grid layer defaults 121
  specifying in layer control 165

zoom level
  displaying in status bar 19
  Layout windows 413

Zsoft Paintbrush (*.pcx ) files
  raster format 432